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5 CHAPTER

General Ledger contains many standard reports to help you quickly and easily produce and view information you
need. Reports in General Ledger are valuable tools for evaluating your financial position, charting growth, and
distributing information about progress. You can print balance sheets, income statements, trial balances, and
prepare financial statements to meet FAS 117 guidelines.

Note: Visit our website at www.blackbaud.com for the latest documentation and information.

This chapter explains the basics of reporting and includes a list of all reports available in General Ledger. In
addition, you will find explanations for the basic tools used in Reports and tab functions. Reports Basics also
contains procedures for creating, printing, previewing, sending as e-mail and exporting reports. Each report is
described in detail in the chapter for that report category. Pivot reports are discussed in the Pivot Reports Guide.

Note: General Ledger is the primary financial transaction register that contains all balance sheet and income
statement accounts. You use General Ledger as a central storage file for all financial transaction records,
whether they are created in subsidiary programs like Accounts Payable or added as manual journal entry
transactions directly in General Ledger. Project reports are available only if you have the optional module
Projects and Grants.

In General Ledger, reports are divided into categories:

e Account Reports

¢ Allocation Reports

¢ Budget Reports

e Custom Reports

¢ Financial Statements

e GASB 34 Reports

e Grant Reports

¢ Journal and Batch Reports

e Pivot Reports

e Project Reports

Basic Reporting

The Reports page is the central location for reporting in General Ledger. On the navigation bar, click Reports to
access the Reports page. This page contains links to each report category. When you click a link, the program
displays a list of the reports in that category.
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Accessing Reports

To select a report, click the link for the category of reports you need from the Reports page. For example, in
General Ledger, click Budget Reports.
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Glossary: A budget distribution is a template that provides a method for you to distribute budget activity
manually, evenly, or with a table among accounts. If you have the optional module Projects and Grants, you
can also apply budget activity manually, evenly, or with a table to projects.

On the Budget Reports page, select Budget Distribution Report in the list on the left. If any budget distribution
reports have been saved, they appear on the right of the screen. You can either open one of the saved reports or
create a new report. For more information about creating or opening a budget distribution report, see the Budget

Reports chapter.

Note: Any column on a report can be hidden, including the base column.
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Relative Date Range Reporting

The Financial Edge now supports relative date ranges for multiple column reports. This means you can save time
by creating report columns using relative dates instead of setting up reports with columns for each specific
reporting period.

A relative date range is a period of time in relationship to a specified date. For example, you could define a report
for the current period, and then have one column for each of the five preceeding periods. By changing the
definition for one column (the base column), all the columns defined relatively will change.

The basic process for using relative date ranges is to create a column and select a date range. This column can
then be used as a base column. The relative dates on a column are relative to the base column you select.

For example, let’s say you want a month by month income statement. Previously, you would have to set up 12
columns. On each column you would define the date range (i.e. 2014 period 1, 2014 period 2). In this scenario, if
you wanted to go back and run the report after the year-end, you would have to redefine the columns. This
process is time consuming.

Now, you simply create the first column: 2014, period 1. Then, on column 2, choose "Relative range" and add
one fiscal period to column 1. Copy that column and change it to add 2 periods, and proceed up to 12. Next year,
instead of redefining those columns, you can copy the report, change column 1 to say 2015, period 1, and you are
done.

Note: Because your columns are now interconnected by relative dates, we recommend you save whenever
you add or edit a column, or after reordering columns.

You can use relative date ranges for the following General Ledger reports:

Financial Statements

Balance Sheet

Income Statement

Statement of Activities
Statement of Financial Position
Statement of Functional Expense
Custom Management Report

Project Reports

Project Financial Statements

Set up a Relative Date Range

To use relative date ranges in your reporting, you select “Relative range” and define the base column on the Date
Range tab. From the Columns tab, click New Column to access the Column <#> screen, showing the General, Date
Range, and Filters tabs.



From the General tab you can name and define report columns on this tab.

Column 4

General | Date Flangel Filtersl

Column heading:
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On the Date Range tab, the selections you make determine date range for which balances are included on the

report.

e

Column 4

=)

General  Date Range i Filtersi

[rate: | <Undefined date range>
Basze column: ] _:J

Flus # miriusg: W

Mumber: |-| |M0nth[s] ..Z.J

ok ] Cancel 1

%

In the Date field, select “Relative range.”

The options on this screen will change based on your selection in the Base column field. The base column
drop-down includes all date columns except those defined as Relative range, Include all dates, or Specific range.

When you enter the base column, consider the following:

¢ You cannot delete the base column if a relative date column references it.

¢ You cannot change the base column to a different period basis if a relative date column references it. For
example, if the base column is “This fiscal year,” you cannot change it to “This month” or “This fiscal period.”

¢ You need to define at least one date column before setting a relative range.

¢ If your organization has a short fiscal year, do not use it as a base.
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If your organization has a short fiscal year, we recomend the following:
¢ Do not use it as a base.

¢ Do not refer to it in a relative date range.

¢ Do not refer to a date range that crosses the short fiscal year.

For example, if you used fiscal years ended 6/30 until 6/30/2009 and then had a short fiscal year ended
12/31/2009 to change to a calendar year, we recommend you do not use a base year of calendar year 2014, and
in a relative range column refer to 2009 (either the fiscal or short year) or before. In instances like this, we
recommend you use specific date references for those columns.

Note: You cannot set relative date ranges against all dates, specific ranges, or other relative date columns.

Manage Tags

The Manage Tags feature allows you to better organize and filter your Financial Edge report parameters. For
example, you can filter all of your saved report parameters by tags and categories, such as “Reconciliation” or
“Fiscal Year 2012.” When you mark the checkbox to show a tag or category on a reports page, only the report
parameters with that specific tag and category display.

To create and manage report parameter tags, simply select Manage Tags below the list of reports on any Reports
page. You can create as many categories and tags as you need, and when necessary, mark tags inactive.

To tag a report parameter, simply right-click an existing parameter and select Tags from the menu. Every
category and tag you have created in that module appear on the list.

» Manage report tags
1. From Reports, select Manage Tags. The Manage Tags screen appears. From here, you can add new tags

and categories, or edit and delete existing tags and categories. You can also use the arrows in the top right
corner of the screen to move items up or down in the list.

Manage Tags E

& Mew Edt ™ Delete

-Year
2012

- Purpose
Auditars
Recaonciliation

EHsave | Cancel |
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2. Select New to add a new tag and category. The Add Tag screen appears.

Cateqgony: ||
Tag |
[V Active
[E 5ave | Cancel |

3. Enter a report category and name for the tag. If you want the tag to be active, mark the checkbox.
Select Save. You return to the Manage Tags screen.

5. You can also edit and delete tags, as well as organize your list of categories and tags. You can change the
name or delete categories and tags at any time.

6. Once you have made your changes, select Save.

» Tag a report parameter

1. Totag a report parameter, simply right-click an existing parameter and select Tags from the menu. Every
active category and tag you have created in that module appear in the menu list.

[PE The Financial Edge (Sample Data) 1=l 3
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2. Select the category and tag. You return to the Reports page.

Tabs

Whether you create a new report or open a saved report in General Ledger, a screen appears with tabs to specify
how the report should look and the information included in the report. Like folders in a filing cabinet, these tabs
help you select information to appear on a report. For example, the Budget Distribution Report report includes
the General, Filters, and Format tabs. To navigate among a report’s tabs, select a tab or use Back and Next. Once
you learn to run one report, it is easy to run other reports because many of the tabs have similar features.
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Reports have common tabs with similar selections. Remember that records must satisfy all parameter settings
you select for the report before they are included in the report. For example, if you mark Include accounts with
zero budgets on the General tab, this does not mean all accounts with zero budgets in the database appear on
the report. A selected date range or a filter can eliminate some accounts. For more information about tabs for a

specific report, see that report in its respective chapter.

Following are pictures of each tab in General Ledger reports. Keep in mind that options, fields, and other

selections vary from report to report.

Note: Keep in mind that options, fields, and other selections vary from report to report.

General Tab. On the General tab, you set parameters specific to the report. You can make selections for the
format and information in the report. All General Ledger reports use the General tab.

A Hew Balance Sheet
File Edt “iew Favorites Tools Help

23 0= =2

1: General | 2: Filters | 3 Columng | 4: Multiple Caolumn Headings | o Folmatl

ﬂ@ at level Irﬁ

|Jze chart template ||j1

v Include acecounts with zero balances

v Include inactive accounts

[T Create an output quemny of accounts

Feport orientation: IF'ortrait 'I

Glossary: A filter is a requirement records must meet to be included in a report. For example, if you apply the
Accounts filter, only the accounts you select are included in the report. You can select filters to apply to a

report from the Filters tab.

Filters Tab. On the Filters tab, you include records based on selected criteria such as accounts, funds, attributes,
or cash flow codes. For example, to run a balance sheet and include accounts with a class code of Unrestricted
Net Assets. Only accounts with a class code of Unrestricted Net Assets recorded in the Class field in the
account record appear on the report. Accounts with other class codes, such as Temporarily Restricted Net
Assets or Permanently Restricted Net Assets, do not appear on the report. All General Ledger reports use the
Filters tab. For information about filters for a specific report, see that report in its respective chapter.
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For each filter listed in the Filters column, specify whether to include all or selected records. When you do not
want to filter records from the report using criteria listed in the Filters column, select All in the Include
column. For example, for a report to list all accounts, regardless of class code, select All in the Include column
for Classes. When you select All, <All Classes> appears in the Selected Filters column. For more information
about filtering criteria, see the Program Basics Guide.

I Mew Balance Sheet
File Edit “iew Favortes Tools Help
FlERE =R

General  Filters | Columns I Multiple Calumn Headings I Format I

&0 0pen 7 Clear Al Filters

Filkers I Include I Selected Filkers ﬂ

Funds all <Al Funds =

Account Codes all <Al Account Codes=

Accounts all <Al Accounts =

Account Aktributes all <Al Account Aktributes =

Projects all <all Projects =

Project Attributes all <all Project Attributes =

Transaction Attributes all <Al Transaction Attribukes =

Classes all <Al Classes=

Journals all <Al Journals =

Mok ek Posted Transactions  Selected <Mone=

Cash Flow Codes All il Cash Flow Codes =

wWorking Capital Codes all <l waorking Capital Codes -

Columns Tab. On the Columns tab, you can format how columns appear on the report. You can enter a heading

and specify the alignment and width of the column. You can select to show headers and totals for each
column and whether to indent the column based on your chart template. Only financial statements and the
Chart of Accounts and Working Capital Schedule (Account Reports) use the Columns tab.

Note: Selections made on the General, Date Range, and Filters tabs of the Columns tab apply only to report
columns and not to the report itself.

The Columns tab opens to three additional tabs: the General, Date Range, and Filters. On the Columns tab you
can open existing columns, delete columns, and view the heading, formula, and dates for columns you have
already created. On the General tab you name and define report columns. Selections you make on the Date
Range tab determine the period or date for which balances are included on the report. On the Filters tab you
can select filters that apply only to the selected columns and not the entire report. For more detailed
information about the Columns tab, see the Financial Statements chapter..

I3 New Balance Sheet x|
File Edit View Favorites Tools Help
daIa a2 |

1: General | 2: Filters | 4: Multiple Column Headings | 5: Format

lurmn @3 Open Column B® Fepeat Column 7 Delete Calumn

Hide? | Heading | Farmula | Date Range
L] (l Account Mumber
| 2 | - Account Description
| e [ Acual {actualt 013172006
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Multiple Column Headings Tab. On the Multiple Column Headings tab, you can specify to have one heading

cover many columns. Only financial statements and two account reports use the Multiple Column Headings
tab. For more information about this tab, see the Financial Statements chapter.

n Hew Balance Sheet
File Edit Wiew Favorites Tools Help
u _5. % —ﬁ |||¢.| ? -

1: General] 2 Filtersl 2 Columnz 4 Multiple Column Headings IE: Format]

Heading | Skart Column | End Column Align

Format Tab. On the Format tab, you designate the format of the report. Settings on this tab determine the

appearance of the report. You can create headings, page footers, and report footers. You can select details
and the criteria used to create the report and include the criteria list with the report. On some reports you can
sort or break the report according to selections you make. You can select the format for displaying monetary
amounts and select colors for the report. All General Ledger reports use the Format tab.

The list on the left of the screen displays formatting options for the report: Headings, Criteria, Detail, Grand
Totals, Sort, Page Footer, Report Footer, Miscellaneous, and Color Scheme. When you select an item in the
list, the right side of the screen displays selections for that section of the report.

For example, in a balance sheet, select Sort, and sort options appear on the right. To print a separate
statement, mark the Print a separate statement for each and select from several categories, such as Fund,
Expense Category (Account Attribute), or Journal. In the Show field, you can select from a variety of details
and summary or a combination.

In the Sort by column, select the records to sort and the order they should appear on the report. In the Order
by column, select Ascending or Descending order. In the Action column, select <None>, Mask, or Subtotal. For
information about formatting a specific report, read about the report in its respective chapter.

1@ New Balance Sheet
File Edit “iew Fawvortes Help
u _'5\ é —a |||4| ? h
General] Filters] Eolumns] Multiple Column Headings ~ Format l
=] Headings Sort
=] Criteria
2] Detail [~ Piint a separate statement for each |Fund ﬂ
5 Page Footer Show |acc:0unt details for the entire statement ﬂ
=l ngort Faoter Sort by | Order by | Action |
2] Mizcelaneous -
] Color Scheme Account Code Aszcending Subtotal

{ Back Cancel Frint Freview Layout
| | | | |
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Report Categories

General Ledger includes many standard reports to help you produce and view information you need quickly and
easily. These reports give you information to help you stay up-to-date with every aspect of your organization. To
help you locate the report you need quickly, reports are divided into categories: Account Reports, Allocation
Reports, Budget Reports, Financial Statements, GASB 34 Reports, Journal and Batch Reports, Pivot Reports, and
Project Reports. For more information about a specific report, see that report in its respective chapter:

Account Reports

¢ Account Profile Report

e Chart of Accounts Report
¢ Chart Validation Report

¢ Fund Profile Report

¢ General Ledger Report

¢ Trial Balance Report

¢ Working Capital Schedule

Note: Allocation reports are available only if you have the optional module Allocation Management.

Allocation Reports

¢ Fee Schedule Profile

¢ Pool Profile Report

Budget Reports

e Budget Adjustments Journal

e Budget Adjustments Report

¢ Budget Distribution Report

Financial Statements

¢ Balance Sheet

® |Income Statement

¢ Statement of Activities

e Statement of Cash Flows

e Statement of Financial Position

¢ Statement of Functional Expenses

e Custom Management Report

GASB 34 Reports

¢ Statement of Activities - Schedule B

¢ Statement of Activities - Standard Format

e Statement of Net Assets - Net Assets Format
¢ Statement of Net Assets - Schedule B

¢ Statement of Net Assets Combined Balance Sheet
¢ Statement of Revenues, Expenditures, and Changes
Journal and Batch Reports

e Batch Detail Report

¢ Batch Summary Report
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e Recurring Batch Detail Report

Note: Pivot reports are available in The Financial Edge only if you have Microsoft Excel 2000 or Excel XP.

¢ Recurring Batch Summary Report
¢ Transaction Journal

Pivot Reports

Project Reports

e Project Activity Report

Note: Project reports are available only if you have the optional module Projects and Grants.

¢ Project Budget vs. Actual Report
¢ Project Detail Report
¢ Project Profile Report

Reporting Procedures

You can use a variety of parameters to define the output for reports in General Ledger. Saving these parameters
also makes future reporting easier. These procedures provide instructions for creating, printing, previewing,
sending as email, and exporting reports. While these procedures are written specifically for budget distribution
reports, you can use these same basic steps as a model for all reporting in General Ledger. For specific
information about tabs, fields, options, and checkboxes for a particular report, see the chapter for that category
of reports.

Creating Reports

Creating a report is a quick and easy process. For this procedure we focus on creating a budget distribution
report.

» Creating a report in General Ledger

Note: An action bar containing links for creating a new report, opening a report, deleting a report, and finding
a report appears above the list of reports. These links are common to all Reports pages.

1. From the Reports page, click Budget Reports. The Budget Reports page appears with a list of all budget
reports on the left.

2. Inthe list on the left, select Budget Distribution Report.

% The Financial Edge
Fille Edit Yiew Go Favortes Tools Help

& Back % Fantvand ] Community Services Inc, ~ « General Ledger ™

sharteuts .g Reports - Budget RepDrtS

I Home

'quf e Hew ‘Dgen |Delata... Reports

T P a Account

Budget Distribution Report Reports

. | Allacation
Reports
Budget
Reports
e

Budget Adjustments Journal
Budget Adjustments Repart
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3. On the action bar, click New. The New Budget Distribution Report screen appears on the General tab.

u New Budget Distribution Beport
File Edit Wiew Favortes Toolz Help

H (&= F W ?-
GBanEﬂl Filters] Format]

Show budget details for
Scenario D |D1 ﬂ M ain Budget

Include budgets in this date range

Date: | This fizcal year x| 07401 /2001 to 0643042002

Show: |Account budgets ﬂ
™ Include accounts with zero budgets

[ Include budget notes

I Include account notes

[ Include percentages

Report onientation: | Partrait &

Note: Depending on the report you are creating, fields, options, and checkboxes on the General tab vary for
each report. For General tab selections on a particular report, see the chapter for that category of reports.

4. In the Scenario ID field, select the budget scenario for the report to use. A description of the scenario
appears in the display on the right. Budget scenario ID’s are defined on the Tables tab in Configuration.

5. In the Include budgets in this date range frame, you can select a date or date range. If you select
“<Specific range>", you can specify a start date and an end date. If you leave the Start date field blank, all
activity is included up to the end date. If you leave the End date field blank, all activity from the start date

until present is included. If you leave both fields blank, all activity is included.

For this example, select “Last week”.

12 New Budget Distribution Report
File Edit “iew Favortes Tools Help

H (&= & E ?-
GEHEFEﬂ] Filters] Folmatl

Show budget detailz for
Scenario [D: |D1 ﬂ Main Budget

Include budgets in this date range

Date: |Last week | 03/02¢2001 to D3/08/2001

Showe |.&ccount budgets ﬂ
™ Include accounts with zer budgets

™ Include budget nokes

I Include aceount notes

[ Include percentages

Fepart arientation: | Portrait =

6. Inthe Show field, select a budget type. For this example, select “Project budgets” and mark Include

budget notes and Include percentages.
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7. Inthe Report orientation field, you can select “Portrait” or “Landscape”. For this example, select
“Portrait”.

l@ MNew Budget Distribution Report E2

File Edit “iew Favortes Help
HE S GG w2 |

Generall Filtersl Formatl

Show budget details for -

Scenarna |D: ID‘I ﬂ Main Budget

Include budgets in thiz date range:

Date: ILast week j 07/M15/2001 to 07/21/2001
Shioer: I Froject budgets j

™ [rclude accounts with zem Eudgets
W Include budget notes
I™ | Include account nates

¥ Include percentages

Repoart arientation: I Partrait v I

8. Click Next or the Filters tab. In the Include column for the Funds filter, choose “Selected”.

lQ Mew Budget Distribution Report E

File Edit “iew Favoitesr Help

H& S G G w2 - |

General Filtersl Formatl

&2 0pen 7, Clear All Filkers
Filkers I Include | Selected Filters I
Accounts all <Al Accounts
Funds Al j <Al Funds >
Account Attributes _ <Al Accaunt Attributes =
Categories 2 ted <l Categories =
Projects All <all Projects >
Project Attributes all <Al Project Attributes =
Department Codes(s) All <Al Department Codesis)>

9. The Selected Funds screen appears.

Selected Funds E

Inchude:; . E"

Fund I Description |

Glossary: A fund is a self-balancing set of accounts in The Financial Edge. Funds separate accounts into groups
specific to certain activities, donor-imposed restrictions, or objectives. You must set up funds in General
Ledger 7.2 before you can enter accounts.
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10. In the Fund column, click the binoculars. The Open screen appears. In the Last modified by field, select

“Supervisor”. For more information about using the Open screen to filter records, see the Program Basics
chapter in the Program Basics Guide.

l]pen

Find: | Furd E
= |Dper

Options

Find Funds that meet these

Bl Exact match only

Furd ID: | = Lestmodiisd by: [Supervisor |
Description; | j Last madified on: |an_.,. time j
Hide Filters | Clear Filtersl Filters are not applied Find Mows I [Eer | Cancel |

11. Click Find Now. A grid appears displaying all funds meeting your requirements. Select “Fund ID 01” and
click Open on the action bar.

Eopen
Find: | Furd E

Options

0z Balance by Class, Pra...

03 Balance by Class and ...
04 Balance by Class, Prao...
05 Balance by Class and ...
kg description

Find Funds that meet these criteria:

Fund 1D: I j Last modified by: ISupe[\.’isg[ j
Description: I j Last modified o |an_.,. time j
Hide Filters | Clear Filtersl Filters are applied Find Mow | Open I Cancel |

|6 records found.
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12. The Selected Funds screen appears with “01” in the Fund column and “Balance by Net Asset Class” in the
Description column.
Fund | Description I
|0t Balance by Met Asset Class
13.

Click OK. You return to the Filters tab. “01” appears in the Selected Filters column on the Funds row.

lg Mew Budget Distribution Report
File Edit “iew Favoites Tools Help

= =R = g

?- |

General Fi“E'SI Formatl

Filkers I Include Selected Filkers I
Accounts all <Al Accounts
Funds Selected 01
Account Attributes all <Al Account Attributes =
Categories all <l Categories =
Projects All <Al Projects >
Project Attributes all <Al Project Attributes=
Department Codes(s) All <Al Department Codesis)>

14. Click Next or select the Format tab. The options on the right side of the screen change as you highlight
selections in the list on the left.

15. From the list, select Headings. In the Title field, enter “Budget Distribution Report”.



16. In the Subtitle field, enter “Main Budget”.
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u Mew Budget Digtribution Beport

FEile Edit Wiew Favorites

H LSS %W

=] Criteria

=] Sort

Z] Page Footer
=] Report Footer
=] Mizcellaneous
] Calor Schemne

General] Filters FDlmat]

Help

Headings

2oy
“

Heading Format
Title: |Budget Distribution Fepart
Subtitle: |Main Budget

Aligr: [ Center -

[v Print organization name in header

[v Print Page Number in Heading [v Print Repart Date in Heading

Format: |F'age 1 ﬂ Format: |Sh0rt Date and Time ﬂ
Align: [Right =] ahan: [Let =
[V Frint repart heading on each page
< Back | | Cancel Print | Preview | Lapout |

Note: If you have the appropriate security rights, you can use credit card, bank account, and Social Security
numbers to sort report data and to identify records included in the report. The Sort by option is hidden for any
user without these rights. For more information, see the Security chapter of the Administration Guide for The

Financial Edge.

17. From the list on the left, click Sort. The sort options appear.
18. In the Sort by column, select “Account Number”.

19. In the Order by column, select “Ascending”.

u New Budget Distribution Beport

File Edit “iew Favortes
B 2= &

General] Filters Formatl

Z] Headings

=] Criteria

Sort

Z] Page Footer
=] Report Footer
2] Mizcellaneous
] Color Scheme

Tools Help
? -

Sort

Sort by | Category | Order by |
Azcending

Account Mumber

Note: You can set an option to maximize the preview window when you preview a report. To do this select
Tools, Options and mark Automatically maximize preview window.
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20.

Click Preview to preview the report on the screen. A message appears indicating the program is
processing the report. The New Budget Distribution Report screen appears so you can preview the report.

IB New Budget Distribution Report _ O] <]
x|« 1w ] e] B|F|&|F = | o
Freview

LEE e Lowzountry Preservation Society
Budget Distribtion Report
Malk Brdget

e Prnsee
110000 - Coon bud oo
Anas

Fracd S "t Lk End Litu Hudgut Acunt
20002001 [TRELELLN odizirzon| 351533
351533

e Prnsee

[IEE T
Anas

Framd wr T Lt End L Budnu Aneunt
20002001 o401 57001 odrzirzonl 35524 55

ETRETET)
e Prnsee

[T

Fameas

Framd wr T Lt End L Budnu Aneunt
20002001 oan 52001 odzizon1 3512 23

551223
e Prnsee

Dla100-00 -

Fameas

Framd st Lt End Lt Budgut Acunt

20002001 Dan szoo| oazizon z2,152 79

Note: To view the report as it will appear using your selections and filters, click Preview. To view a sample
layout of the report without data, click Layout.

21.
22.
23.
24.

When you finish viewing the report, close the view.

Click Save to save the new report. The Save Report as screen appears.
In the Report name field, enter “Main Budget Distribution Report”.

In the Description field, enter “Includes project budgets”.

Save Report as E3 I

Report name: |Main Budget Distribution Fepart

Deseniption: (|ncludes project budgets

¥ Others can run this repart
[ Others can madify this repart

& save | Cancel |

Note: You can set an option to save selections made on report tabs when you close. To do this, select Tools,
Options and mark Automatically save report parameters on close.

25.

Click Save to save the new report. You return to the Format tab.
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26. Close the screen. You return to the Budget Reports page, and the Main Budget Distribution Report
appears in the grid.

@ The Financial Edge
File Edit View Go Favorites Tools Help

4 Back % Forvward J Comrunity Services Inc, ™ * General Ledger ~

1@ Reports » Budget Reports

New |Dgen |Qa\ele Reports J

Shortcuts

" " " Account
gudgel Adustments JRW"H' Budget Distribution Report Reparts ‘
1! s Report
qr 3 epol Mame | Description | Date Created | Created By | Dther: | Allcation
Reports

4 Budget
W ain Budget Distribution 0B/25/2002 Repgrts

Budget Distribution Report Supervizor I

Financial
Skatements

GASB 34 ‘
Reparts

Printing Reports

You can print a hard copy of a saved budget distribution report without opening the report. Selections on the
Format tab of the report determine the information that prints on the report and how this information is
formatted. For this procedure, we focus on printing the budget distribution report created in “Creating Reports”
on page 15. For more information about setting up a printer, see the Program Basics Guide.

» Printing a report in General Ledger

1. From the Reports page, click Budget Reports. The Budget Reports page appears.

2. Inthe list on the left, select Budget Distribution Reports. A list of saved budget distribution reports
appears in the grid on the right.

Note: You can set an option to print the report using the orientation defined in Print Setup. To do this, select
Tools, Options and mark As defined in Print Setup. For example, if a report is designed to print in portrait, but
the print setup is set for landscape, the report prints the report in landscape.

3. Select “Main Budget Distribution Report”.

# The Financial Edge
Eile Edit “iew Go Favortes Tools Help

 Back & Eorvand J Community Services Inc, ~ = General Ledger ™

Sharteuts 1
12 Reports + Budget Reparts
= S Hew |Dgen |Qelete Reports
= " = Account
Lt Sl Ll Budget Distribution Report Reports
Budget Adjustments Report .
E Budget Distribulion Report [l |Description. | Date Created | Created By Other Qlﬁtt'g”
Budget Distribution Report 02/14/2002 Supervisor

r Budget
iMain Budget Distribution 06/25/2002 Supervisar Rapgl’ts
Financial
Statements
GASE 34 |
Reparts

Note: You can set an option to print the report using the orientation defined for the report. To do this, select
Tools, Options and mark As defined for the Report. The report prints in the orientation selected on the report
regardless of what is defined in Print Setup.

4. From the menu bar, select File, Print. A message appears that the report is printing. After the report
prints, you return to the Budget Reports page.
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Previewing Reports

You can preview the format and information in a report without opening the report. We recommend previewing
a report before printing or sending it to another person. By previewing, you can make sure you included the
required information and that the report is formatted as you want it. For this procedure, we focus on previewing
the Budget Distribution Report created in “Creating Reports” on page 15.

» Previewing a report in General Ledger
1. From the Reports page, click Budget Reports. The Budget Reports page appears.

2. Inthe list on the left, select Budget Distribution Report. A list of saved budget distribution reports
appears in a grid on the right.

3. Inthe grid, select “Main Budget Distribution Report”.

# The Financial Edge
Eile Edit “iew Go Favortes Tools Help

 Back & Eorvand J Community Services Inc, ~ = General Ledger ™
12 Reports + Budget Reports
Hew |Dgen |Qelete Reports
a A a Account
Lt Sl Ll Budget Distribution Report Reports
Budget Adjustments Report 5
B Budget Distibution Report | Name | Deseription | Date Created ‘ Created By ‘ Other. lecuartt'f”
Budget Distribution Report 02/14/2002 Supervisor o
Main Budget Distrbution 0B/25/2002  Superviser Reports
Financial
Statements

GASE 34 |
Reoorts

Sharteuts

Note: You can set an option to maximize the preview window when you preview a report. To do this select
Tools, Options and mark Automatically maximize preview window.

4. From the menu bar, select File, Preview.

Note: Click the binoculars at the top of the preview screen to search for specific information in the report
preview. Be sure you are on the first page of the preview if you want to search all pages. The search looks only
on the page you are viewing and pages after. For example, if you are on page three of the preview and click
search, it will not find the information you are searching for on pages one and two.
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5. A message appears indicating the program is processing the report. The Main Budget Distribution Report

preview screen appears.

I3 Main Budget Distribution Aeport _ O] <]
x|« 1w ] e] B|F|&|F = | o
Freview

Lowzountry Preservation Society
Budget Distribtion Report
Malk Brdget

e Prnsee

110000 - Coon bud oo
Anas

Fracd S "t Lk End Litu Hudgut Acunt

20002001 [TRELELLN odizirzon| 351533
351533
e Prnsee

[IEE T
Anas

Framd wr T Lt End L Budnu Aneunt

20002001 o401 57001 odrzirzonl 35524 55
ETRETET)

e Prnsee

[T

Fameas

Framd wr T Lt End L Budnu Aneunt

20002001 oan 52001 odzizon1 3512 23
551223

e Prnsee

Dla100-00 -

Fameas

Framd st Lt End Lt Budgut Acunt

20002001 Dan szoo| oazizon z2,152 79

6. When you finish previewing the report, close the screen. You return to the Budget Reports page.

Exporting Reports

To use report information in another software application, for example, Microsoft Excel or Crystal Reports, you
can export the report. When you export a report, you send report information from the database to another
software application using a data file. You can export a report without opening the report. For this procedure, we
focus on exporting the Budget Distribution Report created in “Creating Reports” on page 15.

»

Exporting a report in General Ledger

1.
2.

From the Reports page, click Budget Reports. The Budget Reports page appears.

In the list on the left, select Budget Distribution Report. A list of saved budget distribution reports

appears in a grid on the right.

In the grid, select “Main Budget Distribution Report”.

# The Financial Edge
File Edit “iew Go Favortes Tools Help

4 Back & Forward J Comrmunity Services Inc. ~ = General Ledger ~

Sharteuts

12 Reports + Budget Reparts

Hew |Dgen |Qelete Reports

a A a Account

Ll Budget Distribution Report Reports
tment: I

| Mame | Deseription | Date Created ‘ Created By ‘ Other Ql?jcjiison
Budget Distribution Repart Supervigar

4 2 Budast Dic i e prm—— Budget
(Main Budget Distribution ... 06, 0z 5 o Reports
Financial
Skatements

GASE 34 |
Reparts

4. From the menu bar, select File, Export. A message appears indicating the program is processing the

report. The Export screen appears.
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5. Inthe Format field, select “Excel 5.0 (XLS)".
6. Inthe Destination field, select “Disk file”.

Export I
Format:
- _DK
[Excel 5.0 (<L5) =l
o Canhicel |
Destination:
| Disk file =l
7. Click OK.

8. The Choose Export File screen appears. In the File name field, enter “Main Budget Distribution Report”.

ChooseEponie ____________@H|
Save jm IaTEFﬂD ﬂ ﬁl

1 _istmp0.dir @ mzoclipl
[ _istnp! i (ke

71 {3c3e523a-3487-11d5-9074-00c04/59791} (L zpwTemp
| 1 Excelf.0

] FrontPageT empDir

| ms

q| | 2

File name: IMain Budget Distribution A eport Save I
Save as lype: IE:-:u:eI 5.0 .zl j Cancel |

9. Click Save. A message appears indicating the program is exporting the data. Once the data has been
exported to the file, you return to the Budget Reports page.

Sending Reports as E-Mail

In General Ledger, you can share report information with other users through electronic mail. You can send the
results of a report to another user for further analysis or to use in other applications. When you send report
information through e-mail, you perform two functions: changing the format of the information to a data file and
sending this data file to another person. Before you can send a report to another user, you must first select a
format (such as Microsoft Excel, Crystal Reports, or Adobe Acrobat) for the data file. The format determines the
appearance of the report and the software applications in which you can open the data file. Sending report
results by e-mail can be particularly useful when an individual needs to quickly reference report results but does
not need to access or edit the report.

You can send report information by e-mail without opening the report. For this procedure we focus on sending
the Budget Distribution Report created in “Creating Reports” on page 15.
» Sending a report as email in General Ledger
1. From the Reports page, click Budget Reports. The Budget Reports page appears.

2. Inthe list on the left, select Budget Distribution Report. A list of saved budget distribution reports
appears in a grid on the right.
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3.

7.

8.
9.

In the grid, select “Main Budget Distribution Report”.

@ The Financial Edge
File Edit “iew Go Favortes Tools Help

4 Back % Forward J Comraunity Services Inc, ~ + General Ledger ~

oo 2 Reports + Budget Reports

New |Elgen |Qalele Reports

" " " Account

gujga“"d‘““mem”“”ma' Budget Distribution Report Repurts
U

get Adjustments Repart
g n A

n Report | MName | Description | Date Created ‘ Created By ‘ Mther: 2!?:?’?50”
02/14/2002

Budget Distribution Report Supervisor

[ Budget
iMain Budget Distribution 02 Superviso Ripﬂis
Financial
Statements
GASE 34 |
Reoorts

From the menu bar, select File, Send as Mail. A message appears indicating the program is processing the

report.
The Export screen appears. In the Format field, select “Report definition”.
In the Destination field, select “Microsoft Mail (MAPI)”.

Export
Earmat:
p -D K.
IHeport Drefinition j
. Cancel |
Diestination:
|Microsott Ml (aP) =]

Click OK. The Send Mail screen appears.

Send Mail H|
Send I Check Namesl Addiess | Cancel |
o |
(e I
Subject: |
IMeszage
=
=

In the To field, enter an email address. For example, enter “cjones@internet.com”.

In the Subject field, enter “Main Budget Distribution Report”.
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10. Inthe Message box, enter a message to the recipient. For example, “Here’s the budget distribution report
you requested!”

Send Mail [ X]

Send I Check Namesl Address | Cancel |

To Iciones@internet. cam

Ce: |

Subject: |Main Budget Distibution Repart

IMessage

Here's the budget distribution repart pau requested! ;I

-]

11. Click Send. The report is sent as an attachment to the message. You return to the Budget Reports page.
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Reporting categories in General Ledger include Account Reports, Allocation Reports, Budget Reports, Financial
Statements, GASB 34 Reports, Journal and Batch Reports, Pivot Reports, and Project Reports.

This chapter discusses Account Reports. For information about other report categories, see the chapter for that
category.

Note: We recommend you read the documentation for The Financial Edge thoroughly. Information presented
here provides you with basic information about account reports in General Ledger. Hands-on experience is the
best way to learn, so we encourage you to view this information and try various options with the sample
database.

Account reports in General Ledger include:

¢ Account Profile Report

¢ Chart of Accounts Report

e Chart Validation Report

¢ Fund Profile Report

¢ General Ledger Report

¢ Trial Balance Report

¢ Working Capital Schedule

Account Profile Report

The Account Profile Report provides a summary of your organization’s accounts. You can view such information
as activity, account attributes, defaults, budgets, and history of changes in the Account Profile Report.

Glossary: An account is a tool you use to group financial transactions posted from Journal Entry or programs
such as Accounts Payable, Accounts Receivable, or Payroll. Accounts show increases, decreases, and an
ending balance that provides a means for creating financial statements.

The Account Profile Report has tabs on which you set parameters: General, Filters, and Format. To move among
the tabs, click Next and Back at the bottom of the screen or select a tab. On these tabs you specify the
information to include in the report and how the report should look. For more information about creating an
Account Profile Report, see “Creating a report in General Ledger” on page 15.
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General Tab

On the General tab, you set parameters specific to the report and make selections about information included in
the report.

I3 New Account Profile Report E

File Edit “iew Favoitez Toole Help
FIEE TS |

1. General |2: Filters I & Folmatl

Include the following account information;

[ Attributes Acthivity Format-

[ Tranzaction codes Fiscal pears: [ = 2000

[ Tranzaction attributes I 2om

[T Mates W 2002

[T Activity

[ Budget worksheet Show: INEt Change j

[ History of changes Budget scenario: IDD j
Budget Work sheet -
Budget scenario: IUU j

Fizzal pear: |2|:||32 j
[~ Forecast actualz from:IPerind12 j

[~ Create an output query of accounts

Repaort anentation; ILandscape "I

Include the following account information. In the Include the following account information box, mark
the checkboxes next to the account information to include in the report.

Activity Format. If you mark Activity in the account information box, you can make selections for account
activity in the Activity Format frame. In the Fiscal years box, mark the fiscal years to include in the report. In
the Show field, select Net Change or End Balance. In the Budget scenario field, select a budget scenario.

Note: To view the report as it will appear using your selections and filters, click Preview. To view a sample
layout of the report without data, click Layout.

Budget Worksheet. If you mark Budget worksheet in the account information box, you can make selections
for budget information in the Budget Worksheet frame. In the Budget scenario field, select a budget
scenario. In the Fiscal year field, select the fiscal year to include in the report. To forecast actual amounts on
the report, mark Forecast actuals from and select a period.

Tip: If you create and save an output query of the accounts in the report, you can use the query later in other
areas of General Ledger. This saves you time by not having to create the query again for other purposes. For
more information about queries, see the Query Guide.

Create an output query of accounts. If you mark Create an output query of accounts, the program creates
a query of the accounts included in the report. You can use the query later in other areas of General Ledger.

Report orientation. In the Report orientation field, select Landscape or Portrait.
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Filters Tab

On the Filters tab, you can include information based on selected criteria such as funds, account codes, and
account attributes. For example, to include only the accounts with an account attribute of Expense Category and
a value of Salaries recorded in the account record. Accounts with other account attributes and with values other
than Salaries do not appear in the report. For more information about filtering in The Financial Edge, see the
Program Basics Guide.

lE MNew Account Profile Beport E
File Edit “iew Fawvaortes Toolz Help

e R el |

1: General  2: Filters | 3 Furmatl

&0 0pen 7 Clear &ll Filters
Filkers I Include Selected Filkers
Funds all <Al Funds =
Account Codes Al <Al Account Codes =
Accounts &l <Al fccounts =
Account Attribukes all <all Account Atkributes=
Cakegories all <Al Categories >
Deparkment(s) ol <l Department(s)=

Open. Click afilter in the grid and click Open on the action bar. The selection screen appears so you can
designate specific filters for the report.

Clear All Filters. Click Clear All Filters to remove all previously selected filters from the report.

Glossary: A filter is a requirement records must meet to be included in a report. For example, if you apply the
Accounts filter, only the accounts you select are included in the report. You can select filters to apply to a
report from the Filters tab. Be patient! Depending on the filters you select, this report may take several
minutes to run after you click Print or Preview.

Filters. The Filters column lists all the filters for this report. You cannot edit this column.

Include. Choose Selected in the Include column. A selection screen appears so you can designate specific filters
for the report.

Note: Mark Selected, Range, or Query to include a selected filter, range of filters, or a previously created
query of filters. Depending on the selection, different options appear on the screen. If you mark All, you cannot
define filters. For more information about filtering in The Financial Edge, see the Program Basics chapter in the
Program Basics Guide.

Selected Filters. Filters you specify appear in the Selected Filters column. If you choose Selected in the Include
column or click a filter and then click Open, the Selected <Filter> screen appears. If you mark Selected, Range,
or Query, a selection screen appears so you can specify filters.

Query name. The Query name field appears if you select Query. Enter the name of the query to use to filter the
report or click the binoculars to search for a query.

To create a new query, click the binoculars and click Add a New Query on the Open Query screen. For more
information about creating queries, see the Query Guide.

Previous Filter. To view or edit the previous filter without returning to the Filters tab, click Previous Filter on
the toolbar.

Next Filter. To view or edit the next filter without returning to the Filters tab, click Next Filter on the toolbar.
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Format Tab

On the Format tab, you decide how the report should look. You can create headings and footers, include a list of
criteria used to create the report, sort the information in the report, and select the format for displaying
monetary amounts. The list on the left of the screen displays formatting options for the Account Profile Report:
Headings, Criteria, Sort, Page Footer, Report Footer, and Miscellaneous. When you select an item in the list, the
right side of the screen displays selections for that section of the report.

Note: The heading defaults to Account Profile Report in the Title field. You can leave this as the title for the
report or enter your own.

Headings. Use Headings to enter a maximum of 60 characters in each of the Title and Subtitle fields. The title
and subtitle appear at the top of the report. You can select how the heading should be alighed and whether
your organization's name will appear in the header. You can include the page number and date in the heading.
You can also include the header on every page of the report.

lB Mew Account Profile Report E

File Edit “iew Favortes Toolz Help
RS -2 |

1 Generall 2 Filterz 3 Format |

B Headings H eadings

Criteria ;

St — Heading Format

Page Footer Title: IA-:cu:-unt Profile Repart
Report Footer Sublitle: I

Miscellaneous

Aligr: IEenter 'I

[+ Print organization name in header

W Print Page Mumber in Heading [¥ Frirt Report Date in Heading
Format: IF'age 1 j Farmat: IShort Date and Time j
Aligr: IHight j Aligr: ILeft j

[¥ Frint report heading on each page

Note: The program automatically selects all criteria. Unmark the checkbox for any you do not want to print
with the report.
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Criteria. Select Criteria to print a list of criteria used to create the report. Mark Print these criteria on and select
a separate page or the first page. Selections print in the criteria section of the report.

lﬂ HNew Account Profile Report %]
File Edit %“iew Favortes Tools Help

e = el e |

1: Generall 2 Filters 3 Format |

Headings Criteria

B Criteria

Sort [w PFrint these criteria on Ia separate page 'l
Fage Footer Saved report name

H?DUft Footer Olutput query nare

Mizcelaneous Funds ta include

Account Codes to include
Accounts bo include

Account attributes to include
Categories to include

|dzer account security access
Department(z] ta include

Sort. Use Sort to select the order for information to appear on the report. When you select Sort, a grid displays
the categories you can sort in the report. Select a sorting category in the Sort by column and select Ascending
or Descending in the Order by column. To print each Sort by selection on a separate page, mark Page break
on each new <Sort by selection>.

lﬂ Mew Account Profile Report
File Edit “iew Fawoites Toolz Help

B2 SR 0 e ?- |

1 Generall 2 Filkers ~ 3: Farmat |

Headings Sort
Criteria

Sort by I Categary I Order by |
Page Footer Account Hurnber Ascending

Freport Footer
Miscellaneous

™ Page break on each new
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Page Footer. Use Page Footer to create a footer to appear at the bottom of each page of the report. You can

enter a maximum of 254 characters in the Text field for the page footer. You can also select how to align the
text and include the page number and date in the footer.

l@ Mew Account Profile Report
File Edit ‘iew Favortes Toolz Help

= D= R I e

1: Generall 2 Filters ~ 3: Farmat |

Headings
Criteria
Sort

— Page Footer Text

Page Footer

B Page Footer

Test:
Report Footer
Miscellaneous

Align: IEenter 'l

= Print Page Mumber it Footer

[~ Print Repart Date in Footer

Format; IF'age 1

—

Fuarmnat; I Shart D ate and Time:

=~

Align: | Right

=

Aligr: ILeft

=

Report Footer. Use Report Footer to create a footer to appear at the bottom of the last page of the report. You
can enter a maximum of 254 characters in the Text field for the report footer and select how to align the text.

Ig Mew Account Profile Report
File Edit “iew Fawortes Toolz Help

HRE & e ?-

1 Generall 2 Filters ~ 3: Format |

Report Footer

Headings
Criteria
Sort Report Footer Text
Page Footer Text:
B Report Foater
Miscellaneous
Aligr ILeft vl

report.

Tip: Make selections for displaying amounts and view them in the Sample amount display before printing the
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Miscellaneous. Use Miscellaneous to specify how numbers should appear on the report and the font size for
the report.

lﬂ New Account Profile Report x|
File Edit ‘“iew Favortes Tools Help

e = el e |

1: Generall 2 Filterz  3: Format |

Headingz Miscellaneous

Criteria
Sort Show currency character on All amounts
Fage Footer Show percent sign on All amounts
Hport Footer Megative amount format [1234.56)
B aneoUs Mumber of digitz after decimal for amounts 2

Mumber of digitz after decimal for percentages 2

Show 1000's separator es

Shows blanks instead of zeros Mo

Font size: a

Sample amaunt:

Amaunt [$1.234.5E]
Percent 100.00%

Chart of Accounts Report

The Chart of Accounts Report lists general ledger accounts. This report displays additional general account
information such as categories, attributes, active/inactive status, and segment values.

Glossary: A chart of accounts is a systematic numeric listing of all accounts that exist in an organization’s
general ledger.

The Chart of Accounts Report has tabs on which you set parameters: General, Filters, Columns, and Format. To
move among the tabs, click Next and Back at the bottom of the screen or select a tab. On these tabs you specify
the information to include in the report and how the report should look. For more information about creating a
Chart of Accounts Report, see “Creating a report in General Ledger” on page 15.
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General Tab

On the General tab, you set parameters specific to the report and make selections about information included in

the report.

lﬂ Mew Chart of Accounts Report
File Edit “iew Favorter Tool: Help

(= REENE NN e R

1: General |2: Filkers | 3 Columml 4 Fu:urmatl

IUze chart template Im j at level Iei_il

¥ Include inactive accounts

[~ Create an output query of accounts

Fieport arientation: IF'ort[ait 'I

Note: You can change the results of a report by using different chart templates to run the same report. You
can define an unlimited number of templates in Visual Chart Organizer. For more information, see the Visual

Chart Organizer Guide.

Use chart template. In the Use chart template field, select a chart template for the report. Chart templates
are created in Visual Chart Organizer. Select the level of detail, from 1 to 10, to display on the report in the at

level field.
Include inactive accounts. To include accounts you no longer use, mark Include inactive accounts.

Create an output query of accounts. If you mark Create an output query of accounts, the program creates
a query of the accounts included in the report. You can use the query later in other areas of General Ledger.

Note: To view the report as it will appear using your selections and filters, click Preview. To view a sample
layout of the report without data, click Layout.

Report orientation. In the Report orientation field, select Portrait or Landscape.
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Filters Tab

On the Filters tab, you can include information based on selected criteria such as funds, account codes, and
account attributes. For example, you can include only the accounts with the account attribute of Location and the
value of Gym recorded in the account record. Accounts with other account attributes, such as Expense Category,
and location values other than Gym do not appear on the report. For more information about filtering in

The Financial Edge, see the Program Basics Guide.

lg Hew Chart of Accounts Report
File Edt “iew Fawonter Toolz Help

SR IR |

1: General 2 Filters | 2 Enlumnsl 4 Fnrmatl

f®0pen | ) Clear Al Filters
Filters I Include I Selected Filbers
Funds &l <Al Funds =
Account Codes all <Al Account Codes =
Accounts Al <Al Accounts =
Account Atkributes &l <Al Account Atkributes =
Cateqories Al <Al Categories =
Classes Al <Al Classes:=
Deparkmentis) Al <Al Departmentis) =

Open. Click afilter in the grid and click Open on the action bar. The selection screen appears so you can
designate specific filters for the report.

Clear All Filters. Click Clear All Filters to remove all previously selected filters from the report.

Glossary: A filter is a requirement records must meet to be included in a report. For example, if you apply the
Accounts filter, only the accounts you select are included in the report. You can select filters to apply to a
report from the Filters tab. Be patient! Depending on the filters you select, this report may take several
minutes to run after you click Print or Preview.

Filters. The Filters column lists all the filters for this report. You cannot edit this column.

Include. Choose Selected in the Include column. A selection screen appears so you can designate specific filters
for the report.

Note: Mark Selected, Range, or Query to include a selected filter, range of filters, or a previously created
query of filters. Depending on the selection, different options appear on the screen. If you mark All, you cannot
define filters. For more information about filtering in The Financial Edge, see the Program Basics chapter in the
Program Basics Guide.

Selected Filters. Filters you specify appear in the Selected Filters column. If you choose Selected in the Include
column or click a filter and then click Open, the Selected <Filter> screen appears. If you mark Selected, Range,
or Query, a selection screen appears so you can specify filters.

Query name. The Query name field appears if you select Query. Enter the name of the query to use to filter the
report or click the binoculars to search for a query.

To create a new query, click the binoculars and click Add a New Query on the Open Query screen. For more
information about creating queries, see the Query Guide.

Previous Filter. To view or edit the previous filter without returning to the Filters tab, click Previous Filter on
the toolbar.
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Next Filter. To view or edit the next filter without returning to the Filters tab, click Next Filter on the toolbar.

Columns Tab

On the Columns tab of the Chart of Accounts Report, you can open existing columns, delete columns, and view
headings and descriptions defined for columns already created. You can also use the New Column button to
create a new column.

IH Mew Chart of Accounts Report x|

File Edit Wiew Faworites Tools Help

dadam o= 2?-

1. General | 2 Filters 3 Columing |4_1: Formatl

48 New Column 8% Open Column  B# Repeat Column

Heading I Colurin Description

1 Account Mumber

2 Account Descripkion

Note: If the report is wider than the page on which you print, the Report width display becomes red to alert
you to the problem.

New Column. When you click New Column, the Column <#> screen appears so you can name and define report
columns. Use the alignment buttons to specify how columns should be aligned. In the Column width field,
enter a width, and the Report width display shows you how wide the report will be. In the Column Definition
frame in the Display field, select the type of account information to appear on the report. To show headers
and totals in this column or to indent the way the chart template indents, mark Show headers and totals in
this column or Indent based on chart template.

Colurmn 3

A& New Column e Repeat Column

Colurn heading: Colurmn width: I‘I Ao inches

Feport width:  4.67 inches

* Delete Column

Calumn Definition -
Type: I [ escription j
Display: IAccount Murnber ﬂ

I~ | Show headers and totals it this column

I~ | Indent based o chart template

[

Open Column. To open an existing column and edit its settings, select a row in the grid and click Open Column.

Repeat Column. To repeat a column, highlight that column in the grid and click Repeat Column. A new row
with the same settings appears in the grid. If you click the drop down arrow on the Repeat Column button,
you can select “All parameters” or “Date parameters only.” If you select “Date parameters only,” you will
create a new column with the same date parameters of the selected column.

Delete Column. To delete a column, highlight that column in the grid and click Delete Column. You can delete
only columns not being used to define another column.
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Heading. The Heading column displays the column heading defined in the Column heading field when you click
Open Column.

Column Description. The Column Description column displays the information selected in the Display field
when you click Open Column.

Format Tab

On the Format tab, you decide how the report should look. You can create headings and footers, include a list of
criteria used to create the report, and sort the information in the report. You can select the format for displaying
monetary amounts and print the report in color.

The list on the left of the screen displays formatting options for the Chart of Accounts Report: Headings, Criteria,
Sort, Page Footer, Report Footer, Miscellaneous, and Color Scheme. When you select anitem in the list, the right
side of the screen displays selections for that section of the report.
Note: The heading defaults to Chart of Accounts Report in the Title field. You can leave this as the title for the
report or enter your own.

Headings. Use Headings to enter a maximum of 60 characters in each of the Title and Subtitle fields. The title
and subtitle appear at the top of the report. You can select how the heading should be aligned and whether
your organization's name will appear in the header. You can include the page number and date in the heading.
You can also select to include the heading on every page of the report.

lE Mew Chart of Accounts Report
File Edit “iew Favoritez Toolz Help

=== e |

1 Eenerall z Filter$| 2 Columng 4 Format |

E Headings Headings
Criteria

Sort — Heading Farmat
Page Footer Title:  [Chart of Accounts Fieport
Report Foaoter Subtitle: I

Miscelaneous
Color Scheme Aligr: IEenter 'I

[# Print crganization narne in header

— v Frint Page Mumber in Heading [V Print Report Date in Heading
Farmat: IPage 1 j Farmat: IShDrt Date and Time j
Align: | Right =l | e [Let =]

¥ Piint report heading on each page

Note: The program automatically selects all criteria. Unmark the checkbox for any you do not want to print
with the report.
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Criteria. Select Criteria to print a list of criteria used to create the report. Mark Print these criteria on and select
a separate page or the first page. Selections print in the criteria section of the report.

Ig Mew Chart of Accounts Report
File Edit “iew Fawortes Toolz Help

B E G e ?-

1 Generall 2 Filtersl 3 Colurmnz — 4: Format |

Headings Criteria

B Criteria

St ¥ Print these criteria on Ia separate page 'I
Page Footer Saved report name

H?P'Z'fl Foater Output query name

Miscellansous Chart template

Color Scheme [w] Account detail level

Include inactive accounts
Fundz to include

Account Codes to include
Arncounts to include
Account attributes to include
Categories to include
Department(z] to include
Clazzes to include

Column Criteria

Sort. Use Sort to select the order for information to appear on the report. To print each fund on a separate page,
mark Print a separate statement for each fund. When you select Sort, a grid displays the categories you can
sort in the report. Select a sorting category in the Sort by column and select Ascending or Descending in the
Order by column.

Glossary: Account masking is the process of inserting asterisks to quickly select a range of accounts without
having to enter specific numbers.

If you make no selections in the Sort by column, the program sorts by the entire account number in
ascending order with no action. If you select a sort option in the Sort by column, you can select Subtotal or
Mask in the Action column. Subtotal is a break for which a total is provided. You can select Subtotal for only
one Sort by option. You can apply masking to any account segment except account code.

IQ Hew Chart of Accounts Report B
File Edit ‘“iew Favortes Toolz Help

e = el |

1 Genelall 2 FiIters' 2 Columnz  4: Format |

Headings Sort
Criteria
B Sort [~ Print a separate chart for each fund
Page Footer
Fieiort Faoter Sort by | Categary | Order by | Action |

Miscellaneous
Color Scheme
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Page Footer. Use Page Footer to create a footer to appear at the bottom of each page of the report. You can
enter a maximum of 254 characters in the Text field for the page footer. You can also select how to align the
text and include the page number and date in the footer.

l@ Mew Chart of Accounts Report E
File Edit ‘iew Favortes Toolz Help

S e = e e |

1: Generall 2 Filtersl 3: Columing 4 Farmat |

Headings Page Footer

Crtera Page Footer Text
Sort B

E Page Footer Test:
Report Footer
Miscellareous
Color Scheme

Align: IEenter v|

I Print Page Mumber it Footer

[~ Print Repart Date in Footer
Format: IF'age 1 j Farmat; IShc-rt Date and Time j
Aligr: [Riight =l alan [Lei d|

Report Footer. Use Report Footer to create a footer to appear at the bottom of the last page of the report. You
can enter a maximum of 254 characters in the Text box for the report footer and select how to align the text.

lQ Mew Chart of Accounts Report
File Edit “iew Fawvoritez Toolz Help

= D= NN e R

1 Generall z Filter$| 2 Columng 4 Format |

Headings Report Footer
Criteria i Fa o T
Sart Epart Foater | ex

Page Footer Text:
B Report Footer

Miscelaneous
Color 5cheme

Align: ||_eﬂ vI

Tip: Make selections for displaying amounts and view them in the Sample amount display before printing the
report.
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Miscellaneous. Use Miscellaneous to specify how numbers appear on the report and the font size for the

report.

lﬂ New Chart of Accounts Report

File Edit “iew Favorites

Tools Help

= D= R = e

Headings
Criteria

Sort

Page Foater
Report Footer

NEOUE

Color Scheme

1: Generall 2 Filtersl 3 Columnz ~ 4: Format |

Miscellaneous

Sample amaunt:

Show currency character on All amounts
Show percent sign on All amounts
Megative amount format [1234.56)
Mumber of digitz after decimal for amounts 2

Mumber of digitz after decimal for percentages 2

Show 1000's separator es

Shows blanks instead of zeros Mo

Font size: a

Amaunt [$1.234.5E]

Percent 100.00%

Note: Any time you want to return to the original color settings, click Restore Defaults.

Color Scheme. Use Color Scheme to select colors for report headings. When you click in the color box next to
the selections, the Color screen appears so you can select a standard color or define a custom color. If you
leave the Apply a Color Scheme checkbox unmarked, the report prints in black and gray.

IQ New Chart of Accounts Report

File Edit ‘fiew Favortes

= DN NN g B

Toaols Help

Headings
Criteria

Sort

Page Footer
Report Footer
Miscell

1 General' 2 Filtersl 2 Columng — 4: Format |

Color Scheme

I~ Apply a Color Scheme

. Calumn heading back. color
|_ Calumn heading fore color
|_ Group heading back color
. Group heading fore color

Restore Defaultz |

Report Name
Subtitle

Column Headings

Group Headings
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Chart Validation Report

The Chart Validation Report lists an?{ missing or duplicate accounts for a chart template. We highly recommend
you run this report before running financial statements to make sure the chart template includes the correct
accounts. Chart templates are established in Visual Chart Organizer.

Glossary: A chart template is a visual representation in General Ledger 7.2 of all or selected accounts from the
general ledger. In General Ledger 7.2, you can create multiple chart templates, each with a different

presentation of the accounts that exist in your organization. Chart templates drive the presentation of
accounts on financial statements.

The Chart Validation Report has tabs on which you set parameters: General, Filters, and Format. To move among
the tabs, click Next and Back at the bottom of the screen or select a tab. On these tabs you specify the
information to include in the report and how the report should look. For more information about creating a Chart
Validation Report, see “Creating a report in General Ledger” on page 15.

General Tab

On the General tab, you set parameters specific to the report and make selections about information included in
the report.

n Hew Chart Yalidation Report
File Edit ‘“iew Favoritez Toolz Help

[ R ?-

1: General ]g; Fillers] 3 Format

Uze chart template ||j1 ﬂ
v Check for duplicate accounts
v Include zeparate section for each fund

[~ Create an output queny of accounts

Feport orientation: | Landscape =

Note: You can change the results of a report by using different chart templates to run the same report. You can
define an unlimited number of templates in Visual Chart Organizer. For more information about chart
templates, see the Visual Chart Organizer Guide.

Use chart template. In the Use chart template field, select a chart template for the report. Chart templates
are established in Visual Chart Organizer.

Check for duplicate accounts. Mark Check for duplicate accounts to see a list of duplicate accounts in the
report.

Include separate section for each fund. Mark Include separate section for each fund to include a separate
section in the report for each fund.

Create an output query of accounts. If you mark Create an output query of accounts, the program creates
a query of the accounts included in the report. You can use the query later in other areas of General Ledger.
Note: To view the report as it will appear using your selections and filters, click Preview. To view a sample
layout of the report without data, click Layout.

Report orientation. In the Report orientation field, select Landscape or Portrait.
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Filters Tab

On the Filters tab, you include information based on selected criteria such as funds and accounts. For example,
you can include only the funds in a selected range. Funds not falling within the range do not appear on the report.
For more information about filtering in The Financial Edge, see the Program Basics Guide.

I New Chart Yalidation Report
File Edit “iew Fawortes Tools Help

RS R -2 |

1 General 2 Filkers |§: Formatl

@ 0pen 7 Clear Al Filters

Filkers I Include Selected Filkers
Funds all <Al Funds =
Broounts Al <Al Accounts =

Open. Click a filter in the grid and click Open on the action bar. The selection screen appears so you can
designate specific filters for the report.

Glossary: A filter is a requirement records must meet to be included in a report. For example, if you apply the
Accounts filter, only the accounts you select are included in the report. You can select filters to apply to a
report from the Filters tab. Be patient! Depending on the filters you select, this report may take several
minutes to run after you click Print or Preview.

Clear All Filters. Click Clear All Filters to remove all previously selected filters from the report.
Filters. The Filters column lists all the filters for this report. You cannot edit this column.

Include. Choose Selected in the Include column. A selection screen appears so you can designate specific filters
for the report.

Selected Filters. Filters you specify appear in the Selected Filters column. If you choose Selected in the Include
column or click a filter and then click Open, the Selected <Filter> screen appears. If you mark Selected,
Range, or Query, a selection screen appears so you can specify filters.

Query name. The Query name field appears if you select Query. Enter the name of the query to use to filter the
report or click the binoculars to search for a query.

To create a new query, click the binoculars and click Add a New Query on the Open Query screen. For more
information about creating queries, see the Query Guide.

Previous Filter. To view or edit the previous filter without returning to the Filters tab, click Previous Filter on
the toolbar.

Next Filter. To view or edit the next filter without returning to the Filters tab, click Next Filter on the toolbar.

Format Tab

On the Format tab, you decide how the report should look. You can create headings and footers, include a list of
criteria used to create the report, and select the format for displaying monetary amounts.
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The list on the left of the screen displays formatting options for the Chart Validation Report: Headings, Criteria,
Page Footer, Report Footer, and Miscellaneous. en you select an item in the list, the right side of the screen
displays selections for that section of the report.

Note: The heading defaults to Chart Validation Report in the Title field. You can leave this as the title for the
report or enter your own.

Headings. Use Headings to enter a maximum of 60 characters in each of the Title and Subtitle fields. The title
and subtitle appear at the top of the report. You can select how the heading should be aligned and whether
your organization's name will appear in the header. You can include the page number and the date in the
heading. You can also select to include the heading on every page of the report.

A New Chart Yalidation Report
File Edit “iew Favaorites Toole Help
H &S G E
1 General] 2: Filters ~ 2: Format ]
Headings
2] Criteria )
5] Page Footer Heading Format
=] Report Foater Title: |Ehart Y alidation Repart
2] Mizcellaneous Sublitle: |
Align: Certer -
¥ Frint organization name in header
[ Print Page Mumber in Heading I Print Report D ate in Heading
Farmat: |F'age 1 ﬂ Farmat: |Short Date and Time ﬂ
Align: | Right =] | | hgn: [Let =

I Print report keading on each page

Note: The program automatically selects all criteria. Unmark the checkbox for any you do not want to print
with the report.

Criteria. Select Criteria to print a list of criteria used to create the report. Mark Print these criteria on and select
a separate page or the first page. Selections print in the criteria section of the report.

n MNew Chart Yalidation Report
File Edit “iew Favaortes Tools Help

H &= % ?-

1: General] 2 Filterz 3: Format ]

2] Headings Criteria

2] Page Footer [v Print these critenia on | a separate page ¥

2] Report Footer
=] Miscellaneous

v Saved report name
| Output query name
w| Chart template

w| Funds to include

w| Sccounts boinclude
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Page Footer. Use Page Footer to create a footer to appear at the bottom of each page of the report. You can

enter a maximum of 254 characters in the Text field for the page footer. You can also select how to align the
text and include the page number and date in the footer.

A New Chart Yalidation Report
File Edit “iew Favaorites Toole Help
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Report Footer. Use Report Footer to create a footer to appear at the bottom of the last page of the report. You
can enter a maximum of 254 characters in the Text field for the report footer and select how to align the text.

I} Hew Chart Yalidation Report
File Edit ‘“iew Favorites Toolz Help

= = RE e 2

1 Genelall 2 Filters ~ 3: Format |

Report Footer

Headings
Criteria
Page Footer Report Footer Text
B Report Footer Test:
Mizcellaneous
Aligr: ILeft vI

Tip: Make selections for displaying amounts and view them in the Sample amount display before printing the

report.
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Miscellaneous. Use Miscellaneous to specify how numbers will appear on the report and the font size for the
report.

I Hew Chart ¥alidation Report [ x|
File Edit %“iew Favortes Tools Help

= D= R = g 2

1: General' 2 Filters 3 Format |

Headingz Miscellaneous
Criteria

Page Footer Show currency character on All amounts
Feport Footer Show percent sign on All amounts
B Miscelaneaus Meqative amount Format [1234.56)

Mumber of digits after decimal for amounts 2

Mumber of digitz after decimal for percentages 2

Show 1000's separator Tes

Show blanks instead of zems Mo

Font size a

Sample amount;
Amauint [$1.234.5E]
Percert 100.00%

Fund Profile Report

The Fund Profile Report lists the characteristics of funds, the history of changes, and other fund-related
information.

Glossary: A fund is a self-balancing set of accounts in The Financial Edge. Funds separate accounts into groups
that are specific to certain activities, donor-imposed restrictions, or objectives. You must set up funds in
General Ledger 7.2 before you can enter accounts.

The Fund Profile Report has tabs on which you set parameters: General, Filters, and Format. To move among the
tabs, click Next and Back at the bottom of the screen or select a tab. On these tabs you specify the information to
include in the report and how the report should look. For more information about creating a Fund Profile Report,
see “Creating a report in General Ledger” on page 15.
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General Tab

On the General tab, you set parameters specific to the report and make selections about information included in
the report.

M2 New Fund Profile Report E3
File Edit “iew Favortes Took Help

=R Rl el |

1: General |2: Filters | K3 Fu:urmatl

Include these report zections:

[+ Transaction requirements
[# Histary of changes

v Interfund accounts

W Notes

Repart origntation: ILandscape "I

Include these report sections. In the Include these report sections box, mark Transaction requirements,
History of changes, Interfund accounts, or Notes.

Note: To view the report as it will appear using your selections and filters, click Preview. To view a sample
layout of the report without data, click Layout.

Report orientation. In the Report orientation field, select Landscape or Portrait.

Filters Tab

On the Filters tab, you include information based on funds. For example, you can include only the fundsin a
certain range, and funds not falling within the range do not appear on the report.

I New Fund Profile Report
File Edit “iew Faworter Toolz Help

e IR E T |

1: General 2 Filters | K3 Fnrmatl

f®0pen | ) Clear Al Filters
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Funds All <Al Funds >

Open. Click a filter in the grid and click Open on the action bar. The selection screen appears so you can
designate specific filters for the report.

Clear All Filters. Click Clear All Filters to remove all previously selected filters from the report.

Glossary: A filter is a requirement records must meet to be included in a report. For example, if you apply the
Accounts filter, only the accounts you select are included in the report. You can select filters to apply to a
report from the Filters tab. Be patient! Depending on the filters you select, this report may take several
minutes to run after you click Print or Preview.

Filters. The Filters column lists all the filters for this report. You cannot edit this column.
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Include. Choose Selected in the Include column. A selection screen appears so you can designate specific filters
for the report.

Note: Mark Selected, Range, or Query to include a selected filter, range of filters, or a previously created
query of filters. Depending on the selection, different options appear on the screen. If you mark All, you cannot
define filters. For more information about filtering in The Financial Edge, see the Program Basics chapter in the
Program Basics Guide.

Selected Filters. Filters you specify appear in the Selected Filters column. If you choose Selected in the Include
column or click a filter and then click Open, the Selected <Filter> screen appears. If you mark Selected,
Range, or Query, a selection screen appears so you can specify filters.

Query name. The Query name field appears if you select Query. Enter the name of the query to use to filter the
report or click the binoculars to search for a query.

To create a new query, click the binoculars and click Add a New Query on the Open Query screen. For more
information about creating queries, see the Query Guide.

Previous Filter. To view or edit the previous filter without returning to the Filters tab, click Previous Filter on
the toolbar.

Next Filter. To view or edit the next filter without returning to the Filters tab, click Next Filter on the toolbar.

Format Tab

On the Format tab, you decide how the report should look. You can create headings and footers, include a list of
criteria used to create the report, sort the information in the report, and select the format for displaying
monetary amounts.

The list on the left of the screen displays formatting options for the Fund Profile Report: Headings, Criteria, Sort,

Page Footer, Report Footer, and Miscellaneous. When you select an item in the list, the right side of the screen
displays selections for that section of the report.

Note: The heading defaults to Fund Profile Report in the Title field. You can leave this as the title for the report
or enter your own.
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Headings. Use Headings to enter a maximum of 60 characters in each of the Title and Subtitle fields. The title

and subtitle appear at the top of the report. You can select how the heading should be aligned and whether
your organization's name will appear in the header. You can include the page number and date in the
heading. You can also select to include the heading on every page of the report.

\@ Mew Fund Profile Report E3
File Edit “iew Favortes Tools Help

= D= RN B 2

1: Generall 2: Filters  3: Format |

Criteria :

ot —Heading Format

Page Foater Title: IFund Prafile Report

Fieport Fooker Subtite: |

Miscellaneous ;

Align: IEenter "l

[v Frint organization name in header

v Print Page Mumber in Heading

¥ Print Report Date in Heading
Format: IF'age 1 j Farmat: IStht Date and Time j
Aligre [Right = sign [Lett =l

¥ Print report heading on each page

Note: The program automatically selects all criteria. Unmark the checkbox for any you do not want to print
with the report.

Criteria. Select Criteria to print a list of criteria used to create the report. Mark Print these criteria on and select
a separate page or the first page. Selections print in the criteria section of the report.

I Mew Fund Profile Report

E

File Edit ‘“iew Favortes Toolz Help
FlEE =R

1 Genelall 2 Filters ~ 3: Format |

Headings Criteria

B Criteria

Sart [¥ Print these criteria on Ia separate page 'I

Page Footer Saved report name

Rieport Footer Funds to include

Miscellaneous
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Sort. Use Sort to select the order for information to appear on the report. When you select Sort, a grid displays
fund ID as the only Sort by selection. Select Ascending or Descending in the Order by column. To start a new
page for each fund ID, mark Page break on each new Fund ID.

N New Fund Profile Report
File Edit “iew Fawortes Toolz Help

e = R |

1 Generall 2: Filters  3: Format |

Heading: Sort

Criteria

O — Ganty [ omn |
Page Footer Fund ID

Azcending
Fiepart Foater

Miscellaneous

¥ Page break on each new Fund ID

Page Footer. Use Page Footer to create a footer to appear at the bottom of each page of the report. You can
enter a maximum of 254 characters in the Text field for the page footer. You can also select how to align the
text and include the page number and date in the footer.

i@ New Fund Profile Report E
File Edit “iew Favorites Toole Help

e = e |

1: General' 2: Filters ~ 3: Format |

Headings Page Footer

Criteria Fane Footer Text

Sort — Page Footer Tex
B Page Footer Text:
Fieport Footer
Miscellaneous

Align: ICenter 'I

I Prirt Page Mumber in Faater [~ Print Report D ate in Footer
Farmat: IPage 1 j Farmat: ISholt Date and Time j

Aligre[Fight =] || g [Lett =l
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Report Footer. Use Report Footer to create a footer to appear at the bottom of the last page of the report. You
can enter a maximum of 254 characters in the Text field for the report footer and select how to align the text.

@ Mew Fund Profile Report
Fie Edit “iew Favortes Tools Help

H &S ah ?-

1 General] 2 Filters~ 3: Format ]

5] Headings Report Footer
=] Criteria

5 Sot Eeport Footer Text

5] Page Footer Text:
I Report Footer

2] Miscelaneous

Aligre | Left -

Tip: Make selections for displaying amounts and view them in the Sample amount display before printing the

report.

Miscellaneous. Use Miscellaneous to specify how numbers will appear on the report and the font size for the

report.

n MNew Fund Profile Report
File Edit “iew Favortes Tools Help

H &S aW ?-

1: General] 2 Filters 3: Format ]

2] Headings Miscellaneous
=] Criteria

= Sort Show currency character on All amaunts
=] Page Footer Show percent sign on Al amounts

=l Hport Footer Megative amount format [1234.5E]
T MHumber of digits after decimal for amounts 2
Mumber of digits after decimal for percentages 2
Show 1000's zeparator Yes
Show blanks instead of zeros MHa
Font size a

Sample amoLnt:

Amount [$1.234.56]
Percent 100.00%

General Ledger Report

The General Ledger Report provides transaction activity by account for a range of accounting periods you select.
Depending on the level of information you need, you can run this report in summary or detail.
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The General Ledger Report has tabs on which you set parameters: General, Filters, and Format. To move among
the tabs, click Next and Back at the bottom of the screen or select a tab. On these tabs you specify the
information to include in the report and how the report should look. For more information about creating a
General Ledger report, see “Creating a report in General Ledger” on page 15.

General Tab

On the General tab, you set parameters specific to the report and make selections about information included in
the report.

I New General Ledger Report
File  Edit iew Faworter Tool: Help

H (&S W b=
1: General ]2: Filters ] 2 Farmat

Include accounts fram this chart template

Template: |<Include all accournts: ﬂ

Include account activity az of this date

Date: |<Spec:ific: fiscal periods> j 12/01/2007 to 124315200
Start fiscal pear: |This fizcal pear ﬂ Start peniod: | Last fiscal period >
End fiscal year: |Thi$ fiscal pear ﬂ End period:  |Last fiscal petiod =

[~ Include encumbrance tranzactions
W Include accounts with zem beginning balances

W Include accounts with no achivity

[ Create an output query of accounts

Repart arientation: | Landscape ™

Note: You can change the results of a report by using different chart templates to run the same report. You
can define an unlimited number of templates in Visual Chart Organizer. For more information, see the Visual
Chart Organizer Guide.

Include accounts from this chart template. In the Template field, select to include all accounts or selected
accounts in the report. You create chart templates in Visual Chart Organizer.

Include account activity as of this date. In the Date field, select a date or date range for which posted
transactions are to be included. If you select <Specific range>, <Specific fiscal periods>, or <Specific fiscal
year>, additional date fields appear.

If you select <Specific range>, you can specify a start date and an end date. If you leave the Start date field
blank, all activity is included up to the end date. If you leave the End date field blank, all activity from the start
date until present is included. If you leave both fields blank, all activity is included.

Include encumbrance transactions. To include encumbrance transactions in the report, mark Include
encumbrance transactions.

Include accounts with zero beginning balances. Include accounts with zero beginning balances defaults
to marked to include accounts with zero beginning balances.

Include accounts with no activity. Include accounts with no activity defaults to marked to include accounts
that have not been credited or debited during the report’s selected date range.

Create an output query of accounts. If you mark Create an output query of accounts, the program creates
a query of the accounts included in the report. You can use the query later in other areas of General Ledger.
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Note: To view the report as it will appear using your selections and filters, click Preview. To view a sample
layout of the report without data, click Layout.

Report orientation. In the Report orientation field, select Landscape or Portrait.

Filters Tab

On the Filters tab, you include information based on selected criteria such as funds, accounts, and account
attributes. For example, you can include only funds in a specified range, and funds not falling within the range do
not appear on the report. You can filter criteria by projects or project attributes only if you have the optional
module Projects and Grants. For more information about filtering in The Financial Edge, see the Program Basics
Guide.

lE Mew General Ledger Report E2
Fie Edit “iew Favoites Tooke Help

FHERE = Tl |

1 General 2 Filkers |§: Fnrmatl

0 0pen 7 Clear All Filters
Filkers I Include Selected Filters Iﬂ
Funds Al <all Funds =
Accounts Al <Al Accounts=
Account Atbributes Al <Al Account Attributes
Account Codes Al <Al Account Codes
Projects all <Al Projects =
Project Atkributes all <Al Project Attributes =
Classes Al <Al Classes=
Transaction Atkribukes Al <all Transaction Attributes=
Categoties all <all Cakegories =
Journals Al <Al Journals:=
Mission(s) all <Al Mission(s)=
Spendable/Mon-Spendabl. .. Al <4l Spendable/hon-Spendables) =
Performanceds) all <Al Performanceis) = LI

Note: You can filter information for projects only if you have the optional module Projects and Grants.

Open. Click a filter in the grid and click Open on the action bar. The selection screen appears so you can
designate specific filters for the report.

Clear All Filters. Click Clear All Filters to remove all previously selected filters from the report.

Glossary: A filter is a requirement records must meet to be included in a report. For example, if you apply the
Accounts filter, only the accounts you select are included in the report. You can select filters to apply to a
report from the Filters tab. Be patient! Depending on the filters you select, this report may take several
minutes to run after you click Print or Preview.

Filters. The Filters column lists all the filters for this report. You cannot edit this column.

Include. Choose Selected in the Include column. A selection screen appears so you can designate specific filters
for the report.



55 CHAPTER

Note: Mark Selected, Range, or Query to include a selected filter, range of filters, or a previously created query
of filters. Depending on the selection, different options appear on the screen. If you mark All, you cannot
define filters. For more information about filtering in The Financial Edge, see the Program Basics chapter in the
Program Basics Guide.

Selected Filters. Filters you specify appear in the Selected Filters column. If you choose Selected in the Include
column or click a filter and then click Open, the Selected <Filter> screen appears. If you mark Selected,
Range, or Query, a selection screen appears so you can specify filters.

Query name. The Query name field appears if you select Query. Enter the name of the query to use to filter the
report or click the binoculars to search for a query.

To create a new query, click the binoculars and click Add a New Query on the Open Query screen. For more
information about creating queries, see the Query Guide.

Previous Filter. To view or edit the previous filter without returning to the Filters tab, click Previous Filter on
the toolbar.

Next Filter. To view or edit the next filter without returning to the Filters tab, click Next Filter on the toolbar.

Format Tab

On the Format tab, you decide how the report should look. You can create headings and footers, include a list of
criteria used to create the report, and sort the information in the report. You can select the format for displaying
monetary amounts and print the report in color.

The list on the left of the screen displays formatting options for the General Ledger Reﬁort: Headings, Criteria,
Detail, Sort/Break, Page Footer, Report Footer, Miscellaneous, and Color Scheme. When you select an item in
the list, the right side of the screen displays selections for that section of the report.

Note: The heading defaults to General Ledger Report in the Title field. You can leave this as the title for the
report or enter your own.

Headings. Use Headings to enter a maximum of 60 characters in each of the Title and Subtitle fields. The title
and subtitle appear at the top of the report. You can select how the heading should be alighed and whether
your organization's name will appear in the header. You can include the page number and date in the
heading. You can also select to include the heading on every page of the report.

IQ Hew General Ledger Report B
File Edit ‘“iew Favortes Toolz Help

e = el |

1 Genelall 2 Filters ~ 3: Format |

B Headings H eadings
Criteria

Distail —Heading Format
Sort/Break Title: IGeneraI Ledger Feport
Page Footer Subtitle: I

Fiepart Footer

Miscelaneous Aligr: ICenter 'I

Color Schi ) L .
oirsEheme [¥ Print crganization narne in header

— ¥ Frint Fage Murmber in Heading [¥ Print Report Date in Heading
Farmat; IF‘age 1 j Format: IShort Date and Time j
Aligre [Fiight =] || #ian: [Left =l

[¥ Print report heading on each page
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Note: The program automatically selects all criteria. Unmark the checkbox for any you do not want to print
with the report.

Criteria. Select Criteria to print a list of criteria used to create the report. Mark Print these criteria on and select
a separate page or the first page. Selections print in the criteria section of the report.

lﬂ New General Ledger Report x|
File Edit ‘“iew Favortes Tools Help

S e = e e |

1: Generall 2 Filters  3: Format |

Headings Criteria
B Criteria
Detail v Print these criteria on Ia separate page 'l

Sort/Break

Saved report narne -
Page Foater Output query name —
Repart Footer Drates to Include
Miscellaneaus Include budget scenaria
Calar Scheme Include budget fiscal year

Include year to date budget analysiz

Transaction types to include

Funds to include

Projects to include

Project attributes to include

Account attributes to include o
Department(z] ta include

Accounts to include

Categories to include

Journals to include

Mizsion(z] to include j

Detail. Use Detail to select details specific to the General Ledger Report.

Show as positive — Select Debit balance or Normal balance as the balance to appear on the report. If you
select Debit balance, you can also select to include fund totals and grand totals in the report. To include
fund totals or grand totals in the General Ledger Report, you must show the debit balance as positive.
Include fund total — Mark the checkbox to include fund totals in the report.
Include grand total — Mark the checkbox to include grand totals in the report.

Report type — Select Detail for beginning and ending balances and transaction details to appear on the
report. If you select Detail, you can also select the distributions to include in the report. Select Summary to
show only the beginning and ending balances and net change with no transaction detail.

Note: If you select Detail in the Report type row and Debit/Credit on the Report format row, you can display
an additional subtotal for each period.
Report format — To add a debit/credit or balance column, select Debit/Credit or Balance.

Subtotal by period — If you select Detail in the Report type row and Debit/Credit on the Report format row,
you can display an additional subtotal for each period.

Show control account in detail — To display transaction details for control accounts, mark the checkbox.

Note: To create the report without a budget scenario, select Do not include budgets.

Show budget scenario — To include a budget scenario in the report, select a scenario. You can include a
budget scenario only if you have the optional module Budget Manager.

Include fiscal year — If you select a budget scenario, select a fiscal year.
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Note: You can select a fiscal year only if you include a budget scenario.

Show distribution for these characteristics — Mark this checkbox to select distributions to include in the
report. The program adds a column to the report displaying distributions for the selected characteristic for
each row with a distribution. You can show distributions only if you select Detail in the Report format row.

Tip: To save time running the report, select only one distribution characteristic. If you mark more than
checkbox in Show distribution for these characteristics, the report can take long time to process or print.

Show transaction total — To see a total of transactions, mark this checkbox.

Include year-to-date budget analysis — To include a comparison between budget and actual activity, mark
the checkbox.

Summarize account details by source transaction — To show a summary of balances and net change for
each transaction, mark the checkbox.

lQ Mew General Ledger Report
File Edit “iew Favoritez Toolz Help

=R = R = e |

1 Generall 2 Filterz 3 Format |

Headings Detail
Criteria

| ]
Sort/Braak Show az positive Debit balance
Eziz[f'c__'zt;;l Include fund tatal -
Miscellananus Include grand tatal -
Color Scheme Repart type Detail
Fiepart format Drehit/ Credit
Subtotal by period -
Show contral account in detail r
Show budget scenario Do not include budgets j
¥ Shaow distribution for these characteristics:

= Froject ID !
[~ Project Description -

il

Down
¥ Show characteristic as a column it the main report body:

[ Show ransaction batal

Sort/Break. Use Sort/Break to select the order for information to appear on the report and where breaks fall
between sets of information. When you select Sort/Break, a grid displays the categories you can sort in the
report. Select a sorting category in the Sort by column and select Ascending or Descending in the Order by
column. To start a new page for each Sort by selection, mark Page break on each new <Sort by selection>.
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You can also create breaks between the sections by which you have sorted. In the Text before value and Text
after value fields, you can enter up to 30 characters of information to print directly before and after the
break. If you mark Print count per or Print count as a percentage of total for the selected sort field, the
number or percentage for each selected sort option appears in the footer. If you mark Page break on each

new, a new page starts for the highest level break.

lﬂ New General Ledger Report
File Edit Help

= = R = I e 2

Wiew Favorites  Tools

1: Generall 2 Filterz  3: Format |

Braak Header for Account Mumber-

Headings Sort/Break
Criteria
Detail Sort by I Category I Order by I Break? I
=] reak, Account Mumber Agcending v
Page Footer r
Report Footer r
Miscellareous
Colar Scheme r

r

Text before value: I

Text after value: I

Break Foober for Account Humber-

[~ Print count per Account Mumber
[~ Print count as a percentage of batal
[" Page break on each new Account Murmber

Page Footer. Use Page Footer to create a footer to appear at the bottom of each page of the report. You can
enter a maximum of 254 characters in the Text field for the page footer. You can also select how to align the

text and include the page number and date in the footer.

IQ Hew General Ledger Report
File  Edit Help

= = R 2

Yiew Fawortes  Tools

1 Genelall 2 Filters ~ 3: Format |

B Page Footer

Fiepart Footer
Miscellaneous
Color Scheme

Align: ICenter "I

Headings Page Footer
Criteria —
Detail — Fage Footer Texl
Sort/Break Text:

I Print Page Mumber in Foater

[~ Print Report Date in Footer
Farmat; IF‘age 1 j Format: IShort Date and Time j
Aligre [Fiight =] || #ian: [Let =l
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Report Footer. Use Report Footer to create a footer to appear at the bottom of the last page of the report. You
can enter a maximum of 254 characters in the Text field for the report footer and select how to align the text.

u Hew General Ledger Report
File Edit “iew Favortes Tools Help

H &= W ?-

1 General] 2 Filters 3 Format l

5] Headings Report Footer

=] Criteria

5 Detai Report Footer Text
=] Saort/Break Text:

=] Page Footer

. Repart Foater

=] Mizcellansous

Z] Color Scheme Aligr: Ih

Tip: Make selections for displaying amounts and view them in the Sample amount display before printing the
report.

Miscellaneous. Use Miscellaneous to specify how numbers appear on the report and the font size for the
report.

n New General Ledger Report
File Edit “iew Favorites Tools Help

H &= ?-

1 General] 2: Filters  2: Format l

5] Headings Miscellaneous

2] Criteria
5] Detail Show currency character on All amaunts
=] Sart/Break Show percent sian on Al amournts
5] Page Footer Megative amount Format [1234.55)
= HeportFote Murnber of digits after decimal for amounts 2
5 Color Sm Mumber of digitz after decimal for percentages 2

Show 1000's separatar Tes

Show blanks instead of zeros Mo

Font size g

Sample amount:

Amount [$1.234.56]
Percent 100.00%

Note: Any time you want to return to the original color settings, click Restore Defaults.
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Color Scheme. Use Color Scheme to select colors for report headings. When you click the color box next to the
selection, the Color screen appears so you can select a standard color or define a custom color. If you leave
the Apply a Color Scheme checkbox unmarked, the report prints in black and gray.

IB Mew General Ledger Report E3
File Edit “iew Favortes Toolz Help

=l |

1 Generall 2: Filterz 3 Format |

Headings Color Scheme
Criteria
Detail [~ Apply a Color Scheme

Sort/Break
Page Foater

Report Name
M Column heading back calar Subtitle

Fleport Footer [ Column heading fore ool Column Headings

Miscellaneous
B Color Scheme

™ Group heading back calar Group Headings

. Group heading fore color

Restore Defaults |

Trial Balance Report

The Trial Balance Re(j?ort lists each account balance and indicates whether the total amount of debits equals the
total amount of credits. You can use this report to reconcile accounts at the end of each accounting period.

Note: You can run the Trial Balance Report in three formats: Balance, Period and year-to-date, and
Year-to-date.

The Trial Balance Report has tabs on which you set parameters: General, Filters, and Format. To move among the
tabs, click Next and Back at the bottom of the screen or select a tab. On these tabs you specify the information to
include in the report and how the report should look. For more information about creating a Trial Balance Report,
see “Creating a report in General Ledger” on page 15.

General Tab

Glossary: A parameter is any field, option, or filter that narrows information in a report and determines the
appearance of the report’s output. By specifying parameters, you customize output results of the report. For
example, you can apply filters, create a header and footer, or choose a color scheme for the report’s results.
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On the General tab, you set parameters specific to the report and make selections about information included in
the report.

A New Trial Balance Report
File Edt “iew Fawonter Toolz Help
B (&= ?-

1: Gereral ]g: Filters] 3: Farmat ]

Feport fomat: |Balance j

|nelude transactions with post dates in this range

Date: | <Specific fiscal periods> (x| 047201 /2002 to 04/30/2002

Start fizcal year: |This fiscal year ﬂ Start pefiad: ’W

Erd fizzal pear: |This figcal year ﬂ End period: ’W

W Orly include accourts from this chart template: |U'| ﬂ

v Include accounts with a zero beginning balance as of 04/01/2002
W Include accounts with no activitg from 04,001 /2002 to 04,/30,/2002

Include these transaction types: | Regular ﬂ

[ Create an output query of accounts

Report Onentation: Landzcape

Report format. In the Report format field, select Balance, Period and year-to-date, or Year-to-date as the dates
to include in the report.

Include transactions with post dates in this range. In the Date field, select the date range to include
posted transactions. Select <Specific range>, <Specific fiscal periods>, or <Specific fiscal year>. This selection
determines the options available to define the date range.

If you select <Specific range>, you can specify a start date and an end date. If you leave the Start date field
blank, all activity is included up to the end date. If you leave the End date field blank, all activity from the start
date until present is included. If you leave both fields blank, all activity is included.

Warning: Be careful if you include accounts from a chart template. It can produce an out-of-balance Trial
Balance Report. For more information about chart templates, see the Visual Chart Organizer Guide.

Only include accounts from this chart template. To select a chart template, mark Only include accounts
from this chart template and select a template. Templates are created in Visual Chart Organizer.

Include accounts with a zero beginning balance as of <Date>. Include accounts with a zero beginning
balance as of defaults to marked to include accounts with zero beginning balances as of the first day of the
report’s date range. The beginning date displayed here is defined by the values you select in the Start period,
Start date, or Fiscal year fields. This checkbox is enabled only if you select Balance as the report format.

Include accounts with no activity. Include accounts with no activity defaults to marked to include accounts
not credited or debited during the report’s specified date range. The beginning date displayed here is defined
by the values you select in the Start period, Start date, or Fiscal year fields. The end date is defined by the
values you select in the End period, End date, or Fiscal year fields.

Create an output query of accounts. If you mark Create an output query of accounts, the program creates
a query of the accounts included in the report. You can use the query later in other areas of General Ledger.
Note: To view the report as it will appear using your selections and filters, click Preview. To view a sample
layout of the report without data, click Layout.

Report orientation. The Trial Balance Report automatically prints in landscape orientation.
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Filters Tab

Glossary: A filter is a requirement records must meet to be included in a report. For example, if you apply the
Accounts filter, only the accounts you select are included in the report. You can select filters to apply to a
report from the Filters tab. Be patient! Depending on the filters you select, this report may take several
minutes to run after you click Print or Preview.

On the Filters tab, you include information based on selected criteria such as funds, accounts, and account
attributes. For example, you can include accounts in a specified range. Accounts not falling within the range do
not appear on the report. You can filter by projects or project attributes only if you have the optional module
Projects and Grants. For more information about filtering in The Financial Edge, see the Program Basics Guide.

IQ Mew Trial Balance Report E
File Edit “iew Favortes Toolz Help

= JheN= =0 e |

1 General 2 Filkers |§: Folmatl

" Clear &l Filters

Filkers I Include Selected Filkers
Accounts Al <all Accounts =
Funds Al <Al Funds =
Account Codes Al <4l Bccount Codes =
Account Attribukes all <all Account Attribukes=
Projects all <Al Projects =
Project Attributes all <Al Project Atkribukes =
Transackion Attributes Al <Al Transaction Atkributes =
Classes all <all Classes=
Mot Vet Posted Transactions  Mone <Maone >
Missionls) all <Al Missionls)
Spendable/Mon-Spendableis) Al <l Spendable/Mon-Spendablels) =
Performance]s) all <all Performancels) >
Deparkment(s) Al <Al Department(s)=

Note: You can filter information for projects only if you have the optional module Projects and Grants.

Open. Click afilter in the grid and click Open on the action bar. The selection screen appears so you can
designate specific filters for the report.

Clear All Filters. Click Clear All Filters to remove all previously selected filters from the report.
Filters. The Filters column lists all the filters for this report. You cannot edit this column.

Include. Choose Selected in the Include column. A selection screen appears so you can designate specific filters
for the report.

Note: Mark Selected, Range, or Query to include a selected filter, range of filters, or a previously created
query of filters. Depending on the selection, different options appear on the screen. If you mark All, you cannot
define filters. For more information about filtering in The Financial Edge, see the Program Basics chapter in the
Program Basics Guide.

Selected Filters. Filters you specify appear in the Selected Filters column. If you choose Selected in the Include
column or click a filter and then click Open, the Selected <Filter> screen appears. If you mark Selected,
Range, or Query, a selection screen appears so you can specify filters.
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Query name. The Query name field appears if you select Query. Enter the name of the query to use to filter the
report or click the binoculars to search for a query.

To create a new query, click the binoculars and click Add a New Query on the Open Query screen. For more
information about creating queries, see the Query Guide.

Previous Filter. To view or edit the previous filter without returning to the Filters tab, click Previous Filter on
the toolbar.

Next Filter. To view or edit the next filter without returning to the Filters tab, click Next Filter on the toolbar.

Format Tab

On the Format tab, you decide how the report should look. You can create headings and footers, include a list of
criteria used to create the report, and sort the information in the report. You can select the format for displaying
monetary amounts and print the report in color.
The list on the left of the screen displays formatting options for the Trial Balance Report: Headings, Criteria,
Detail, Sort/Break, Page Footer, Report Footer, Miscellaneous, and Color Scheme. When you select an item in
the list, the right side of the screen displays selections for that section of the report.
Note: The heading defaults to Trial Balance Report in the Title field. You can leave this as the title for the
report or enter your own.

Headings. Use Headings to enter a maximum of 60 characters in each of the Title and Subtitle fields. The title
and subtitle appear at the top of the report. You can select how the heading should be alighed and whether
your organization's name will appear in the header. You can include the page number and date in the
heading. You can also select to include the heading on every page of the report.

lﬂ Mew Trial Balance Report E=
File Edit “iew Fawoites Toolz Help

QRS G =] 2- |
1 Generall 2 Filkers ~ 3: Farmat |

B Hesdigs

Criteria

Detail — Heading Format
Sart/Break Title: |Tria| Balance Fepart
Page Footer Sublile: |

Report Footer

Miscelaneous Align: Il:entel v|

Color Scheme

[¥ Print arganization name in header

¥ PFrint Page Humber in Heading ¥ Print Report Date in Heading ———
Farmat: IF'age 1 j Farmat: IStht Date and Time j
Align: | Right =l | Al [Let =]

¥ Print report heading on each page

Note: The program automatically selects all criteria. Unmark the checkbox for any you do not want to print
with the report.



ACCOUNT REPORTS 64

Criteria. Select Criteria to print a list of criteria used to create the report. Mark Print these criteria on and select
a separate page or the first page. Selections print in the criteria section of the report.

lﬂ New Trial Balance Report
File Edit ‘“iew Favortes Tools Help

= D= R = e

1: Generall 2 Filterz  3: Format |

Headings

Detail
Sort/Break
Page Foaoter
Fiepart Footer
Miscellaneous
Colar Scheme

¥ Print these criteria on Ia zeparate page 'I

Saved repart name

Cutput query hame

Report format

Post dates to include

Include accounts from thiz chart template

Include accounts with zero balances
Include accounts with noactivity
Include these tranzaction types
Accounts to include

Funds to include

Account Codes to include
Account attributes to include
Department|s] to include
Projects to include

Project attributes to include
Tranzaction attributes ta include

=l

Note: You can show project details only if you have the optional module Projects and Grants.

Detail. Use Detail to select details specific to the Trial Balance Report. Details vary, depending on selections on
the other tabs. In the Show distribution by row, select how to display distributions. The distributions appear

below each account on the report.

If you select Period and year-to-date format on the General tab, you can select how to format period activity.
In the Period activity format row, select Total debits and credits or Net change.

To display account category totals after each break on the report, mark the checkbox in the Show account

category totals row.

To create a column for worksheet adjustment figures on the report, mark the checkbox in the Show

worksheet adjustments column row.

If you select Balance in the Report format field on the General tab, you can mark the checkbox in the Show
net change column row to display net change figures on the report.

lE Mew Trial Balance Report
File Edit ‘“iew Favortes Toolz Help

= RN = R

1 Genelall 2 Filters 3 Farmat |

Page Foter

Fieport Footer
Miscelaneous
Color Scheme

Show aoccount category totals

Show worksheet adjustments column

Show net change column

Headings Detail

Criteria

Show distribution by <Mo distributio:>
Sort/Break Period activity format N

-
r
r
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Sort/Break. Use Sort/Break to select the order for information to appear on the report and where breaks fall
between sets of information. When you select Sort/Break, a grid displays the categories you can sort in the
report. Select a sorting category in the Sort by column and select Ascending or Descending in the Order by

column. In the Action column, you can select Mask or Subtotal. Subtotal creates a break and provides a
subtotal.

Note: You can sort by project class only if you have the optional module Projects and Grants.

If you create breaks between sections, you can create headers for each section. In the Text before value and
Text after value fields, enter up to 30 characters of information to print directly before and after the break. If
you mark Print count per <Section> or Print count as a percentage of total for the selected sort field, the
number or percentage for each selected sort option appears in the footer. If you mark Page break on each
new <Section>, a new page starts for the highest level break.

IQ Hew Trial Balance Report B
File Edit ‘“iew Favortes Toolz Help

e = el |

1 Genelall 2 Filters ~ 3: Format |

Headings Sort/Break

Criteria

Detail Sort by | Order by | action |
B Sot/Break Fund Azcending Subtatal
Page Footer

Fiepart Footer
Miscellaneaus
Color Scheme

Break Header for Fund:

Test before value: I

Test after value: I

Break Footer for Fund-

[~ Print count per Fund

[~ Print count 23 & percentage of total
™ Page break on each new Fund
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Page Footer. Use Page Footer to create a footer to appear at the bottom of each page of the report. You can
enter a maximum of 254 characters in the Text field for the page footer. You can also select how to align the
text and include the page number and date in the footer.

lﬂ MNew Trial Balance Report

File Edit “iew Favaorites Toole Help

= D= NN g B

1 Generall 2: Filters ~ 2: Format |

Page Footer

Headings

Criteria
Dietail —Page Footer Text
Sort/Break Text

B Page Footer

Fieport Footer
Miscellaneous
Color Schemne

Align: IEentel 'I

~ I Prirt Page Number in Faater

Farmat: IF'age 1

[

Align: | Right

=

[~ Print Report D ate in Footer

Farmat: I Short Date and Time

=

Aligr: ILefl

=

Report Footer. Use Report Footer to create a footer to appear at the bottom of the last page of the report. You
can enter a maximum of 254 characters in the Text field for the report footer and select how to align the text.

lg Mew Trial Balance Report
File Edit “iew Favorites Help

= M= e

Toals

1 Genelall 2: Filters  3: Farmat |

Headings
Criteria

Feport Footer Text

Report Footer

Dretail

Sort/Break Text:

Page Footer
B Report Footer

Miscellaneous
Color Scheme

Align: | Left vI

Tip: Make selections for displaying amounts and view them in the Sample amount display before printing the

report.
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Miscellaneous. Use Miscellaneous to specify how numbers appear on the report and the font size for the
report.

lﬂ New Tral Balance Report
File Edit “iew Favorites Tools Help

e = e |

1: Generall 2 Filters  3: Farmat |

Headings Miscellaneous
Criteria

Detail Show currency character on All amounts
Sort/Break, Show percent zign on All amounts
Page Footer Megative amount farmat [1234.56)
Fisport Foole Mumber of digits after decimal for amounts 2
Colar S-:hem MHumnber of digits after decimal for percentages 2

Show 1000's separatar Tes

Show blanks instead of zeros Mo

Font size g

Sample amount;

Aot [$1.234.56)
Percent 100.00%

Note: Any time you want to return to the original color settings, click Restore Defaults.

Color Scheme. Use Color Scheme to select colors for report headings. When you click in the color box next to
the selection, the Color screen appears so you can select a standard color or define a custom color. If you
leave the Apply a Color Scheme checkbox unmarked, the report prints in black and gray.

lB Mew Trial Balance Report [ x|
File Edit “iew Favortes Tools Help

HRE RG] -

1 Generall 2 Filterz 3 Format |

Headings Color Scheme
Criteria
Detail [~ Apply a Color Scheme

Sort/Break
Page Foater

Report Name
M Column heading back calar Subtitle

Fleport Footer [ Calumn heading fore color Column Headings

Miscellaneous

[T Group heading back calar Group Headings

. Group heading fore colar

Restore Defaults |

Working Capital Schedule

The Working Capital Schedule identifies the working capital available to your organization for day-to-day
activities. This report subtracts aggregate current liabilities from aggregate current assets.
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The Working Capital Schedule has tabs on which you set parameters: General, Filters, Columns, Multiple Column
Headings, and Format. To move among the tabs, click Next and Back at the bottom of the screen or select a tab.
On these tabs you specify the information to include in the report and how the report should look. For more
information about creating a Working Capital Schedule report, see “Creating a report in General Ledger” on
page 15.

General Tab

On the General tab, you set parameters specific to the report and make selections about information included in
the report.

I New Working Capital Schedule
File Edit “iew Fawoitesr Toolz Help
EH &2 5w B

1: General ]2: Filters] 2 Columng | 4: Multiple Column Headings | & Format

v Include accounts with zero balances

W Include inactive accounts

[ Only include accounts from this chart template: | 07 ﬂ

[ Create an output query of accounts

Repart anientation: | Portrait -

Include accounts with zero balances. Include accounts with zero balances defaults to marked to include
accounts with zero balances as of the end of the fiscal year defined on the Columns tab.

Include inactive accounts. Include inactive accounts defaults to marked to include accounts you no longer
use.

Warning: If the chart template you use does not have any valid accounts defined, no information appears on
the report.

Only include accounts from this chart template. To select a chart template, mark Only include accounts
from this chart template and select a template. Templates are created in Visual Chart Organizer.

Create an output query of. If you mark Create an output query of accounts, the program creates a query of
the accounts included in the report. You can use the query later in other areas of General Ledger.
Note: To view the report as it will appear using your selections and filters, click Preview. To view a sample
layout of the report without data, click Layout.

Report orientation. In the Report orientation field, select Portrait or Landscape.
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Filters Tab

On the Filters tab, you include information based on selected criteria such as funds, account codes, and account
attributes. For example, you can include only the accounts with the account attribute of Location and the value of
Gym recorded in the account record. Accounts with other account attributes, such as Expense Category, and
location values other than Gym do not appear on the report. You can filter by projects or project attributes only if
you have the optional module Projects and Grants. For more information about filtering in The Financial Edge,
see the Program Basics Guide.

Ig New Working Capital Schedule E3
File Edit “iew Fawvoites Toolz Help

FIEE NN e |

1: General 2 Filterz | K3 D:ulumnsl 4 Multiple Column Headingz | 5 Format

&8 Open |7 Clear &ll Filters
Filters I Include Selected Filkers Iﬂ
Funds Al <Al Funds >
Account Codes Al <Al Account Codes =
Accounts all <Al Accounts =
Deparkmentis) all <Al Departmentis) =
Account Atkributes Al <Al Account Atkributes=
Projects Al <Al Projects =
Project Attributes All <Al Project Attributes=
Classes Al <Al Classes:=
Mission(s) Al <Al Mission(s) =
SpendablefMon-Spendabl. .. Al <Al Spendable/Non-Spendablelsi=
Performancels) all <Al Performancels) =
Cash Flow Codes Al <Al Cash Flow Codes >
Working Capital Codes Al <Al Whorking Capital Codes LI

Open. Click afilter in the grid and click Open on the action bar. The selection screen appears so you can
designate specific filters for the report.

Clear All Filters. Click Clear All Filters to remove all previously selected filters from the report.

Glossary: A filter is a requirement records must meet to be included in a report. For example, if you apply the
Accounts filter, only the accounts you select are included in the report. You can select filters to apply to a
report from the Filters tab. Be patient! Depending on the filters you select, this report may take several
minutes to run after you click Print or Preview.

Filters. The Filters column lists all the filters for this report. You cannot edit this column.

Include. Choose Selected in the Include column. A selection screen appears so you can designate specific filters
for the report.

Note: Mark Selected, Range, or Query to include a selected filter, range of filters, or a previously created query
of filters. Depending on the selection, different options appear on the screen. If you mark All, you cannot
define filters. For more information about filtering in The Financial Edge, see the Program Basics chapter in the
Program Basics Guide.

Selected Filters. Filters you specify appear in the Selected Filters column. If you choose Selected in the Include
column or click a filter and then click Open, the Selected <Filter> screen appears. If you mark Selected,
Range, or Query, a selection screen appears so you can specify filters.

Query name. The Query name field appears if you select Query. Enter the name of the query to use to filter the
report or click the binoculars to search for a query.
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To create a new query, click the binoculars and click Add a New Query on the Open Query screen. For more
information about creating queries, see the Query Guide.

Previous Filter. To view or edit the previous filter without returning to the Filters tab, click Previous Filter on
the toolbar.

Next Filter. To view or edit the next filter without returning to the Filters tab, click Next Filter on the toolbar.

Columns Tab

On the Columns tab of the Working Capital Schedule, you can open existing columns and view their headings and
descriptions. The program creates five columns for this report, and they cannot be changed: Column 1 will always
be Account Number, Column 2 will always be Account Description, and Columns 3, 4, and 5 will always be
amounts. You cannot add, delete, repeat, or move columns. However, you can modify some parameters, such as
date ranges in Columns 3 and 4.

I New Working Capital Schedule
File Edt “iew Favorites Tools Help

= Tl e |

1 Generall 2 Fiters 3 Columnz | 4: Multiple Column Headings | 5: Format

4 |z Column | @@0pen Column | R Flapzzi Column 4 Dizleiz Dol
Hide? I Heading I Formula I Date Range
| 1] [l Account Murmber
| 2 (l Accounk Description
| 3 T Previous Year {Actual} 05/31/2001
4 | [T This Year Jactuall 0531 /2002
1 5 [T changein Working Capital  {Caolurnn 4} - {Colurn 3¢ 05/31 /2002

Open column. To open an existing column and edit its settings, select a row in the grid and click Open Column.
On the Working Capital Schedule, you can make changes only on the General tab for Columns 1 and 2. For
Columns 3, 4, and 5, you can make certain edits on the General, Filters, and Date Range tabs.

Hide? Mark the checkbox in the Hide? column for any column you do not want to appear in the report.

Heading. The Heading column displays the column heading defined in the Column heading field when you click
Open Column.

Formula. The Formula column displays the column information defined in the Column Definition frame of the
General tab when you click Open Column.

Date Range. The Date Range column displays the dates selected on the Date Range tab when you click Open
Column.

Warning: Selections made on the General, Date Range, and Filters tabs when you open a column apply only to
report columns and not to the report itself.
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General tab. You can name and define report columns on the General tab when you click Open Column. Use
the alignment buttons to specify how to align columns. You can make column formatting options in the
Column width, Format, and Decimal places fields. The Report width display is for informational purposes
only, and changes according to formatting selections. In the Column Definition frame, the Type field is for

informational purposes only; you cannot edit this field. If you mark Hide this column on the report and
export the report, hidden columns will not be exported.

N |

General | Date Hangel Filtersl

Colurnn heading: Previous Year Calumn width: |1 0o inches

Report width:  6.83 inches

= E Eos of Dlate Faormat; ICunency 'l
Decimal places: |2 Yl

Column D efinition -

Type: | 4mount j

{Actuall

__,I

[~ Hide this column on the report \u"alidatel [Elear, | + | - | = | /! |JJ
Cancel |

Date Range tab. The selections you make on the Date Range tab determine the period or date for which
balances are included on the report. The Date Range tab appears for Columns 3, 4, and 5.

Column 3

General Date Range I Filtersl

Date: [ <Specitc fiscal periad: x| 103142002

Fizeal year: ILast fizcal pear ﬂ A of period: IThiS fizcal period 'I
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Filters tab. When you click Open Column, you can select filters on the Filters tab that apply only to the selected
columns and not the entire report. The Filters tab appears for Columns 3, 4, and 5. For more information
about filtering in The Financial Edge, see the Program Basics Guide.

Column 3

Filkers I Include Selected Filkers Iﬂ
Funds Al <Al Funds =
Account Codes al <Al Account Codes =
Accaunts &l ZAll Accounts =
Departmentis) Al <Al Department(s) =
Account Attribukes Al <Al Account Attributes =
Projects all <Al Projects =
Project Attributes Al <Al Project Attributes =
Classes Al <Al Classes=
Mission(s) All <Al Missionis)=
SpendablefMon-Spendableds) Al <Al SpendablefMon-Spendablels) >
Performances) Al <All Performanceis) >
Cash Flow Codes &l Al Cash Flow Codes=
Working Capital Codes Al <Al Warking Capital Codes= :I

Cancel |

Multiple Column Headings Tab

On the Multiple Column Headings tab, you can create a heading to cover more than one column.

IE Mew Working Capital 5chedule E
File Edit ‘“iew Faworitez Toolz Help

= IR R e |

1 Generall 2 Filtersl 2 Colurmnz 4 Multiple Column Headings |§: Formatl

Heading I Stark Column I End Calumn Align

7]

Heading. Text entered in the Heading column appears as a heading above one or more of the individual column
headers.

Start. In the Start column, select the first column the multiple column heading covers.

End. In the End column, select the last column the multiple column heading covers. The End column must be
greater than or equal to the Start column.

Align. In the Align column, select left, center, or right alignment.

Format Tab

On the Format tab, you decide how the report should look. You can create headings and footers, include a list of
criteria used to create the report, and sort the information for the report. You can also select the format for
displaying monetary amounts, and print the report in color.
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The list on the left of the screen displays formatting options for the Working Capital Schedule: Headings, Criteria,
Sort, Page Footer, Report Footer, Miscellaneous, and Color Scheme. When you select an item in the list, the right
side of the screen displays selections for that section of the report.

Note: The heading defaults to Working Capital Schedule in the Title field. You can leave this as the title for the

report or enter your own.

Headings. Use Headings to enter a maximum of 60 characters in each of the Title and Subtitle fields. The title
and subtitle appear at the top of the report. You can select how the heading should be aligned and whether
your organization's name will appear in the header. You can include the page number and the date in the
heading. You can also select to include the heading on every page of the report.

l@ MNew wWorking Capital Schedule E
File Edit ‘“iew Favortes Tools Help

S e = e e |

1: Generall 2 Filtersl 3 Eolumnsl 4: Multiple Caolumn Headings  5: Format |

B e

Criteria
St — Heading Farmat
Page Footer Title:  [w/orking Capital Schedule
Fiepart Footer Subite: |

Miscellaneous

Colar Scheme Align: IEentel 'l

[V Print arganization name in header

v Frint Page Humber in Heading ¥ Print Report Date in Heading
Format: IF'age 1 j Format: IStht Date and Time j
Align: IHight j Aligr: ILeft j

¥ Print repart heading on each page

Note: The program automatically selects all criteria. Unmark the checkbox for any you do not want to print
with the report.
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Criteria. Select Criteria to print a list of criteria used to create the report. Mark Print these criteria on and select
a separate page or the first page. Selections print in the criteria section of the report.

lﬂ New Working Capital Schedule
File Edit Toolz Help

= D= R = g 2

Wiew  Favorites

1: General' 2 Filtersl & Eolumnsl 4 Multiple Column Headings  5: Format |

Headings

B Criteria

Sot

Page Footer
Report Footer
Miscellaneous
Color Scheme

Criteria
¥ Piint these criteria on Ia separate page 'I

Saved repart nane -
Cutput querny name

Include accounts with zero balances

Include inactive accounts

Include accounts from thiz chart template
|Jzer account security access
lzer project secunity access
Funds ta include

Account Codes to include
Accounts to include
Department(s) to include
Account attributes to include
Projects to include

Project attibutes to include
Classes to inchude

tizsion(z] to include

=

Sort. Use Sort to select the order for information to appear on the report. When you select Sort, a grid displays
the categories you can sort in the report. Select a sorting category in the Sort by column and select Ascending
or Descending in the Order by column. To print a separate statement for a value, mark Print a separate
statement for each. In the Show field, you can show account detail, working capital codes, or both.

Note: If you show working capital codes on the report, the additional working capital codes you defined in

Configuration appear on the report.

If you make no selections in the Sort by column, the program sorts by the entire account number in
ascending order with no action. If you select an account segment, in the Action column, you can select
Subtotal or Mask. Subtotal is a break for which a total is provided. You can select Subtotal for only one Sort
by option. You can apply masking to any account segment except account code.

l@ MNew wWorking Capital Schedule
File  Edit Tools Help

= D= R I e

Yiew Favarites

1: Generall 2 Filtersl 3 Eolumnsl 4: Multiple Caolumn Headings  5: Format |

Headings
Criteria

Sort

[~ Print a separate statement for each IFund

Page Footer
Report Footer

Shiow Iaccount detail

[

|

Miscellaneous
Colar Scheme

Sort by I

Order by I

Action




75 CHAPTER

Page Footer. Use Page Footer to create a footer to appear at the bottom of each page of the report. You can
enter a maximum of 254 characters in the Text field for the page footer. You can also select how to align the
text and include the page number and date in the footer.

lE MNew Wworking Capital Schedule [ x|
File Edit “iew Favortes Tools Help

= D= R gl

1: General' 2 Filtersl & Eolumnsl 4: Multiple Column Headings  5: Format |

Headings Page Footer

Ctera Page Footer Text
Sart B

B Page Footer Text:
Report Footer
Miscellaneous
Color Scheme

Align: IEenter 'I

[ Print Page Mumber in Foater

[~ Print Report Date in Footer
Farmat: I Page1 j Format: IShnrt Date and Time j
Alian: [Fight =] | [ igre [Lei =l

Report Footer. Use Report Footer to create a footer to appear at the bottom of the last page of the report. You

can enter a maximum of 254 characters in the Text field for the report footer and select alighment of the
text.

lQ MNew Working Capital Schedule
File Edit “iew Favoites Tools Help

B3 S G ] 2 |

1: Generall 2 Filtersl e Columnsl 4: Multiple Column Headings  5: Farmat |

Headings Miscellaneous
Criteria

Sart Show currency character on All arnounts
Page Footer Show percent sigh an &l amounts
Hport Footer Megative amount format [1234.5E)
Calor Sm Mumber of digitz after decimal for amounts 2

Mumber of digitz after decimal for percentages 2

Show 1000'z zeparator Tes

Show blanks instead of zeros Mo

Font size 8

Sample amaLnt:

Aot [$1.234.5E)
Percent 100.00%

Tip: Make selections for displaying amounts and view them in the Sample amount display before printing the
report.
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Miscellaneous. Use Miscellaneous to specify how numbers appear on the report and the font size for the
report.

Ig New Working Capital Schedule E
Fil= Edit “iew Favortes Tools Help

e = el s |

Generall Filtersl Columnsl Multiple Caolumn Headings Formatl

Headings Miscellaneous
Criteria

Sart Show currency character on All amounts
Page Footer Show percent sign on Al amounts
Report Footer Megative amount farmat [1234.56)
Color Sche Mumber of digits after decimal for amounts 2

MHurnber of digits after decinal for percentages 2

Show 1000z separatar Yes

Show blanks instead of zeros Mo

Font size g

Sample amount;

Arnaurt [$1.234.56]
Percent 100.00%

Note: Any time you want to return to the original color settings, click Restore Defaults.

Color Scheme. Use Color Scheme to select colors for report headings. When you click in the color box next to
the selection, the Color screen appears so you can select a standard color or define a custom color. If you
leave the Apply a Color Scheme checkbox unmarked, the report prints in black and gray.

lﬂ MNew Working Capital Schedule E=
File Edit *“iew Favoritez Toole Help

BREEE @ ?-

1 General' 2 Filtersl & Eolumnsl 4: Multiple Colurn Headings  5: Farmat |

Headings Color Scheme

Criteria

Sart ™ Apply a Color Scheme
Page Footer

Report Name

Report Footer . Column heading back color Subtitle
Miscellaneous [ Column heading fore colar Column Headings
: [~ Group heading back calar Group Headings

. Group heading fore color

Restore Defaults |
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Reporting categories in General Ledger include Account Reports, Allocation Reports, Budget Reports, Financial
Statements, GASB 34 Reports, Journal and Batch Reports, Pivot Reports, and Project Reports. This chapter
discusses Allocation Reports. For information about other report categories, see the chapter for that category.
Allocation Reports are available only if you have the optional module Allocation Management.

Note: We recommend you read documentation for The Financial Edge thoroughly. Information presented
here provides you with basic information about allocation reports in General Ledger. Hands-on experience is
the best way to learn, so we encourage you to try various options with the sample database.

Allocation reports in General Ledger include:

¢ Fee Schedule Profile

¢ Pool Profile Report

Fee Schedule Profile

The Fee Schedule Profile provides management fee tables and calculation rules for investment accounts used to
calculate investment fees. A fee schedule is a list of amounts or percentages applied against account balances to
determine an amount or fee to calculate.

Glossary: A fee schedule is a table you use to define amounts or percentages charged when calculating
expense distributions.

The Fee Schedule Profile has tabs on which you set parameters: General, Filters, and Format. To move among the
tabs, click Next and Back at the bottom of the screen or select a tab. On these tabs you specify information to
include in the report and how the report should look. For more information about creating a Fee Schedule Profile,
see “Creating a report in General Ledger” on page 15.

General Tab

On the General tab, you can select the orientation of the printed report. You cannot set any other parameters on
the General tab of the Fee Schedule Profile.

lB Hew Fee Schedule Profile Report [ x|
File Edit ‘“iew Faworitez Toolz Help

SR el |

1: General |2: Fillersl 3 Format I

General options are not available for thiz report.

Report orientation; I Fuotrait - I

Note: To view the report as it will appear using your selections and filters, click Preview. To view a sample
layout of the report without data, click Layout.

Report orientation. In the Report orientation field, select Portrait or Landscape.
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Filters Tab

On the Filters tab, you can include information based on fee schedules. For example, you can include fee
schedules within a selected range, and schedules not falling within the range do not appear on the report. For
more information about filtering in The Financial Edge, see the Program Basics Guide.

I& New Fee Schedule Piofile Report
File Edit “iew Fawortes Tools Help

RS R -2 |

1 General 2 Filkers |§: Formatl

" Clear All Filters

Filkers I Includs Selected Filkers
Fee Schedules Al <4l Fee Schedules =

Open. Click afilter in the grid and click Open on the action bar. The selection screen appears so you can
designate specific filters for the report.

Clear All Filters. Click Clear All Filters to remove all previously selected filters from the report.

Glossary: A filter is a requirement records must meet to be included in a report. For example, if you apply the
Accounts filter, only the accounts you select are included in the report. You can select filters to apply to a
report from the Filters tab. Be patient! Depending on the filters you select, this report may take several
minutes to run after you click Print or Preview.

Filters. The Filters column lists all the filters for this report. You cannot edit this column.

Include. Choose Selected in the Include column. A selection screen appears so you can designate specific filters
for the report.

Selected Filters. Filters you specify appear in the Selected Filters column. If you choose Selected in the Include
column or click a filter and then click Open, the Selected <Filter> screen appears. If you mark Selected, Range,
or Query, a selection screen appears so you can specify filters.

Query name. The Query name field appears if you select Query. Enter the name of the query to use to filter the
report or click the binoculars to search for a query.

To create a new query, click the binoculars and click Add a New Query on the Open Query screen. For more
information about creating queries, see the Query Guide.

Previous Filter. To view or edit the previous filter without returning to the Filters tab, click Previous Filter on
the toolbar.

Next Filter. To view or edit the next filter without returning to the Filters tab, click Next Filter on the toolbar.

Format Tab

Note: If you mark All, you cannot define filters. You must mark Selected or Range to define filters.

On the Format tab, you decide how the report should look. You can create headings and footers, include a list of
criteria used to create the report, sort the information in the report, and select the format for displaying
monetary amounts.
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The list on the left of the screen displays formatting options for the Fee Schedule Profile: Headings, Criteria, Sort,

Page Footer, Report Footer, and Miscellaneous. When you select an item in the list, the right side of the screen
displays selections for that section of the report.

Note: The heading defaults to Fee Schedule Profile in the Title field. You can leave this as the title for the
report or enter your own.

Headings. Use Headings to enter a maximum of 60 characters in each of the Title and Subtitle fields. The title
and subtitle appear at the top of the report. You can select how the heading should be aligned and whether
your organization's name will appear in the header. You can include the page number and date in the
heading. You can also select to include the heading on every page of the report.

lE Mew Fee Schedule Profile Report

KB
File Edit ‘“iew Favortes Toolz Help
e =l R
1 Genelall 2 Filters 3 Farmat |
B Headings H eadingg
Criteria 5
Sort —Heading Farmat
Page Footer Title: |Fee Schedule Profile Repart
Fh_apolt Footer Subtitie: I
Miscellaneaus
Align: ICenter 'I
[¥ Print crganization narne in header
—Iv Print Fage Murmber in Heading [¥ Print Beport Date in Heading
Format: IF'age 1 j Format: IShDrt Diate and Time j
Align: IHight j Align: ILeft j
¥ Piint report heading on each page

Note: The program automatically selects all criteria. Unmark the checkbox for any you do not want to print
with the report.

Criteria. Select Criteria to print a list of criteria used to create the report. Mark Print these criteria on and select
a separate page or the first page. Selections print in the criteria section of the report.

lE Mew Fee Schedule Profile Report

E

File Edit ‘“iew Favortes Toolz Help
FlERE R =R |

1: Generall 2 Filters  3: Format |

Headings Criteria

B Criteria

Sort v Print these criteria on Ia separate page 'l

Page Foater Saved report name

Repart Footer Fee schedules to include

Miscellareous
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Sort. Use Sort to select the order for information to appear on the report. When you select Sort, a grid displays
the categories you can sort in the report. Select a sorting category in the Sort by column and select Ascending
or Descending in the Order by column. To print each fee schedule ID on a separate page, mark Page break on

each new Fee Schedule ID.

lﬂ New Fee Schedule Profile Report
File Edit ‘“iew Favortes Toolz Help

= N R = I ey 2

1: Generall 2 Filters  3: Format |

Headings
Criteria

Sort

Sort by

Order by

Page Footer
Report Footer
Miscellareous

Fee Schedule 1D Azcending

¥ Page break on each new Fee Schedule |0

Page Footer. Use Page Footer to create a footer to appear at the bottom of each page of the report. You can
enter a maximum of 254 characters in the Text field for the page footer. You can also select how to align the

text and include the page number and date in the footer.

lE Mew Fee Schedule Profile Report
File Edit “iew Favoritesx Toolz Help

= P e = e B

1 Generall 2 Filterz 3 Format |

Headings Page Footer
Criteria Paoe Footar Test
Sort — Page Foater Tex
B Page Footer Text:
Report Foater
Mizcelaneous
Aligr: IEenter 'I
[ Print Page Mumber in Footer [~ Print Repaort Date in Footer
Farmat: IF'age 1 j Farmat: IShDrt Date and Time j
Align:  [Right =l | [ Aign: [Let =l




83 CHAPTER

Report Footer. Use Report Footer to create a footer to appear at the bottom of the last page of the report. You
can enter a maximum of 254 characters in the Text field for the report footer and select how to align the text.

lQ Mew Fee Schedule Frofile Report
File Edit ‘“iew Favorites Toolz Help

= D= e R = el e 2

1 Generall 2 Filters ~ 3: Format |

Headings Report Footer
Criteria Renort Footer Test
Sart Epart Footer | ex

Page Footer Text:
B Report Footer

Miscelaneous

Aligr: ||_ef[ vI

Tip: Make selections for displaying amounts and view them in the Sample amount display before printing the
report.

Miscellaneous. Use Miscellaneous to specify how numbers appear on the report and the font size for the
report.

IB Mew Fee Schedule Frofile Report E
File Edit “iew Favortes Toolz Help

S =l |

1 Generall 2: Filterz 3 Format |

Headings Miscellaneous
Criteria

Sart Show currency character on All amounts
Page Footer Show percent sign on Al amounts
Report Footer Meqative amount format [1234.5E]

Murnber of digits after decimal for amounts 2

Mumber of digits after decimal for percentages 2

Show 1000's zeparator Yes

Show blanks instead of zeroz Mo

Fant size 8

Sample amaunt;

Armnalnt [$1.234.58)
Percent 100.00%

Pool Profile Report

The Pool Profile Report provides the allocation basis, pool accounts, and source and destination accounts used to
calculate allocation amounts. An allocation pool is a set of entities used to determine relative balances used in
the allocation process. Pools can consist of accounts, projects, classes, transactions codes, transactions
attributes, account attributes, or project attributes.



ALLOCATION REPORTS 84

Glossary: An allocation pool is a group of accounts, organized by account, project, class, transaction code, or
attribute, used to track investment account monies received from different funds or endowments.

The Pool Profile Report has tabs on which you set parameters: General, Filters, and Format. To move among the
tabs, click Next and Back at the bottom of the screen or select a tab. On these tabs you specify information to
include in the report and how the report should look. For more information about creating a Pool Profile Report,
see “Creating a report in General Ledger” on page 15.

General Tab

On the General tab, you set parameters specific to the report and make selections about information included in
the report.

I@ Hew Pool Profile Report
File Edit “iew Favorter Toolz Help

e w2

1: General |2: Fillersl 2 Farmat |

Ihiciude theze pool sections: Include these ling item sections:
¥ Contact Information ¥ Accounts
¥ Line Items [V Filters
[+ Defaults

Fiepart orientatian: IPmtrait 'I

Include these pool sections. In the Include these pool sections box, mark Contact Information or Line Items
or both to select the allocation pool sections for the profile.

Include these line item sections. In the Include these line item sections box, mark Accounts, Filters, or
Defaults or any combination.

Note: To view the report as it will appear using your selections and filters, click Preview. To view a sample
layout of the report without data, click Layout.

Report orientation. In the Report orientation field, select Portrait or Landscape.

Filters Tab

On the Filters tab, you can include information based on pools. For example, you can include pools in a certain

range, and pools not falling within the range do not appear on the report. For more information about filtering in
The Financial Edge, see the Program Basics Guide.

1@ Hew Pool Profile Report
File Edit “iew Fawvortez Tool: Help

FIeERE = e |

1: General 2 Filters |§: Farmat |

=, ~Clear ANl Filters

Filters I Include Selected Filkers
Paols Al <&l Poals =
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Open. Click afilter in the grid and click Open on the action bar. The selection screen appears so you can
designate specific filters for the report.

Clear All Filters. Click Clear All Filters to remove all previously selected filters from the report.

Glossary: A filter is a requirement records must meet to be included in a report. For example, if you apply the
Accounts filter, only the accounts you select are included in the report. You can select filters to apply to a
report from the Filters tab. Be patient! Depending on the filters you select, this report may take several
minutes to run after you click Print or Preview.

Filters. The Filters column lists all the filters for this report. You cannot edit this column.

Include. Choose Selected in the Include column. A selection screen appears so you can designate specific filters
for the report.

Selected Filters. Filters you specify appear in the Selected Filters column. If you choose Selected in the Include
column or click a filter and then click Open, the Selected <Filter> screen appears. If you mark Selected,
Range, or Query, a selection screen appears so you can specify filters.

Query name. The Query name field appears if you select Query. Enter the name of the query to use to filter the
report or click the binoculars to search for a query.

To create a new query, click the binoculars and click Add a New Query on the Open Query screen. For more
information about creating queries, see the Query Guide.

Previous Filter. To view or edit the previous filter without returning to the Filters tab, click Previous Filter on
the toolbar.

Next Filter. To view or edit the next filter without returning to the Filters tab, click Next Filter on the toolbar.

Format Tab

On the Format tab, you decide how the report should look. You can create headings and footers, include a list of
criteria used to create the report, sort the information in the report, and select the format for displaying
monetary amounts.

The list on the left of the screen displays formatting options for the Pool Profile Report: Headings, Criteria, Sort,
Page Footer, Report Footer, and Miscellaneous. en you select an item in the list, the right side of the screen
displays selections for that section of the report.

Note: The heading defaults to Pool Profile Report in the Title field. You can leave this as the title for the report
or enter your own.
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Headings. Use Headings to enter a maximum of 60 characters in each of the Title and Subtitle fields. The title
and subtitle appear at the top of the report. You can select how the heading should be aligned and whether
your organization's name will appear in the header. You can include the page number and date in the
heading. You can also select to include the heading on every page of the report.

I8 New Pool Profile Report [ %]

File Edit “iew Fawoites Toolz Help
=Rl R el |

1 Generall 2 Filkers 3 Format |

-
Criteria J

Sort — Heading Format
Page Footer Title: |F'o-:-| Prafile Feport
Freport Footer Sublite: |

Miscelaneous
Align: Il:entel 'l

[¥ Print arganization name in header

¥ PFrint Page Humber in Heading W Print Report Date in Heading
Farmat: IF'age 1 j Farmat: IStht Date and Time j
Align: | Right 2 L [ =]

[V Print report heading on each page

Note: The program automatically selects all criteria. Unmark the checkbox for any you do not want to print
with the report.

Criteria. Select Criteria to print a list of criteria used to create the report. Mark Print these criteria on and select
a separate page or the first page. Selections print in the criteria section of the report.

& New Pool Profile Report
File Edit “iew Favoritez Toolz Help

RS R ] ?- |

1 Generall 2 Filters 2 Format |

Headings Criteria

B Criteria

Gt [V Print these criteria on Ia separate page 'l
Page Footer Saved repart name
Report Footer Paools to include

Miscelaneous
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Sort. Use Sort to select the order for allocation pools to appear on the report. When you select Sort, a grid
displays Pool ID in the Sort by column as the only category you can sort in the report. Select Ascending or
Descending in the Order by column. To print each allocation pool on a separate page, mark Page break on
each new Pool ID.

I3 New Pool Profile Report

File Edit Y“iew Favoritez Toolz Help
=Rl =R = e |
1 Generall 2 Filters 2 Format |
Heading: Sort
Criteria
[ Sty T
Page Footer Paal D Azcending
Report Footer
Mizcelaneous
¥ Page break on each new Pool 1D

Page Footer. Use Page Footer to create a footer to appear at the bottom of each page of the report. You can

enter a maximum of 254 characters in the Text field for the page footer. You can also select how to align the
text and include the page number and date in the footer.

I3 New Pool Profile Report

B
File Edit “iew Favortes Toolz Help
= JheS= R = e |
1 Generall 2: Filterz ~ 3: Format |
Headings Page Footer
Criteria
Sort — Page Footer Text

B Page Footer Text:
Fepaort Foater
Miscellaneous

Align: IEenter 'I

I Print Page Murber in Footer

[~ Print Report Date in Footer
Format: IF'age 1 j Format: IShDrt Date and Time j

Aligr: | Right =l | ddan Left =]
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Report Footer. Use Report Footer to create a footer to appear at the bottom of the last page of the report. You
can enter a maximum of 254 characters in the Text field for the report footer and select how to align the text.

1@ New Pool Profile Report E
File Edit “iew Favorites Tools Help

FIEN = e |

1: General' 2: Filters ~ 3: Format |

Headings Repor’[ Footer
Critetia e —
Sort eport Footer Tex

Page Footer Text:
B Report Foater

Miscellaneous

Align: | Ledt - I

Tip: Make selections for displaying amounts and view them in the Sample amount display before printing the
report.

Miscellaneous. Use Miscellaneous to specify how numbers appear on the report and the font size for the
report.

A& New Pool Profile Report [ x|
File Edit ‘“iew Fawvortez Toolke Help

RS R -2 |
1 Generall 2: Filters ~ 2: Format |

3 Headr Miscellaneous |
Criteria

Sart Show cumency character on Al amounts
Fage Footer Show percent sign on Al amounts

Flport Footer Megative amount Format [1234.55)
arenus Mumber of digits after decimal for amounts 2
MHumber of digitz after decimal for percentages 2
Show 1000's geparatar Yes
Show blanks instead of zeros Ho
Font size g

Sample amount:

Amount [$1.234.56]
Percent 100.00%
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Warning: Your original budgets must be finalized before you can create Budget Reports.

Reporting categories in General Ledger include Account Reports, Allocation Reports, Budget Reports, Custom
Reports, Financial Statements, GASB 34 Reports, Grant Reports, Journal and Batch Reports, Pivot Reports, and
Project Reports. This chapter discusses Budget Reports. For information about other report categories, see the
chapter for that category.

Note: We recommend you read the documentation for The Financial Edge thoroughly. Information presented
here provides you with basic information about budget reports in General Ledger. Hands-on experience is the
best way to learn, so we encourage you to try various options with the sample database.

Budget reports in General Ledger include:

¢ Budget Adjustments Journal

¢ Budget Adjustments Report

¢ Budget Distribution Report

Budget Adjustments Journal

The Budget Adjustments Journal lists adjustments to account, grant, and project budgets for a time period you
select. It can include the dates adjustments were made and who made the adjustments.

Keep in mind, to budget by grant and report grant budgets, you must set up a grant-tracking transaction code on
Grant Business Rules page of Configuration.

Glossary: An adjustment is a journal entry made to correct errors or allocate items between accounting
periods. An adjustment record contains details of the adjustment.

You can include adjustments made on a certain date or within a date range, and you can select a budget scenario.
You can filter this report in several ways.

The Budget Adjustments Journal has tabs on which you set parameters: General, Filters, and Format. To move
among the tabs, click Next and Back at the bottom of the screen or select a tab. On these tabs you specify
information to include in the report and how the report should look. For more information about creating a
Budget Adjustments Journal, see “Creating a report in General Ledger” on page 15.

General Tab

Glossary: A parameter is any field, option, or filter that narrows information in a report and determines the
appearance of the report’s output. By specifying parameters, you customize output results of the report. For
example, you can apply filters, create a header and footer, or choose a color scheme for the report’s results.
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On the General tab, you set parameters specific to the report and make selections about information included in

the report.

I3 New Budget Adjustments Journal x|

File Edit View Favorites Tools Help

?-

dasam o

1: General |2: Filtersl 2 Formatl

Show budget adjustments for:

Scenario D IM VI b ain Operating Budget

Include adjustments in thiz date range -
Date: I This fizcal year j 01/01/2007 to 124312007

Show: I.&ccount budgets j
[~ Print reazon for adiustment
[¥ Print account description

[ Fririt Grant and Project deschption

Report arientation: IF'ortrait "I

< Back | Mewut » | Cancel | Print Preview Layaut

Glossary: A budget scenario is a single version of an organization’s budget for a given time period. You can
have multiple budget scenarios if you have the optional module Budget Management. For example, you can
create a scenario of your original budget and also create scenarios for various revisions of that budget.

Show budget adjustments for. In the Scenario ID field in the Show budget adjustments for frame, select the
budget scenario to use in the report. A brief description of the scenario appears in the display to the right.

Include Adjustments in this date range. In the Date field, select the time period of the budget adjustments

to include.

If you select <Specific range>, you can specify a start date and an end date. If you leave the Start date field
blank, all activity is included up to the end date. If you leave the End date field blank, all activity from the start

date until present is included. If you leave both fields blank, all activity is included.

Show. In the Show field, you can select to display “Account budgets”, “Account budgets with Grant detail”,
“Account budgets with Project detail”, “Account budgets with Grant and Project detail”, “Grant Budgets”, or
“Project budgets” on the report. Project and grant options appear only if you have the optional module

Projects and Grants.

The grant options appear only if you set up a grant-tracking transaction code on Grant Business Rules page of

Configuration.

Glossary: The Budget Manager is a grid that provides one location for adding, distributing, adjusting, and
finalizing an unlimited number of budget scenarios. The Budget Manager is available only if you have the

optional module Budget Management.

Print reason for adjustment. If you mark Print reason for adjustment, the reason for each budget

adjustment, as recorded in the Budget Manager, appears on the report.

Print account description. If you leave Print account description marked, the description of the account, as

recorded in the account record, appears on the report.
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Print project description. If you leave Print project description marked, the description of the project, as
recorded in the project record, appears on the report.

If you select a grant option in the Show field, the Print Grant and Project description checkbox appears. Keep
in mind, to report on grant budgets you must set up a grant-tracking transaction code on Grant Business Rules
page of Configuration.

Report orientation. In the Report orientation field, select Portrait or Landscape.

Filters Tab

On the Filters tab, you include information based on selected criteria such as accounts, projects, grants, and
funds. For example, you can include only the accounts with an account attribute of Expense Category and the
value of Salaries recorded in the account record. Accounts with other account attributes do not appear on the
report. For more information about filtering in The Financial Edge, see the Program Basics Guide.

I New Budget Adjustments Journal =l
File Edit View Favorites Tools Help
Filters | incude Selected Filters

Accounts all <All Accounts>

Funds All <All Funds =

Account Attributes all <All Account Attributes =

Cateqgories All <Al Cateqories =

Projects all <All Projects =

Project Attributes All <Al Project Attributes =

Grants all <All Grants >

Grant Attributes All <All Grant Attributes =

Mission(s) all <All Mission(s) =

Adjustments Entered By All <Al Adjustments Entered By >

Department(s) all <All Department(s) =

< Back | Mext » Cancel FBrrint Prewview Layout
|

Note: You can filter by transaction code, grant attributes, projects or project attributes only if you have the
optional module Projects and Grants.

Open. Click afilter in the grid and click Open on the action bar. The selection screen appears so you can
designate specific filters for the report.

Clear All Filters. Click Clear All Filters to remove all previously selected filters from the report.

Glossary: A filter is a requirement records must meet to be included in a report. For example, if you apply the
Accounts filter, only the accounts you select are included in the report. You can select filters to apply to a
report from the Filters tab. Be patient! Depending on the filters you select, this report may take several
minutes to run after you click Print or Preview.

Filters. The Filters column lists all the filters for this report. You cannot edit this column.
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Include. Choose Selected in the Include column. A selection screen appears so you can designate specific filters
for the report.

Selected Filters. Filters you specify appear in the Selected Filters column. If you choose Selected in the Include
column or click a filter and then click Open, the Selected <Filter> screen appears. If you mark Selected, Range,
or Query, a selection screen appears so you can specify filters.

Query name. The Query name field appears if you select Query. Enter the name of the query to use to filter the
report or click the binoculars to search for a query.

To create a new query, click the binoculars and click Add a New Query on the Open Query screen. For more
information about creating queries, see the Query Guide.

Previous Filter. To view or edit the previous filter without returning to the Filters tab, click Previous Filter on
the toolbar.

Next Filter. To view or edit the next filter without returning to the Filters tab, click Next Filter on the toolbar.

Format Tab

On the Format tab, you decide how the report should look. You can create headings and footers, include a list of
criteria used to create the report, and sort the information in the report. You can also select the format for
displaying monetary amounts and print the report in color.

The list on the left of the screen displays formatting options for the Budget Adjustments Journal: Headings,
Criteria, Sort, Page Footer, Report Footer, Miscellaneous, and Color Scheme. When you select an item in the list,
the right side of the screen displays selections for that section of the report.

Note: The heading defaults to Budget Adjustments Journal in the Title field. You can leave this as the title for
the report or enter your own.

Headings. Use Headings to enter a maximum of 60 characters in each of the Title and Subtitle fields. The title
and subtitle appear at the top of the report. You can select how the heading should be alighed and whether
your organization's name will appear in the header.

You can include the page number and date in the heading. You can also select to include the heading on every
page of the report.

l@ MNew Budget Adjustments Journal E
File Edit ‘“iew Favortes Tools Help

S e = e e |

1: Generall 2 Filters ~ 3: Farmat |

B e

Criteria
St — Heading Farmat
Page Footer Title: |Budget Adjustrments Journal
Fiepart Footer Subite: |

Miscellaneous
Colar Scheme Align: IEentel 'l

[V Print arganization name in header

v Print Page Humber in Heading ¥ Print Repart Date in Heading
Format: IF'age 1 j Format: IStht Date and Time j
Align: IHight j Align: ILeft ﬂ

¥ Print report heading on each page

Note: The program automatically selects all criteria. Unmark the checkbox for any you do not want to print
with the report.
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Criteria. Select Criteria to print a list of criteria used to create the report. Mark Print these criteria on and select
a separate page or the first page. All selected options print in the criteria section of the report.

I& new Budget Adjustments Journal . x|

File Edit WView Favorites Tools Help

Ba3az o= ?- |

8 Genelall 2: Filters ~ 3: Farmat |

Headings

‘B Criteria

Sart [ Print these criteria on Ia separate page 'I

Page Footer Saved report name =
Feport Footer Seenaria D —
Miscellaneaus Dates to include

Calor Scheme Funds ta include

Accounts to inchude

Account attributes to include
Categories to include

Projects to include

Project attributes o include
Include adjustments entered by
Show

Uszer account secunty access
Uzer Project security access
Grants to include

Grant attributes to include
Mizsion(z] to include LI

< Back | Hexts | Cancel | Frint | Preview | Layout |

Sort. Use Sort to select the order for information to appear on the report. When you select Sort, a grid displays
the categories you can sort in the report. Select a sorting category in the Sort by column and select Ascending
or Descending in the Order by column. If you make no selections in the Sort by column, the program sorts by
the entire account number in ascending order.

lﬂ MNew Budget Adjustments Journal E=
File Edit *“iew Favoritez Toole Help

RS R = ?- |

1 General' 2 Filters 3 Farmat |

Headings Sort

Criteria

Sort by I Category I Order by I
Page Foater Account Number Ascending

Freport Footer
Miscelaneous
Color Scheme
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Page Footer. Use Page Footer to create a footer to appear at the bottom of each page of the report. You can

enter a maximum of 254 characters in the Text field for the page footer. You can also select the alignment and
include the page number and date in the footer.

Ig Mew Budget Adjustments Journal
File Edit “iew Favoritez Toolz Help

= = RE R = el B 2

1 Generall 2 Fiters 3 Format |

Page Footer

Headings
Criteria
Sart — Page Footer Text
B Page Footer Text:
Report Footer
Miscellaneous
Color Scheme
Aligr: IEenter VI
[ Print Page Mumber in Footer
Format: IF'age 1 j
Aligr: [ Right |

[~ Print Repaort Date in Footer

Format: I Short D ate and Time

=

Aligr: ILeft

=~

Report Footer. Use Report Footer to create a footer to appear at the bottom of the last page of the report. You
can enter a maximum of 254 characters in the Text field for the report footer and select alighnment of the

text.

lQ MNew Budget Adjustments Journal
File Edit Wiew Favorites Toolz Help

= DI NN =0 el e 2

1 Generall 2 Filters 3 Format |

Headings
Criteria
Sort

Report Footer Text

Report Footer

Page Footer
B Feport Footer

Text:

Miscelaneous
Color 5cheme

Align: ||_ef[ vI

Tip: Make selections for displaying amounts and view them in the Sample amount display before printing the

report.
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Miscellaneous. Use Miscellaneous to specify how numbers appear on the report and the font size for the

report.

lﬂ MNew Budget Adjustments Journal

File Edit “iew Favaortes

= DS RES = I

Toolz: Help

Headings
Criteria

Sort

Page Footer
Freport Footer

[yl=lulRE

Colar Scheme

1 Generall 2 Filkers ~ 3: Farmat |

Miscellaneous

Sample amount:

Show currency character an All amaunts
Show percent sign ok All amaunts
Megative amaunt farmat [1234.56)
Murnber of digitz after decimal for amounts 2

Murnber of digitz after decimal for percentages 2

Show 1000's separator Yes

Shaw blanks inztead of zeros Ma

Fant size g

Amount [$1.234.5E]

Percent 100.00%

Note: Any time you want to return to the original color settings, click Restore Defaults.

Color Scheme. Use Color Scheme to select colors for report headings. When you click in the color box next to
the selection, the Color screen appears so you can select a standard color or define a custom color. If you
leave the Apply a Color Scheme checkbox unmarked, the report prints in black and gray.

lﬂ MNew Budget Adjustments Journal

File Edit “iew Favaortes

= PR R e e R

Toolz: Help

Headings
Criteria

Sort

Page Footer
Freport Footer
Miscellaneous

1 Generall 2 Filkers ~ 3: Farmat |

Color Scheme

I~ Apply a Color Scheme
. Column heading back color
|_ Calurin heading fore color
|_ Group heading back calor
. Group heading fore color

Restare Defaults |

Report Name
Subtitle

Column Headings

Group Headings

Budget Adjustments Report

The Budget Adjustments Report lists adjustments to account, grant, and project budgets. This report includes
original budget information with adjustments and final budget information.

Keep in mind, to budget by grant and report grant budgets, you must set up a grant-tracking transaction code on
Grant Business Rules page of Configuration.
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You can select a budget scenario, include accounts and projects with no adjustments, and format the report. You
can filter this report in several ways.

Glossary: An adjustment is a journal entry made to correct errors or allocate items between accounting
periods. An adjustment record contains details of the adjustment.

The Budget Adjustments Report has tabs on which you set parameters: General, Filters, and Format. To move
among the tabs, click Next and Back at the bottom of the screen or select a tab. On these tabs you specify
information to include in the report and how the report should look. For more information about creating a
Budget Adjustments Report, see “Creating a report in General Ledger” on page 15.

General Tab

On the General tab, you set parameters specific to the report and make selections about information included in
the report.

I New Budget Adjustments Report x|
File Edit View Favorites Tools Help

Hdadam o= 2-

1. Gereral |2: Filtersl Vi Formatl

Shove budget adiustments for

Scenario 1D: IM vl b ait Operating Budget

Start Fiscal Year ||_ast fiscal pear x| 0170142006 to 12/31/2006

Show: I.-’-‘«ccount budgets with Grant detail j
[~ Include accounts with no adiustments

I Ihelude prajects with no adjustments

Repart farmat: IDetaiI 'I

Show adjusted: I.-’-‘«ccount budaet j

Report arientation: IF'mt[ait 'I

< Back | Ment » | Cancel | FBrrint | Prewview | Layout |

Show budget adjustments for. In the Scenario ID field, select the budget scenario to use in the report. A
brief description of the scenario appears in the display to the right. In the Start Fiscal Year field, select the
time period of the budget adjustments to include in the report.

Note: You can select Project and Grant budgets only if you have the optional module Projects and Grants.

Show. In the Show field, you can select to display “Account budgets”, “Account budgets with Grant detail”,
“Account budgets with Project detail”, “Account budgets with Grant and Project detail”, “Grant Budgets”, or
“Project budgets” on the report. Project and grant options appear only if you have the optional module
Projects and Grants.

The grant options appear only if you set up a grant-tracking transaction code on Grant Business Rules page of
Configuration.

Include accounts with no adjustments. If you mark Include accounts with no adjustments, accounts with
no adjustments entered appear on the report.
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Include projects with no adjustments. If you mark the Include projects with no adjustments, projects with
no adjustments appear on the report. This checkbox is active only if you select “Project budgets” in the Show
field.

Note: To view the report as it will appear using your selections and filters, click Preview. To view a sample
layout of the report without data, click Layout.

Report format. In the Report format field, select “Detail” or “Summary”.

Show adjusted. In the Totals field, select “Account budget” to show the development or the original budget to
the adjusted budget at the account level, or select “Account period budgets” to the show the development of
the original budget to the adjusted budget both at the account level and each period budget for the account.

Report orientation. In the Report orientation field, select Portrait or Landscape.

Filters Tab

On the Filters tab, you include information based on selected criteria such as accounts, funds, and grant. For
example, you can include only the accounts with an account attribute of Expense Category and the value of
Salaries recorded in the account record. Accounts with other account attributes do not appear on the report.

Glossary: A filter is a requirement records must meet to be included in a report. For example, if you apply the
Accounts filter, only the accounts you select are included in the report. You can select filters to apply to a
report from the Filters tab. Be patient! Depending on the filters you select, this report may take several
minutes to run after you click Print or Preview.

You can filter by project or grant only if you have the optional module Projects and Grants. For more information
about filtering in The Financial Edge, see the Program Basics Guide.

I8 New Budget Adjustments Report x|
File Edit View Favorites Tools Help
EIEEEEIFIEIR S |

1: General | & Fu:urmatl

&3 Open = Clear All Filters

Filters I Indude Selected Filters

Accounts All <All Accounts =

Funds All <All Funds>

Account Attributes All <All Account Attributes =

Cateqgories Al <Al Categories =

Projects All <Al Projects >

Project Attributes All <All Project Attributes =

Grants All <Al Grants =

Grant Attributes All <All Grant Attributes >

Mission(s) All <Al Mission(s) >

Department{s) All <Al Department(s) =

< Back I Hewt » | Cancel I Prrint | Presiew I Layout

Open. Click afilter in the grid and click Open on the action bar. The selection screen appears so you can
designate specific filters for the report.
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Clear All Filters. Click Clear All Filters to remove all previously selected filters from the report.
Filters. The Filters column lists all the filters for this report. You cannot edit this column.

Include. Choose Selected in the Include column. A selection screen appears so you can designate specific filters
for the report.

Note: Mark Selected, Range, or Query to include a selected filter, range of filters, or a previously created
query of filters. Depending on the selection, different options appear on the screen. If you mark All, you cannot
define filters. For more information about filtering in The Financial Edge, see the Program Basics chapter in the
Program Basics Guide.

Selected Filters. Filters you specify appear in the Selected Filters column. If you choose Selected in the Include
column or click a filter and then click Open, the Selected <Filter> screen appears. If you mark Selected,
Range, or Query, a selection screen appears so you can specify filters.

Query name. The Query name field appears if you select Query. Enter the name of the query to use to filter the
report or click the binoculars to search for a query.

To create a new query, click the binoculars and click Add a New Query on the Open Query screen. For more
information about creating queries, see the Query Guide.

Previous Filter. To view or edit the previous filter without returning to the Filters tab, click Previous Filter on
the toolbar.

Next Filter. To view or edit the next filter without returning to the Filters tab, click Next Filter on the toolbar.

Format Tab

On the Format tab, you decide how the report should look. You can create headings and footers, include a list of
criteria used to create the report, and sort the information in the report. You can select the format for displaying
monetary amounts and print the report in color.

The list on the left of the screen displays formatting options for the Budget Adjustments Report: Headings,
Criteria, Sort, Page Footer, Report Footer, Miscellaneous, and Color Scheme. When you select an item in the list,
the right side of the screen displays selections for that section of the report.

Note: The heading defaults to Budget Adjustments Report in the Title field. You can leave this as the title for
the report or enter your own.

Headings. Use Headings to enter a maximum of 60 characters in each of the Title and Subtitle fields. The title
and subtitle appear at the top of the report. You can select how the heading should be alighed and whether
your organization's name will appear in the header.
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You can include the page number and date in the heading. You can also select to include the heading on every
page of the report.

lﬂ MNew Budget Adjustments Report
File  Edit Help

BEE0- |

1 Generall 2 Filkers 3 Format |

Wiew Favortes  Tools

g2 Headings
Criteria -
Sart ~Heading Farmat
Page Footer Title: IBudget Adiustments Feport
Repart Foaoter S ubtitle: I

Miscelaneous
Color Scheme

Align: Il:entel "l

[¥ Print arganization name in header

¥ Print Report Date in Heading ———
Format: IStht Date and Time j

=~

v PFrint Page Humber in Heading

=l
[

¥ Print report heading on each page

Farmat: IF'age 1

Aligr:[Right Align: |Left

Criteria. Select Criteria to print a list of criteria used to create the report. Mark Print these criteria on and select
a separate page or the first page. All selected options print in the criteria section of the report. The program
automatically selects all criteria. Unmark the checkbox for any you do not want to print with the report.

I New Budget Adjustments Journal
File Edit View Favorites

Hadam a2

Tools Help

s Generall 2 Filters  3: Farmat |

Criteria
¥ Print these criteria on Ia separate page "I

Headings
‘B Criteria

Sort

Page Footer

Fieport Footer
Miscellaneous
Colar Scheme

Saved report name

Scenario D

Dates to include

Funds to include

Accounts to include

Account atiibutes to include
Categories to include
Projects to include

Project attributes to include
Include adjustrents entered by
Shaow

Uszer account secunty access
Uszer Project security access
Grantz to include

Grant attributes to include
Mizzion(z] ta include

-

||

Sort. Use Sort to select the order for information to appear on the report. When you select Sort, a grid displays
the categories you can sort in the report. Select a sorting category in the Sort by column and select Ascending
or Descending in the Order by column.
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If you make no selections in the Sort by column, the program sorts by the entire account number in

ascending order.

lﬂ New Budget Adjustments Report
File Edit Help

= = R = e 2

Wiew  Faworites  Tools

1: Generall 2 Filterz  3: Format |

Report Footer
Miscellareous
Color Scheme

Headings Sort
Criteria

Sort by Categon I Order by I
Fage Footer Account Mumber Azcending

Page Footer. Use Page Footer to create a footer to appear at the bottom of each page of the report. You can
enter a maximum of 254 characters in the Text field for the page footer. You can also select the alignment
and include the page number and date in the footer.

lQ MNew Budget Adjustments Report
File  Edit Help

= = RE e ] el B 2

Wiew  Favorites  Tools

1: Generall 2 Filters  2: Farmat |

Headings
Criteria

Page Footer

—Page Footer Text

Sot

g ber Teut:
Report Footer
Miscelaneous

Color Scheme

Align: IEentel v|

I Print Page Mumber in Footer

[~ Print Repart Date in Footer

Farmat; IF'age 1

=

Fuarmnat; I Shart D ate and Time

=

Align: |Right

—

Blign:  [Left

=
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Report Footer. Use Report Footer to create a footer to appear at the bottom of the last page of the report. You
can enter a maximum of 254 characters in the Text field for the report footer and select alignment of the

text.
u Mew Budget Adjustments Report
File Edit “iew Fawvoritez Toolz Help
u _1 % —ﬁ |||J ? T
1 General] 2 Filterz 3 Format l
=] Headings Report Footer
=] Critenia
ER Report Footer Text
] Page Foater Text:
B Report Footer
2] Mizcellaneous
=] Color Scheme
Aligr: | Left -

Tip: Make selections for displaying amounts and view them in the Sample amount display before printing the
report.

Miscellaneous. Use Miscellaneous to specify how numbers appear on the report and the font size for the
report.

u Mew Budget Adjustments Report
File  Edit Help

H &S a W ?-

1 General] 2 Filters  3: Format l

YView Favortes  Tools

] Headng:
=] Criteria
=] Sort Show currency character on All arnounts
Z] Page Footer Show percent sign on Al amounts
=] Report Footer Megative amount format [1234.56)
5] Color Scheme Mumber of digits after decimal for amounts 2
Mumber of digits after decimal for percentages 2
Show 1000z separator ez
Show blanks instead of zeros Mo
Farnt gize 2

Sample amount:

Amaunt [$1.234.5E)

100.00%

Percent

Note: Any time you want to return to the original color settings, click Restore Defaults.
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Color Scheme. Use Color Scheme to select colors for report headings. When you click in the color box next to
the selection, the Color screen appears so you can select a standard color or define a custom color. If you
leave the Apply a Color Scheme checkbox unmarked, the report prints in black and gray.

lQ Mew Budget Adjustments Report
File Edit “iew Favoritez Toolz Help

RS R ] ?- |

1 Generall 2 Filters 2 Format |

Headings Color Scheme
Criteria

Sort I~ Apply a Colar Scheme Report Name
Ezzrlt:!c:lzt:t:er . Column heading back color Subtitle
Mizcellaneous [ Column heading fore calor Column Headings

B Color Scheme

[ Group heading back colar Group Headings

- Group heading fore color

Restore Defaults |

Budget Distribution Report

The Budget Distribution Report lists budget distributions for account, grant, and project budgets for a time period
you select. You can include budget and account notes on this report. You can also include percentages and
accounts with zero budgets.

Keep in mind, to budget by grant and report grant budgets, you must set up a grant-tracking transaction code on
Grant Business Rules page of Configuration.

You can select a budget scenario and include accounts with no zero budgets. You can filter this report in several
ways.

Glossary: A budget distribution is a template that provides a method for you to distribute budget activity
manually, evenly, or with a table among accounts. If you have the optional module Projects and Grants, you
can also apply budget activity manually, evenly, or with a table to projects or grants.

The Budget Distribution Report has tabs on which you set parameters: General, Filters, and Format. To move
among the tabs, click Next and Back at the bottom of the screen or select a tab. On these tabs you specify
information to include in the report and how the report should look. For more information about creating a
Budget Distribution Report, see “Creating a report in General Ledger” on page 15.
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General Tab

On the General tab, you set parameters specific to the report and make selections about information included in
the report.

& New Budget Distribution Report x|
File Edit View Favorites Tools Help

Hdadam o= 2-

: Filtersl 1 Formatl

Shove budget details for -
Scenario [D: IDD j td ain Operating Budget

Include budgets in thiz date range-
Diate: |This fiscal pear x| 04012007 to 1242142007

Shw: I.-’-‘«ccount budgets j

[ Include budget adiustments with these entry dates: IIncIude all dates ﬂ
[ Include accounts with zero budgets

Report arientation: IF'mt[ait 'I

< Bach | Mest » | Cancel | FBrrint Prewview Layout

Glossary: A budget scenario is a single version of an organization’s budget for a given fiscal year. You can have
multiple budget scenarios if you have the optional module Budget Management. For example, you can create
a scenario of your original budget and also create scenarios for various revisions of that budget.

Show budget details for. In the Scenario ID field in the Show budget details for frame, select the budget
scenario to use in the report. A brief description of the scenario appears in the display to the right.

Include budgets in this date range. In the Date field in the Include budgets in this date range frame, select
the time period of the budgets to include.
If you select <Specific range>, you can specify a start date and an end date. If you leave the Start date field
blank, all activity is included up to the end date. If you leave the End date field blank, all activity from the start
date until present is included. If you leave both fields blank, all activity is included.

Show. In the Show field, you can select to display “Account budgets”, “Account budgets with Grant detail”,
“Account budgets with Project detail”, “Account budgets with Grant and Project detail”, “Grant Budgets”, or
“Project budgets” on the report. Project and grant options appear only if you have the optional module
Projects and Grants.

The grant options appear only if you set up a grant-tracking transaction code on Grant Business Rules page of
Configuration.

Include budget adjustments with these entry dates. If you mark Include budget adjustments with these

entry dates, you can show the budget adjustments on the report for all dates, or enter the specific dates.

Include accounts with zero budgets. If you mark Include accounts with zero budgets, accounts with no
budget amount recorded in the account record appear on the report.

Report orientation. In the Report orientation field, select “Portrait” or “Landscape”.
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Filters Tab

On the Filters tab, you include information based on selected criteria such as accounts, funds, and grants. For
example, you can include only the accounts with an account attribute of Expense Category and the value of
Salaries recorded in the account record. Accounts with other account attributes do not appear on the report.

You can filter by project and grant only if you have the optional module Projects and Grants. For more
information about filtering in The Financial Edge, see the Program Basics Guide.

I New Budget Distribution Report x|
Fle Edit View Favorites Tools Help
d a3 =2 |

1: General &b Formatl

3 Open . Clear All Filters

Filters | indude Selected Filters

Accounts All <All Accounts >

Funds all <All Funds>

Account Attributes All <All Account Attributes =

Categories all <All Categories =

Projects All <Al Projects =

Project Attributes all <All Project Attributes >

Grants All <All Grants >

Grant Attributes all <All Grant Attributes >

Mission(s) All <Al Mission{s) =

Department(s) all <All Department(s) =

< Back Mewut » Cancel Print Preview Layaut

Note: You can filter by grant, grant attributes, projects, and project attributes only if you have the optional
module Projects and Grants.

Open. Click afilter in the grid and click Open on the action bar. The selection screen appears so you can
designate specific filters for the report.

Clear All Filters. Click Clear All Filters to remove all previously selected filters from the report.

Glossary: A filter is a requirement records must meet to be included in a report. For example, if you apply the
Accounts filter, only the accounts you select are included in the report. You can select filters to apply to a
report from the Filters tab. Be patient! Depending on the filters you select, this report may take several
minutes to run after you click Print or Preview.

Filters. The Filters column lists all the filters for this report. You cannot edit this column.

Include. Choose Selected in the Include column. A selection screen appears so you can designate specific filters
for the report.

Selected Filters. Filters you specify appear in the Selected Filters column. If you choose Selected in the Include
column or click a filter and then click Open, the Selected <Filter> screen appears. If you mark Selected,
Range, or Query, a selection screen appears so you can specify filters.

Query name. The Query name field appears if you select Query. Enter the name of the query to use to filter the
report or click the binoculars to search for a query.



107 CHAPTER

To create a new query, click the binoculars and click Add a New Query on the Open Query screen. For more

information about creating queries, see the Query Guide.

Previous Filter. To view or edit the previous filter without returning to the Filters tab, click Previous Filter on

the toolbar.

Next Filter. To view or edit the next filter without returning to the Filters tab, click Next Filter on the toolbar.

Format Tab

On the Format tab, you decide how the report should look. You can creat

e headings and footers, include a list of

criteria used to create the report, and sort the information in the report. You can select the format for displaying

monetary amounts and print the report in color.

The list on the left of the screen displays formatting options for the Budget Distribution Report: Headings,
Criteria, Sort, Page Footer, Report Footer, Miscellaneous, and Color Scheme. When you select an item in the list,
the right side of the screen displays selections for that section of the report.

Note: The heading defaults to Budget Distribution Report in the Title field. You can leave this as the title for

the report or enter your own.

Headings. You can enter a maximum of 60 characters in each of the Titl
subtitle appear at the top of the report. You can select how the headi
organization's name will appear in the header.

e and Subtitle fields. The title and
ng should be aligned and whether your

You can include the page number and date in the heading. You can also select to include the heading on every

page of the report.

@ New Budget Distribution Report

File Edit View Favorites Tools Help

da IR o= ?-

1: General' 2 Filters 3 Farmat |

. Criteria

Detsil —Heading Format
Sart Title: |Budget Distibution Fleport
Page Footer Subite: |

Feport Footer
Miscelaneous
Color Scheme

Align: ICenter 'I

[ PFrint organization name in header

v Print Page Number in Heading v Frirt Feport Date in Heading

Farmat: IF'age 1 j Format: IShDrt Date and Time j
Align: | Right x| || Aign Let =l
[v Print report heading on each page
< Back fewt o Cancel Brint Freview Layout

Note: The program automatically selects all criteria. Unmark the checkb
with the report.

ox for any you do not want to print
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Criteria. Select Criteria to print a list of criteria used to create the report. Mark Print these criteria on and select
a separate page or the first page. All selected options print in the criteria section of the report.

& tiew Budget Distribution Report
File Edit View Favorites Tools Help

F I RE =R

gl General' 2 Filters 3 Format |

Criteria
Dretail
Sart
Page Faoter
Feport Footer
Miscelaneous
Color Scheme

Criteria
¥ Frint these criteria an Ia separate page 'l

Saved report name

Scenario 1D

Dates to include

Funds to include

Accounts to include

Account attributes to include
Department(s] to include
Categories to include
Frojects to include

Project attributes to include
Shiow

Include accounts with zero budgets
Include budget notes

Include budget period notes
Include percentages

Uzer account securnty access

-

< Back | (L= |

Cancel |

Brint | Freview | Laypout |

Detail. Select Detail to further customize your Budget Distribution report.

Note: If you mark Include budget notes, and no notes are recorded in the Budget Manager for the account,

nothing appears next to the heading on the report.

¢ Mark Include budget notes if you want budget notes from the Budget Manager to appear on the report.

¢ Mark Include budget period notes if you want notes recorded for budget periods to appear on the report.

¢ Mark Include percentages if you want the percentage distribution of the budget to appear on the report.
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¢ Mark Include account category summary if you want to include the budget account totals or budget final
balance on the report.

I3 New Budget Distribution Report x|

File Edit View Favorites Tools Help

da3sam =2 |

1: General' 2 Filters 3 Format |

Headings Detail
Criteria

[~ Include budget notes

gort Font [~ Include budget period notes

'age Foater

Report Footer [T Include percentages
Mizcelaneous [ Include acoount categary summary

Color Scheme

< Back | Ewt > | Cancel | Brint | Freview | Layout |

Sort. Use Sort to select the order for information to appear on the report. When you select Sort, a grid displays

the categories you can sort in the report. Select a sorting category in the Sort by column and select Ascending
or Descending in the Order by column.

If you make no selections in the Sort by column, the program sorts by the entire account number in
ascending order.

@ New Budget Distribution Report : x|

File Edit View Favorites Tools Help

Bacaca=?- |

ol General' 2 Filters 3 Format |

Headings Sort

Criteria

Dretail Sort by |  category | Qrder by |i|
Account Number Ascending

Page Footer

Fieport Footer
Mizcelansous
Color Scheme
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Page Footer. Use Page Footer to create a footer to appear at the bottom of each page of the report. You can
enter a maximum of 254 characters in the Text field for the page footer. You can also select the alignment
and include the page number and date in the footer.

@ New Budget Distribution Report x|
File Edit View Favorites Tools Help

dasaR@ = 2- |

1: General' 2 Filters 3 Format |

Headings Page Footer

Criteria
Dietail — Page Foater Text
Sort Text:

:8 Page Foater
Fieport Footer
Mizcelansous

Calar Scheme Bligre IEenter 'I

I Print Page Number in Footer [~ Piint Report Date in Foater
Format; IF'age 1 j Farmat: IShc-rt Date and Time j
Aligr: IHight j Aligr: ILeﬂ j

< Back | [ et 2 | Cancel | Erint | Freview | Lapout |

Report Footer. Use Report Footer to create a footer to appear at the bottom of the last page of the report. You
can enter a maximum of 254 characters in the Text field for the report footer and select alignment of the
text.

& New Budget Distribution Report x|
File Edit Wiew Favorites Tools Help

Ha3a = - |

1 Generall 2 Filters  3: Format |

Headings Report Footer

Criteria
Detail Report Footer Test
Sart Teuxt:
Page Faoter

‘B Feport Footer
Miscellaneous

Color Scheme Aligr: I Left = I

Tip: Make selections for displaying amounts and view them in the Sample amount display before printing the
report.
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Miscellaneous. Use Miscellaneous to specify how numbers appear on the report and the font size for the
report.

& New Budget Distribution Report . X
File Edit View Favorites Tools Help

da3aE o= 2?- |

1: General' 2 Filters 3 Format |

Headings Miscellaneous

x}

Criteria
Dretai Show currency character on All amounts
Sort Show percent sign on All amounts
Page Foater Megative amount format (1234.56)
Fi=port Foote Mumber of digits after decimal for amounts 2
E -:I-:r Sche Mumber of digits after decimal for percentages 2

Show 1000's separator Yes

Show blanks instead of zeros Mo

Font size 8

Sample amovnt:

Amount (51,234.56)
Percent 100.00%:
< Back Ewt > Cancel Brint Freview Laypout

Note: Any time you want to return to the original color settings, click Restore Defaults.
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Color Scheme. Use Color Scheme to select colors for report headings. When you click in the color box next to

the selection, the Color screen appears so you can select a standard color or define a custom color. If you
leave the Apply a Color Scheme checkbox unmarked, the report prints in black and gray.

& New Budget Distribution Report , x|

File Edit View Favorites Tools Help

FIEEELE

X

il General' 2 Filters 3 Format |

Headings Color Scheme

Criteria
Dretail [~ Apply a Color Scheme

Report Name

gz;e Fontor . Colurmn heading back. color Subtitle

Fieport Footer
Mizcellaneous

[ Group heading back color Group Headings

. Group heading fore color

Feztone Mefaults |

< Back | [=He Cancel Erint Freview Lapout
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Custom Reports make it easy for you to access and share reports you create using Crystal Reports. Using Custom
Reports, you can link a Crystal report file with a Financial Edge export file and then save the linked report in your
Financial Edge database. Once the files are linked, you and other Financial Edge users can easily view or print
custom Crystal reports directly from The Financial Edge without having to open Crystal Reports.

The Financial Edge includes one license for Crystal Reports XI. Clients creating custom reports using Export in
The Financial Edge with Crystal Reports will need a license for each person creating custom reports. In addition,
each license is associated with a particular product, which means if one person is reporting for both The Financial
Edge and The Raiser’s Edge, that individual needs two Crystal Reports Xl licenses. For information about
purchasing additional Crystal Reports Xl licenses, send an email request to solutions@blackbaud.com or contact
your account representative.

Creating Custom Reports

When setting up the Crystal report and the export file, it is important to remember that you can add as many or
as few fields as you want to the Crystal report as long as those fields are also contained in the export file. You can
add additional fields to the export file that are not included in the Crystal report, but you cannot add fields to the
Crystal report that are not included in the export file.

Make sure to format the export file in one of these *.MDB formats: Blackbaud Report Writer Database, Microsoft
Access 2.x Database, Microsoft Access 95 Database, Microsoft Access 97 Database, or Microsoft Access 2000
Database. For more information about creating export files, see the Export Guide. For more information about
creating Crystal reports, see the Crystal Reports help file.

» Creating a custom report
1. From the General Ledger Reports page, click Custom Reports. The Custom Reports page appears.

% The Financial Edge
File Edit %iew Go Favoites Took Help

& Back & o ] Community Services Inc. ™ ¢ General Ledger =

\2 Reports - Custom Reports

Shartcuts

New ‘Dpen |Qelels Reports
Custom Repo Account
B Custom Report Custom Repoﬁ CEpEi
inti i Allocation
D escription Date Crald Created By Others May Modify P

09 002 Supervisor
Budget
10/01/2003  Supervisor [N e

Custom
Reports

Financial
Statements

GASE 34
Repotts

el

Journal and
Batch
Repotts

Reports

Project
Reports

B

KN |

[~ Only show my reports

from export data. Just ink the Crystal report file with an export to store it in the
database and make it available to all users.

The Custom Repoart pravides an easy way to share Crystal reparts pou create
Maonthly Reports
Web Links

Welcome to General Ledger |
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2. Click New. The Custom Report screen appears.

I3 Mew Custom Report I
File Edit “iew Favortes Tools Help

BRE R0 =2 |

1: General I

Select Export: I ﬁl%l

Select Cryztal Report: I _I

¥ Refresh Export

< Blanhk | et | Catcel | Print | Praview | Layaout |

3. Inthe Select Export field, click the binoculars to locate the export file you want to use as a data source for
your custom report. The Open screen appears.

Flopen @
Find: | Export 7| Search using query: [< Defauls [

= | Dz 1i Add a Mew Export Optionz

Export bype: I j Last modified by: I j
Export format: I j Lazt modified or: Iany time j
Export name: I j
Description: I j

Hide Filters | Clear Filtersl Previous Filtersl Filters are not applied Find Mow I [Hper Cancel

|F'less F7 to zoom

Note: Only exports in saved in a Microsoft Access database file format (*.MDB) appear on the Open screen.

4. From this screen you can select an existing export file or create a new export file.

¢ To select a file, select the file name and click Open. You return to the Custom Report screen and the
selected export file name appears in the Select Export field.
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Note: Make sure to format the export file in one of these *.MDB formats: Blackbaud Report Writer Database,
Microsoft Access 2.x Database, Microsoft Access 95 Database, Microsoft Access 97 Database, or Microsoft
Access 2000 Database.

¢ To create a new export file, click Add New. The Create a New Export screen appears where you can
create an export file to use with Custom Reports. After you create and save your export file, you return
to the Custom Report screen and the selected export file name appears in the Select Export field. For
more information about creating export files, see the Export Guide.

In the Select Crystal Report field, browse to the Crystal report file you want to link to the selected export
file. The Open screen appears.

Select the Crystal report and click Open. You return to the Custom Report screen and the selected report
name appears in the Select Crystal Report field.

u Mew Custom Report
File Edit “iew Favortes Tools Help
H &2 & W ¥ =
1: General l
Select Expart: |Beginning Balances ﬁl&l
Select Cryztal Report: |Beginning_BalanceS.lpl J

[vw Refresh Export

| | Catcel | Print | Praview | Layaout |

Note: If you selected the Save Data with Report option when you created the Crystal report, this option has no
effect when the report is run from The Financial Edge — the program simply ignores it. If you want to make
the custom report “static” (the data does not update each time the report is run) you should unmark the
Refresh Export option.

7. To automatically refresh the export file every time you view the report, mark Refresh Export. If you do

not mark this checkbox, when you run the report the program checks to see if the export file is saved on
your machine. If it is, the program uses the existing export file and will not update the data each time you
run the report. If the export file is not saved to your machine, the program generates a new export file
and includes current data from the database.
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8. Click Preview to view a copy of the report on your screen before printing.

I3 Mew Custom Report _ (O] <] I
X {4 4 1of1+ = FIERE | #h T

Presvigw

9. A copy of the report appears on your screen. If the report is okay, click the Print button at the top of the
preview screen to print the report.
10. To save the report parameter file, click File, Save from the menu bar. The Save report as screen appears.

Save Report as x| I

Repart hame: |

Description:

[V Others can run this report
[" Others can modify this report

Hsave | Cancel |

11. Enter a Report name and a Description. You can also mark options to allow other users to run or modify
this report.

12. Click Save. You return to the Custom Reports screen.

13. To return to the Reports page, select File, Close from the menu bar.

Editing an Export for a Custom Report

Warning: You cannot delete fields from an export file if the export is linked with a Custom Report. The
Remove button is disabled in Export. You also cannot delete an export file linked with a Custom Report. If you

try, an error message appears.
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You can edit an export file directly from the Custom Reports screen by clicking the Click to edit export button.
You can add additional fields to the export file that are not included in the Crystal report, but you cannot add
fields to the Crystal report that are not included in the export file. Each time you run a saved Custom Report,
The Financial Edge checks to make sure the fields selected for the Crystal report are still included in the export

file.

» Editing an export file from an open Custom Report
1. Open the saved Custom Report you want to edit. The report opens displaying the General tab.

File Edit “iew Favortes Tool: Help

RS W o2

I3 Beginning Balances E I

1. General I

Select Expart: |B eginning Balances

D

Select Crystal Report: |B eqinning_B alances.ipt

¥ Refrash Export

< Bach et > Catcel

Print

Freview Layout
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2. Inthe Select Export field, click the Click to edit export button next to the binoculars. The export file
appears, displaying the Filters tab.

2|

I[=] E3

Selected Filkers

=al Accounts =

<Al Funds =

<Al Account Attribubes =
<all Departmentis) =
<Al Categories >

Export Noﬂl

E. Beginning Balances
Elle Edit “iew Favorites Tools Help
ESaveandElosev| = X| -] @| |
1: Filters |g; Dutputl
& 0pen ) Clear &l Filkers
Filkers | Include
Accounts all
Funds &l
Account Attributes all
Department(s) all
Cakegories all
¢ Back | Mext » | Cancel |

v

3. Make any necessary changes on the Filters and Output tabs, and click Save and Close. You return to the
Custom Report screen.

4. Click Print to print the report or save and close the updated report.
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Reporting categories in General Ledger include Account Reports, Allocation Reports, Budget Reports, Financial
Statements, GASB 34 Reports, Journal and Batch Reports, Pivot Reports, and Project Reports. This chapter
discusses Financial Statements. For information about other report categories, see the chapter for that category.

Note: We recommend you read the documentation for The Financial Edge thoroughly. Descriptions
presented here provides you with basic information about financial statements in General Ledger. Hands-on
experience is the best way to learn, so we encourage you to try various options with the sample database.

Financial statements in General Ledger include:

¢ Balance Sheet

® |Income Statement

¢ Statement of Activities

¢ Statement of Cash Flows

¢ Statement of Financial Position

¢ Statement of Functional Expenses

e Custom Management Report

¢ “Financial Statements and GASB Report Troubleshooting” on page 189

Balance Sheet

The Balance Sheet reflects your organization’s financial position at a specific moment in time. It reports on
balances for all asset, liability, and net asset accounts as of a specific date or as of the end of a selected fiscal
period.

The Balance Sheet has tabs on which you set parameters: General, Filters, Columns, Multiple Column Headings,
and Format. To move among the tabs, click Next and Back at the bottom of the screen or select a tab. On these
tabs you specify information to include in the report and how the report should look. For more information about
creating a Balance Sheet, see “Creating Reports” on page 15.

General Tab

On the General tab, you set parameters specific to the report and make selections about information included in
the report.

M@ Mew Balance Sheet | x|
File Edit “iew Favortez Toolz Help

= IR R e |

1. General |2: Filtersl 3 Cnlumnsl A Multiple Colunin Headingsl 5 Formatl

Usze chart template Im j@ at level |4_j

v Include accounts with zemo balances

v Include inactive accounts

[~ Create an output query of accounts

R eport orientation: IPu:urtrait 'I
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Note: You can change the results of a report by using different chart templates to run the same report. You
can define an unlimited number of templates in Visual Chart Organizer. For more information, see the Visual
Chart Organizer Guide.

Use chart template. In the Use chart template field, select a chart template for the report. Chart templates
are established in Visual Chart Organizer. Then click the Validate chart template button to verify that all
existing accounts are represented in the chart template and that there are no duplicate accounts in the chart
template. Select a level by clicking the up and down arrows to the right of the level field.

Include accounts with zero balances. Include accounts with zero balances defaults to marked to include all
accounts with zero balances.

Include inactive accounts. Include inactive accounts defaults to marked to include inactive accounts.
Create an output query of accounts. Mark this option to create a query of account records and include it in
the report. This query is available for use in other areas of the program.

Note: To view the report as it will appear using your selections and filters, click Preview. To view a sample
layout of the report without data, click Layout.

Report orientation. In the Report orientation field, select Portrait or Landscape.

Filters Tab

On the Filters tab, you can include information based on selected criteria such as funds, accounts, and classes. For
example, you can include only the funds within a certain range. Funds not in the range do not appear on the
report. You can filter by projects only if you have the optional module Projects and Grants.

I@ Hew Balance Sheet
Fil=e Edit “iew Favortez Toolz Help
HRe w2 |
1. General | a Culumnsl 4 Multiple Column Headingz | & Fulmatl
f®0pen ) Clear Al Filters
Filters I Include Selected Filkers Iﬂ
Funds All <Al Funds =
Account Codes Al <Al Account Codes
Accounts &l <Al Accounts =
Account Attributes All <Al Account Attributes:
Projects Al <8l Projects=
Project Attributes all <Al Project Attribukes =
Transaction Attributes all <all Transaction Attribukes=
Classes &l <Al Classes=>
Journals &l <Al Journals =
Mok Yet Posted Transactions Selected <Mone
Cash Flow Codes &l <fll Cash Flow Codes=
Working Capital Codes Al <Al Working Capital Codes >
Mlissiongs) all <Al Mission{s) = LI

Open. Click a filter in the grid and click Open on the action bar. The selection screen appears so you can
designate specific filters for the report.

Clear All Filters. Click Clear All Filters to remove all previously selected filters from the report.
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Glossary: A filter is a requirement records must meet to be included in a report. For example, if you apply the
Accounts filter, only the accounts you select are included in the report. You can select filters to apply to a
report from the Filters tab. Be patient! Depending on the filters you select, this report may take several
minutes to run after you click Print or Preview.

Filters. The Filters column lists all the filters for this report. You cannot edit this column.

Include. Choose Selected in the Include column. A selection screen appears so you can designate specific filters
for the report.

Selected Filters. Filters you specify appear in the Selected Filters column. If you choose Selected in the Include
column or click a filter and then click Open, the Selected <Filter> screen appears. If you mark Selected, Range,
or Query, a selection screen appears so you can specify filters.

Query name. The Query name field appears if you select Query. Enter the name of the query to use to filter the
report or click the binoculars to search for a query.

To create a new query, click the binoculars and click Add a New Query on the Open Query screen. For more
information about creating queries, see the Query Guide.

Previous Filter. To view or edit the previous filter without returning to the Filters tab, click Previous Filter on
the toolbar.

Next Filter. To view or edit the next filter without returning to the Filters tab, click Next Filter on the toolbar.

Columns Tab

On the Columns tab, you can open existing columns, delete columns, and view the heading, formula, and dates
defined for columns you have already created.

A3 New Balance Sheet x|

File Edit View Faworites Tools Help

Bagam o

- |
4

1: General | 2 Filters

4 Multiple Calurin Headings | 5 Farmat

‘ Mew Column &3 Open Colurmn Ee R epeat Colurnh * Delete Column
Hide? I Heading I Farmula I Date Range
1 I Account Number
2 (l Account Description
3 [T actual {actualt 013172006

New Column. When you click New Column, the Column <#> screen appears, showing the General, Date Range,
and Filters tabs from which you can create a new column.

Open Column. To open an existing column and edit its settings, select a row in the grid and click Open Column.

Repeat Column. To repeat a column’s settings, select that column and click Repeat Column. A new row with
the same settings appears in the grid. If you click the drop down arrow on the Repeat Column button, you can
select “All parameters” or “Date parameters only.” If you select “Date parameters only,” you will create a new
column with the same date parameters of the selected column.

Delete Column. To delete a column’s settings, select that column and click Delete Column. Only columns not
being used to define another column can be deleted.

Hide? Mark the checkbox in the Hide? column for any column you do not want to appear in the report.
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Heading. The Heading column displays the column heading defined in the Column heading field of the Columns

General tab.

Formula. The Formula column displays the column information defined in the Column Definition frame of the

Columns General tab.

Date range. The Date Range column displays the dates selected on the Date Range tab.

Note: Selections made on the General, Date Range, and Filters tabs of the Columns tab apply only to report

columns and not to the report itself.

General tab. You can name and define report columns on this tab. Using the alignment buttons, you can specify
how columns should be aligned. Column formatting options include: Column width, Report width, Format,
and Decimal places. In the Column Definition frame, you select the column Type, Amount or Description and
determine the calculations or description for that column. Click Validate to validate the expression created in
the Column Definition frame. Click Clear to clear the expression. If you mark Hide this column on the report
and export the report, the hidden columns will not be exported.

Column 4

1i New Column By Repeat Column Delete Colurnn

General I Dabe: Hangel Fillersl

Colurmn heading:

Column width: I‘I an inches

Report width: — 5.75 inches

Format: I Cumency A I

{Budget Adjustments}

{Calurnn 3} Y |

= = = [FAsofDae
Decimal places: |2 - I
Calumn Definition -
Tepe: | Amount =]
{Achuall
{Original Budget}
{Adjusted Budget}

[~ Hide this colurnn on the repart ‘Walidate Clear

N N B VRPN

Date Range tab. On this tab, the selections you make determine the period or date for which balances are

included on the report.

Column 5

*i Mew Column  Bpy Repeat Column

General  Date Range I Filtersl

Date: [ <Specilc fiscal periad> | 0473042000

Fizeal year: IThis fiscal pear j As of period: IThis fizcal period 'I
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Filters tab. On this tab you can select filters that apply only to the selected columns and not the entire report.

Column 4

Filters I Include Selected Filkers ﬂ

Funds Al <Al Funds =

Account Codes Al <Al Account Codes =

Accounts all Al Accounts=

Accaunt Attribukes &l <Al Account Attributes =

Projects Al <Al Projects>

Project Attributes all <Al Project Attributes=

Transaction Attributes all <Al Transaction Attributes =

Classes &l <Al Classes >

Journals &l <Al Journals:

Mok Yet Posted Transactions Al <Al Mot ek Posted Transactions =

Cash Flow Codes Al <Al Cash Flow Codes>

working Capital Codes all <all Working Capital Codes = -

K _'l_I

Multiple Column Headings Tab

On the Multiple Column Headings tab, you can create a heading to cover more than one column.

12 New Balance Sheet
File  Edit iew Faworter Tool: Help

FlERE R =T |

1: Generall 2 Filkers | 3 Colurinz — 4: Multiple Columi Headings |§: Formatl

Heading I Start Calumn I End Colurnn Align

Heading. Text entered into the Heading column appears as a heading above one or more of the individual
column headers.

Start. In the Start column, select the first column the multiple column heading will cover.

End. In the End column, select the last column the multiple column heading will cover. The End column must be
greater than or equal to the Start column.

Align. In the Align column, select a left, center, or right alignment.

Format Tab

On the Format tab, you decide how the report should look. You can create headings and footers, sort the records
for the report, select the format for displaying monetary amounts, and print the report in color.
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The list on the left of the screen displays formatting options for the Balance Sheet: Headings, Criteria, Detail,
Sort, Page Footer, Report Footer, Miscellaneous, and Color Scheme. When you select an item in the list, the right

side of the screen displays selections for that section of the report.

Note: The heading defaults to New Balance Sheet in the Title field. You can leave this as the title for the report

or enter your own.

Headings. Use Headings to enter a maximum of 60 characters in each of the Title and Subtitle fields. The title
and subtitle appear at the top of the report. You can select how the heading should be aligned and whether
your organization's name will appear in the header. You can include the page number and date in the heading.

You can also select to include the header on every page of the report.

n Mew Balance Sheet
Fil= Edit “iew Favortes Toolz Help

H <=2 ?-

1 Genelal] 2 Filters ] 3 Eolumns] 4: Multiple Column Headings

2] Mizcellaneous Align: | Center ~

Color Schi . . .
= Lolor scheme [+ Print organization name in header

W Print repart heading on each page

Headings
=] Critenia )
5 Detail Heading Format
] Sort Tile:  [Balarice Shest
=] Page Footer Sublitle: |
=] Report Footer

=~

v Frint Page Mumber in Heading [v Print Report Date in Heading
Format: |F'age 1 ﬂ Format: |Sh0rt Date and Time
Align: | Right =] | | At Left

[~

Criteria. Select Criteria to print a list of criteria used to create the report. Mark Print these criteria on and select
a separate page or the first page. Selections print in the criteria section of the report.

n MNew Balance Sheet
Fil= Edit Wiew Favortes Tools Help

(= PR Qi = ?-

1 General] 2 Filtersl & Eolumnsl 4: Multiple Column Headings  5: Format ]

Criteria

=] Headings Criteria

| Include inactive accounts

v| User account security access
| lzer project secuity access
| Funds ta include

| Account Codes to include

| Bocounts bo include

w| Account attributes o include
v| Department(z] to include

v| Projects to include

v| Project attibutes to include

w| Tranzachion attributes to include

] Detail [V Fiint these critenia on | a separate page -

=] Sort V| Saved report name -
] Page Foater | Dutput quemny name =l
=] Report Footer | Chart template

=] Miscellaneous V] Account detail level

Z] Color Scheme | Include accounts with zero balances
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Detail. Use Detail to indent totals. To indent totals when the statement contains only one amount column, mark
Indent totals when statement only contains one amount column.

Glossary: A net asset is residual value in an entity’s asset remaining after liability is deducted.

If you mark Print change in net assets, you must select a chart template that includes income statement
accounts on the General tab, or the net surplus/deficit cannot be calculated and appears as zero.

If you mark Calculate net surplus/(deficit) based on category definitions, all NSD calculations will be grouped
by account category. This can significantly improve runtime if you have numerous nominal details in your
Visual Chart Organizer.

I3 New Balance Sheet g x|

File Edit Miew Faworites Tools Help

dE3daE =

il Generall 2 Filtersl 2h Enlumnsl 4: Multiple Column Headings  5: Format |

Headings Detail
Criteria

. ‘

Indent tatals when statement only contains one amaount column
Sort Print change in net assets

Page Footer

Report Footer
Miscellaranus Calculate net surplus/(deficit) based on category definitions

Color Scheme

Print net assets for encumbrance on a separate ling

[ 1 e

Sort. use Sort to print a separate statement for a selected value. If you select to summarize any portion of the
statement in the Show field, select how to summarize in the Summarize by field. You cannot select the same
value you selected in the Print a separate statement field.

If you select to Show account details for the entire statement, a grid appears so you can select various
sorting options.

In the Change in net assets section format field, you can select “Show summary of change in net assets,” or
“Show detailed change in net assets by characteristic.” If you select “Show detailed change in net assets by
characteristic,” the Summarize by field appears.

Glossary: An account segment is a set of digits in an account number, such as fund and account code
segments, that categorize transactions for creating financial statements. For example, in account
01-1100-00-00, the first set of numbers in the series is usually the fund (01), followed by more segments such
as the account code (1100), department (00), and location (00). Fund and account code segments are required.
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If you make no selections in the Sort by column, the program sorts by the entire account number in
ascending order with no action. If you select a sort option in the Sort by column, you can select Subtotal or
Mask in the Action column. Subtotal is a break for which a total is provided. You can select Subtotal for only
one Sort by option. You can apply masking to any account segment.

I New Balance Sheet x|
Fil= Edit “iew Favorites Tools Help
dagdm =2 |
s Generall 2 Filtersl &b Enlumnsl 4: Multiple Column Headings  5: Format |
Headings Sort
Criteria
Dletail [~ Print a separate statement far each IFund j
Page Foater Statement body format:
Repart Foater IShow detail by account for statement j
Miscell ; ;
ISCETANGOUE Change in net assets section format;
Color Scheme
IShow summary of change in net assets j
Sark by COrder by Action |
< Back | et s | Cancel | Print | Freview | Layout |

Page Footer. Use Page Footer to create a footer to appear at the bottom of each page of the report. You can
enter a maximum of 254 characters in the Text field for the page footer. You can also select the alignment
and include the page number and date in the footer.

I Hew Balance Sheet %]
File Edit %“iew Favortes Tools Help

e = et |

1: General' 2 Filtersl & Eolumnsl 4: Multiple Column Headings  5: Format |

Headings Page Footer

Criteria
Dietail —Page Footer Text
o Text:

B Page Footer

Fieport Footer
Miscellaneous

Color Scheme Align: Im

I Print Page Mumber in Footer [~ Print Repart Date in Footer
Format: IF'age 1 j Farmat; IShc-rt Date and Time j

Align: [ Riight =l adan: [Lst |
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Report Footer. Use Report Footer to create a footer to appear at the bottom of the last page of the report. You
can enter a maximum of 254 characters in the Text field for the report footer and select alignment of the text.

I Hew Balance Sheet %]
File Edit %“iew Favortes Tools Help

e = el |

1: General' 2 Filtersl & Eolumnsl 4: Multiple Column Headings  5: Format |

Headings Report Footer
Criteria

Dretail Report Footer Text
Sort Text:
Page Footer

B Report Footer

Miscellaneous

Calor Scheme Aligr: m

Tip: Make selections for displaying amounts and view them in the Sample amount display before printing the
report.

Miscellaneous. Use Miscellaneous to specify how numbers appear on the report and the font size for the
report.

I New Balance Sheet E=
File Edit Wiew Favortes Tools Help

= D= RE = el

1: General' 2 Filtersl & Columnsl 4 Multiple Column Headings  5: Format |

Headingz Miscellaneous
Criteria

Detail Show currency character on Al amounts
Sort Show percent sigh on Al amounts
Page Footer Megative amount format [1234.56)
F||:u:rt facter Mumber of digitz after decimal for amournts 2
i ANEOLE
Color 5 chame Mumber of digitz after decimal for percentages 2

Show 1000's separator Tes

Showe blanks instead of zeros Mo

Font size a

Sample amount;

Amauint [$1.234.5E]
Percent 100.00%
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Color Scheme. You can apply a color scheme to the column heading and group heading of the report. When
you click in the color box next to the selection, the Color screen appears so you can select a standard color or
define a custom color. If you leave the Apply a Color Scheme checkbox unmarked, the report prints in black

and gray.

I Mew Balance Sheet

File Edit WView Favorites

= = e =

Toolz Help

?-

1 Generall 2 Filter$| 2 Enlumnsl 4: Multiple Column Headings  5: Format |

Heading: Color Scheme

Criteria

Distail [ Apply a Colar Scheme Report Name
22;8 Fonter . Calumn heading back colar Subtitle
Report Foater [ Column heading fore color Column Headings

I_ Group heading back color

Miscellananus
E Calor Scheme

Group Headings

. Group heading fore color

Restore Defaults |

Income Statement

The Income Statement provides a summary of your organization’s financial activity over a time period you select.
It is a traditional accounting report providing information about all revenue, expense, gift, transfer, loss, and gain

accounts over a specified period of time.

The Income Statement has tabs on which you set parameters: General, Filters, Columns, Multiple Column
Headings, and Format. To move among the tabs, click Next and Back at the bottom of the screen or select a tab.
On these tabs you specify information to include in the report and how the report should look. For more
information about creating an Income Statement, see “Creating Reports” on page 15.

General Tab

On the General tab, you set parameters specific to the report and make selections about information included in

the report.

I3 Mew Income Statement
File  Edit Tools

== R e |

YWiew Faworites Help

1. General |2: Filtersl 3 Enlumnsl 4 Multiple Calunin Headingsl B Formatl

j@ at level |4_j

Usze chart template Im

¥ Include accounts with no activits

v Include inactive accounts

[~ Create an output query of accounts

Fiepart orientatian: I Landzcape ™ I
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Note: You can change the results of a report by using different chart templates to run the same report. You
can define an unlimited number of templates in Visual Chart Organizer. For more information, see the Visual
Chart Organizer Guide.

Use chart template. In the Use chart template field, select a chart template for the report. Chart templates
are established in Visual Chart Organizer. Then click the Validate chart template button to verify that all
existing accounts are represented in the chart template and that there are no duplicate accounts in the chart
template. Select a level by clicking the up and down arrows to the right of the level field.

Include accounts with no activity. Include accounts with no activity defaults to marked to include all
accounts with no activity.

Include inactive accounts. Include inactive accounts defaults to marked to include inactive accounts.
Create an output query of accounts. Mark this option to create a query of account records and include it in
the report. This query is available for use in other areas of the program.

Note: To view the report as it will appear using your selections and filters, click Preview. To view a sample
layout of the report without data, click Layout.

Report orientation. In the Report orientation field, select Portrait or Landscape.

Filters Tab

On the Filters tab, you can include information based on selected criteria such as accounts, classes, and journals.
For example, you can include only the accounts within a certain range. Accounts not in the range do not appear
on the report. You can filter by projects only if you have the optional module Projects and Grants.

i@ Mew Income Statement
Fil= Edit “iew Favartes Toolz Help

B R0 - |

1. General 2 Filters | 3 Columnsl 4 Multiple Column Headingz | & Folmatl

f@0pen 7 Clear All Filters

Filters I Include Selected Filkers Iﬂ
Funds all <all Funds =
Account Codes &l <Al Account Codes >
Accounts &l <Al Accounts =
Account Attributes all <all Account Attributes =
Zakegories all <l Cakegories =
Projects all <Al Projects=
Project Attributes all <all Project Aktribukes =
Transaction Attributes &l <Al Transackion Attribukes =
Classes Al <Al Classes=
Journals all <all Journals =

Mak ¥et Posted Transactions Selected
Missiongs) Al
apendable/Mon-3pendabl... Al

=MNare =
<Al Mission{s)=
<Al 3pendablefMon-3pendablels) =

[

Open. Click afilter in the grid and click Open on the action bar. The selection screen appears so you can
designate specific filters for the report.

Clear All Filters. Click Clear All Filters to remove all previously selected filters from the report.
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Glossary: A filter is a requirement records must meet to be included in a report. For example, if you apply the
Accounts filter, only the accounts you select are included in the report. You can select filters to apply to a
report from the Filters tab. Be patient! Depending on the filters you select, this report may take several
minutes to run after you click Print or Preview.

Filters. The Filters column lists all the filters for this report. You cannot edit this column.

Include. Choose Selected in the Include column. A selection screen appears so you can designate specific filters
for the report.

Note: Mark Selected, Range, or Query to include a selected filter, range of filters, or a previously created
query of filters. Depending on the selection, different options appear on the screen. If you mark All, you cannot
define filters. For more information about filtering in The Financial Edge, see the Program Basics chapter in the
Program Basics Guide.

Selected Filters. Filters you specify appear in the Selected Filters column. If you choose Selected in the Include
column or click a filter and then click Open, the Selected <Filter> screen appears. If you mark Selected, Range,
or Query, a selection screen appears so you can specify filters.

Query name. The Query name field appears if you select Query. Enter the name of the query to use to filter the
report or click the binoculars to search for a query.

To create a new query, click the binoculars and click Add a New Query on the Open Query screen. For more
information about creating queries, see the Query Guide.

Previous Filter. To view or edit the previous filter without returning to the Filters tab, click Previous Filter on
the toolbar.

Next Filter. To view or edit the next filter without returning to the Filters tab, click Next Filter on the toolbar.

Columns Tab

On the Columns tab, you can open existing columns, delete columns, and view the heading, formula, and dates
defined for columns you have already created.

I New Income Statement ' .‘ x|
File Edit ‘Wiew Favoribes Tools Help
W ada@ o= ?- |

1 Generall 2 Filters - Multiple Caolurit Headings | 5: Faormat

48 Mew Column @3 Open Column Be Repeat Column ™ Delete Calumn

Hide? I Heading I Farmula I Cate Range I
| 1] r Account Murnber
i r Account Description
3 T Actual {Actualt 01/01/2006 ko O1/31...

New Column. When you click New Column, the Column <#> screen appears, showing the General, Date Range,
and Filters tabs from which you can create a new column.

Open Column. To open an existing column and edit its settings, select a row in the grid and click Open Column.

Repeat Column. To repeat a column’s settings, select that column and click Repeat Column. A new row with
the same settings appears in the grid. If you click the drop down arrow on the Repeat Column button, you can
select “All parameters” or “Date parameters only.” If you select “Date parameters only,” you will create a new
column with the same date parameters of the selected column.
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Delete Column. To delete a column’s settings, select that column and click Delete Column. Only columns not
being used to define another column can be deleted.

Hide? Mark the checkbox in the Hide? column for any column you do not want to appear in the report.

Heading. The Heading column displays the column heading defined in the Column heading field of the Columns
General tab.

Formula. The Formula column displays the column information defined in the Column Definition frame of the
Columns General tab.

Date range. The Date Range column displays the dates selected on the Date Range tab.

Note: Selections made on the General, Date Range, and Filters tabs of the Columns tab apply only to report
columns and not to the report itself.

General tab. You can name and define report columns on this tab. Using the alignment buttons, you can specify
how columns are aligned. Column formatting options include: Column width, Report width, Format, and
Decimal places. In the Column Definition frame, you select the column Type, Amount or Description, and
determine the calculations or description for that column. Click Validate to validate the expression created in
the Column Definition frame. Click Clear to clear the expression. If you mark Hide this column on the report
and export the report, the hidden columns will not be exported.

Column 4

*i New Column  Bgy Repeat Column

General I Date Hangel Filtelsl

Coluran heading: Colurnn width: I‘I oo inches

Report width: ~ 5.75 inches
= = = R ol iz Format: IEunenc_l,l 'I

Decimal places: |2 'I

Column Definition -

Type: IAmount =l

iActualk

{Driginal Budget}

{Adiusted Budget}

{Budget Adjustments}

{Calurnn 3} Y |

[~ Hide this column on the report Y alidate Clear jjﬂjﬂﬂ

Date Range tab. On this tab, the selections you make determine the period or date for which balances are
included on the report.

Column 4

@ Mew Column  Be Repeat Column Delet

General  Date Range | Filters|

Drate: |<Specific fizcal periods> j 0BADT/2000 ta 06/30/2000
Start fiscal pear: IThis figeeal year j Start period: IThis fizcal period 'l

End fizcal pear: IThis figeeal year j End period: IThis fizcal period 'l
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Filters tab. On this tab you can select filters that apply only to the selected columns and not the entire report.

Column 4

Filters I Include Selected Filkers ﬂ

Funds Al <Al Funds =

Account Codes Al <Al Account Codes =

Accounts all Al Accounts=

Accaunt Attribukes &l <Al Account Attributes =

Projects Al <Al Projects>

Project Attributes all <Al Project Attributes=

Transaction Attributes all <Al Transaction Attributes =

Classes &l <Al Classes >

Journals &l <Al Journals:

Mok Yet Posted Transactions Al <Al Mot ek Posted Transactions =

Cash Flow Codes Al <Al Cash Flow Codes>

working Capital Codes all <all Working Capital Codes = -

K _'l_I

Multiple Column Headings Tab

On the Multiple Column Headings tab, you can create a heading to cover more than one column.

I3 Hew Income Statement E

Fil=  Edit “iew Fawortez Toolz Help
A= |

1: General | 2 Fillersl 2 Columnz  4: Multiple Column Headings i§: Formatl

Heading I Start Column I End Colurnn Align

Heading. Text entered into the Heading column appears as a heading above one or more of the individual
column headers.

Start. In the Start column, select the first column the multiple column heading will cover.

End. In the End column, select the last column the multiple column heading will cover. The End column must be
greater than or equal to the Start column.

Align. In the Align column, select a left, center, or right alignment.

Format Tab

On the Format tab, you designate the format for the report. You can create headings and footers, sort the records
for the report, select the format for displaying monetary amounts, and print the report in color.
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The list on the left of the screen displays formatting %ptions for the Income Statement: Headings, Criteria, Detail,
i Color Scheme. When you select an item in the list, the right

Sort, Page Footer, Report Footer, Miscellaneous, an
side of the screen displays selections for that section of the report.

Note: The heading defaults to Income Statement in the Title field. You can leave this as the title for the report

or enter your own.

Headings. Use Headings to enter a maximum of 60 characters in each of the Title and Subtitle fields. The title
and subtitle appear at the top of the report. You can select how the heading should be aligned and whether
your organization's name will appear in the header. You can include the page number and date in the heading.

You can also select to include the header on every page of the report.

I New Income Statement

Fil= Edt ¥iew Favorites Tools Help

= = R = gl B

1 Generall & Filtersl & Eolumnsl 4: Multiple Column Headings  5: Format |

B Headings Headings

Criteria )

Ditail — Heading Format

Sart Title: Ilncome Statement
Page Footer Sublitle: I

Feport Footer

Miscelaneous Align: ICenter "I

Color Scherne . _ .
¥ Pirint organization narme in header

W Print Page Numnber in Heading ¥ Print Report Date in Heading
Format;: IF'age 1 j Farmat; IShort Date and Time j
Aligre  [Fiight =] || A Lt =l

[V Print report heading on each page

Criteria. Select Criteria to print a list of criteria used to create the report. Mark Print these criteria on and select
a separate page or the first page. Selections print in the criteria section of the report.

I New Income Statement

File Edit %iew Favortes Tools Help

H &S W= ?-

1 Generall & Filtersl & Eolumnsl 4: Multiple Column Headings  5: Format |

Headings
‘B Ciitena

Include inactive accounts
Uszer acocount secunty access
Uzer project security access
Funds to include

Account Codes to include
Accounts to include

Account attributes to include
Department(z] to include
Projects to include

Project attributes o include
Tranzaction attibutes to inchude

' Detail [w Print these criteria on Ia separate page 'I

Sort Saved report name =
Fage Footer Dutput query name I~
Report Footer Chart template

Mizcellansous Account detail lavel

Color Schemne Ihclude accounts with no activity




FINANCIAL STATEMENTS 13

Detail. Use Detail to indent totals. To indent totals when the statement contains only one amount column, mark
Indent totals when statement only contains one amount column.

Glossary: A net asset is residual value in an entity’s asset remaining after liability is deducted.

If you mark Print change in net assets at the end of the report, you must select a chart template on the
General tab that includes net asset accounts or the total beginning net assets appear as zero.

In the Print net surplus/(deficit) before and after row, select Gifts or Gains/Losses. You can print the net
surplus/deficit only if Gifts or Gains/Losses are defined for the account in Configuration.

You can also select to print the total net surplus/(deficit) or the net assets for encumbrance on a separate line.

Ig New Income Statement

File Edit Wiew Favorites Tools Help

dagag o= ?-

Headings
Criteria
‘B Detai

Sont

Page Footer
Fieport Footer
Mizcellaneous
Color Scheme

1 Generall s FiIters' & Columnsl 4: Multiple Column Headings  5: Format |

Indent totals when skatement only contains one amount column

i

Print change in net assets at the end of the report:

b

Print net surplusi{deficit) before and after Do mok print
Print total net surplusf{deficit )
Print net assets for encumbrance on a separate line

Include encumbered balances in statement body

i i e

Calculate change in net assets For budget columns

Sort. use Sort to print a separate statement for a selected value. In the Show field, you can select from several

options:

Note: You cannot select the same value in the Summarize by field as you selected in the Print a separate

statement field.

¢ Select Show account details for the entire statement to access a grid in which you can sort by a selected
account segment. By default, the report is sorted by the entire account number in ascending order, with

no action.

If you select a sort option in the Sort by column, you can select Subtotal or Mask in the Action column.
Subtotal is a break for which a total is provided. You can select Subtotal for only one Sort by option. You
can apply masking to any account segment except account code.

Note: “Summarize” in the Summarize by field applies to the amounts displayed in the lowest level of detail.
For example, if displaying at level 4 (the account number), selecting to summarize replaces those account
numbers with a selected characteristic, such as class. Rather than three cash accounts under the level 3
heading that total $150, there are unrestricted, temporarily restricted, and permanently restricted amounts

totaling $150.

¢ Select Account details with summary for the entire statement to show each account summarized by
account segment, project, account attribute, project attribute, transaction code, class, or journal.

¢ Select Summary for the entire statement to show summary information only. You can summarize by
account segment, project, account attribute, project attribute, transaction code, class, or journal.

¢ Select Account details for statement body; summary for totals to show account details with summary
totals by account segment, project, account attribute, project attribute, transaction code, class, or journal.
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¢ Select Summary for statement body; account details for totals to show summaries for the selected account
segment, project, account attribute, project attribute, transaction code, class, or journal followed by totals
for all accounts.

I New Income Statement il
Fil= Edit “iew Fawvorites Tools Help
H a3 a2 |
i Generall s Filtersl & Enlumnsl 4: Multiple Column Headings  5: Format |
Headings Sort
Criteria
Dletail [~ Print a separate statement far each IFund j
Page Foater Statement body format:
Repart Foater IShow detail by account for statement j
Miscell ; ;
ISCETANGOUE Change in net assets section format;
Color Scheme
IShow summary of change in net assets j
Sark by COrder by Action |
< Back | et s | Cancel | Print | Freview | Layout |

Page Footer. Use Page Footer to create a footer to appear at the bottom of each page of the report. You can
enter a maximum of 254 characters in the Text field for the page footer. You can also select the alignment
and include the page number and date in the footer.

I Hew Income Statement B
File Edit ‘“iew Favorites Toolz Help

S = el |

1 Genelall 2 Filtersl 3 Eolumnsl 4: Multiple Column Headings  5: Format |

Headings Page Footer

Criteria
Dretail — Page Footer Text
Sart Text:

B Page Footer
Fiepart Footer
Miscellaneaus

Color 5 cheme Align: Im

~ I Print Page Mumber in Faater [~ Print Repaort Date in Footer
Farmat; IF‘age 1 j Format: IShort Date and Time j

Aligre [Fiight =] || aian: [Left =l
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Report Footer. Use Report Footer to create a footer to appear at the bottom of the last page of the report. You

can enter a maximum of 254 characters in the Text field for the report footer and select alignment of the text.

I Mew Income Statement
File Edit Toolz Help

= D= R = e R

View Favorites

1 Generall z Filter$| 2 Enlumnsl 4: Multiple Column Headings 5 Format |

B Report Footer

Miscelaneous
Color Scheme

Align: ||_eﬂ vI

Headings Report Footer
Criteria q Fomtor Text
Detail eport Footer Tex
Sart Text:

Page Foaoter

Tip: Make selections for displaying amounts and view them in the Sample amount display before printing the

report.

Miscellaneous. Use Miscellaneous to specify how numbers appear on the report and the font size for the

report.

I Mew Income Statement
File Edit “iew Faworites

Help
? -

Toolz

== R = ey

1 Generall 2 Filtersl 2 Enlumnsl 4: Multiple Column Headings  5: Format |

Criteria
Detail Show curmency character on All amounts
Sort Show percent sign on All amounts
Page Footer Megative amount format [1234.56]
Flepor Fot Murnber of digits after decimal for amounts 2
E -:I-:-r Sche MWumber of digits after decimal for percentages 2

Show 1000's zeparator Tes

Show blanks inztead of zeros Ha

Fant zize g

Sample amount;

Amount

[$1.234.56)
100.00%

Percent
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Color Scheme. You can apply a color scheme to the column heading and group heading of the report. When
you click in the color box next to the selection, the Color screen appears so you can select a standard color or
define a custom color. If you leave the Apply a Color Scheme checkbox unmarked, the report prints in black
and gray.

I New Income Statement x|
File Edit ‘“iew Favortes Tools Help

S = e |

1 Genelall & Filtersl K3 Eolumnsl 4: Multiple Column Headings  5: Format |

Headings Color Scheme

Criteria
getta” I~ Apply a Color Scheme Report Name
PZ[ge Fooler B Column heading back color Subtitle
Report Footer I_ Colurn heading fore color
MiSCE”hE—'DU$ [~ Group heading back calar Group Headings
- . Group heading fore color
Restore Defaults |

Statement of Activities

The Statement of Activities report provides a view of your organization’s performance for a specific reporting
period. This is a profit-loss statement that you can use to produce an FAS 117 report. The Statement of Activities
reports on your organization’s revenue, gifts, expenses, transfers, and reclassifications. This report displays the
changes in total net assets, unrestricted net assets, temporarily restricted net assets, and permanently restricted
net assets.

The Statement of Activities has tabs on which you set parameters: General, Filters, Columns, Multiple Column
Headings, and Format. To move among the tabs, click Next and Back at the bottom of the screen or select a tab.
On these tabs you specify information to include in the report and how the report should look. For more
information about creating a Statement of Activities, see “Creating Reports” on page 15.

General Tab

On the General tab, you set parameters specific to the report and make selections about information included in
the report.

M@ Hew Statement of Activities | x|
File Edit “iew Favortez Toolz Help

= IR R e |

1. General |2: Filtersl x Enlumnsl 4 Multiple Colunin Headingsl 5 Formatl

Usze chart template Im j@ at level |4_j

v Include accounts with no activite

v Include inactive accounts

[~ Create an output query of accounts

R eport orientation: I Landzcape ™ I




FINANCIAL STATEMENTS 14

Note: You can change the results of a report by using different chart templates to run the same report. You can
define an unlimited number of templates in Visual Chart Organizer. For more information, see the Visual Chart
Organizer Guide.

Use chart template. In the Use chart template field, select a chart template for the report. Chart templates
are established in Visual Chart Organizer. Then click the Validate chart template button to verify that all
existing accounts are represented in the chart template and that there are no duplicate accounts in the chart
template. Select a level by clicking the up and down arrows to the right of the level field.

Include accounts with no activity. Include accounts with no activity defaults to marked to include all
accounts with no activity.

Include inactive accounts. Include inactive accounts defaults to marked to include inactive accounts.
Create an output query of accounts. Mark this option to create a query of account records and include it in
the report. This query is available for use in other areas of the program.

Note: To view the report as it will appear using your selections and filters, click Preview. To view a sample
layout of the report without data, click Layout.

Report orientation. In the Report orientation field, select Portrait or Landscape.

Filters Tab

On the Filters tab, you can include information based on selected criteria such as funds, accounts, and classes. For
example, you can include only the funds within a certain range. Funds not in the range do not appear on the
report. You can filter by projects only if you have the optional module Projects and Grants.

M@ Mew Statement of Activities I
Fil= Edit “iew Favartes Toolz Help
ER e == |
1. General | 3 Columnsl 4 Multiple Column Headingz | 5 Format
#@0pen 7 Clear All Filkers
Filters I Includs Selected Filkers Iﬂ
Funds all <all Funds =
Account Codes &l <Al Account Codes =
Accounts &l <Al Accounts =
Account Attributes all <all Account Attribukes =
Projects all <l Projects=
Project Attributes all <Al Project Aktribukes=
Transaction Attributes all <all Transaction Attributes:
Classes &l <Al Classes =
Journals Al <Al Journals =
Mok Yet Posted Transactions Selected <Mone:
Pelisionis) all <l Mission(s) =
SpendablefMon-Spendabl... Al <Al SpendablefMon-3pendableds) =
Performancels) all <Al Performanceis)= LI

Open. Click afilter in the grid and click Open on the action bar. The selection screen appears so you can
designate specific filters for the report.

Clear All Filters. Click Clear All Filters to remove all previously selected filters from the report.
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Glossary: A filter is a requirement records must meet to be included in a report. For example, if you apply the
Accounts filter, only the accounts you select are included in the report. You can select filters to apply to a
report from the Filters tab. Be patient! Depending on the filters you select, this report may take several
minutes to run after you click Print or Preview.

Filters. The Filters column lists all the filters for this report. You cannot edit this column.

Include. Choose Selected in the Include column. A selection screen appears so you can designate specific filters
for the report.

Note: Mark Selected, Range, or Query to include a selected filter, range of filters, or a previously created
query of filters. Depending on the selection, different options appear on the screen. If you mark All, you cannot
define filters. For more information about filtering in The Financial Edge, see the Program Basics chapter in the
Program Basics Guide.

Selected Filters. Filters you specify appear in the Selected Filters column. If you choose Selected in the Include
column or click a filter and then click Open, the Selected <Filter> screen appears. If you mark Selected,
Range, or Query, a selection screen appears so you can specify filters.

Query name. The Query name field appears if you select Query. Enter the name of the query to use to filter the
report or click the binoculars to search for a query.

To create a new query, click the binoculars and click Add a New Query on the Open Query screen. For more
information about creating queries, see the Query Guide.

Previous Filter. To view or edit the previous filter without returning to the Filters tab, click Previous Filter on
the toolbar.

Next Filter. To view or edit the next filter without returning to the Filters tab, click Next Filter on the toolbar.

Columns Tab

lB New Statement of Activities il

File Edit Wiew Faworites Tools Help

Ba A o

1. General I 2 Filters

' |

4 Multiple Column Headingz | 5 Format

48 New Column @5 Open Column B® Repeat Colurmn

Hide? I Heading I Formula I Date Range I
| B (Il Account Murmber
2| Accaunt Description
| = [T Unrestricted {Actual} 010172006 bo 12031...
| 4 ] [T Temporarily Restricted {Actualt 010172006 ko 12/31...
| = [T Permanently Restricked {Actual} 01/01§2006 ko 12131...
| BES [T Total {Calurn 3} + {Column 4} + {Column 5} 010172006 ko 12131...

New Column. When you click New Column, the Column <#> screen appears, showing the General, Date Range,
and Filters tabs from which you can create a new column.

Open Column. To open an existing column and edit its settings, select a row in the grid and click Open Column.

Repeat Column. To repeat a column’s settings, select that column and click Repeat Column. A new row with
the same settings appears in the grid. If you click the drop down arrow on the Repeat Column button, you
can select “All parameters” or “Date parameters only.” If you select “Date parameters only,” you will create a
new column with the same date parameters of the selected column.
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Delete Column. To delete a column’s settings, select that column and click Delete Column. Only columns not
being used to define another column can be deleted.

Hide? Mark the checkbox in the Hide? column for any column you do not want to appear in the report.

Heading. The Heading column displays the column heading defined in the Column heading field of the Columns
General tab.

Formula. The Formula column displays the column information defined in the Column Definition frame of the
Columns General tab.

Date Range. The Date Range column displays the dates selected on the Date Range tab.

Note: Selections made on the General, Date Range, and Filters tabs of the Columns tab apply only to report
columns and not to the report itself.

General tab. You can name and define report columns on this tab. Using the alignment buttons, you can specify
how columns are aligned. Column formatting options include: Column width, Report width, Format, and
Decimal places. In the Column Definition frame, you select the column Type, Amount or Description, and
determine the calculations or description for that column. Click Validate to validate the expression created in
the Column Definition frame. Click Clear to clear the expression. If you mark Hide this column on the report
and export the report, the hidden columns will not be exported.

Column 7

fi MNew Column Bey Repeat Column Delete Colurmn

General I Date Hangel Filtersl

Column heading: Column width: I‘I 0o inches

Repart width:  8.80 inches

Start D ate End Date et ICunency jv

Decimal places: |2 vl
Column Definition -
Tpe: | Amount =]
{Actuall =

{Encumbrance}
{&ctual + Encumbrance}
{Original Budget}

{Adjusted Budget} Y
{Budget Adjustments} _l
{Calurmn 3}

{Calurmnn 4}

{Coturn 5} =

[~ Hide this column on the report alidate Clear jiﬂﬂﬂﬂ

Date Range tab. On this tab, the selections you make determine the period or date for which balances are
included on the report.

Column 7 E

umn B Repeat Calumn Delete Colurnn

General Date Range I Filtersl

D ate: IThis fiscal pear j 07/01/2001 to DB/30/2002
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Filters tab. On this tab you can select filters that apply only to the selected columns and not the entire report.

Column 4

Generall Date Range  Filters I

f®0pen ) Clear Al Filters
Filters I Include Selected Filkers ﬂ
Funds Al <Al Funds =
Account Codes Al <Al Account Codes =
Accounts all Al Accounts=
Accaunt Attribukes &l <Al Account Attributes =
Projects Al <Al Projects>
Project Attributes all <Al Project Attributes=
Transaction Attributes all <Al Transaction Attributes =
Classes &l <Al Classes >
Journals &l <Al Journals:
Mok Yet Posted Transactions Al <Al Mot ek Posted Transactions =
Cash Flow Codes Al <Al Cash Flow Codes>
working Capital Codes all <all Working Capital Codes = -
K _'l_I

Multiple Column Headings Tab

On the Multiple Column Headings tab, you can create a heading to cover more than one column.

I3 Mew Statement of Activities
Fil= Edit “iew Favartes Toolz Help

HRS R - |

1. General I 2 Filtersl 2 Columne 4 Multiple Colurmn Headingz |§: Folmatl

Heading I Stark Column I End Calumn Align

Heading. Text entered into the Heading column appears as a heading above one or more of the individual
column headers.

Start. In the Start column, select the first column the multiple column heading will cover.

End. In the End column, select the last column the multiple column heading will cover. The End column must be
greater than or equal to the Start column.

Align. In the Align column, select a left, center, or right alignment.

Format Tab

On the Format tab, you designate the format for the report. You can create headings and footers, sort the records
for the report, select the format for displaying monetary amounts, and print the report in color.

The list on the left of the screen displays formatting options for the Statement of Activities: Headings, Criteria,
Detail, Sort PaFe Footer, Report Footer, Miscellaneous, and Color Scheme. When you select an item in the list,
the right side of the screen displays selections for that section of the report.
Note: The heading defaults to Statement of Activities in the Title field. You can leave this as the title for the
report or enter your own.
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Headings. Use Headings to enter a maximum of 60 characters in each of the Title and Subtitle fields. The title
and subtitle appear at the top of the report. You can select how the heading should be aligned and whether
your organization's name will appear in the header. You can include the page number and date in the
heading. You can also select to include the header on every page of the report.

I New Statement of Activities
Fil= Edt ¥iew Favorites Tools Help

= = R = gl B

1 Generall & Filtersl & Eolumnsl 4: Multiple Column Headings  5: Format |

B Headings Headings

Criteria )

Ditail ~ Heading Formnat

Sart Title: ISlatement of Activities
Page Footer Subtite: |

Feport Footer
Miscellaneaus
Color Scheme

Align: I Center hd I

¥ Print arganization narme in header

~ W Print Page Number in Heading
Format;: IF'age 1 j

Align: | Right =

¥ Print Report Date in Heading
Fuarmat: IShort [rate and Time j

Aligr: |Left =l

[¥ Frint report heading on each page

Criteria. Select Criteria to print a list of criteria used to create the report. Mark Print these criteria on and select
a separate page or the first page. Selections print in the criteria section of the report.

I Mew Statement of Activities
File Edt “iew Fawaortes Toolz Help

RS -2

1 Generall 2 Filtersl 2 Enlumnsl 4: Multiple Column Headings  5: Format |

' Detai [ Print these criteria on Ia separate page 'I
Sort Saved report name =]
Page Footer Output query name

Feport Footer
Miscellaneous
Color Scheme

Chart template

Account detail level

Include accounts with no activity

Include inactive accounts

User account securty access

Uszer project securty access

Funds to include

Account Codes to include

Accounts to include o
Account attributes to inchude

Department(z] ta inchude

Projects to include

Project attributes to include

Tranzaction attributes to include hd|

Detail. Use Detail to indent totals. To indent when the statement contains only one column for amounts, mark
Indent totals when statement only contains one amount column.

Glossary: A net asset is residual value in an entity’s asset remaining after liability is deducted.
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To print the change in net assets at the end of the report, mark Print change in net assets at the end of the

report. You also must select a chart template on the General tab that includes net asset accounts or the total
beginning net assets appear as zero.

To print the net surplus or deficit before and after gifts or gains and losses, select Gifts or Gains/Losses in the
Print net surplus/(deficit) before and after. You can select either of these only if you define Gifts and
Gains/Losses for the account in Configuration.

To print the total net surplus or deficit, mark Print total net surplus/(deficit).

lE New Statement of Activities ::': ﬂ

File Edit Wiew Favorites Tools Help

dasag o

1 Genelall & Filters| & Eolumnsl 4: Multiple Column Headings  5: Format |

- |

Criteria

B Detal Indent totals when statement only contains one amount colurmn r

Sort Print change in net assets at the end of the report I

E‘Zi;’:?iﬁ;r Print net surplusi{deficit) before and after Do niot prink

Miscellanenus Print total net surplusi{deficit) W

Color Scheme Print net assets for encumbrance on a separate line |
Calculate change in net assets for budget columns |

Sort. use Sort to print a separate statement for a selected value. If you select to summarize any portion of the

statement in the Show field, select how to summarize in the Summarize by field. You cannot select the same
value you selected in the Print a separate statement field.

If you select to Show account details for the entire statement, a grid appears so you can select various
sorting options.
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If you make no selections in the Sort by column, the program sorts by the entire account number in
ascending order with no action. If you select a sort option in the Sort by column, you can select Subtotal or
Mask in the Action column. Subtotal is a break for which a total is provided. You can select Subtotal for only
one Sort by option. You can apply masking to any account segment except account code.

I3 New Statement of Activities il
Fil= Edit “iew Fawvorites Tools Help
dagam =2 |
i Generall s Filtersl & Enlumnsl 4: Multiple Column Headings  5: Format |
Headings Sort
Criteria
Dletail [~ Print a separate statement far each IFund j
Page Foater Statement body format:
Repart Foater IShow detail by account for statement j
Miscell ; ;
ISCETANGOUE Change in net assets section format;
Color Scheme
IShow summary of change in net assets j
Sark by COrder by Action |
< Back | et s | Cancel | Print | Freview | Layout |

Page Footer. Use Page Footer to create a footer to appear at the bottom of each page of the report. You can
enter a maximum of 254 characters in the Text field for the page footer. You can also select the alignment

and include the page number and date in the footer.

I New Statement of Activities
File Edit Help

= Fe = RES = el B

Wiew Fawortes  Tools

1 Generall 2 Filtersl 2 Enlumnsl 4: Multiple Caolumn Headings  5: Format |

B Page Footer

Report Footer
Miscellanenus
Color Scheme

Aligr: IEentel 'I

Headings Page Footer
Criteria 5 ——
5 Detail — Page Footer Tex
Sart Text:

[ Print Page Number in Footer ————

Format: IF'age 1

[

Align: | Right

=

[~ Print Repaort Date in Footer—————

Format: IStht Drate and Time

[

Aligr: ILeft

=
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Report Footer. Use Report Footer to create a footer to appear at the bottom of the last page of the report. You

can enter a maximum of 254 characters in the Text field for the report footer and select alignment of the
text.

I Mew Statement of Activities
File Edit Wiew Favorites Toolz Help

= BN R0 el e 2

1 Generall 2 Filter$| 3 Enlumnsl 4 Multiple Column Headings 5 Format |

Headings Report Footer
Critena 5 ——
Detail eport Footer Tex
Sort Text:

Page Footer

B Feport Footer

Miscellananus

Color Scheme Aligr: Il_eft 'I

Tip: Make selections for displaying amounts and view them in the Sample amount display before printing the
report.

Miscellaneous. Use Miscellaneous to specify how numbers appear on the report and the font size for the
report.

I New Statement of Activities x|
File Edit “iew Favortes Tools Help

&S w2

1 Genelall & Filtersl K3 Eolumnsl 4: Multiple Column Headings  5: Format |

Headray
Criteria
Dretail Show currency character on All amounts
Sart Show percent sign on All amounts
Page Footer Meqgative amount format [1234.5E)
HportFo Mumber of digits after decimal for amounts 2
E Colar 5 MWumber of digitz after decimal for percentages 2
Show 1000's zeparator Tes
Show blanks instead of zeros Mo
Font size a
Sample amaount;
Amount [$1.234.5E]
Percent 100.00%




FINANCIAL STATEMENTS 15

Color Scheme. You can apply a color scheme to the column heading and group heading of the report. When
you click in the color box next to the selection, the Color screen appears so you can select a standard color or

define a custom color. If you leave the Apply a Color Scheme checkbox unmarked, the report prints in black
and gray.

1@ New Statement of Activities E
File Edit ‘“iew Favortes Tools Help

S e = e e |

1: Generall 2 Filtersl 3 Eolumnsl 4: Multiple Caolumn Headings  5: Format |

Headings Color Scheme
Criteria

Detail I~ Apply a Color Scheme Report Name
IE'Z:_::e Fonter . Colurin heading back color Subtitle
Report Footer [ Column heading fore color
ED [ Group heading back colar Group Headings
E— B Group heading fore color
Restare Defaults |

Statement of Cash Flows

The Statement of Cash Flows reports on the flow of cash and cash equivalents in and out of your organization.
This report provides information about the sources and uses of cash flow during a time period you select. The
Statement of Cash Flows provides information about operating, investing, and financing activities. Each balance
sheet account has a cash flow code that determines the section of the report in which the account appears.

The Statement of Cash Flows has tabs on which you set parameters: General, Filters, Columns, Multiple Column
Headings, and Format. To move among the tabs, click Next and Back at the bottom of the screen or select a tab.
On these tabs you specify information to include in the report and how the report should look. For more
information about creating a Statement of Cash Flows, see “Creating Reports” on page 15.
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General tab

On the General tab, you set parameters specific to the report you have open and make selections about the
information included in the report.

A3 New Statement of Cash Flows I
Fil=e Edit “iew Favortes Toolz Help

S |
|
B Heaing:
Criteria

1: General | 2 Fillersl X Columnsl 4 Multiple Calurn Headings

St —Heading Format
Page Footer Title:  [Statement of Cash Flovs
Report Footer S wbtile: I

Miscellaneous

Color Scheme Aligre IEenter "l

[+ Frint organization name in header

v Print Page Mumber in Heading v Frint Report Date in Heading ——
Farmat: IPage 1 j Farrnat: IShnrt Date and Time j
Aigre [Right =] | | Aane Lt =l

[+ Prirt report heading on each page

Include accounts with no activity. Mark this checkbox to include all accounts with no activity.
Include inactive accounts. Mark this checkbox to include inactive accounts.

Only include accounts from this chart template. Mark this checkbox to select a chart template of
accounts.

Create an output query of accounts. Mark this option to create a query of account records and include it in
the report. This query is available for use in other areas of the program.

Note: To view the report as it will appear using your selections and filters, click Preview. To view a sample
layout of the report without data, click Layout.

Report orientation. In the Report orientation field, select Portrait or Landscape.
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Filters Tab

On the Filters tab, you can include information based on selected criteria such as funds, accounts, and classes. For
example, you can include only the funds within a certain range. Funds not in the range do not appear on the
report. You can filter by projects only if you have the optional module Projects and Grants.

I@ Hew Statement of Cash Flows I
Fil=e Edit “iew Favortes Toolz Help
RS w2 |
1 General 2 Filters | a Culumnsl 4 Multiple Column Headingzs | 5 Format
f®0pen ) Clear Al Filters
Filters I Include Selected Filkers Iﬂ
Funds All <Al Funds =
Account Codes Al <Al Account Codes
Accounts &l <Al Accounts =
Account Attributes All <Al Account Attributes =
Projects Al <8l Projects=
Project Attributes all <Al Project Aktribukes=
Classes all <all Classes =
Cash Flow Codes &l <all Cash Flow Codes =
Mok Yet Posted Transactions Selected <Mone:
working Capital Codes all <Al working Capital Codes =
Mlission(s) all <l Mission(s) =
SpendablefMon-Spendabl... Al <Al SpendablefMon-3pendableds) =
Performancels) all <Al Performanceis)= LI

Open. Click a filter in the grid and click Open on the action bar. The selection screen appears so you can
designate specific filters for the report.

Clear All Filters. Click Clear All Filters to remove all previously selected filters from the report.

Glossary: A filter is a requirement records must meet to be included in a report. For example, if you apply the
Accounts filter, only the accounts you select are included in the report. You can select filters to apply to a
report from the Filters tab. Be patient! Depending on the filters you select, this report may take several
minutes to run after you click Print or Preview.

Filters. The Filters column lists all the filters for this report. You cannot edit this column.

Include. Choose Selected in the Include column. A selection screen appears so you can designate specific filters
for the report.

Note: Mark Selected, Range, or Query to include a selected filter, range of filters, or a previously created
query of filters. Depending on the selection, different options appear on the screen. If you mark All, you cannot
define filters. For more information about filtering in The Financial Edge, see the Program Basics chapter in the
Program Basics Guide.

Selected Filters. Filters you specify appear in the Selected Filters column. If you choose Selected in the Include
column or click a filter and then click Open, the Selected <Filter> screen appears. If you mark Selected,
Range, or Query, a selection screen appears so you can specify filters.

Query name. The Query name field appears if you select Query. Enter the name of the query to use to filter the
report or click the binoculars to search for a query.

To create a new query, click the binoculars and click Add a New Query on the Open Query screen. For more
information about creating queries, see the Query Guide.
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Previous Filter. To view or edit the previous filter without returning to the Filters tab, click Previous Filter on
the toolbar.

Next Filter. To view or edit the next filter without returning to the Filters tab, click Next Filter on the toolbar.

Columns Tab

On the Columns tab of the Statement of Cash Flows, there are always three columns. You cannot change these
column types: Column 1 will always be Account Number, Column 2 will always be Account Description, and
Column 3 will always be Amount. You cannot delete these columns nor add a new column. However, you can
modify some parameters, such as date ranges in Column 3.

A3 New Statement of Cash Flows x|

File Edit View Faworites Tools Help

Basam o

1. General | 2 Filters

- |
-

4 Multiple Column Headingz | & Fulmatl

A (=0 Lol @5 Open Column B2 Fizmzzt Caliin - . Delete Colurt
Hide? I Heading I Formula I Date Range I
1 (il Account Number
2 (il Accounk Description
3| T actual {actualt 01012006 ta 0131,

New Column. The New Column button is disabled for the Statement of Cash Flows.

Open Column. To open an existing column and edit its settings, select a row in the grid and click Open Column.
For this report you can make changes only to the General tab for columns 1 and 2. For Column 3, you can
make certain edits to the General, Filters, and Date Range tabs.

Repeat Column. The Repeat Column button is disabled for the Statement of Cash Flows. If you click the drop
down arrow on the Repeat Column button, you can select “All parameters” or “Date parameters only.” If you
select “Date parameters only,” you will create a new column with the same date parameters of the selected
column.

Delete Column. The Delete Column button is disabled for the Statement of Cash Flows.
Hide? Mark the checkbox in the Hide? column for any column you do not want to appear in the report.

Heading. The Heading column displays the column heading defined in the Column heading field of the Columns
General tab.

Formula. The Formula column displays the column information defined in the Column Definition frame of the
Columns General tab.

Date Range. The Date Range column displays the dates selected on the Date Range tab.

Note: Selections made on the General, Date Range, and Filters tabs of the Columns tab apply only to report
columns and not to the report itself.
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General tab. You can name and define report columns on this tab. Using the alignment buttons, you can specify
how columns are aligned. Column formatting options vary according to column type. In the Column
Definition frame, the column Type, Amount or Description, is pre-selected, although you can select the

description displayed in Column 1 and Column 2. If you mark Hide this column on the report and export the
report, the hidden columns will not be exported.

Column 1

General |

Calurnn heading: Colurrin width: |1 0o ihches

Report width: 467 inches

Format: I Currency - l

5 GtarDate. B End|Diate

Decimal places: |2 'l
Calumn D efinition -
Type: IDescription j
Display: IAccount D ezcription j

[~ Hide this column on the report

Date Range tab. The selections you make on this tab determine the period or date for which balances are
included on the report. The Date Range tab is available only for Column 3.

General  Date Range I Filtersl

[ate: |<Specific fiscal periods> j 04/00/2007 bo 044302001
Start fiscal year: IThis fiscal pear j Start period: IThis fizcal period 'I

End fiscal year: [ This fiscal year > End perio: |Thisfiscalperiod |
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Filters tab. On this tab you can select filters that apply only to the selected columns and not the entire report.
The Filters tab is available only for Column 3.

General | Date Range Filters |

&0 0pen ) Clear 4l Filkers
Filkers | Include Selected Filters ﬂ
Funds all <4l Funds =
Account Codes all <Al Account Codes =
Accounts all <Al Accounts =
Account Attributes all <all Account Atkributes =
Projects all <l Projecks =
Projact Attributes all <Al Praject Attributes =
Classes all <Al Classes=
Cash Flow Codes all <Al Cash Flow Codes=
Mok et Posted Transactions Al «all Mot et Posted Transactions =
‘Working Capital Codes all <Al Working Capital Codes>
Existing Endowmnents(s) All < All Existing Endowments{s)=
Spendablefton-Spendableis)  All «all SpendablefMon-Spendablels) = -
KN _>I_I

Cancel |

Multiple Column Headings Tab

On the Multiple Column Headings tab, you can create a heading to cover more than one column.

IQ New Statement of Cash Flows
File Edit Wiew Favortes Toolz Help

e 0 == |

1 Generall 2 Filters I 2 Coluronz — 4; Multiple Column Headings |§: Fnlmatl

Heading I Skart Column I End Column Align

Heading. Text entered into the Heading column appears as a heading above one or more of the individual
column headers.

Start. In the Start column, select the first column the multiple column heading will cover.

End. In the End column, select the last column the multiple column heading will cover. The End column must be
greater than or equal to the Start column.

Align. In the Align column, select a left, center, or right alignment.

Format Tab

On the Format tab, you designate the format for the report. You can create headings and footers, sort the records
for the report, select the format for displaying monetary amounts, and print the report in color.
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The list on the left of the screen displays formatting options for the Statement of Cash Flows: Headings, Criteria,
Sort, Page Footer, Report Footer, Miscellaneous, and Color Scheme. When you select an item in the list, the right
side of the screen displays selections for that section of the report.

Note: The heading defaults to Statement of Cash Flows in the Title field. You can leave this as the title for the
report or enter your own.

Headings. Use Headings to enter a maximum of 60 characters in each of the Title and Subtitle fields. The title
and subtitle appear at the top of the report. You can select how the heading should be aligned and whether
your organization's name will appear in the header. You can include the page number and date in the
heading. You can also select to include the header on every page of the report.

u Hew Statement of Cash Flows
Fil= Edt ¥iew Favorites Tools Help

H &2 @ ?-

1 General] & Filters] & Eolumns] 4: Multiple Column Headings  5: Format l

eadings #l Headings
=] Criteria )
5 sott Heading Format
] Page Faoter Title:  |Statement of Cash Flows
2] Report Footer Subtitie: |

2] Miscellaneous
2] Colar Scheme Align: | Center hd

W Print organization name in headsar

W Frint Page Mumber in Heading W Print Report Date in Heading
Format;: |F'age 1 ﬂ Farmat; |Short Date and Time ﬂ
Align: [Fight = g Left =l

[w PFrint report heading on each page

Criteria. Select Criteria to print a list of criteria used to create the report. Mark Print these criteria on and select
a separate page or the first page. Selections print in the criteria section of the report.

n Mew Statement of Cash Flows
File Edit Wiew Favortes Toolz Help

H &= ahW ?-

1: General ] 2 Filters ] 2 Columniz ] 4: Multiple Calurn Heading:  5: Format ]

=] Headings Criteria

Criteria

S Sort [ Print these criteria on | a zeparate page hd

=] Page Footer V| Saved report name =
=l ngort Faater | Output querny name

=] Miscellaneous w| Include accounts from this chart template

=] Calor Scheme V| Include accounts with no activie

v| Include inactive accounts

w| zer account securnity access

w| zer project securnty access

v| Funds to include

v Account Codes to include

v Accounts to include

v Account attributes to include i
w| Department{z] to include

w| Projects to include

w| Project attributes to include

v| Clazzes to include

w| Mot yet posted tranzactions to include ﬂ
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Sort. Use Sort to print a separate statement for a selected value. If you leave the Show field blank, only the main
headings appear in the report. You can select to show account detail, cash flow codes, or both. If you show
cash flow codes, the additional cash flow codes you defined in Configuration appear on the report.

If you leave the Sort by field blank in the grid, the program sorts by the entire account number in ascending
order with no action. If you select an account segment, in the Action column, you can select Subtotal or
Mask. Subtotal is a break for which a total is provided. You can select Subtotal for only one Sort by option.

You can apply masking to any account segment except Account Code.

lQ Mew Statement of Cash Flows
File Edit “iew Favorites

= P R gl R

Tool: Help

]|

1: General | 2: Filters I 3 Columnis | 4: Multiple Caolumn Headings  5: Format |

Headings Sort

Criteria

I~ Frint & separate statement for each IFund

- Page Footer
Report Footer

Shiow Iaccount detail j

[~

Miscellaneous

Sart by I Order by I

Actioh I

Color Scheme

Page Footer. Use Page Footer to create a footer to appear at the bottom of each page of the report. You can
enter a maximum of 254 characters in the Text field for the page footer. You can also select the alignment

and include the page number and date in the footer.

lﬂ Mew Statement of Caszh Flows
File Edit

S &0 =22

Wiew Favortes Tool: Help

1 General' 2 Filtersl & Cc-lurnnsl 4 Multiple Column Headings  5: Farmat |

Headings Page Footer
Criteria Page Footer Test
Sort [ Fage raoler | Xl

B Page Footer Text:
Report Foater
Mizcellaneous
Color Scheme

Align: ICenter 'I

[ Print Page Mumber in Foater [~ Print Repart Date in Footer

Farmat: I Page 1 j Format: IShnrt Date and Time

=

Align: IHight j Aligre ILefl

=~
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Report Footer. Use Report Footer to create a footer to appear at the bottom of the last page of the report. You
can enter a maximum of 254 characters in the Text field for the report footer and select alignment of the
text.

lE Mew Statement of Cash Flows I
File  Edt “iew Fawaortes Toolz Help

W3S R = 2

1 Genelall 2 Filtersl 3 Eolumnsl 4: Multiple Column Headings  5: Format |

Headings Report Footer

Likeria Report Footer Test
Sort

Page Footer Text

‘B Report Footer
Miscellaneous
Color Scherne

Aligr: I Center I I

Tip: Make selections for displaying amounts and view them in the Sample amount display before printing the
report.

Miscellaneous. Use Miscellaneous to specify how numbers appear on the report and the font size for the
report.

lg Mew Statement of Cash Flows
File Edt “iew Fawortes Toolz Help

RS G 2

1 Generall 2 Filtersl 2 Enlumnsl 4: Multiple Caolumn Headings  5: Format |
Headings Miscellaneous

Criteria

Sort Show cumency character on Al arnourks
Fage Foater Shaw percent zign on &1 amourts

Report Foater Megative amount format [1234.56]
5 Eolore MWumber of digits after decimal for amounts 2
MWumber of digits after decimal for percentages 2
Show 1000°: separatar Yes
Show blanks inztead of zeros Ha
Fant zize g

Sample amount;

Amait [$1.234.5E)
Percent 100.00%
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Color Scheme. You can apply a color scheme to the column heading and group heading of the report. When
you click in the color box next to the selection, the Color screen appears so you can select a standard color or

define a custom color. If you leave the Apply a Color Scheme checkbox unmarked, the report prints in black
and gray.

Ig Hew Statement of Cash Flows
File Edit %iew Favortes Tools Help

e = el |

1 Generall & Filtersl & Eolumnsl 4: Multiple Column Headings  5: Format |

Headings Color Scheme

Criteria

Sort r me Report Name
:2?25?2;13[ M Column heading back colar Subtitle

[T Group heading back calor Group Headings

. Group heading fore color

Hestore Wefaults |

Statement of Financial Position

The Statement of Financial Position provides the financial position of your organization at a particular moment in
time. This report displays information about total assets, total liabilities, unrestricted net assets, temporarily

restricted net assets, permanently restricted net assets, and total net assets. You can use this report for FAS 117
reporting.

The Statement of Financial Position has tabs on which you set parameters: General, Filters, Columns, Multiple
Column Headings, and Format. To move among the tabs, click Next and Back at the bottom of the screen or
select a tab. On these tabs you specify information to include in the report and how the report should look. For
more information about creating a Statement of Financial Position, see “Creating Reports” on page 15.
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General Tab

On the General tab, you set parameters specific to the report and make selections about information included in
the report.

IQ New Statement of Financial Position

File Edit View Favortes Toolz Help
FlEE = el |

: Filtersl 3 Cnlumnsl 4 Multiple Column Headingsl a8 Fnlmatl

Use chart template |U1 j@ at lewel |4_i|

¥ Include accounts with zen balances

¥ Include inactive accounts

[~ Create an output query of accounts

Report arientation: IF'ortrait 'I

Note: You can change the results of a report by using different chart templates to run the same report. You
can define an unlimited number of templates in Visual Chart Organizer. For more information, see the Visual
Chart Organizer Guide.

Use chart template. In the Use chart template field, select a chart template for the report. Chart templates
are established in Visual Chart Organizer. Then click the Validate chart template button to verify that all
existing accounts are represented in the chart template and that there are no duplicate accounts in the chart
template. Select a level by clicking the up and down arrows to the right of the level field.

Include accounts with zero balances. Include accounts with zero balances defaults to marked to include
all accounts with zero balances.

Include inactive accounts. Include inactive accounts defaults to marked to include inactive accounts.
Create an output query of accounts. Mark this option to create a query of account records and include it in
the report. This query is available for use in other areas of the program.

Note: To view the report as it will appear using your selections and filters, click Preview. To view a sample
layout of the report without data, click Layout.

Report orientation. In the Report orientation field, select Portrait or Landscape.
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Filters Tab

On the Filters tab, you can include information based on selected criteria such as funds, accounts, and transaction
attributes. For example, you can include only the funds within a certain range. Funds not in the range do not
appear on the report. You can filter by projects only if you have the optional module Projects and Grants.

I Hew Statement of Financial Position I
Fil=e Edit “iew Favortes Toolz Help
RS w2 |
1. General a Culumnsl 4 Multiple Column Headingzs | 5 Format
f®0pen ) Clear Al Filters
Filters I Include Selected Filkers Iﬂ
Funds All <Al Funds =
Account Codes Al <Al Account Codes
Accounts &l <Al Accounts =
Account Attributes All <Al Account Attributes =
Projects Al <8l Projects=
Project Attributes all <Al Project Aktribukes=
Transaction Attributes all <Al Transaction Attribukes=
Classes &l <Al Classes =
Journals &l <Al Journals =
Mok Yet Posted Transactions Selected <Mone =
Cash Flow Codes &l =<fll Cash Flow Codes =
working Capital Codes all <Al working Capital Codes>
Tlissiongs) all <Al Mission{s) = LI

Open. Click afilter in the grid and click Open on the action bar. The selection screen appears so you can
designate specific filters for the report.

Clear All Filters. Click Clear All Filters to remove all previously selected filters from the report.

Glossary: A filter is a requirement records must meet to be included in a report. For example, if you apply the
Accounts filter, only the accounts you select are included in the report. You can select filters to apply to a
report from the Filters tab. Be patient! Depending on the filters you select, this report may take several
minutes to run after you click Print or Preview.

Filters. The Filters column lists all the filters for this report. You cannot edit this column.

Include. Choose Selected in the Include column. A selection screen appears so you can designate specific filters
for the report.

Note: Mark Selected, Range, or Query to include a selected filter, range of filters, or a previously created
query of filters. Depending on the selection, different options appear on the screen. If you mark All, you cannot
define filters. For more information about filtering in The Financial Edge, see the Program Basics chapter in the
Program Basics Guide.

Selected Filters. Filters you specify appear in the Selected Filters column. If you choose Selected in the Include
column or click a filter and then click Open, the Selected <Filter> screen appears. If you mark Selected,
Range, or Query, a selection screen appears so you can specify filters.

Query name. The Query name field appears if you select Query. Enter the name of the query to use to filter the
report or click the binoculars to search for a query.

To create a new query, click the binoculars and click Add a New Query on the Open Query screen. For more
information about creating queries, see the Query Guide.
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Previous Filter. To view or edit the previous filter without returning to the Filters tab, click Previous Filter on
the toolbar.

Next Filter. To view or edit the next filter without returning to the Filters tab, click Next Filter on the toolbar.

Columns Tab

On the Columns tab, you can open existing columns, delete columns, and view the heading, formula, and dates
defined for columns you have already created.

g New Statement of Financial Position x|

File Edit Wiew Faworites Tools Help

dEda

1. General I 2 Filters

4| 2 - |

4 Multiple Column Headingz | & Folmatl

48 New Column &% Open Column B® Repeat Colurmn

Hide? I Heading I Formula I Date Range
| B (Il Account Murmber
2| Accaunt Description
| =N [T Unrestricted {Actual} 0113172008
| 4 ] [T Temporarily Restricted {Actualt 013172006
| B [T Permanently Restricked {Actual} 01312006

New Column. When you click New Column, the Column <#> screen appears, showing the General, Date Range,
and Filters tabs from which you can create a new column.

Open Column. To open an existing column and edit its settings, select a row in the grid and click Open Column.

Repeat Column. To repeat a column’s settings, select that column and click Repeat Column. A new row with
the same settings appears in the grid. If you click the drop down arrow on the Repeat Column button, you
can select “All parameters” or “Date parameters only.” If you select “Date parameters only,” you will create a
new column with the same date parameters of the selected column.

Delete Column. To delete a column’s settings, select that column and click Delete Column. Only columns not
being used to define another column can be deleted.

Hide? Mark the checkbox in the Hide? column for any column you do not want to appear in the report.

Heading. The Heading column displays the column heading defined in the Column heading field of the Columns
General tab.

Formula. The Formula column displays the column information defined in the Column Definition frame of the
Columns General tab.

Date Range. The Date Range column displays the dates selected on the Date Range tab.

Note: Selections made on the General, Date Range, and Filters tabs of the Columns tab apply only to report
columns and not to the report itself.
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General tab. You can name and define report columns on this tab. Using the alignment buttons, you can specify
how columns are aligned. Column formatting options include: Column width, Report width, Format, and
Decimal places. In the Column Definition frame, you select the column Type, Amount or Description, and
determine the calculations or description for that column. Click Validate to validate the expression created in
the Column Definition frame. Click Clear to clear the expression. If you mark Hide this column on the report
and export the report, the hidden columns will not be exported.

General I Date Hangel Filtelsl

Coluran heading: Colurnn width: I‘I oo inches

Report width: ~ 5.75 inches
= A of Date Farmat: IEunenc_l,l 'I

Decimal places: |2 - I

Column Definition -

Type: IAmount =l

iActualk

{Driginal Budget}

{Adiusted Budget}

{Budget Adjustments}

{Calurnn 3} Y |

[~ Hide this column on the report Y alidate Clear jjﬂjﬂﬂ

Date Range tab. On this tab, the selections you make determine the period or date for which balances are
included on the report.

Column 5

General  Date Range I Filtersl

Date: I <Specific fiscal period: j 043042001

Fiscal year: IThis fiscal pear j As of period: IThis fiscal perind 'I
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Filters tab. On this tab you can select filters that apply only to the selected columns and not the entire report.

Column 4

Filters I Include Selected Filkers ﬂ

Funds Al <Al Funds =

Account Codes Al <Al Account Codes =

Accounts all Al Accounts=

Accaunt Attribukes &l <Al Account Attributes =

Projects Al <Al Projects>

Project Attributes all <Al Project Attributes=

Transaction Attributes all <Al Transaction Attributes =

Classes &l <Al Classes >

Journals &l <Al Journals:

Mok Yet Posted Transactions Al <Al Mot ek Posted Transactions =

Cash Flow Codes Al <Al Cash Flow Codes>

working Capital Codes all <all Working Capital Codes = -

K _'l_I

Multiple Column Headings Tab

On the Multiple Column Headings tab, you can create a heading to cover more than one column.

IQ Hew Statement of Financial Pozsition I

Fil=  Edit “iew Favortes Toolz Help
SRR |

1: General | 2 Fillersl 3 Calurns 4 Multiple Calurn Headings | & Farmat |

Heading I Stark Calurn I End Calumn Align

Heading. Text entered into the Heading column appears as a heading above one or more of the individual
column headers.

Start. In the Start column, select the first column the multiple column heading will cover.

End. In the End column, select the last column the multiple column heading will cover. The End column must be
greater than or equal to the Start column.

Align. In the Align column, select a left, center, or right alignment.

Format Tab

On the Format tab, you designate the format for the report. You can create headings and footers, sort the records
for the report, select the format for displaying monetary amounts, and print the report in color.
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The list on the left of the screen displays formatting options for the Statement of Financial Position: Headings,
Criteria, Detail, Sort, Page Footer, Report Footer, Miscellaneous, and Color Scheme. When you select an item in
the list, the rlgﬁt side of the screen displays selections for that section of the report.

Note: The heading defaults to Statement of Financial Position in the Title field. You can leave this as the title
for the report or enter your own.

Headings. Use Headings to enter a maximum of 60 characters in each of the Title and Subtitle fields. The title
and subtitle appear at the top of the report. You can select how the heading should be aligned and whether
your organization's name will appear in the header. You can include the page number and date in the
heading. You can also select to include the header on every page of the report.

Fil= Edit “iew Favortes Toolz Help

RS R w2 |

1 Genelall 2 FiIters' 3 Eolumnsl 4: Multiple Column Headings  5: Format |

B Headings H eadings
Criteria

Detail —Heading Farmat
Sort Title:  |Statemert of Financial Positior
Page Foter Subite: |

Fieport Footer

Miscelaneous Aligr: IEenter 'I
Color Scheme

[# Print crganization narne in header

— v Frint Page Mumber in Heading [¥ Print Report Date in Heading
Format: IF'age 1 j Format: IShDrt Date and Time j
Align: IHight j Align: ILeft j

¥ Pirint repart heading on each page

Criteria. Select Criteria to print a list of criteria used to create the report. Mark Print these criteria on and select
a separate page or the first page. Selections print in the criteria section of the report.
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You can select to print criteria on either the first page of the report or on a separate page. All selected options

print in the criteria section of the report.

lE MNew Statement of Financial Position
Fil= Edit Wiew Favortes Toolz Help

= D= R = el

1: General' 2 Filtersl & Eolumnsl 4: Multiple Column Headings  5: Format |

Headings
‘B Criteria
Detail
Sont

Page Footer

Freport Footer
Miscellaneous
Color Scheme

¥ Piint these criteria on Ia separate page 'I

Saved report name

Cutput querny name

Chart template

Account detail level

Include accounts with zero balances
Include inactive accounts

Uszer account secunity access
|lzer project secunity access
Funds ta include

Account Codes to include
Accounts o include

Account attributes to include
Department{s] to include
Projects to include

Praject attibutes ta include
Tranzaction attributes ta include

=

Detail. Use Detail to indent totals. To indent totals when the statement contains only one column for amounts,
mark Indent totals when statement only contains one amount column.

Glossary: A net asset is residual value in an entity’s asset remaining after liability is deducted.

To print the change in net assets at the end of the report, mark Print change in net assets at the end of the
report. You also must select a chart template on the General tab that includes net asset accounts or the total

beginning net assets appear as zero.

I new Statement of Financial Position

File Edit View Favorites Tools Help

da S o= -

=]|

1 Genelall = Filtersl i Eolumnsl 4: Multiple Column Headings  5: Format |

Headings
Criteria

Sort

Page Footer
Fiepart Footer
Miscellaneaus
Color Scherne

Indent totalz when statement only containg one amount column
Print change in net assets

Print net azzets for encumbrance on a separate line

Calculate net surplus/[deficit) based on categom definitions
Calculate budgets for cloging accounts based on;

I i i

All accounts

Sort. Use Sort to print a separate statement for a selected value. If you select to show account details for the
entire statement, a grid appears so you can select various sorting options.

If you make no selections in the Sort by column, the program sorts by the entire account number in
ascending order with no action. If you select an account segment, in the Action column, you can select
Subtotal or Mask. Subtotal is a break for which a total is provided. You can select Subtotal for only one Sort
by option. You can apply masking to any account segment except Account Code.
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If you select an option in the Show field that includes a summary, you must select a value by which to
summarize the report. You cannot select the same value you selected in the Print a separate statement field.

lE Mew Statement of Financial Position il
File Edit View Favorites Tools Help
CIEE T EIEDR A |
1: General | 2: Filters | 2 Columiniz | 4 Multiple Calurin Heading: 5 Format |
Headings Sort
Criteria
Dietail [~ Print a separate statement far sach IFund j
(B Sort
i Statemnent body format:
Page Faoter
Feport Footer IShc-w detail by account for statement j
Mizcell ; i
ISEETAnenLs Change in net azzets section format:
Color Scheme
IShow summary of change in net assets j
Sort by Crder by Ackion |
< Back | HEwt > | Cancel | Brint | Freview | Laypout |

Page Footer. Use Page Footer to create a footer to appear at the bottom of each page of the report. You can
enter a maximum of 254 characters in the Text field for the page footer. You can also select the alignment

and include the page number and date in the footer.

lE MNew Statement of Financial Position [ ]
Fil= Edit “iew Fawortes Tools Help

H RS G w2

1 Genelall 2 Filtersl 3 Eolumnsl 4: Multiple Column Headings  5: Format |

Headings Page Footer

Criteria
Detail — Page Footer Test
Sort Text:

‘B Page Footer
Feport Footer
Miscellaneous

Colar Scheme Aligr; I Center - I

[ Print Page Mumber in Footer [~ Print Repart Date in Footer
Format: IF'age 1 j Format: IStht [rate and Time j

Align | Right 2 (5 [ =
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Report Footer. Use Report Footer to create a footer to appear at the bottom of the last page of the report. You
can enter a maximum of 254 characters in the Text field for the report footer and select alignment of the

text.

Ig Hew Statement of Financial Position

Filz Edit %iew Favorites

= = R = gl B

Tools Help

Headings
Criteria

Detail

Sort

Page Footer
‘B Feport Footer
Miscellanenus
Color Scheme

1: General | s Filtersl 3 Enlumnsl 4: Multiple Column Headings  5: Format |

Report Footer

Report Footer Test
Test:

Aligr: IEenter "I

Tip: Make selections for displaying amounts and view them in the Sample amount display before printing the

report.
Miscellaneous. Use Miscellaneous to specify how numbers appear on the report and the font size for the
report.
lE Mew Statement of Financial Position [ x|

Fil=  Edit “iew Faworites

== R =y

Toolzs Help
? -

Headings
Criteria
Dretail
Sort
Page Footer
Fieport Footer
E i

. Color Scherne

1 Genelall 2 Filtersl 3 Eolumnsl 4: Multiple Column Headings  5: Format |

Miscellaneous

Show currency character on All amounts
Show percent sign an All amounts
MWegative amount farmat [12:34.56]
MNumber of digits after decimal for amounts 2

MWumber of digitz after decimal for percentages 2

Show 1000's zeparator Tes

Show blanks instead of zeros Mo

Font size a

Sample amaount;

Amount [$1.234.5E]

Percent 100.00%
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Color Scheme. You can apply a color scheme to the column heading and group heading of the report. When
you click in the color box next to the selection, the Color screen appears so you can select a standard color or

define a custom color. If you leave the Apply a Color Scheme checkbox unmarked, the report prints in black
and gray.

lE Mew Statement of Financial Pozition [ x|
File Edit “iew Favortez Toolz Help

e IR =l |

1: General | 2 Filters | 2 Colurnng | 4: Multiple Column Headingz  5: Format |

Headings Color Scheme
Criteria

[Dietail ™ Apply a Colar Scheme Report Name
iz;e Fuater . Colurnn heading back. colar Subtitle

Miscellaneous

E Conroo ™ Group heading back color Group Headings
H L.alar 2Ccheme

. Group heading fore colar

F e store [V efaults |

Statement of Functional Expenses

The Statement of Functional Expenses report provides functional expense information over a specified period of
time. For this report, you can select the chart template the report is based on. All expense accounts used by the
selected chart template will appear in the report, but you can determine the level of detail displayed in the report

for each account. You can also use the Columns tab to define comparative columns and the figures that define
those columns.

This report can help you meet FASB Statement Number 117 requirements by providing the additional
information about expenses (but not losses) reported by functional classification, such as major classes of
program services and supporting activities.

The Statement of Functional Expenses has tabs on which you set parameters: General, Filters, Columns, Multiple
Column Headings, and Format. To move among the tabs, click Next and Back at the bottom of the screen or
select a tab. On these tabs you specify information to include in the report and how the report should look. For
more information about creating a Statement of Functional Expenses, see “Creating Reports” on page 15.
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General Tab

On the General tab, you set parameters specific to the report and make selections about information included in
the report.

I@ Hew Statement of Functional Expenses
Fil=e Edit “iew Favortez Toolz Help

FERE = e |
1: General |2: Fillersl X Columnsl 4 Multiple Calunin Headingsl 5 Formatl

I e chart template ||j‘| j@‘ at level |4_:I

W Include accounts with no activig

W Include inactive accounts

[~ Create an output query of accounts

Report onentation; I Landzcape ™ I

Note: You can change the results of a report by using different chart templates to run the same report. You
can define an unlimited number of templates in Visual Chart Organizer. For more information, see the Visual
Chart Organizer Guide.

Use chart template. In the Use chart template field, select a chart template for the report. Chart templates
are established in Visual Chart Organizer. Then click the Validate chart template button to verify that all
existing accounts are represented in the chart template and that there are no duplicate accounts in the chart
template. Select a level by clicking the up and down arrows to the right of the level field.

Include accounts with no activity. Include accounts with no activity defaults to marked to include all
accounts with no activity.

Include inactive accounts. Include inactive accounts defaults to marked to include inactive accounts.
Create an output query of accounts. Mark this option to create a query of the record you select and include
it in the report. This query is available for use in other areas of the program.

Note: To view the report as it will appear using your selections and filters, click Preview. To view a sample
layout of the report without data, click Layout.

Report orientation. In the Report orientation field, select Portrait or Landscape.
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Filters Tab

On the Filters tab, you can include information based on selected criteria such as funds, account codes, and
transaction attributes. For example, you can include only the funds within a certain range. Funds not in the range
do not appear on the report. You can filter by projects only if you have the optional module Projects and Grants.

I New Statement of Functional Expenses
File Edit “iew Favorter Toolz Help

RS RN =2 |

1: General | .

| 3 Eolumnsl 4: Multiple Column Headingz | 5: Format

@ 0pen ) Clear All Filkers
Filkers I Include Selected Filkers Iﬂ
Funds Al <Al Funds
Account Codes Al <Al Account Codes
Accounts Al <Al Accounts =
Account Attributes Al <Al Account Attributes=
Projects all <Al Projects =
Project Atkributes all <Al Project Attributes =
Transaction Atkribukes Al <Al Transaction Attributes=
Cakegoties Selected Expense
Classes Al <Al Classes=
Journals Al <all Journals:=
Mot et Posted Transactions | Selected <Mone =
Mission{s) Al <Al Mission(s)=
apendablefton-spendatbl... Al <Al apendable/Mon-3pendableds) = ;I

Open. Click a filter in the grid and click Open on the action bar. The selection screen appears so you can
designate specific filters for the report.

Clear All Filters. Click Clear All Filters to remove all previously selected filters from the report.

Glossary: A filter is a requirement records must meet to be included in a report. For example, if you apply the
Accounts filter, only the accounts you select are included in the report. You can select filters to apply to a
report from the Filters tab. Be patient! Depending on the filters you select, this report may take several
minutes to run after you click Print or Preview.

Filters. The Filters column lists all the filters for this report. You cannot edit this column.

Include. Choose Selected in the Include column. A selection screen appears so you can designate specific filters
for the report.

Note: Mark Selected, Range, or Query to include a selected filter, range of filters, or a previously created
query of filters. Depending on the selection, different options appear on the screen. If you mark All, you cannot
define filters. For more information about filtering in The Financial Edge, see the Program Basics chapter in the
Program Basics Guide.

Selected Filters. Filters you specify appear in the Selected Filters column. If you choose Selected in the Include
column or click a filter and then click Open, the Selected <Filter> screen appears. If you mark Selected,
Range, or Query, a selection screen appears so you can specify filters.

Query name. The Query name field appears if you select Query. Enter the name of the query to use to filter the
report or click the binoculars to search for a query.

To create a new query, click the binoculars and click Add a New Query on the Open Query screen. For more
information about creating queries, see the Query Guide.
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Previous Filter. To view or edit the previous filter without returning to the Filters tab, click Previous Filter on
the toolbar.

Next Filter. To view or edit the next filter without returning to the Filters tab, click Next Filter on the toolbar.

Columns Tab

On the Columns tab, you can open existing columns, delete columns, and view the heading, formula, and dates
defined for columns you have already created.

A New Statement of Functional Expenses x|

File Edit \iew Faworites Tools Help

e

1. General | 2 Filters

4| 7 - |

4 Multiple Colurin Headings | 5 Format

& New Calumn @50 pen Column Bz epeat Column " Delete Column
Hide? I Heading I Formmula I Date Range I
1 [T &ccount Mumber Account Number
2 [T Account Descripkion Accounk Descripkion
| [T Actual Inctualk 01012006 ko 01/31..,

New Column. When you click New Column, the Column <#> screen appears, showing the General, Date Range,
and Filters tabs from which you can create a new column.

Open Column. To open an existing column and edit its settings, select a row in the grid and click Open Column.

Repeat Column. To repeat a column’s settings, select that column and click Repeat Column. A new row with
the same settings appears in the grid. If you click the drop down arrow on the Repeat Column button, you
can select “All parameters” or “Date parameters only.” If you select “Date parameters only,” you will create a
new column with the same date parameters of the selected column.

Delete Column. To delete a column’s settings, select that column and click Delete Column. Only columns not
being used to define another column can be deleted.

Hide? Mark the checkbox in the Hide? column for any column you do not want to appear in the report.

Heading. The Heading column displays the column heading defined in the Column heading field of the Columns
General tab.

Formula. The Formula column displays the column information defined in the Column Definition frame of the
Columns General tab.

Date Range. The Date Range column displays the dates selected on the Date Range tab.

Note: Selections made on the General, Date Range, and Filters tabs of the Columns tab apply only to report
columns and not to the report itself.
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General tab. You can name and define report columns on this tab. Using the alignment buttons, you can specify
how columns are aligned. Column formatting options include: Column width, Report width, Format, and
Decimal places. In the Column Definition frame, you select the column Type, Amount or Description, and
determine the calculations or description for that column. Click Validate to validate the expression created in
the Column Definition frame. Click Clear to clear the expression. If you mark Hide this column on the report
and export the report, the hidden columns will not be exported.

General I Date Hangel Filtelsl

Coluran heading: Colurnn width: I‘I Ao ihches

Report width: ~ £.00 inches

== Start Date End Date IFarmett IEUHEHG}I jv

Decimal places: I 2 - I
Column Definition -
Type: IAmount =l
ihctualk
{0niginal Budgst}
iAdiusted Budget!

{Budget Adjustrents}

{Calumn 3} s |

[~ Hide this column on the repart Validate Clear jjﬂjﬂj
Cancel |

Date Range tab. On this tab, the selections you make determine the period or date for which balances are
included on the report.

General Date Range I Filtersl

Date: |<Specific fiscal periods: j 07/01/2001 o 0F/31/2000
Start figceal year: |This fiscal pear j Start period: IThis fizcal period 'l

End fiscal pear: [ This fiscal year > End period: |This fiscal period | 7]




FINANCIAL STATEMENTS 17

Filters tab. On this tab you can select filters that apply only to the selected columns and not the entire report.

Cowmns

Generall Date Range Filers I

= Clear
Filters I Include I Selected Filters ﬂ
Funds &l <Al Funds =
Account Codes all <Al Account Codes =
Accounts all <Al Accounts =
Account Attribukes &l <Al Account Atkributes =
Projects Al <Al Projects:=
Project Attributes all <Al Project Attributes=
Transaction Attributes all <Al Transaction Attributes >
Categories all <Al Cateqories >
Classes &l <Al Classes>
Journals &l <Al Journals=
Mok et Posted Transactions Al <Al Mot et Posted Transackions =
Existing Endowments{s) all <Al Existing Endowmentsis) = -
KN _'l_I

Multiple Column Headings Tab

On the Multiple Column Headings tab, you can create a heading to cover more than one column.

lE Mew Statement of Functional Expenses E3
File Edit Wiew Fawonter Toolz Help

FlERE R = |

1 Generall 2 Filters | 3 Colurinz 4 Multiple Colurn Headings |§: Formatl

Heading I Skart Colurmn I End Column Align

Heading. Text entered into the Heading column appears as a heading above one or more of the individual
column headers.

Start. In the Start column, select the first column the multiple column heading will cover.

End. In the End column, select the last column the multiple column heading will cover. The End column must be
greater than or equal to the Start column.

Align. In the Align column, select a left, center, or right alignment.

Format Tab

On the Format tab, you designate the format for the report. You can create headings and footers, sort the records
for the report, select the format for displaying monetary amounts, and print the report in color.
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The list on the left of the screen displays formatting options for the Statement of Functional Expenses: Headings,
Criteria, Sort, Page Footer, Report Footer, Miscellaneous, and Color Scheme. When you select an item in the list,
the right side of the screen displays selections for that section of the report.

Note: The heading defaults to Statement of Functional Expenses in the Title field. You can leave this as the
title for the report or enter your own.

Headings. Use Headings to enter a maximum of 60 characters in each of the Title and Subtitle fields. The title
and subtitle appear at the top of the report. You can select how the heading should be aligned and whether
your organization's name will appear in the header. You can include the page number and date in the
heading. You can also select to include the header on every page of the report.

lQ Mew Statement of Functional Expenses
File Edit “iew Favortes Tools Help

A=l el |
B Heaine
Criteria

1 Generall 2 Filters| & Eolumnsl 4: Multiple Column Headings

St —Heading Format
Page Faater Title: IStatement of Functional Expenses
Report Footer S ubtitle: I

Miscelaneous
Color Scheme Aligr: ICenter 'I

[¥ Print organization narne in header

¥ Print Fage Mumber in Heading ¥ Print Report Date in Heading
Farmat; IF‘age 1 j Farmat; IShort Date and Time j
Aligre [Fiight =] || dian: [Left =l

[¥ Piint report heading on each page

Criteria. Select Criteria to print a list of criteria used to create the report. Mark Print these criteria on and select
a separate page or the first page. Selections print in the criteria section of the report.
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You can select to print criteria on either the first page of the report or on a separate page. All selected options
print in the criteria section of the report.

lE Mew Statement of Functional Expenses [ x|
Fil= Edit “iew Favortes Tools Help

&S G2

1 Genelall 2 Filtersl 3 Eolumnsl 4: Multiple Column Headings  5: Format |

Headings

‘B Criteria

Sart [ Print these criteria on Ia separate page 'I

Page Footer Saved report name -
FReport Fagter Dutput query name —
Miscellanenus Chart template

Color Scheme Account detail level

Include accounts with no activity
Include inactive accounts

User account securty access
Uszer project securnty access
Funds to include

Account Codes to include
Accounts to include

Account atiributes to include
Department(s] ta inchude
Projects to include

Project attributes to include
Tranzaction attibutes to inchude LI

Sort. Use Sort to print a separate statement for a selected value. If you select to show account details for the
entire statement, a grid appears so you can select various sorting options.

If you leave the Sort by field blank, the report is sorted by the entire account number in ascending order with
no action. If you select an account segment, you can select an Action of Subtotal or Mask. Subtotal is a break
for which a total is provided. You can select Subtotal for only one Sort by option. You can apply masking to
any account segment except Account Code.

If you select an option in the Show field that includes a summary, you must select a value by which to
summarize the report. You cannot select the same value you selected in the Print a separate statement field.

lﬂ Hew Statement of Functional Expenses E3
File Edit “iew Favortes Tocl: Help

HGE R - ?-

1: General | 2: Filters I 3 Columns | 4: Multiple Column Headings  5: Format |

Headings Sort

Criteria

: I~ Frint & separate statement for each IFund j
Page Footer

F|e|gnlort Footer Shiow Iaccount detailz for the entire statement j

Miscelaneaus Sart by I Order by I Actioh I

Color Scheme
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Page Footer. Use Page Footer to create a footer to appear at the bottom of each page of the report. You can
enter a maximum of 254 characters in the Text field for the page footer. You can also select the alignment
and include the page number and date in the footer.

lﬂ Mew Statement of Functional Expenses E
Filz Edit Y“iew Favortes Teocl: Help

= D= R Il

1 General' 2 Filtersl & Eolumnsl 4 Multiple Column Headings  5: Farmat |

Headings Page Footer
Criteria Pane Footer Test
Sort [ Fage rooter | exl

{§ Page Footer Text:
Fieport Footer
Miscellaneous
Color Scheme

Align: IEenter 'I

I Print Page Mumber in Foater—— [ Print Repart Date in Footer
Format: I FPage 1 j Format: IShnrt Date and Time j
Aligr: IHight j Align: ILeft j

Report Footer. Use Report Footer to create a footer to appear at the bottom of the last page of the report. You
can enter a maximum of 254 characters in the Text field for the report footer and select alignment of the
text.

lQ Mew Statement of Functional Expenses [ x|
File Edit “iew Favortes Toolz Help

= = R e

1 Genelall 2 Filters| 3 Eolumnsl 4: Multiple Column Headings 5 Format |

Headings Report Footer

Criteria
Sort Report Footer Text
Page Footer Text:
E Fieport Footer

Miscellaneous
Color Scheme

Aligr: ICenter 'I

Tip: Make selections for displaying amounts and view them in the Sample amount display before printing the
report.
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Miscellaneous. Use Miscellaneous to specify how numbers appear on the report and the font size for the
report.

lE Mew Statement of Functional Expenses
File Edit Wiew Favortes Toolz Help

= D= R i e

1: General | 2 Filters | 2 Columniz | 4: Multiple Calurn Heading:  5: Format |

Headings Miscellaneous

Criteria
Sort Show currency character on Al amounts
Page Footer Show percent sign on Al amounts
R eport Footer Megative amaunt farmat [1234.5E)
H L% .. a
P — Mumnber of d!g!ts after dec!mal for amounts 2

Mumber of digits after decimal for percentages 2

Show 1000's zeparator Yesz

Showe blank s instead of zeros Mo

Font zize a

Sample amoLnt:
Arnount [$1.234 5E)
Percent 100,002

Color Scheme. You can apply a color scheme to the column heading and group heading of the report. When
you click in the color box next to the selection, the Color screen appears so you can select a standard color or
define a custom color. If you leave the Apply a Color Scheme checkbox unmarked, the report prints in black
and gray.

lQ Mew Statement of Financial Position
File Edit “iew Favortes Tool: Help

= P R gl R

1: General | 2: Filters I 3 Columnis | 4: Multiple Caolumn Headings  5: Format |

Headings Color Scheme

Criteria
Dretail [ Apply a Colar Scheme Report Name
Sart M Colurn heading back colar Subtitle

Page Footer

isellos [ Group heading back color Group Headings

. Group heading fore colar

Hestore Weraults |

Custom Management Report

The Custom Management Report provides a combined view of balance sheet and income statement accounts. It
gives you flexibility in reporting financial information by combining balances across an entire chart template.
With this report, you can intermingle income statement and balance sheet accounts to get a broad view of your
organization.
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This single report provides you with a complete look at the income statement and balance sheet accounts
included in the selected chart template, as well as a complete view of activity across net assets, expenses,
revenues, and adjustments. The result is a report your organization can use to determine how income affects net
assets, cash, or other balance sheet accounts.

For this report, you select the chart template the report is based on. All accounts in the selected chart template
are available to include in the report and you can determine the level of detail displayed in the report for each
account. You can also use the Columns tab to define comparative columns and the figures that define those
columns.

The Custom Management Report has tabs on which you set parameters: General, Filters, Columns, Multiple
Column Headings, and Format. To move among the tabs, click Next and Back at the bottom of the screen or
select a tab. On these tabs you specify information to include in the report and how the report should look. For
more information about creating a Custom Management Report, see “Creating Reports” on page 15.

General Tab

On the General tab, you set parameters specific to the report and make selections about information included in
the report.

IQ Mew Custom Management Report I
File Edit “iew Favortez Toolz Help

=R R el |

1. General |2: Filtersl 3 Enlumnsl 4 Multiple Colurin Headingsl & Format |

Usze chart template Im j@ at lewel Ial_ﬁ

v Include accounts with zemo balances

v Include inactive accounts

[~ Create an output query of accounts

R eport orientation: I Landzcape = I

Note: You can change the results of a report by using different chart templates to run the same report. You
can define an unlimited number of templates in Visual Chart Organizer. For more information, see the Visual
Chart Organizer Guide.

Use chart template. In the Use chart template field, select a chart template for the report. Chart templates
are established in Visual Chart Organizer. Then click the Validate chart template button to verify that all
existing accounts are represented in the chart template and that there are no duplicate accounts in the chart
template. Select a level by clicking the up and down arrows to the right of the level field.

Include accounts with no activity. Include accounts with no activity defaults to marked to include all
accounts with no activity.

Include inactive accounts. Include inactive accounts defaults to marked to include inactive accounts.
Create an output query of accounts. Mark this option to create a query of the record you select and include
it in the report. This query is available for use in other areas of the program.

Note: To view the report as it will appear using your selections and filters, click Preview. To view a sample
layout of the report without data, click Layout.

Report orientation. In the Report orientation field, select Portrait or Landscape.
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Filters Tab

On the Filters tab, you can include information based on selected criteria such as funds, account codes, and
transaction attributes. For example, you can include only the funds within a certain range. Funds not in the range
do not appear on the report. You can filter by projects only if you have the optional module Projects and Grants.

I@ Hew Custom Management Report I
Fil=e Edit “iew Favortes Toolz Help
== e |
1. General | a Culumnsl 4 Multiple Column Headingzs | 5 Format
f®0pen ) Clear Al Filters
Filters I Include Selected Filkers Iﬂ
Subsidiaries All <fll Subsidiaries =
Funds all <All Funds =
Account Codes Al <All Account Codes >
Zakegories all <Al Categories =
Accounts All <All Accounts >
Account Attributes all <All Account Attributes >
Projects all <Al Projects =
Project Attributes Al <Al Project Attributes =
Transaction Attributes all <All Transaction Attributes >
Classes Al <ill Classes>
Journals All <Al Journals =
Mot et Posted Transactions Mone <Mone =
Cash Flow Codes Al <All Cash Flow Codes= LI
< Back | Hemt » | Cancel | Print | Preview | Layout |

Open. Click afilter in the grid and click Open on the action bar. The selection screen appears so you can
designate specific filters for the report.

Clear All Filters. Click Clear All Filters to remove all previously selected filters from the report.

Glossary: A filter is a requirement records must meet to be included in a report. For example, if you apply the
Accounts filter, only the accounts you select are included in the report. You can select filters to apply to a
report from the Filters tab. Be patient! Depending on the filters you select, this report may take several
minutes to run after you click Print or Preview.

Filters. The Filters column lists all the filters for this report. You cannot edit this column.

Include. Choose Selected in the Include column. A selection screen appears so you can designate specific filters
for the report.

Selected Filters. Filters you specify appear in the Selected Filters column. If you choose Selected in the Include
column or click a filter and then click Open, the Selected <Filter> screen appears. If you mark Selected,
Range, or Query, a selection screen appears so you can specify filters.

Query name. The Query name field appears if you select Query. Enter the name of the query to use to filter the
report or click the binoculars to search for a query.

To create a new query, click the binoculars and click Add a New Query on the Open Query screen. For more
information about creating queries, see the Query Guide.

Previous Filter. To view or edit the previous filter without returning to the Filters tab, click Previous Filter on
the toolbar.
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Note: Mark Selected, Range, or Query to include a selected filter, range of filters, or a previously created
query of filters. Depending on the selection, different options appear on the screen. If you mark All, you cannot
define filters. For more information about filtering in The Financial Edge, see the Program Basics chapter in the
Program Basics Guide.

Next Filter. To view or edit the next filter without returning to the Filters tab, click Next Filter on the toolbar.

Columns Tab

On the Columns tab, you can open existing columns, delete columns, and view the heading, formula, and dates
defined for columns you have already created. The Custom Management Report includes default columns for
Beginning Balance, Revenue, Expenses, Gifts, Transfers, and Ending Balance.

IE New Custom Management Repork 5[

File Edit Wiew Faworites Tools Help

?- |

= s R =

1. General | 2 Filters

4 Multiple Colurin Headings | & Formatl

48 New Column 8% Open Column B® Repeat Column ™ Delete Column
Hide:? I Heading I Farmmula I Diate Range I

| (Il Account Murmber

|2 [T Beginning Balance {actualt 120012005 ko 12031,
| S [T Reverue {ackual} 01/01J2006 to 0131,
st [T Expenses {actual} 01/01/2006 bo 01/31...
5| O aits {actualt 01012006 ko 01/31...
LE [T Transfers {Ackual} 01/01J2006 to 01731...
7| ¥ {actual} 01012006 ta 0131,
| B | [T surplus/{Deficit) and adjus... {Column 7} - {Column 2} 010172006 to 0131,
|2 [T Ending Balance {Colurmin 2} + {Calumn 8} 01012006 ko 0131,

New Column. When you click New Column, the Column <#> screen appears, showing the General, Date Range,
and Filters tabs from which you can create a new column.

Open Column. To open an existing column and edit its settings, select a row in the grid and click Open Column.

Repeat Column. To repeat a column’s settings, select that column and click Repeat Column. A new row with
the same settings appears in the grid. If you click the drop down arrow on the Repeat Column button, you
can select “All parameters” or “Date parameters only.” If you select “Date parameters only,” you will create a
new column with the same date parameters of the selected column.

Delete Column. To delete a column’s settings, select that column and click Delete Column. Only columns not
being used to define another column can be deleted.

Hide? Mark the checkbox in the Hide? column for any column you do not want to appear in the report.

Heading. The Heading column displays the column heading defined in the Column heading field of the Columns
General tab.

Formula. The Formula column displays the column information defined in the Column Definition frame of the
Columns General tab.

Date Range. The Date Range column displays the dates selected on the Date Range tab.

Note: Selections made on the General, Date Range, and Filters tabs of the Columns tab apply only to report
columns and not to the report itself.
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General tab. When you open a column the General tab is displayed. You can name and define report columns
on this tab. Using the alignment buttons, you can specify how columns are aligned. Column formatting
options include: Column width, Report width, Format, and Decimal places. In the Column Definition frame,
you select the column Type, Amount or Description, and determine the calculations or description for that
column. Click Validate to validate the expression created in the Column Definition frame. Click Clear to clear
the expression. If you mark Hide this column on the report and export the report, the hidden columns will

not be exported.

Column 4 I
Column Delete Column
General I D ate Hangel Filtersl
Calumn heading: Columm width: I‘I oo inches
Fieport width:  B.00 inches
= Start Date End Date et ICunency jv
Decimal places: |2 VI
Colurnn L efinition -
Type: IAmount j
{actualt
{0riginal Budget}
1A djusted Budget}
{Budget Adjustrments}
{Calumn 3} BN |
[~ Hide thiz colurnn an the repart Walidate | Clear | + | = | * | ! | ( | ] |
0K I Cancel |

determine the period or date for which balances are included on the report.

Column 3

Diate:

j 02/01/2003 to 02/28/2003

j Start period; ILast fiscal period 'I
j End period: ILastfiscaIperiod 'I

|<Specific fizcal penods:

Start fiscal vear IThis fiszal year

End fizcal pear: I Thiz fizzal pear

Cancel

o

Date Range tab. You access the Date Range tab after opening a column. On this tab, the selections you make
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Filters tab. You access the Filters tab after opening a column. On this tab you can select filters that apply only to
the selected columns and not the entire report.

Column 3

Delete Column

General I [rate Range

@2 0pen  * Clear All Filters
Filters I Include I Selected Filkers Iﬂ
Subsidiaries all <Al Subsidiaries =
Funds all <all Funds >
Account Codes all <all Account Codes =
Categories Selected Met Assets
Accounts Al <Al Accounts >
Account Attributes Al <Al Account Attributess
Projects Al <Al Projects =
Project Attributes all «<all Project Attributes =
Transaction Attributes all <all Transaction Attributes >
Classes all <all Classes =
Journals Al <Al Journals =
Mok et Posted Transactions | Al <Al Mok ‘et Posted Transactions »
Cash Flow Codes &l <Al Cash Flow Codes = LI

Ok I Cancel |

Multiple Column Headings Tab

On the Multiple Column Headings tab, you can create a heading to cover more than one column.

IQ Mew Custom Management Report I
File Edit “iew Favortez Toolz Help

FIEE Rl R |

1. General | 2 Filtersl 2 Columng 4 Multiple Colurn Headings | & Format |

Heading I Stark Colurn I End Calumn Align

|7

Heading. Text entered into the Heading column appears as a heading above one or more of the individual
column headers.

Start. In the Start column, select the first column the multiple column heading will cover.

End. In the End column, select the last column the multiple column heading will cover. The End column must be
greater than or equal to the Start column.

Align. In the Align column, select a left, center, or right alignment.

Format Tab

On the Format tab, you designate the format for the report. You can create headings and footers, sort the records
for the report, select the format for displaying monetary amounts, and print the report in color.



FINANCIAL STATEMENTS 18

The list on the left of the screen displays formatting options for the Custom Management Report: Headings,
Criteria, Sort, Page Footer, Report Footer, Miscellaneous, and Color Scheme. When you select an item in the list,
the right side of the screen displays selections for that section of the report.

Note: The heading defaults to Custom Management Report in the Title field. You can leave this as the title for
the report or enter your own.

Headings. Use Headings to enter a maximum of 60 characters in each of the Title and Subtitle fields. The title
and subtitle appear at the top of the report. You can select how the heading should be aligned and whether
your organization's name will appear in the header. You can include the page number and date in the
heading. You can also select to include the header on every page of the report.

lE Mew Custom Management Report I
File  Edt “iew Fawaortes Toolz Help

FlER = |
1: General | 2 Filtersl 2 Enlumnsl 4: Multiple Column Headings i

B Head

Criteria

Sort — Heading Format
Page Footer Title: |Eustom Management Repart
Fieport Footer Subtite: |

Miscellaneous

Colar Scheme Aligr: I Center ~ I

[¥ Print organization narne in header

W Print Page Number in Heading ¥ Print Report Date in Heading
Format: IF'age 1 j Format: I Short Date and Time j
Align: [Right =] | A JLet =]

¥ Print report heading on each page

< Back | L= | Cancel | Print | Freview | Layout |

Criteria. Select Criteria to print a list of criteria used to create the report. Mark Print these criteria on and select
a separate page or the first page. Selections print in the criteria section of the report.
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You can select to print criteria on either the first page of the report or on a separate page. All selected options
print in the criteria section of the report.

lE Mew Custom Management Report
Fil= Edit “iew Fawortes Tools Help

G E R0 =2 |

1 Genelall 2 Filtersl 3 Eolumnsl 4: Multiple Column Headings  5: Format |

Headings
‘B Criteria
Sort

Page Footer

Feport Footer
Miscellaneaus
Color Scheme

Criteria
¥ Print these criteria on Ia zeparate page 'I

Saved report name
Output query name
Chart ternplate

Account detail level

-

Include accounts with zero balances
Include inactive accounts
User account securty access
Uszer project securnty access
Subsidiaries to include

Funds to include

Account Codes to include
Categories to include
Accounts to include

Account attributes to include
Diepartment(z] to include
Projects to include

=l

Frrint | Plevie@l Layout |

< Back | [Hexts | Cancel |

Sort. Use Sort to print a separate statement for a selected value. If you select to show account details for the
entire statement, a grid appears so you can select various sorting options.

If you leave the Sort by field blank, the report is sorted by the entire account number in ascending order with
no action. If you select an account segment, you can select an Action of Subtotal or Mask. Subtotal is a break
for which a total is provided. You can select Subtotal for only one Sort by option. You can apply masking to
any account segment except Account Code.
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If you select an option in the Show field that includes a summary, you must select a value by which to
summarize the report. You cannot select the same value you selected in the Print a separate statement field.

n Mew Custom Management Report
Fil= Edit “iew Fawortes Tools Help
H (&= W L
1 Genelal] 2 Filters] 3 Eolumns] 4: Multiple Column Headings  5: Format l
=] Headings Sort
] Criteria
W Print & zeparate statement for eact |Fund ﬂ
Page Foot
=] Page Footer Statement body format:
2] Report Footer
2] Mizcellaneous |Sh0w detail by account for statement ﬂ
=] Colar Scheme
Sort by Order by Action |
< Back | Cancel Frrint | Preview | Layout |

Page Footer. Use Page Footer to create a footer to appear at the bottom of each page of the report. You can
enter a maximum of 254 characters in the Text field for the page footer. You can also select the alighment
and include the page number and date in the footer.

u Hew Custom Management Report
File Edit Wiew Favorites Tools Help

H &2 @& ?-

1 Genelal] s Filters] 3 Eolumns] 4: kultiple Column Headings  5: Format l

=] Headings Page Footer
=] Criteria

=] Sart Page Footer Test
B Page Footer Text:
] Report Footer
=] Miscellaneous
=] Colar Scheme
[ Print Page Mumber in Footer [ Prirt Report Date in Footer

< Back | | Cancel Print Preview Layout
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Report Footer. Use Report Footer to create a footer to appear at the bottom of the last page of the report. You
can enter a maximum of 254 characters in the Text field for the report footer and select alignment of the
text.

lE Mew Custom Management Report I
File  Edt “iew Fawaortes Toolz Help

W3S R = 2 |

1 Generall 2 Filtersl 2 Enlumnsl 4: Multiple Column Headings  5: Format |

Headings Report Footer

Literia Fepart Footer Text
Sart

Page Footer Teut:

‘& Heport Footer
Miscellaneous
Colar Scheme

Align: | Leit vI

< Back | L= Cancel Print Freview Layout

Tip: Make selections for displaying amounts and view them in the Sample amount display before printing the
report.
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Miscellaneous. Use Miscellaneous to specify how numbers appear on the report and the font size for the
report.

lE Mew Custom Management Report [ x| I
Fil= Edit “iew Fawortes Tools Help

G E R0 =2

1 Genelall 2 Filtersl 3 Eolumnsl 4: Multiple Column Headings  5: Format |

Headings Miscellaneous

Criteria
Sark Show curmency character on All amaounts
Fage Faoter Show percent sign an All amaounts

Fieport Foater MWegative amount format [1234.56]
E ol Sche MNumber of digits after decimal for amounts 2
MNumber of digitz after decimal for percentages 2
Show 1000's zeparator Yes
Show blankz instead of zeros Mo
Font size a

Sample amaoLint:

Armnount [$1,234.5E]
Percent 100.00%
< Back | [Hexts | Cancel | Frrint | Preview | Layout |

Color Scheme. You can apply a color scheme to the column heading and group heading of the report. When
you click in the color box next to the selection, the Color screen appears so you can select a standard color or
define a custom color. If you leave the Apply a Color Scheme checkbox unmarked, the report prints in black
and gray.

lE Mew Custom Management Report [ x| I
Fil= Edit “iew Fawortes Tools Help

G E R0 =2

1 Genelall 2 Filtersl 3 Eolumnsl 4: Multiple Column Headings  5: Format |

Headings Color Scheme

Criteria
Sart [~ Apply a Calar Scheme Report Name
Page Footer M Column heading back calar Subtitle

Feport Footer

[~ Group heading back calor Group Headings

. Group heading fore color

Eestore [Mefaults |

< Back | [Hexts Cancel Frrint Preview Layout
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Financial Statements and GASB Report
Troubleshooting

If totals or subtotals on reports are different than what you expected, review the report templates and filters.
Report totaling problems often result from changes to the chart template or report filters. To determine the
cause, we recommend you follow these steps:

Run the report using the default VCO template. As a test, run the report using a default template. The
default template creates broad category sections in the chart. These sections include major headings, such as
Assets and Liabilities, and their detail sections. The default template includes all accounts and categories that
may have been omitted from the chart being used. If the report run using the default template is correct, add
any missing accounts to the VCO template originally used.

Mark the option to include inactive accounts. When excluded from your report, inactive accounts with
activity will cause it to total incorrectly. Open the report and mark the checkbox to Include inactive accounts.
If the report totals correctly, create a query of inactive accounts, then change the account(s) from “Inactive”
to “Active”.

Validate the VCO template. The Financial Edge relies on multiple Chart of Account templates. You can run
reports from a selected template, allowing flexibility in report design. However, accounts can inadvertently
be omitted or duplicated within the template design, causing the report to be out of balance or total
incorrectly. To verify that a template will work properly, run a chart template validation. Templates can also
be filtered by Project, Project Attribute, or Transaction Code, meaning that the chart validation may indicate
duplicate or omitted accounts even though the report balances correctly.

Check the filters on the report to ensure you don't filter out important information. With the
advanced filters in The Financial Edge, you can essentially filter your way out of balance. Remove all filters
from the report to determine if the filters are the cause of the problem. Check the box to include accounts
with no activity, if available.

Run the report as Supervisor or as a user without account-level security defined. A user with
account-level security restrictions for specific accounts cannot see those accounts on reports. Therefore,
reports run by that user are out of balance if they include accounts the user cannot access.

Run the report at a level 9. Print or preview the report at a level 9. This will include all accounts and their
detail.

Recreate the report to ensure the parameter file is not corrupt. Open the report that is not totaling
correctly and record the filters and selected options; then create a new report. Define parameters identical to
the parameters of the original report. This will verify whether or not the original report parameters are
corrupt.
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Glossary: GASB stands for the Governmental Accounting Standards Board, a private, nonprofit organization
responsible for establishing and improving state and local governmental accounting and financial reporting
standards.

General Ledger offers the following reporting categories: Account Reports, Allocation Reports, Budget Reports,
Financial Statements, GASB 34 Reports, Journal and Batch Reports, Pivot Reports, and Project Reports. Project
Reports are available if you have the optional module Projects and Grants.

This chapter discusses GASB 34 Reports and is intended only for those involved with governmental accounting
and financial reporting.

GASB Statement No. 34 is entitled Basic Financial Statements-and Managements Discussion and Analysis- for
State and Local Governments. This statement establishes new requirements for the annual financial reports of
state and local governments.

The Governmental Accounting Standards Board (GASB) is a private, nonprofit organization responsible for
establishing and improving state and local governmental accounting and financial reporting standards.

You can create the following GASB 34 Reports in General Ledger.
¢ Statement of Net Assets - Net Assets Format

¢ Statement of Net Assets Combined Balance Sheet

¢ Statement of Net Assets - Schedule B

¢ Statement of Activities - Standard Format

e Statement of Activities - Schedule B

¢ Statement of Revenues, Exchanges, Changes

Statement of Net Assets - Net Assets Format

The Statement of Net Assets - Net Assets Format presents the financial position of your organization at a

distinct point in time. This report is much like a Balance Sheet statement, but it is pre-formatted with

columns according to the GASB requirements. You must use the appropriate chart template and column filters to
ensure this report meets GASB requirements. For more information about chart templates, see “Creating a Chart
Template” on page 236.

Warning: You must use the correct chart template and column filters to ensure the Statement of Net Assets
report meets GASB requirements.You can use advanced filters only if you set the business rule in
Configuration.

The Statement of Net Assets - Net Assets Format has five tabs on which you set parameters: General, Filters,
Columns, Multiple Column Headings, and Format. To move among the tabs, click Next and Back at the bottom of
the screen or select the tab itself. On these tabs you specify information to include in the report and how the
report should look.
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General Tab

On the General tab, you set parameters specific to the report and make selections about information included in
the report.

n Mew Statement of Met Azzets - Het Aszets Format
File Edit “iew Favortez Toolz Help

H &S 5w Y=

1. General ]g: Filters] 3 Enlumns] 4 Multiple Colurin Headings] & Format ]

Use chist et RN - | 1 - ==l [~ =

v Include accounts with zero balances

v Include inactive accounts

[~ Create an output query of accounts

Fepart orientatian: | Portrait -

ou muszt define column filkers in order for thiz report to display walid information.

Glossary: A chart template is a visual representation in General Ledger 7.2 of all or selected accounts from the
general ledger. In General Ledger 7.2, you can create multiple chart templates, each with a different
presentation of accounts. Chart templates drive the presentation of accounts on financial statements.

Use chart template. In the Use chart template field, select a chart template for the report. You establish chart
templates in Visual Chart Organizer. Then click the Validate chart template button to verify that all existing
accounts are represented in the chart template and that there are no duplicate accounts in the chart template.
Select a level by clicking the up and down arrows to the right of the at level field. For more information about
chart templates, see “Creating a Chart Template” on page 236.

Include accounts with zero balances. Mark this option to include accounts with zero balances in the report.
The Include accounts with zero balances checkbox is marked as a default.

Include inactive accounts. Mark this option to include inactive accounts in the report. The Include inactive
accounts checkbox is marked as a default.

Create an output query of accounts. Mark this option to create a query of account records. This query is
available for use in other areas of the program.
Note: To view the report as it will print using the selections and filters, click Preview. To view a sample layout
of the report without data, click Layout.

Report orientation. In the Report orientation field, select Portrait or Landscape.
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Filters Tab

On the Filters tab, you can include information based on selected criteria such as Funds, Accounts, and Classes.
For example, to include only funds within a certain range. Funds not in the range do not appear on the report.
You can filter by projects only with the optional module Projects and Grants.

I@ Hew Statement of Net Assets - Net Assets Format
File Edit “iew Favortez Toolz Help
RS- ?-

1 General 2 Filters | a Culumnsl 4 Multiple Column Headingz | 5 Format

f®0pen ) Clear AllF

Filters I Include Selected Filkers Iﬂ

Funds all <l Funds =

Account Codes All <Al Account Codesz

Accounts all <Al Accounts>

Account Attributes Al <Al Account Attributesz

Projects Al <8l Projects=

Project Attributes all <Al Project Attribukes =

Transaction Attributes Al <Al Transaction Attributes=

Classes All il Classes =

Journals all <Al Journals =

Mot et Posted Transactions Selected <MNone

Zash Flow Codes all <l Cash Flow Codes

Working Capital Codes Al <Al W'orking Capital Codes >

Tlissiongs) all <Al Mission{s)= LI

Open. Click afilter in the grid and click Open on the action bar. The Selected <Filter> screen appears so you can
select a specific filter or a range.

Clear All Filters. To remove all previously selected filters from the report, click Clear All Filters.

Glossary: A filter is criteria records must meet to be included in a report. For example, if you apply the
Accounts filter, only the accounts you select are included in the report.

Filters. The Filters column lists all filters for this report. You cannot edit this column.

Include. Choose Selected in the Include column next to the filter you want. The Selected <Filter> screen appears
so you can designate specific filters for the report.

Selected Filters. Filters you specify appear in the Selected Filters column. If you choose Selected in the Include
column or click a filter and then click Open on the action bar, the Selected <Filter> screen appears.

Note: Mark Selected, Range, or Query to include a selected filter, range of filters, or a previously created query
of filters. Depending on the selection, different options appear on the screen.
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If you mark Selected or Range, a grid appears so you can specify individual filters.

Selected Accounts

Inchude: QO All Selecter ® Range ® Query Previous Filter  Mest Filter

Account | Description |

If you mark Query, the Query name field appears so you can select a query to use as a filter.

Selected Accounts [ x|

Include: @ Al Selecter ® Range O Query Previous Filter  Mest Filter

Guerny name: | QI

Query name. The Query name field appears if you select Query. Enter the name of the query to use to filter the
report or click the binoculars to search for a query.

Glossary: A parameter is any field, option, or filter that narrows information in a report and determines the
appearance of the report’s output. By specifying parameters, you customize output results of the report.

To create a new query, click the binoculars and click Add a New Query on the Open Query screen. For more
information about queries, see the Query Guide.

Previous Filter. To view or edit the previous filter without returning to the Filters tab, click Previous Filter on
the toolbar.

Next Filter. To view or edit the next filter without returning to the Filters tab, click Next Filter on the toolbar.

Columns Tab

On the Columns tab, you can create new columns that appear on the report, open existing columns, delete
columns, and view the heading, formula, and dates defined for columns you have already created.

The column headings are predefined, but you must set the appropriate filters to ensure the report is accurate.
Warning: Most organizations separate governmental activities, business-type activities, and component units

by fund. We recommend you filter the business activities and component units columns by the appropriate
funds also.
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To set the appropriate filters, open the Governmental Activities column, filter by fund and only include the funds
allocated for governmental activity. Most organizations separate governmental activities, business-type
activities, and component units by fund. We recommend you filter the business activities and component units
columns by the appropriate funds also.

la Mew Statement of Net Assets - Net Assets Format x|

File Edit Wiew Favoribes Tools Help

daga@ o

1 Generall 2 Filters

i |

4 Multiple Colurin Headings | 5: Format

& Mew Column @30 pen Co Eg Fepeat Column * Delete Calumn
Hide? I Heading I Farmula I Date Range
[ EELE I Account Description
| 2 | [T Governmental Activities {actualt 01/158/2006
3 [T Business-Type Ackivities {Actualt 01/158/2006
| 4 ] T Total {Column 2} + {Column 3} 01/158/2006
| 5 | [T cComponent Units {actualt 01/158/2006

New Column. When you click New Column, the Column <#> screen appears, showing three tabs you can use to
create a new column. These tabs are the General tab, Date Range tab, and Filters tab.

Open Column. To open an existing column and edit its settings, select a row in the grid and click Open Column.

Repeat Column. To repeat a column’s settings, highlight that column and click Repeat Column. A new row with
the same settings appears in the grid. If you click the drop down arrow on the Repeat Column button, you can
select “All parameters” or “Date parameters only.” If you select “Date parameters only,” you will create a new
column with the same date parameters of the selected column.

Delete Column. To delete a column’s settings, highlight that column and click Delete Column. You can delete
only unused columns.

Hide? Mark the checkbox in the Hide? column for any column you do not want to appear in the report.

Heading. The Heading column displays the column heading defined in the Column heading field of the Columns
General tab.

Formula. The Formula column displays the column information defined in the Column Definition frame of the
Columns General tab.

Date range. The Date Range column displays the dates selected on the Date Range tab.

Note: Selections made on the General, Date Range, and Filters tabs of the Columns tab apply only to report
columns and not to the report itself.



GASB 34 REPORTS 19

General tab. You can name and define report columns on this tab. Use the alignment buttons to specify how
columns are aligned. Column formatting options include: Column width, Report width, Format, and Decimal
places. In the Column Definition frame, you select the column type, amount or description and determine
the calculations or description for that column. Click Validate to validate the expression created in the
Column Definition frame. Click Clear to clear the expression. If you mark Hide this column on the report and
export the report, hidden columns will not be exported.

General I Date Hangel Filtelsl

Coluran heading: Colurnn width: I‘I oo inches

Report width: ~ 5.75 inches
= A of Date Farmat: IEunenc_l,l 'I

Decimal places: |2 - I

Column Definition -

Type: IAmount =l

iActualk

{Driginal Budget}

{Adiusted Budget}

{Budget Adjustments}

{Calurnn 3} Y |

[~ Hide this column on the report Y alidate Clear jjﬂjﬂﬂ

Date Range tab. On this tab, the selections you make determine the period or date for which balances are
included on the report.

Column 5

General  Date Range I Filtersl

Date: I <Specific fiscal period: j 043042001

Fiscal year: IThis fiscal pear j As of period: IThis fiscal perind 'I
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Filters tab. On this tab you can select filters that apply only to the selected columns and not the entire report.

Column 4

Filters I Include Selected Filkers ﬂ
Funds Al <Al Funds =
Account Codes Al <Al Account Codes =
Accounts all Al Accounts=
Accaunt Attribukes &l <Al Account Attributes =
Projects Al <Al Projects>
Project Attributes all <Al Project Attributes=
Transaction Attributes all <Al Transaction Attributes =
Classes &l <Al Classes >
Journals &l <Al Journals:
Mok Yet Posted Transactions Al <Al Mot ek Posted Transactions =
Cash Flow Codes Al <Al Cash Flow Codes>
working Capital Codes all <all Working Capital Codes = -
K _'l_I

Multiple Column Headings Tab

On the Multiple Column Headings tab, you can create a heading to cover more than one column.

lﬂ Hew Statement of Het Aszets - Net Assets Format
Fil= Edit “iew Favartes Toolz Help

HRS R - |

1. General I 2 Filtersl 2 Columne 4 Multiple Colurmn Headingz |§: Folmatl

Heading I Stark Column I End Calumn Align

Primary Government Column 2 Column 4 Cenker

Heading. Text entered into the Heading column appears as a heading above one or more of the individual
column headings.

Start Column. In the Start Column, select the first column the multiple column heading will cover.

End Column. In the End Column, select the last column the multiple column heading will cover. The End
Column must be greater than or equal to the Start column.

Align. In the Align column, select a left, center, or right alignment.
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Format Tab

On the Format tab, you decide how the report should look. You can create headings and footers, include a list of
criteria used to create the report, sort the information in the report, and select the format for displaying
monetary amounts. A description of each formatting option is provided.

IQ MNew Statement of Net Aszets - Net Assets Format I
Fil=e Edit “iew Favortes Toolz Help

RS w2 |

1. General | 2 Filtersl a Culumnsl 4 Multiple Column Headings

B Headings Headings

Criteria
Dietail —Heading Format
Sor Title:  [Statement of Net Assets - Met Assets Format
Page Foater Subtie: |

Repart Footer

Miscellaneous Aligr: IEenter 'l

Calor Scheme ) L .
[+ Frint organization name in header

v Print Page Mumber in Heading ¥ PFiint Report Date in Heading
Farmat: IF'age 1 j Farmat: ISholt Date and Time j
Hligr [Right =] || Al Left =

¥ Frint report heading on each page

The list on the left of the screen displays formatting options for the Balance Sheet: Headings, Criteria, Detail,
Sort, Page Footer, Report Footer, Miscellaneous, and Color Scheme. When you select an item in the list, the right
side of the screen changes to present selections for that section of the report.

Note: The heading defaults to Statement of Net Assets - Net Assets Format in the Title field. You can leave this
as the title for the report or enter your own.

Headings. Use Headings to enter a maximum of 60 characters in each of the Title and Subtitle fields. The title
and subtitle appear at the top of the report. You can select how the heading should be alighed and whether
your organization's name will appear in the header. You can include the page number and date in the heading.
You can also select to include the heading on every page of the report.

Criteria. Select Criteria to print a list of criteria used to create the report. Mark Print these criteria on and select
a separate page or the first page. Selections print in the criteria section of the report.

Detail. Use Detail to indent totals. To indent totals when the statement contains only one amount column, mark
Indent totals when statement only contains one amount column.

If you mark Print change in net assets, you must select a chart template that includes income statement
accounts on the General tab, or the net surplus/deficit cannot be calculated and appears as zero.

Sort. Use Sort to print a separate statement for a selected value. If you select to summarize any portion of the
statement in the Show field, select how to summarize in the Summarize by field. You cannot select the same
value you selected in the Print a separate statement field.

If you select to Show account details for the entire statement, a grid appears so you can select various
sorting options.

Glossary: Account masking is the process of inserting asterisks to quickly select a range of accounts without
having to enter specific numbers.
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If you make no selections in the Sort by column, the program sorts by the entire account number in
ascending order with no action. If you select a sort option in the Sort by column, you can select Subtotal or
Mask in the Action column. Subtotal is a break for which a total is provided. You can select Subtotal for only
one Sort by option. You can apply masking to any account segment.

Page Footer. Use Page Footer to create a footer to appear at the bottom of each page of the report. You can
enter a maximum of 254 characters in the Text field for the page footer. You can also select the alignment
and include the page number and date in the footer.

Report Footer. Use Report Footer to create a footer to appear at the bottom of the last page of the report. You
can enter a maximum of 254 characters in the Text field for the report footer and select alignment of the text.

Miscellaneous. Use Miscellaneous to specify how numbers appear on the report and the font size for the
report.

Color Scheme. You can apply a color scheme to the column heading and group heading of the report. When
you click in the color box next to the selection, the Color screen appears so you can select a standard color or
define a custom color.

Statement of Net Assets Combined Balance
Sheet

The Statement of Net Assets Combined Balance Sheet provides a summary of your organization’s

financial activity at a distinct point in time. This report is much like a balance sheet statement, but it is
pre-formatted with columns according to the GASB requirements. You must use a chart template with

net assets summarized by funds to ensure this report meets GASB requirements. For more information about
chart templates, see “Creating a Chart Template” on page 236.

Note: You should run the Statement of Net Assets - Schedule B report with the Statement of Net Assets
Combined Balance Sheet.

The Statement of Net Assets Combined Balance Sheet has five tabs on which you set parameters: General, Filters,
Columns, Multiple Column Headings, and Format. To move among the tabs, click Next and Back at the bottom of
the screen or select the tab itself. On these tabs you specify information to include in the report and how the
report should look.
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General Tab

On the General tab, you set parameters specific to the report and make selections about the information
included in the report. You must select a chart template for the Statement of Net Assets Combined Balance Sheet
that summarizes net assets by fund. The rows in this report depend entirely on how you set up the chart
template.

u Mew Statement of Met Aszetz Combined Balance Sheet
File  Edit iew Faworter Tool: Help

H 4SS LW ?-

1: General ]g: Filters ] 2 Eolumns] 4: Multiple Columi Headings ] & Format]

Use chat tenriac [EETARGGGGG—GG—G—G—G—G—GGG——— -| - - [~ =]

W Include accounts with zera balances

v Include inactive accounts

[~ Create an output quen of accounts

Report orientation: | Partrait -

ou must define colunns filkers in order Far this repart to displag valid infarmation.

Warning: You must select a chart template for the Statement of Net Assets Combined Balance Sheet that
summarizes net assets by fund. Chart templates are established in Visual Chart Organizer. For more
information about chart templates, see the Visual Chart Organizer Guide.

Use chart template. In the Use chart template field, select a chart template for the report. Then click the
Validate chart template button to verify that all existing accounts are represented in the chart template and
that there are no duplicate accounts in the chart template. Select a level by clicking the up and down arrows
to the right of the at level field. For more information about chart templates, see “Creating a Chart Template”

on page 236.

Include accounts with zero balances. Mark this option to include accounts with zero balances in the
report. The Include accounts with zero balances checkbox is marked as a default.

Include inactive accounts. Mark this option to include inactive accounts in the report. The Include inactive
accounts checkbox is marked as a default.

Create an output query of accounts. Mark this option to create a query of account records. This query is
available for use in other areas of the program.

Note: To view the report as it will appear using your selections and filters, click Preview. To view a sample
layout of the report without data, click Layout.

Report orientation. In the Report orientation field, select Portrait or Landscape.
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Filters Tab

On the Filters tab, you can include information based on selected criteria such as Funds, Accounts, and Classes.
For example, to include only funds within a certain range. Funds not in the range do not appear on the report.
You can filter by projects only with the optional module Projects and Grants.

I@ Hew Statement of Het Assets Combined Balance Sheet I
Fil=e Edit “iew Favortes Toolz Help
RS w2 |
1. General a Culumnsl 4 Multiple Column Headingzs | 5 Format
f®0pen ) Clear Al Filters
Filters I Include Selected Filkers Iﬂ
Funds All <Al Funds =
Account Codes Al <Al Account Codes
Accounts &l <Al Accounts =
Account Attributes All <Al Account Attributes =
Projects Al <8l Projects=
Project Attributes all <Al Project Aktribukes=
Transaction Attributes all <all Transaction Attribukes=
Classes &l <Al Classes =
Journals &l <Al Journals =
Mok Yet Posted Transactions Selected <Mone:
Cash Flow Codes &l =<fll Cash Flow Codes =
Working Capital Codes Al <Al Working Capital Codes>
Tlissiongs) all <Al Mission{s) = LI

Open. Click a filter in the grid and click Open on the action bar. The Selected <Filter> screen appears so you can
select a specific filter or a range.

Clear All Filters. To remove all previously selected filters from the report, click Clear All Filters.

Glossary: A filter is criteria records must meet to be included in a report. For example, if you apply the
Accounts filter, only the accounts you select are included in the report.

Filters. The Filters column lists all filters for this report. You cannot edit this column.

Include. Choose Selected in the Include column next to the filter you want. The Selected <Filter> screen appears
so you can designate specific filters for the report.

Selected Filters. Filters you specify appear in the Selected Filters column. If you choose Selected in the Include
column or click a filter and then click Open on the action bar, the Selected <Filter> screen appears.

Note: Mark Selected, Range, or Query to include a selected filter, range of filters, or a previously created
query of filters. Depending on the selection, different options appear on the screen.
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If you mark Selected or Range, a grid appears so you can specify individual filters.

Selected Accounts

Inchude: QO All Selecter ® Range ® Query Previous Filter  Mest Filter

Account | Description |

If you mark Query, the Query name field appears so you can select a query to use as a filter.

Selected Accounts

Include: @k Al @ Selected @ Bange  ©F Query | Elrzious Filizr  Mewxt Filter

Guery name: ﬁl

Query name. The Query name field appears if you select Query. Enter the name of the query to use to filter the
report or click the binoculars to search for a query.

To create a new query, click the binoculars and click Add a New Query on the Open Query screen. For more
information about queries, see the Query Guide.

Previous Filter. To view or edit the previous filter without returning to the Filters tab, click Previous Filter on
the toolbar.

Next Filter. To view or edit the next filter without returning to the Filters tab, click Next Filter on the toolbar.

Columns Tab

On the Columns tab, you can create new columns that appear on the report, open existing columns, delete
columns, and view the heading, formula, and dates defined for columns you have already created.

Warning: The column headings are predefined, but you must set the appropriate filters to ensure the report is
accurate.

The column headings are predefined, but you must set the appropriate filters to ensure the report is accurate.



203 CHAPTER

To set the appropriate filters, open the General Fund and Other Funds columns, and filter by fund. Make sure you
account for all funds in your organization. Most organizations use the adjustments column to list the audit
adjustments defined in the organization. The filter you apply to this column depends on how you tag adjustments
(i.e., Journals, Attributes). Make sure you filter this data out of the General Fund and Other Funds columns so
that adjustments are not counted twice.

& New Statement of Net Assets Combined Balance Sheet |

File Edit Wiew Faworites Tools Help
HG S al=?- |

1. General I 2 Filters

4 Multiple Column Headingz | 5 Format

#& New Column @3 Open Column B® Repeat Column ™ Delete Column
Hide? I Heading I Formula I Date Range

L [ Account Descripkion

| 2| T General Fund {Achual} 01312008

| 3 [T Other Funds {actusl 01/31/2008

| 4 ] [T Total -{CDIuE“l)n 24 + {Column 3} 013172006

| = [T adjustments {hckualt 0113172008

L& [T sStatement of et Assets {Calumn 4} + {Calumn 5} 0153172008

New Column. When you click New Column, the Column <#> screen appears, showing three tabs you can use to
create a new column. These tabs are the General tab, Date Range tab, and Filters tab.

Open Column. To open an existing column and edit its settings, select a row in the grid and click Open Column.

Repeat Column. To repeat a column’s settings, highlight that column and click Repeat Column. A new row with
the same settings appears in the grid. If you click the drop down arrow on the Repeat Column button, you can
select “All parameters” or “Date parameters only.” If you select “Date parameters only,” you will create a new
column with the same date parameters of the selected column.

Delete Column. To delete a column’s settings, highlight that column and click Delete Column. You can delete
only unused columns.

Hide? Mark the checkbox in the Hide? column for any column you do not want to appear in the report.

Heading. The Heading column displays the column heading defined in the Column heading field of the Columns
General tab.

Formula. The Formula column displays the column information defined in the Column Definition frame of the
Columns General tab.

Date range. The Date Range column displays the dates selected on the Date Range tab.

Note: Selections made on the General, Date Range, and Filters tabs of the Columns tab apply only to report
columns and not to the report itself.
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General tab. You can name and define report columns on this tab. Use the alignment buttons to specify how
columns are aligned. Column formatting options include: Column width, Report width, Format, and Decimal
places. In the Column Definition frame, you select the column type, amount or description and determine
the calculations or description for that column. Click Validate to validate the expression created in the

Column Definition frame. Click Clear to clear the expression. If you mark Hide this column on the report and
export the report, hidden columns will not be exported.

Column 7

General | Date Hangel Filtersl

Colurnn heading: Colurnn width: IT inches
Report width: .00 inches
= E = Az of Date Format: lm
Decimal places: m
Calurnn D efinition
Type: |Amount |
{Actual} =

{Encumbrance}

{&ctual + Encumbrance}

{0riginal Budget}

{Aduzted Budget} BN |
{Budget Adjustments}

{Column 2}

{Column 3}
{Column i} =

[ Loy A,

[~ Hide this column on the report \"'alidatel Clear | + | = | * | ! |JJ

Date Range tab. On this tab, the selections you make determine the period or date for which balances are
included on the report.

General  Date Range I Filtersl

Date: [ <Specilc fiscal periad> | 04/30/2002

Fiscal year: IThis fiscal pear j Az of period: IThis fizcal period 'I
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Filters tab. On this tab you can select filters that apply only to the selected columns and not the entire report.

General | Date Range  Filters I

&20pen ) Clear &l Filters
Filters I Include Selected Filters I;
Funds &l <Al Funds = —
Account Codes Al <Al Account Codes =
Accounts Al <Al Accounts =
Account Attribukes al <Al Account Attribubes =
Projects Al <Al Projecks =
Project Attribukes Al <Al Praject Atkributes =
Transaction Attributes Al <All Transaction Attributes =
Classes Al Al Classes=
Journals al Al Journals =
Mok et Posted Transactions | Al <Al Mok Yet Posted Transackions =
Cash Flow Codes Al <Al Cash Flow Codes=
Working Capital Codes All <Al Working Capital Codes»
Mission(s) all <Al Missiongs)= LI

Multiple Column Headings Tab

On the Multiple Column Headings tab, you can create a heading to cover more than one column.

lﬂ Hew Statement of Het Assets Combined Balance Sheet I
Fil= Edit “iew Favartes Toolz Help

B2 S & 2 |

1. General I 2 Filtersl 2 Columnz 4 Multiple Column Headings | 5 Format I

Heading I Start Column I End Column Align

Heading. Text entered into the Heading column appears as a heading above one or more of the individual
column headings.

Start Column. In the Start Column, select the first column the multiple column heading will cover.

End Column. In the End Column, select the last column the multiple column heading will cover. The End
Column must be greater than or equal to the Start column.

Align. In the Align column, select a left, center, or right alignment.
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Format Tab

On the Format tab, you decide how the report should look. You can create headings and footers, include a list of
criteria used to create the report, sort the information in the report, and select the format for displaying
monetary amounts. A description of each formatting option is provided.

I@ Hew Statement of Het Assets Combined Balance Sheet
Fil=e Edit “iew Favortez Toolz Help

R = ?-

1. General | 2 Filtersl a Culumnsl 4 Multiple Column Headings 5 Format |

B Headings Headings
Criteria

Detail —Heading Format
Sort Title: |Statemenl of Met Assets Combined Balance Shest
Page Footer Subite:

Repart Footer

Miscellaneous Aligr: IEenter "I

Calor Scheme . L .
¥ Print organization name in header

v Print Page Mumber in Heading ¥ PFiint Report Date in Heading
Farmat: IF'age 1 j Farmat: IStht Date and Time j
Hligr: [Right =l | Al Lett =

¥ Frirt report heading on each page

The list on the left of the screen displays formatting options for the Balance Sheet: Headings, Criteria, Detail,
Sort, Page Footer, Report Footer, Miscellaneous, and Color Scheme. When you select an item in the list, the right
side of the screen changes to present selections for that section of the report.

Note: The heading defaults to Statement of Net Assets Combined Balance Sheet in the Title field. You can leave
this as the title for the report or enter your own.

Headings. Use Headings to enter a maximum of 60 characters in each of the Title and Subtitle fields. The title
and subtitle appear at the top of the report. You can select how the heading should be alighed and whether
your organization's name will appear in the header. You can include the page number and date in the heading.
You can also select to include the heading on every page of the report.

Criteria. Select Criteria to print a list of criteria used to create the report. Mark Print these criteria on and select
a separate page or the first page. Selections print in the criteria section of the report.

Detail. Use Detail to indent totals. To indent totals when the statement contains only one amount column, mark
Indent totals when statement only contains one amount column.

If you mark Print change in net assets, you must select a chart template that includes income statement
accounts on the General tab, or the net surplus/deficit cannot be calculated and appears as zero.

Sort. Use Sort to print a separate statement for a selected value. If you select to summarize any portion of the
statement in the Show field, select how to summarize in the Summarize by field. You cannot select the same
value you selected in the Print a separate statement field.

If you select to Show account details for the entire statement, a grid appears so you can select various
sorting options.
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Glossary: An account segment is a set of digits in an account number, such as fund and account code
segments, that categorize transactions for creating financial statements. For example, in account
01-1100-00-00, the first set of numbers in the series is usually the fund (01), followed by more segments such
as the account code (1100), department (00), and location (00). Fund and account code segments are required.

If you make no selections in the Sort by column, the program sorts by the entire account number in
ascending order with no action. If you select a sort option in the Sort by column, you can select Subtotal or
Mask in the Action column. Subtotal is a break for which a total is provided. You can select Subtotal for only
one Sort by option. You can apply masking to any account segment.

Page Footer. Use Page Footer to create a footer to appear at the bottom of each page of the report. You can
enter a maximum of 254 characters in the Text field for the page footer. You can also select the alignment
and include the page number and date in the footer.

Report Footer. Use Report Footer to create a footer to appear at the bottom of the last page of the report. You
can enter a maximum of 254 characters in the Text field for the report footer and select alignment of the text.

Miscellaneous. Use Miscellaneous to specify how numbers appear on the report and the font size for the
report.

Color Scheme. You can apply a color scheme to the column heading and group heading of the report. When
you click in the color box next to the selection, the Color screen appears so you can select a standard color or
define a custom color.

Statement of Net Assets - Schedule B

The Statement of Net Assets - Schedule B provides a summary of your organization’s financial activity at a distinct
point in time.

Warning: We highly recommend you run the Statement of Net Assets - Schedule B report with the Statement
of Net Assets Combined Balance Sheet.

You should run the Statement of Net Assets - Schedule B report with the Statement of Net Assets Combined
Balance Sheet. This report requires a separate chart template from the template you used for the Statement of
Net Assets Combined Balance Sheet because it requires a different grouping of net assets (invested capital, net of
related debt, Restricted for debt service, and unrestricted).

The Statement of Net Assets - Schedule B has five tabs on which you set parameters: General, Filters, Columns,
Multiple Column Headings, and Format. To move among the tabs, click Next and Back at the bottom of the
screen or select the tab itself. On these tabs you specify information to include in the report and how the report
should look.
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General Tab

On the General tab, you set parameters specific to the report and make selections about information included in
the report.

I New Statement of Met Assets - Schedule B
File Edit “iew Favorter Toolz Help

H &= %W ?-

1: General ]2: Filters ] 3 Eolumns] 4: Multiple Calurnn Headings ] 5 Format]

Use chart teriat (TG ~ | 2 - = - [ =]

v Include accounts with zero balances

WV Include inactive accounts

[~ Create an output quen of accounts

Report orientation: | Partrait -

ou must define colunns filkers in order Far this repart to displag valid infarmation.

Use chart template. In the Use chart template field, select a chart template for the report. Chart templates
are established in Visual Chart Organizer. Then click the Validate chart template button to verify that all existing
accounts are represented in the chart template and that there are no duplicate accounts in the chart temlga)late.
Select a level by clicking the up and down arrows to the right of the at level field. For more information about
chart templates, see “Creating a Chart Template” on page 236.

Warning: You establish chart templates in Visual Chart Organizer. For more information about chart

templates, see the Visual Chart Organizer Guide.

Include accounts with zero balances. Mark this option to include accounts with zero balances in the
report. The Include accounts with zero balances checkbox is marked as a default.

Include inactive accounts. Mark this option to include inactive accounts in the report. The Include inactive
accounts checkbox is marked as a default.

Create an output query of accounts. Mark this option to create a query of account records. This query is
available for use in other areas of the program.
Note: To view the report as it will appear using your selections and filters, click Preview. To view a sample
layout of the report without data, click Layout.

Report orientation. In the Report orientation field, select Portrait or Landscape.
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Filters Tab

On the Filters tab, you can include information based on selected criteria such as Funds, Accounts, and Classes.

File Edit “iew Favontez Toolz Help
A= |
1. General x Columnsl 4 Multiple Colurin Headings | & Formatl
& 0pen ) Clear AllF;
Filters I Include Selected Filters Iﬂ
Funds &l <4l Funds =
Account Codes &l <Al Account Codes
Accounts all <Al Accounts =
Account Attributes &l <Al Account Attributes =
Projects all <Al Projects=
Project Aktributes all <Al Project Aktribukes =
Transaction Attributes &l <Al Transackion Attribukes =
Classes &l <Al Classes=
Journals all <all Journals =
Mok et Posted Transactions Selected <Mone
Cash Flow Codes Al <Al Cash Flow Codes>
working Capital Codes all <Al working Capital Codes =
Missionis) all <Al Mission{s)= LI

Open. Click a filter in the grid and click Open on the action bar. The Selected <Filter> screen appears so you can
select a specific filter or a range.

Clear All Filters. To remove all previously selected filters from the report, click Clear All Filters.

Filters. The Filters column lists all filters for this report. You cannot edit this column.
Tip: You can shorten this report by filtering out the assets and liabilities account codes. Only the net assets
accounts will appear.

Include. Choose Selected in the Include column next to the filter you want. The Selected <Filter> screen appears
so you can designate specific filters for the report.

Selected Filters. Filters you specify appear in the Selected Filters column. If you choose Selected in the Include
column or click a filter and then click Open on the action bar, the Selected <Filter> screen appears.
Note: Mark Selected, Range, or Query to include a selected filter, range of filters, or a previously created
query of filters. Depending on the selection, different options appear on the screen.

If you mark Selected or Range, a grid appears so you can specify individual filters.

Selected Accounts

Inchude: QO All ngs @ Query

Account | Description |
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If you mark Query, the Query name field appears so you can select a query to use as a filter.

Selected Accounts [ x|

Include: All ® Selected ® Range o Query Previous Filter  Mest Filter

Guerny name: | QI

Query name. The Query name field appears if you select Query. Enter the name of the query to use to filter the
report or click the binoculars to search for a query.

To create a new query, click the binoculars and click Add a New Query on the Open Query screen. For more
information about creating queries, see the Query Guide.

Previous Filter. To view or edit the previous filter without returning to the Filters tab, click Previous Filter on
the toolbar.

Next Filter. To view or edit the next filter without returning to the Filters tab, click Next Filter on the toolbar.

Columns Tab

On the Columns tab, you can create new columns that appear on the report, open existing columns, delete
columns, and view the heading, formula, and dates defined for columns you have already created.

A2 New Statement of Net Assets - Schedule B x|

File Edit Wiew Favorites Tools Help

dadam

1 Generall 2 Filters

?- |

4 Multiple Colunin Headings | 5: Faormat

% Mew Column @30 pen Column Ee Repeat Column “* Delete Calumn

Hide? I Heading I Farmula I Cate Range
AL I Account Description
| 2 | [T Adjustments {actualt 01/31/2008
=R [T Statement of Met Assets {Calurn 2 0131 /2006

New Column. When you click New Column, the Column <#> screen appears, showing three tabs you can use to
create a new column. These tabs are the General tab, Date Range tab, and Filters tab.

Open Column. To open an existing column and edit its settings, select a row in the grid and click Open Column.

Repeat Column. To repeat a column’s settings, highlight that column and click Repeat Column. A new row with
the same settings appears in the grid. If you click the drop down arrow on the Repeat Column button, you can
select “All parameters” or “Date parameters only.” If you select “Date parameters only,” you will create a new
column with the same date parameters of the selected column.

Delete Column. To delete a column’s settings, highlight that column and click Delete Column. You can delete
only unused columns.

Hide? Mark the checkbox in the Hide? column for any column you do not want to appear in the report.

Heading. The Heading column displays the column heading defined in the Column heading field of the Columns
General tab.

Formula. The Formula column displays the column information defined in the Column Definition frame of the
Columns General tab.
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Date range. The Date Range column displays the dates selected on the Date Range tab.

Note: Selections made on the General, Date Range, and Filters tabs of the Columns tab apply only to report
columns and not to the report itself.

General tab. You can name and define report columns on this tab. Use the alignment buttons to specify how
columns are aligned. Column formatting options include: Column width, Report width, Format, and Decimal
places. In the Column Definition frame, you select the column type, amount or description and determine
the calculations or description for that column. Click Validate to validate the expression created in the
Column Definition frame. Click Clear to clear the expression. If you mark Hide this column on the report and
export the report, hidden columns will not be exported.

Column 4

*i New Column  Bgy Repeat Column

General I Date Hangel Filtelsl

Coluran heading: Colurnn width: I‘I oo inches

Report width:  5.75 inches
= = = A of Date Format: ICunenc_l,l 'I

Decimal places: |2 'I

Column Definition -

Type: IAmount =l

hctualk

{0niginal Budget}

{Adjusted Budget}

{Budaget Adjustrments}

{Calurnn 3} s |

[~ Hide this column on the repart Yalidate Clear jjﬂﬂﬂﬂ

Date Range tab. On this tab, the selections you make determine the period or date for which balances are
included on the report.

Column 5

olurt Bey Repeat Column Del

General Date Range I Filtersl

Date: I <Specific fiscal period: ﬂ 04.,/30/2001

Fiscal year: IThis fiscal pear ﬂ As of period: IThis fiscal perind 'I
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Filters tab. On this tab you can select filters that apply only to the selected columns and not the entire report.

Column 4

Filters I Include Selected Filkers ﬂ
Funds Al <Al Funds =
Account Codes Al <Al Account Codes =
Accounts all Al Accounts=
Accaunt Attribukes &l <Al Account Attributes =
Projects Al <Al Projects>
Project Attributes all <Al Project Attributes=
Transaction Attributes all <Al Transaction Attributes =
Classes &l <Al Classes >
Journals &l <Al Journals:
Mok Yet Posted Transactions Al <Al Mot ek Posted Transactions =
Cash Flow Codes Al <Al Cash Flow Codes>
working Capital Codes all <all Working Capital Codes = -
K _'l_I

Multiple Column Headings Tab

On the Multiple Column Headings tab, you can create a heading to cover more than one column.

lﬂ Hew Statement of Het Assets - Schedule B I
Fil= Edit “iew Favartes Toolz Help

H2S R - |

1. General I 2 Filtersl 2 Columnz 4 Multiple Column Headings | 5 Format I

Heading I Start Column I End Column Align

Heading. Text entered into the Heading column appears as a heading above one or more of the individual
column headings.

Start Column. In the Start Column, select the first column the multiple column heading will cover.

End Column. In the End Column, select the last column the multiple column heading will cover. The End
Column must be greater than or equal to the Start column.

Align. In the Align column, select a left, center, or right alignment.



213 CHAPTER

Format Tab

On the Format tab, you decide how the report should look. You can create headings and footers, include a list of
criteria used to create the report, sort the information in the report, and select the format for displaying
monetary amounts. A description of each formatting option is provided.

IQ Mew Statement of Met Agzets - Schedule B E
File Edit “iew Favortez Toolz Help

HR S G w2 |
|

B Hoadng:
Criteria

1. General | 2 Filtersl x Enlumnsl 4 Multiple Colurin Headingz

Detail —Heading Format
Sart Title: IStatement of Met &ssets - Schedule B
Page Footer Subtitle: I

Report Foater

Miscellaneous Aligr: ICenter 'I
Color Sch - - .
oo Eneme ¥ Print organization name in header

— W Print Page Murmber in Heading ¥ Prirt Beport D ate in Heading
Farmat; IF'age 1 j Faormat: IShort Date and Time j
#ligr: [Right =] | [ Aigne [Lett |

v Frint report heading on each page

The list on the left of the screen displays formatting options for the Balance Sheet: Headings, Criteria, Detail,
Sort, Page Footer, Report Footer, Miscellaneous, and Color Scheme. When you select an item in the list, the right
side of the screen changes to present selections for that section of the report.

Note: The heading defaults to Statement of Net Assets - Schedule B in the Title field. You can leave this as the
title for the report or enter your own.

Headings. Use Headings to enter a maximum of 60 characters in each of the Title and Subtitle fields. The title
and subtitle appear at the top of the report. You can select how the heading should be aligned and whether
your organization's name will appear in the header. You can include the page number and date in the
heading. You can also select to include the heading on every page of the report.

Criteria. Select Criteria to print a list of criteria used to create the report. Mark Print these criteria on and select
a separate page or the first page. Selections print in the criteria section of the report.

Detail. Use Detail to indent totals. To indent totals when the statement contains only one amount column, mark
Indent totals when statement only contains one amount column.

If you mark Print change in net assets, you must select a chart template that includes income statement
accounts on the General tab, or the net surplus/deficit cannot be calculated and appears as zero.

Sort. Use Sort to print a separate statement for a selected value. If you select to summarize any portion of the
statement in the Show field, select how to summarize in the Summarize by field. You cannot select the same
value you selected in the Print a separate statement field.

If you select to Show account details for the entire statement, a grid appears so you can select various
sorting options.

If you make no selections in the Sort by column, the program sorts by the entire account number in
ascending order with no action. If you select a sort option in the Sort by column, you can select Subtotal or
Mask in the Action column. Subtotal is a break for which a total is provided. You can select Subtotal for only
one Sort by option. You can apply masking to any account segment.
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Page Footer. Use Page Footer to create a footer to appear at the bottom of each page of the report. You can
enter a maximum of 254 characters in the Text field for the page footer. You can also select the alignment
and include the page number and date in the footer.

Report Footer. Use Report Footer to create a footer to appear at the bottom of the last page of the report. You
can enter a maximum of 254 characters in the Text field for the report footer and select alignment of the
text.

Miscellaneous. Use Miscellaneous to specify how numbers appear on the report and the font size for the
report.

Color Scheme. You can apply a color scheme to the column heading and group heading of the report. When
you click in the color box next to the selection, the Color screen appears so you can select a standard color or
define a custom color.

Statement of Activities - Standard Format

The Statement of Activities - Standard Format presents the financial position of your organization over a given
time period.

Warning: This report requires a chart template that groups the income statement accounts by fund, using
advanced filters. You can use advanced filters only if you set the business rule in Configuration.

You must select a chart template for the Statement of Activities - Standard Format that summarizes income
statement accounts. This requires a chart template that groups the income statement accounts by fund, using
advanced filters. For more information about chart templates, see “Creating a Chart Template” on page 236.

The Statement of Activities - Standard Format has five tabs on which you set parameters: General, Filters,
Columns, Multiple Column Headings, and Format. To move among the tabs, click Next and Back at the bottom of
the screen or select the tab itself. On these tabs you specify information to include in the report and how the
report should look.

General Tab

On the General tab, you set parameters specific to the report and make selections about information included in
the report.

Warning: You must select a chart template for the Statement of Activities - Standard Format that summarizes
income statement accounts.
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You must select a chart template for the Statement of Activities - Standard Format that summarizes income
statement accounts. This will show how income (expense and revenue) is broken out into funds. The rows in the
report depend entirely on how you define the chart template.

n Mew Statement of Activities - Standard Format
File Edit “iew Favortez Toolz Help

H &S 5w Y=

1. General ]g: Filters] 3 Enlumns] 4 Multiple Colurin Headings] & Format ]

Use chist et RN - | 1 - ==l [~ =

v Include accounts with no activity

v Include inactive accounts

[~ Create an output guery of accounts

Report arientation: |Landscape | =

ou muszt define column filkers in order for thiz report to display walid information.

Use chart template. In the Use chart template field, select a chart template for the report. Chart templates
are established in Visual Chart Organizer. Then click the Validate chart template button to verify that all
existing accounts are represented in the chart template and that there are no duplicate accounts in the chart
template. Select a level by clicking the up and down arrows to the right of the at level field. For more
information about chart templates, see “Creating a Chart Template” on page 236.

Warning: You establish chart templates in Visual Chart Organizer. For more information about chart
templates, see the Visual Chart Organizer Guide.

Include accounts with no activity. Mark this option to include accounts with no activity in the report. The
Include accounts with no activity checkbox is marked as a default.

Include inactive accounts. Mark this option to include accounts inactive accounts in the report. The Include
inactive accounts checkbox is marked as a default.

Create an output query of accounts. Mark this option to create a query of account records. This query is
available for use in other areas of the program.
Note: To view the report as it will appear using your selections and filters, click Preview. To view a sample
layout of the report without data, click Layout.

Report orientation. In the Report orientation field, select Portrait or Landscape.
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Filters Tab

On the Filters tab, you can include information based on selected criteria such as Accounts, Funds, Projects, and
Project Attributes. For example, to include only funds within a certain range. Funds not in the range do not
appear on the report.

I New Statement of Activities - Standard Format
File Edit “iew Favorter Toolz Help

RS RN =2 |

1: General 2 Filkers |§: Eolumnsl 4: Multiple Column Headingz | 5: Format

@ 0pen ) Clear All Filkers

Filkers I Include Selected Filkers Iﬂ
Funds Al <Al Funds
Account Codes Al <Al Account Codes
Accounts Al <Al Accounts =
Account Attributes Al <Al Account Attributes=
Projects all <Al Projects =
Project Atkributes all <Al Project Attributes =
Transaction Atkribukes Al <Al Transaction Attributes =
Classes Al <Al Classes=
Journals Al <Al Journals=
Mot et Posted Transactions |Selected <Mone=
Mission(s) all <Al Mission(s)=

Spendablefmon-spendabl... Al <Al spendable/Mon-3pendables)=
Performanceds) all <all Performancels) = ;I

Open. Click a filter in the grid and click Open on the action bar. The Selected <Filter> screen appears so you can
designate specific filters for the report.

Clear All Filters. To remove all previously selected filters from the report, click Clear All Filters.
Glossary: A filter is criteria records must meet to be included in a report. For example, if you apply the
Accounts filter, only the accounts you select are included in the report.

Filters. The Filters column lists all filters for this report. You cannot edit this column.

Include. Choose Selected in the Include column next to the filter you want. The Selected <Filter> screen appears
so you can designate specific filters for the report.

Selected Filters. Filters you specify appear in the Selected Filters column. If you choose Selected in the Include
column or highlight a filter and then click Open on the action bar, the Selected <Filter> screen appears.

Note: If you mark All, you cannot define filters. You must mark Selected, Range, or Query to define filters.

If you mark Selected or Range, a grid appears so you can specify individual filters.

Selected Accounts

Includes: Qb Al te ® Range @ Luery

Account | Description |
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If you mark Query, the Query name field appears so you can select a query to use as a filter.

Selected Accounts [ x|

Include: @ Al Selecte ® Fange @ Query Previous Filter  Mest Filter

Guerny name: | QI

Query name. The Query name field appears if you select Query. Enter the name of the query to use to filter the
report or click the binoculars to search for a query.

To create a new query, click the binoculars and click Add a New Query on the Open Query screen. For more
information about queries, see the Query Guide.

Previous Filter. To view or edit the previous filter without returning to the Filters tab, click Previous Filter on
the toolbar.

Next Filter. To view or edit the next filter without returning to the Filters tab, click Next Filter on the toolbar.

Columns Tab

On the Columns tab, you can create new columns that appear on the report, open existing columns, delete
columns, and view the heading, formula, and dates defined for columns you have already created.

A New Statement of Activities - Standard Format =
File Edit Wiew Faworites Tools Help
e o= 2- |
1. General | 2 Filters 4 Multiple Colurin Headings | & Formatl
A NewCalumn @50 pen Column Bz epeat Column . Delete Column
Hide? I Heading I Formmula I Diate Range I
il l Functions/Programs Account Description
z [T Expenses {Ackualt 01/01/2006 bo 12/31...
3 [T harges for Services {actualt 0101 /2006 ko 12031,
4 [T Operating Grants and Con... {actual} 01/01J2006 to 12031,
5 [T Capital Grants and Contrib,.. {actual} 01/01/2006 bo 12/31...
f [T Governmental Activities {actualt 010172006 ko 12031...
7 [T Business-type Activities {Ackual} 01/01J2006 ko 12131...
g T Total {Calumn 6} + {Calumn 7} 01/01/2006 bo 12/31...
9 [T Component Units {actualt 010172006 to 12031...

New Column. When you click New Column, the Column <#> screen appears, showing three tabs you can use to
create a new column. These tabs are the General tab, Date Range tab, and Filters tab.

Open Column. To open an existing column and edit its settings, select a row in the grid and click Open Column.

Repeat Column. To repeat a column’s settings, highlight that column and click Repeat Column. A new row with
the same settings appears in the grid. If you click the drop down arrow on the Repeat Column button, you
can select “All parameters” or “Date parameters only.” If you select “Date parameters only,” you will create a
new column with the same date parameters of the selected column.

Delete Column. To delete a column’s settings, highlight that column and click Delete Column. You can delete
only unused columns.

Hide? Mark the checkbox in the Hide? column for any column you do not want to appear in the report.
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Heading. The Heading column displays the column heading defined in the Column heading field of the Columns
General tab.

Formula. The Formula column displays the column information defined in the Column Definition frame of the
Columns General tab.

Date range. The Date Range column displays the dates selected on the Date Range tab.

Note: Selections made on the General, Date Range, and Filters tabs of the Columns tab apply only to report
columns and not to the report itself.

General tab. You can name and define report columns on this tab. Use the alignment buttons to specify how
columns are aligned. Column formatting options include: Column width, Report width, Format, and Decimal
places. In the Column Definition frame, you select the column type, amount or description and determine
the calculations or description for that column. Click Validate to validate the expression created in the
Column Definition frame. Click Clear to clear the expression. If you mark Hide this column on the report and
export the report, hidden columns will not be exported.

Column 6

mh  Bey Bepeat Colurn

General I Date Riange | Filters |

Colurn heading: Column width: I‘I Ao inches

Report width: 7,92 inches

= 1= = Start Date End Date et IEunenc_u :Iv

Decimal places: I 2 - I
Calumn Definition -
Type: IAmount j
ihctualk -

{Eneumbrance}
{Actual + Encumbrance}
{0niginal Budgst}

{Adjusted Budgeth =
{Budget Adjustrents} _l
{Calumn 2}

{Colurnn 3}

{Cofurnn 4} =

[~ Hide this column on the repart Yalidate Clear jjﬂﬂﬂﬂ

Date Range tab. On this tab, the selections you make determine the period or date for which balances are
included on the report.

Column &

'1i Mew Column B Repeat Column Delete Colurn

General  Date Range I Filtersl

Date: |<Specific fisal pears j 01/01/2002 bo 12/31./2002

Fiscal year: I Thisz fiscal pear j
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Filters tab. On this tab you can select filters that apply only to the selected columns and not the entire report.

Column 10

Ep; Repeat Colurnn

Generall Date Range  Filters |

= Clear &l Filters
Filtets | Include Selected Filkers |ﬂ
Funds &l <Al Funds =
Account Codes &l <Al Account Codes=
Accounts all <Al Accounts =
Sccount Attributes &l <Al Account Attributes=
Projects all <Al Projects>
Project Attributes Al <Al Project Attributes >
Transaction Attributes all <Al Transaction Attributes =
Classes &l <Al Classes>
Journals &l <Al Journals s
Mok Yet Posted Transackions  All <Al Mot ek Posted Transactions =
Missiongs) all <Al Mission{s)=
SpendableMon-Spendableds) Al <all SpendablefMon-Spendableds) =
Performance(s) all <Al Performance(s) > ;l

Multiple Column Headings Tab

On the Multiple Column Headings tab, you can create a heading to cover more than one column.

IQ Mew Statement of Activities - Standard Format I
File Edit “iew Favortez Toolz Help

== R el |

1. General | 2 Filtersl 2 Columng 4 Multiple Colurin Headings | & Format |

Heading I Stark Colurin I End Calumn Blign
Program Revenues Column 3 Column 5 Center
Met (Expenses) Revenue and Changes in Met As... Column & Column & Center

Heading. Text entered into the Heading column appears as a heading above one or more of the individual
column headings.

Start Column. In the Start Column, select the first column the multiple column heading will cover.

End Column. In the End Column, select the last column the multiple column heading will cover. The End
Column must be greater than or equal to the Start column.

Align. In the Align column, select a left, center, or right alignment.
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On the Format tab, you decide how the report should look. You can create headings and footers, include a list of
criteria used to create the report, sort the information in the report, and select the format for displaying

monetary amounts. A description of each formatting option is provided.

IQ Mew Statement of Activities - Standard Format E
File Edit “iew Favortez Toolz Help

== RN e |

1. General | 2 Filtersl x Enlumnsl 4 Multiple Colurin Headingz 5: Format |

B Headings Headings
Criteria

Detail —Heading Format
Sart Title: IStatement of Activities - Standard Format
Page Footer Subtitle: I

Report Foater
Miscellaneous
Color Scheme

Align: ICenter 'I

v PFrint arganization name in header

— W Print Page Murmber in Heading

¥ Prirt Beport D ate in Heading
Farmat; IF'age 1 j Faormat: IShort Date and Time j

#ligr: [Right =] | [ Aigne [Lett |

v Frint report heading on each page

The list on the left of the screen displays formatting options for the Account Profile Report: Headings, Criteria,

Sort, Page Footer, Report Footer, Miscellaneous, and Color Scheme. When you select an item in the list, the right

side of the screen changes to present selections for that section of the report.

Note: The heading defaults to Statement of Activities - Standard Format in the Title field. You can leave this as

the title for the report or enter your own.

Headings. You can enter a maximum of 60 characters in each of the Title and Subtitle fields. The title and

subtitle appear at the top of the report. You can select how the heading should be aligned and whether your
organization's name will appear in the header.

You can include other options in the heading, such as the page number and the date. You can also select to
include the heading on every page of the report.

Note: The program automatically selects all criteria. Unmark the checkbox for any criteria you do not want to
print with the report.

Criteria. Select Criteria to print a list of criteria used to create the report. Mark Print these criteria on and select
a separate page or the first page. Selections print in the criteria section of the report.

Sort. Use Sort to print a separate statement for a selected value. If you select to summarize any portion of the
statement in the Show field, select how to summarize in the Summarize by field. You cannot select the same
value you selected in the Print a separate statement field.

If you select to Show account details for the entire statement, a grid appears so you can select various
sorting options.

If you make no selections in the Sort by column, the program sorts by the entire account number in
ascending order with no action. If you select a sort option in the Sort by column, you can select Subtotal or
Mask in the Action column. Subtotal is a break for which a total is provided. You can select Subtotal for only
one Sort by option. You can apply masking to any account segment.
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Page Footer. Use Page Footer to create a footer to appear at the bottom of each page of the report. You can
enter a maximum of 254 characters in the Text field for the page footer. You can also select how to align the
text and include the page number and date in the footer.

Report Footer. Use Report Footer to create a footer to appear at the bottom of the last page of the report. You
can enter a maximum of 254 characters in the Text field for the report footer and select how to align the text.

Miscellaneous. Use Miscellaneous to specify how numbers appear on the report and the font size for the
report.

Color Scheme. You can apply a color scheme to the column heading and group heading of the report. When
you click in the color box next to the selection, a Color screen appears so you can select a standard color or
define a custom color.

Statement of Activities - Schedule B

The Statement of Activities - Schedule B is a variation of the revenue portion of your organization’s standard
income statement. You should run this report with the Statement of Activities - Standard Format report.

Warning: We highly recommend you run this report with the Statement of Activities - Standard Format report.

This report requires a separate chart template from the one used for the Statement of Activities - Standard
Format report. For more information about chart templates, see “Creating a Chart Template” on page 236.

The Statement of Activities - Schedule B has five tabs on which you set parameters: General, Filters, Columns,
Multiple Column Headings, and Format. To move among the tabs, click Next and Back at the bottom of the
screen or select the tab itself. On these tabs you specify information to include in the report and how the report
should look.

General Tab

On the General tab, you set parameters specific to the report and make selections about information included in
the report.



GASB 34 REPORTS 22

This report requires a separate chart template from the one used for the Statement of Activities - Standard
Format report.

n Hew Statement of Activities - Schedule B
Fil= Edit “iew Favartes Toolz Help

EH &S 5w ?-

1. General ]g; Filters] 3 Columns] 4 Multiple Column Headings] 5 Folmat]

Use chat tempiets TR - | - - == [ ]

W Include accounts with no activin

¥ Include inactive accounts

[~ Create an output query of accounts

Report onientation: |Landscape | ™

ou muzt define calumn filkers in order for thiz report to display walid information.

Glossary: A chart template is a visual representation in General Ledger 7.2 of all or selected accounts from the
general ledger. In General Ledger 7.2, you can create multiple chart templates, each with a different
presentation of accounts. Chart templates drive the presentation of accounts on financial statements.

Use chart template. In the Use chart template field, select a chart template for the report. You establish chart
templates in Visual Chart Organizer. Then click the Validate chart template button to verify that all existing
accounts are represented in the chart template and that there are no duplicate accounts in the chart
template. Select a level by clicking the up and down arrows to the right of the at level field. For more
information about chart templates, see “Creating a Chart Template” on page 236.

Include accounts with no activity. Mark this option to include accounts with no activity in the report. The
Include accounts with no activity checkbox is marked as a default.

Include inactive accounts. Mark this option to include inactive accounts in the report. The Include inactive
accounts checkbox is marked as a default.

Create an output query of accounts. Mark this option to create a query of account records. This query is
available for use in other areas of the program.
Note: To view the report as it will appear using your selections and filters, click Preview. To view a sample
layout of the report without data, click Layout.

Report orientation. In the Report orientation field, select Portrait or Landscape.
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Filters Tab

On the Filters tab, you can include information based on selected criteria such as Funds, Projects, Journals,
Account Attributes, and Classes. In the Statement of Activities - Schedule B report, we recommend you filter the
expense account codes out of this report because only the activity for the revenue and transfer account codes
should be included.

Fil=  Edit “iew Fawortez Toolz Help
SRR = |
1: General  2: Filters | & Columnsl 4: Multiple Column Headings | & Formatl
@ 0pen ) Clear Al Filters
Filters I Include Selected Filters Iﬂ
Funds All il Funds =
Account Codes all <Al Account Codes>
Accounts Al <Al Accountsz
Account Attributes All <Al Account Attributes s
Projects all <Al Projects=
Project Aktributes all <Al Project Aktribukes =
Transaction Attributes All <Al Transackion Atkributes=
Classes All <Al Classes>
Journals Al <Al Journals =
Mak ¥et Posted Transactions Selected <Maone =
Mlission(s) Al <l Mission(s) =
apendable/Mon-3pendabl... Al <Al 3pendablefMon-3pendablels) =
Perfarmancels) all <Al Perfarmanceis) = LI

Open. Click a filter in the grid and click Open on the action bar. The Selected <Filter> screen appears so you can
designate specific filters for the report.

Glossary: A filter is criteria records must meet to be included in a report. For example, if you apply the Funds
filter, only the funds you select are included in the report.

Clear All Filters. To remove all previously selected filters from the report, click Clear All Filters.
Filters. The Filters column lists all filters for this report. You cannot edit this column.

Include. Choose Selected in the Include column next to the filter you want. The Selected <Filter> screen appears
so you can designate specific filters for the report.

Warning: In the Statement of Activities - Schedule B report, we highly recommend you filter the expense
account codes out of this report because only the activity for the revenue and transfer account codes should
be included.

Selected Filters. Filters you specify appear in the Selected Filters column. If you choose Selected in the Include
column or highlight a filter and then click Open on the action bar, the Selected <Filter> screen appears.
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If you mark Selected or Range, a grid appears so you can specify individual filters.

Selected Accounts

Include: @ All ® Selected ® Hange ® Query Previous Filter  Mest Filter

Account | Description |

Note: If you mark All, you cannot define filters. You must mark Selected, Range, or Query to define filters.

If you mark Query, the Query name field appears so you can select a query to use as a filter.

Selected Accounts E

Include: @ Al @ ® Hange  © [uery Previous Filter  Mest Filter

Cuery name: I ﬁl

Query name. The Query name field appears if you select Query. Enter the name of the query to use to filter the
report or click the binoculars to search for a query.

To create a new query, click the binoculars and click Add a New Query on the Open Query screen. For more
information about queries, see the Query Guide.

Previous Filter. To view or edit the previous filter without returning to the Filters tab, click Previous Filter on
the toolbar.

Next Filter. To view or edit the next filter without returning to the Filters tab, click Next Filter on the toolbar.

Columns Tab

On the Columns tab, you can create new columns that appear on the report, open existing columns, delete
columns, and view the heading, formula, and dates defined for columns you have already created.

@ New Statement of Activities - Schedule B x|

File Edit Wiew Faworites Tools Help

FIEEEYE

1: Generall 2: Filker :

4| - |

| 4: Multiple Colurn Headings | &: Farmat I

& NewCalumn @50 pen Columni Bz epeat Colurnn " Delete Calumn

Hide? I Heading I Farmula I Date Range I
| [ Accounk Description
| 28| [T Governmental Activities {Ackualt 01/01/2006 to 12/31...
| 3 | [T Business-type Activities {actualt 010172006 ko 12(31...
st [T Total {Calurn 2} + {Calurn 3} 01/01J2006 to 12131...
| S | [T Component Units {actual} 01/01/2006 to 12/31...
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New Column. When you click New Column, the Column <#> screen appears, showing three tabs you can use to
create a new column. These tabs are the General tab, Date Range tab, and Filters tab.

Open Column. To open an existing column and edit its settings, select a row in the grid and click Open Column.

Repeat Column. To repeat a column’s settings, highlight that column and click Repeat Column. A new row with
the same settings appears in the grid. If you click the drop down arrow on the Repeat Column button, you
can select “All parameters” or “Date parameters only.” If you select “Date parameters only,” you will create a
new column with the same date parameters of the selected column.

Delete Column. To delete a column’s settings, highlight that column and click Delete Column. You can delete
only unused columns.

Hide? Mark the checkbox in the Hide? column for any column you do not want to appear in the report.

Heading. The Heading column displays the column heading defined in the Column heading field of the Columns
General tab.

Formula. The Formula column displays the column information defined in the Column Definition frame of the
Columns General tab.

Date range. The Date Range column displays the dates selected on the Date Range tab.

Note: Selections made on the General, Date Range, and Filters tabs of the Columns tab apply only to report
columns and not to the report itself.

General tab. You can name and define report columns on this tab. Use the alignment buttons to specify how
columns are aligned. Column formatting options include: Column width, Report width, Format, and Decimal
places. In the Column Definition frame, you select the column type, amount or description and determine
the calculations or description for that column. Click Validate to validate the expression created in the
Column Definition frame. Click Clear to clear the expression. If you mark Hide this column on the report and
export the report, hidden columns will not be exported.

Column 6 I

mh By Repeat Column Delete Column e Column ]z

allinr -

General I Dabe: Hangel Fillersl

Colurmn heading: Column width: I‘I 0o inches

Report width: 792 inches

Start D ate End Date IFmmEt: ICWBM}I jv
Decimal places: I 2 - I

Column Definition -
Tepe: | Amount =]

{Actualt -
{Encumbrance}

%Actual + Encum}brance}

Original Budget

{adjusted Budget} Y |
{Budget Adjustments}

{Colurnn 2}

{Colurnn 3}

{Coumn 2 =

[ Hide this column on the report Yalidate Clear jjﬂﬂﬂﬂ
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Date Range tab. On this tab, the selections you make determine the period or date for which balances are
included on the report.

General Date Range I Filters |

Date: |<Specific fisal pears j 01/01/2002 bo 12/31./2002

Fiscal year: I Thisz fiscal pear j

Filters tab. On this tab you can select filters that apply only to the selected columns and not the entire report.

Filters | Include Selected Filkers |ﬂ
Funds &l <Al Funds =
Account Codes &l <Al Account Codes’
Accounts &l <Al Accounts =
Account Attributes all <Al Account Attributes:=
Projects all <Al Projects>
Project Attributes all <Al Project Attributes >
Transaction Attributes &l <Al Transaction Attributes =
Classes all <Al Classes>
Journals all Al Journals>
Mok et Posted Transackions Al <Al Mat ek Posted Transactions =
Missionis) Al <Al Mission{s) =
SpendableMon-Spendableds) Al <Al SpendablefMon-Spendableds) =
Performance(s) all <all Performancels) = LI

Multiple Column Headings Tab

On the Multiple Column Headings tab, you can create a heading to cover more than one column.

IQ Hew Statement of Activities - Schedule B E

File Edit “iew Favontez Toolz Help
A= |

1. General | 2 Fillersl 3 Columns 4 Multiple Colunin Headings |§: Formatl

Heading I Start Column I End Colurnn Align

| |Met (Expenses) Revenue and Changes in et As... Calumn 2 Colurnn 4 Cenker

Heading. Text entered into the Heading column appears as a heading above one or more of the individual
column headings.

Start Column. In the Start Column, select the first column the multiple column heading will cover.

End Column. In the End Column, select the last column the multiple column heading will cover. The End
Column must be greater than or equal to the Start column.
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Align. In the Align column, select a left, center, or right alignment.

Format Tab

On the Format tab, you decide how the report should look. You can create headings and footers, include a list of
criteria used to create the report, sort the information in the report, and select the format for displaying
monetary amounts. A description of each formatting option is provided.

l@ Mew Statement of Activities - Schedule B I
Fil= Edit ‘“iew Fawortes Toolz Help
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B Headia
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Sort Title: IStatement of Activities - Schedule B
Page Footer Sublite:

Feport Footer
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[+ Print report heading on each page

The list on the left of the screen displays formatting options for the report: Headings, Criteria, Sort, Page Footer,
Report Footer, Miscellaneous, and Color Scheme. When you select an item in the [ist, the right side of the screen
changes to present selections for that section of the report.

Note: The heading defaults to Statement of Activities - Schedule B in the Title field. You can leave this as the
title for the report or enter your own.

Headings. You can enter a maximum of 60 characters in each of the Title and Subtitle fields. The title and
subtitle appear at the top of the report. You can select how the heading should be aligned and whether your
organization's name will appear in the header.

You can include other options in the heading, such as the page number and the date. You can also select to
include the heading on every page of the report.

Note: The program automatically selects all criteria. Unmark the checkbox for any criteria you do not want to
print with the report.

Criteria. Select Criteria to print a list of criteria used to create the report. Mark Print these criteria on and select
a separate page or the first page. Selections print in the criteria section of the report.

Sort. Use Sort to print a separate statement for a selected value. If you select to summarize any portion of the
statement in the Show field, select how to summarize in the Summarize by field. You cannot select the same
value you selected in the Print a separate statement field.

If you select to Show account details for the entire statement, a grid appears so you can select various
sorting options.
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If you make no selections in the Sort by column, the program sorts by the entire account number in
ascending order with no action. If you select a sort option in the Sort by column, you can select Subtotal or
Mask in the Action column. Subtotal is a break for which a total is provided. You can select Subtotal for only
one Sort by option. You can apply masking to any account segment.

Page Footer. Use Page Footer to create a footer to appear at the bottom of each page of the report. You can
enter a maximum of 254 characters in the Text field for the page footer. You can also select how to align the
text and include the page number and date in the footer.

Report Footer. Use Report Footer to create a footer to appear at the bottom of the last page of the report. You
can enter a maximum of 254 characters in the Text field for the report footer and select how to align the text.

Miscellaneous. Use Miscellaneous to specify how numbers appear on the report and the font size for the
report.

Color Scheme. You can apply a color scheme to the column heading and group heading of the report. When
you click in the color box next to the selection, a Color screen appears so you can select a standard color or
define a custom color.

Statement of Revenues, Expenditures, and
Changes

The Statement of Revenues, Expenditures, and Changes provides a summary of your organization’s financial
activity over a time period you select. This report is much like a typical income statement, but it is pre-formatted
with columns according to the GASB requirements. You must use the appropriate chart template and column
filters to ensure this report meets GASB requirements.

Warning: You must use the appropriate chart template and column filters to ensure the Statement of
Revenues, Expenditures, and Changes report meets GASB requirements.

The Statement of Revenues, Expenditures, Changes has five tabs on which you set parameters: General, Filters,
Columns, Multiple Column Headings, and Format. To move among the tabs, click Next and Back at the bottom of
the screen or select the tab itself. On these tabs you specify information to include in the report and how the
report should look.
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General Tab

On the General tab, you set parameters specific to the report and make selections about information included in
the report.

u Mew Statement of Revenues, Expenditures. and Changes

Fil= Edit ‘iew Faworter Toolz Help
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o must define column filkers in order for this report to displag valid information,

Glossary: A chart template is a visual representation in General Ledger 7.2 of all or selected accounts from the
general ledger. In General Ledger 7.2, you can create multiple chart templates, each with a different
presentation of accounts. Chart templates drive the presentation of accounts on financial statements. For
more information about chart templates, see the Visual Chart Organizer Guide.

Use chart template. In the Use chart template field, select a chart template for the report. You establish chart
templates in Visual Chart Organizer. Then click the Validate chart template button to verify that all existing
accounts are represented in the chart template and that there are no duplicate accounts in the chart
template. Select a level by clicking the up and down arrows to the right of the at level field. For more
information about chart templates, see “Creating a Chart Template” on page 236.

Include accounts with no activity. Mark this option to include accounts with no activity in the report. The
Include accounts with no activity checkbox is marked as a default.

Include inactive accounts. Mark this option to include inactive accounts in the report. The Include inactive
accounts checkbox is marked as a default.

Create an output query of accounts. Mark this option to create a query of account records. This query is
available for use in other areas of the program.
Note: To view the report as it will appear using your selections and filters, click Preview. To view a sample
layout of the report without data, click Layout.

Report orientation. In the Report orientation field, select Portrait or Landscape.



GASB 34 REPORTS 23

Filters Tab

On the Filters tab, you can include information based on selected criteria such as Funds, Accounts, and Classes.
For example, to include only funds within a certain range. Funds not in the range do not appear on the report.
You can filter by projects only with the optional module Projects and Grants.

IE Mew Statement of Revenues, Expenditures, and Changes E
File Edit “iew Fawortez Toolz Help
SR = el |
1: General 2 Filters |§: D:ulurnnsl 4 Multiple Colurin Headings | & Formatl
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Funds all <Al Funds =
Account Codes All <Al Account Codes=
Accounts All <Al Accounts:
Account Attribukes all <Al Account Attributes >
Projects all <Al Projects=
Project Attributes all <Al Project Aktribukes =
Transaction Attributes All <Al Transackion Attributes=
Classes all <Al Classes=
Journals all <Al Journals =
Mot et Posted Transactions Selected “Mone =
MMissiongs all <Al Mission{s)=
SpendablefMon-Spendabl... Al <l SpendablefMon-3pendableds) =
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Open. Click a filter in the grid and click Open on the action bar. The Selected <Filter> screen appears so you can
select a specific filter or a range.

Clear All Filters. To remove all previously selected filters from the report, click Clear All Filters.

Glossary: A filter is criteria records must meet to be included in a report. For example, if you apply the
Accounts filter, only the accounts you select are included in the report.

Filters. The Filters column lists all filters for this report. You cannot edit this column.

Include. Choose Selected in the Include column next to the filter you want. The Selected <Filter> screen appears
so you can designate specific filters for the report.

Selected Filters. Filters you specify appear in the Selected Filters column. If you choose Selected in the Include
column or click a filter and then click Open on the action bar, the Selected <Filter> screen appears.

Note: Mark Selected, Range, or Query to include a selected filter, range of filters, or a previously created query
of filters. Depending on the selection, different options appear on the screen.



231 CHAPTER

If you mark Selected or Range, a grid appears so you can specify individual filters.

Selected Accounts

Include: @ All ® Selected ® Hange ® Query Previous Filter  Mest Filter

Account | Description |

If you mark Query, the Query name field appears so you can select a query to use as a filter.

Selected Accounts [ x|

Include: All ® Selected ® Range o Query Previous Filter  Mest Filter

Guerny name: | QI

Query name. The Query name field appears if you select Query. Enter the name of the query to use to filter the
report or click the binoculars to search for a query.

To create a new query, click the binoculars and click Add a New Query on the Open Query screen. For more
information about queries, see the Query Guide.

Previous Filter. To view or edit the previous filter without returning to the Filters tab, click Previous Filter on
the toolbar.

Next Filter. To view or edit the next filter without returning to the Filters tab, click Next Filter on the toolbar.

Columns Tab

On the Columns tab, you can create new columns that appear on the report, open existing columns, delete
columns, and view the heading, formula, and dates defined for columns you have already created.

Warning: The column headings are predefined, but you must set the appropriate filters to ensure the report is
accurate.

The column headings are predefined, but you must set the appropriate filters to ensure the report is accurate.

Glossary: An adjustment is a journal entry made to correct errors or allocate items between accounting
periods. An adjustment record contains details of the adjustment.
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To set filters, open the General Fund and Other Funds columns, and filter by fund. Make sure you account for all
funds in your organization. Most organizations use the adjustments column to list the audit adjustments defined
in the organization. The filter you apply to this column depends on how you tag adjustments (i.e., Journals,
Attributes). Make sure you filter this data out of the General Fund and Other Funds columns so that adjustments
are not counted twice.

IQ MNew Statement of Revenues, Expenditures, and Changes x|

File Edit Wiew Favoribes Tools Help
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New Column. When you click New Column, the Column <#> screen appears, showing three tabs you can use to
create a new column. These tabs are the General tab, Date Range tab, and Filters tab.

Open Column. To open an existing column and edit its settings, select a row in the grid and click Open Column.

Repeat Column. To repeat a column’s settings, highlight that column and click Repeat Column. A new row with
the same settings appears in the grid. If you click the drop down arrow on the Repeat Column button, you
can select “All parameters” or “Date parameters only.” If you select “Date parameters only,” you will create a
new column with the same date parameters of the selected column.

Delete Column. To delete a column’s settings, highlight that column and click Delete Column. You can delete
only unused columns.

Hide? Mark the checkbox in the Hide? column for any column you do not want to appear in the report.

Heading. The Heading column displays the column heading defined in the Column heading field of the Columns
General tab.

Formula. The Formula column displays the column information defined in the Column Definition frame of the
Columns General tab.

Date range. The Date Range column displays the dates selected on the Date Range tab.

Note: Selections made on the General, Date Range, and Filters tabs of the Columns tab apply only to report
columns and not to the report itself.
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General tab. You can name and define report columns on this tab. Use the alignment buttons to specify how
columns are aligned. Column formatting options include: Column width, Report width, Format, and Decimal
places. In the Column Definition frame, you select the column type, amount or description and determine
the calculations or description for that column. Click Validate to validate the expression created in the
Column Definition frame. Click Clear to clear the expression. If you mark Hide this column on the report and
export the report, hidden columns will not be exported.

Column 7

General | Date Hangel Filtersl

Calurnn heading: Colurrin width: |1.DD ihches

Report width: ~ 9.00 inches
= =E = Start Date End Date Format: IEunency jv

Decimal places: |2 'l

Calumn D efinition -

Type: IAmount =l

1Actualy a

{Encumbrance}

%i\ctual + En-:un'ibrance}

Qriginal Budget

{Adiuzted Budget} Y |

{Budget Adjustments}

{Column 2}

{Column 3}

{folumn & =l

[~ Hide this column on the report Walidate: | Clear | + | - | * | ! | [ 1

Date Range tab. On this tab, the selections you make determine the period or date for which balances are
included on the report.

Gemeral Date Range | Filters I

Diate: |«Specitic fiscal periods> | 040142002 ta 0473042002
Start fiscal pear: IThis figzal year j Start period: IThis figal petiod 'I

End fiscal year: IThis figzal year j End period: IThis figal petiod 'I
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Filters tab. On this tab you can select filters that apply only to the selected columns and not the entire report.

Column 7 [ X]

o lumn B Repeat Column
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Funds all <Al Funds =
Account Codes &l <Al Account Codes =
Accounts &l <Al Accounts =
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Multiple Column Headings Tab

On the Multiple Column Headings tab, you can create a heading to cover more than one column.

lE Mew Statement of Revenues, Expenditures. and Changes E3
File Edit “iew Fawaortes Tool: Help
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Heading. Text entered into the Heading column appears as a heading above one or more of the individual
column headings.

Start Column. In the Start Column, select the first column the multiple column heading will cover.

End Column. In the End Column, select the last column the multiple column heading will cover. The End
Column must be greater than or equal to the Start column.

Align. In the Align column, select a left, center, or right alignment.
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Format Tab

On the Format tab, you decide how the report should look. You can create headings and footers, include a list of
criteria used to create the report, sort the information in the report, and select the format for displaying
monetary amounts. A description of each formatting option is provided.

I@ Hew Statement of Revenues. Expenditures, and Changes
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The list on the left of the screen displays formatting options for the Balance Sheet: Headings, Criteria, Detail,
Sort, Page Footer, Report Footer, Miscellaneous, and Color Scheme. When you select an item in the list, the right
side of the screen changes to present selections for that section of the report.

Note: The heading defaults to Statement of Revenues, Expenditures, and Changes in the Title field. You can
leave this as the title for the report or enter your own.

Headings. Use Headings to enter a maximum of 60 characters in each of the Title and Subtitle fields. The title
and subtitle appear at the top of the report. You can select how the heading should be aligned and whether
your organization's name will appear in the header. You can include the page number and date in the
heading. You can also select to include the heading on every page of the report.

Criteria. Select Criteria to print a list of criteria used to create the report. Mark Print these criteria on and select
a separate page or the first page. Selections print in the criteria section of the report.

Detail. Use Detail to indent totals. To indent totals when the statement contains only one amount column, mark
Indent totals when statement only contains one amount column.

If you mark Print change in net assets, you must select a chart template that includes income statement
accounts on the General tab, or the net surplus/deficit cannot be calculated and appears as zero.

Sort. Use Sort to print a separate statement for a selected value. If you select to summarize any portion of the
statement in the Show field, select how to summarize in the Summarize by field. You cannot select the same
value you selected in the Print a separate statement field.

If you select to Show account details for the entire statement, a grid appears so you can select various
sorting options.

If you make no selections in the Sort by column, the program sorts by the entire account number in
ascending order with no action. If you select a sort option in the Sort by column, you can select Subtotal or
Mask in the Action column. Subtotal is a break for which a total is provided. You can select Subtotal for only
one Sort by option. You can apply masking to any account segment.
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Page Footer. Use Page Footer to create a footer to appear at the bottom of each page of the report. You can
enter a maximum of 254 characters in the Text field for the page footer. You can also select the alignment
and include the page number and date in the footer.

Report Footer. Use Report Footer to create a footer to appear at the bottom of the last page of the report. You
can enter a maximum of 254 characters in the Text field for the report footer and select alignment of the
text.

Miscellaneous. Use Miscellaneous to specify how numbers appear on the report and the font size for the
report.

Color Scheme. You can apply a color scheme to the column heading and group heading of the report. When
you click in the color box next to the selection, the Color screen appears so you can select a standard color or
define a custom color.

Creating a Chart Template

Visual Chart Organizer is the central location for creating templates for a chart of accounts in General Ledger. You
must use the appropriate chart template and column filters to ensure reports meet GASB requirements.

For example, in the Statement of Net Assets Combined Balance Sheet, you must select a chart template that
summarizes net assets by fund. The rows in this report depend entirely on how you set up the chart template.

The Statement of Net Assets - Schedule B report requires a separate chart template from the template you used
for the Statement of Net Assets Combined Balance Sheet because it requires a different grouping of net assets
(invested capital, net of related debt, Restricted for debt service, and unrestricted).

In the Statement of Activities - Standard Format report, you must select a chart template that summarizes
income statement accounts. This requires a chart template that groups the income statement accounts by fund,
using advanced filters. The Statement of Activities - Schedule B requires a separate chart template from the one
used for the Statement of Activities - Standard Format report.
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» Creating a chart of accounts template

Scenario: You are creating a Statement of Net Assets Combined Balance Sheet report, so you need to create
a chart template that summarizes net assets by fund to show how your fund balance is separated.

1. On the Visual Chart Organizer page, click New on the action bar. The Visual Chart Organizer - Design View
screen appears.

EQVisual Chart Organizer - Design View !EE

File Edit Wiew Template Favortes Toolz Help

AccountView|U|&ﬁ|ﬁEﬂ|N 1 b N|D|||§'|?' ‘

Template |D: I Status: IActive = I

Description: I

[E NewDetal Bl Mew Header/Tatal 7| o - -+

s {1 Balance Sheet
o] Income Statement

Header |

Balance Sheet

Header caption: |B alatice Sheet
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Glossary: A chart template is a visual representation in General Ledger 7.2 of all or selected accounts from the
general ledger. In General Ledger 7.2, you can create multiple chart templates, each with a different
presentation of accounts. Chart templates drive the presentation of accounts on financial statements.

2. Enter a Template ID for the chart template. The program uses this ID in reports, and it appears on the
chart of accounts.

3. Inthe Status field, select “Active”. If you select “Inactive”, the template does not appear for reports.

4. Inthe Description field, enter “GASB 34”. The template description appears in reports and displays on the
chart of accounts.

5. Inthe tree view, select Balance Sheet.

On the action bar, click New Header/Total to add new header and total lines below Balance Sheet in the
tree view. The Header and Total tabs appear at the bottom of the screen.

7. Inthe Header caption field, enter “Assets”.
In the Category field, select “Balance Sheet”.
9. Select the Total tab. “Total Assets” automatically appears in the Total caption field.
10. On the action bar of the Total tab, click the B so Total Assets appears in bold on reports.
11. In the Skip field, select “2”.
12. In the tree view, select Assets.
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13. On the action bar, click New Detail. The program adds the Account Detail - Assets line under Assets in
the tree view. The Account Detail Formatting and Account Detail Definition tabs appear at the bottom of
the screen.

14. Select the Account Detail Definition tab.

15. In the Include field, choose the “Selected accounts using advanced filter” option. You can use filters such
as funds, accounts, or attributes. You can also filter by selecting individual accounts or funds, and select a
range or use a query when filtering.

16. On the toolbar, click the Validate button. The Select a Parameter File screen appears with saved
parameter files in a grid.

17. After selecting a parameter file the program searches the database to ensure no accounts have been
duplicated or omitted from the template. The Standard Validation preview screen appears.

18. Close the preview. You return to the Visual Chart Organizer - Design View screen.

Note: You must save the template before you can change to Account View. If you click Account View, you get
a message asking if you want to save the template. Click Yes. The program saves the template, and Account
View appears.

19. To save the new template, click the Save button on the toolbar. You get a message telling you the
template has been saved.

20. On the toolbar, click Account View. The Visual Chart Organizer - Account View screen appears.

21. Now that you have created the template, you can create reports using it. Close the Visual Chart
Organizer - Design View screen. You return to the Visual Chart Organizer page and the “GASB 34"
template appears in the grid.
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Reporting categories in General Ledger include Account Reports, Allocation Reports, Budget Reports, Custom
Reports, Financial Statements, GASB 34 Reports, Grant Reports, Journal and Batch Reports, Pivot Reports, and
Project Reports.

This chapter discusses Grant Reports. For information about other report categories, see the chapter for that
category.

Note: We recommend you read the documentation for The Financial Edge thoroughly. Information presented
here provides you with basic information about account reports in General Ledger. Hands-on experience is the
best way to learn, so we encourage you to view this information and try various options with the sample
database.

Grant reports in General Ledger include:

¢ Grant Reimbursement Accounts Validation Report
e Grant Analysis Report

e “Grant Budget vs. Actual Report” on page 255

Grant Reimbursement Accounts Validation
Report

The Grant Reimbursement Accounts Validation Report lists any missing or duplicate accounts that have been
assigned to Grant billing items. We recommend you run this report prior to creating accounts receivable charges
for grants to ensure billing items have been assigned to the appropriate accounts.

The Grant Reimbursement Accounts Validation Report has tabs on which you set parameters: General, Filters,
and Format. To move among the tabs, click Next and Back at the bottom of the screen or select a tab. On these
tabs you specify the information to include in the report and how the report should look. For more information
about creating a Grant Reimbursement Accounts Validation Report, see “Creating a report in General Ledger” on
page 15.
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General Tab
On the General tab, you set parameters specific to the report and make selections about information included in

the report.

lQ New Grant Reimbursenment Accounts ¥alidation Report

File Edit Wiew Favorites Tools Help

B ESDF| a2

1. General |2: Filtersl 2 Fc-rmatl

[V Check for duplicate accounts

[v Include separate section for each fund

[~ Create an output queny of Imissing accounts 'l
Report onientation: ILandscape 'I

Frint | Freview Layout |

< Back | Hext > | Cancel |

Check for duplicate accounts. Mark Check for duplicate accounts to see a list of duplicate accounts in the

report.
Include separate section for each fund. Mark Include separate section for each fund to include a separate

section in the report for each fund.
Create an output query of accounts. If you mark Create an output query of accounts, the program creates
a query of the accounts included in the report. You can use the query later in other areas of General Ledger.

Note: To view the report as it will appear using your selections and filters, click Preview. To view a sample

layout of the report without data, click Layout.
Report orientation. In the Report orientation field, select “Landscape” or “Portrait”.
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Filters Tab

On the Filters tab, you include information based on selected criteria such as funds and accounts. For example,
you can include only the funds in a selected range. Funds not falling within the range do not appear on the report.
For more information about filtering in The Financial Edge, see the Program Basics Guide.

I New Grant Reimbursement Accounts Yalidation Report x|
File Edt Wiew Favorites Tools Help
Hasam g ?- |

1. General | | & Fc-rmatl

&5 0pen 7, Clear All Filters

Filkers I Include Selected Filkers

Funds all <Al Funds =

Accounts &l <Al Accounts =

Account attributes All <Al Account Attributes:

Cateqaries all <Al Categaories =

Department(s) all <Al Department{s)>

Grants all <Al Granks =

Grant tkributes &l <Al Grant Attribukes =

¢ Back | MHext > | Cancel | Frint | Freview | Layout |

Open. Click a filter in the grid and click Open on the action bar. The selection screen appears so you can
designate specific filters for the report.

Glossary: A filter is a requirement records must meet to be included in a report. For example, if you apply the
Accounts filter, only the accounts you select are included in the report. You can select filters to apply to a
report from the Filters tab. Be patient! Depending on the filters you select, this report may take several
minutes to run after you click Print or Preview.

Clear All Filters. Click Clear All Filters to remove all previously selected filters from the report.
Filters. The Filters column lists all the filters for this report. You cannot edit this column.

Include. Choose Selected in the Include column. A selection screen appears so you can designate specific filters
for the report.

Selected Filters. Filters you specify appear in the Selected Filters column. If you choose Selected in the Include
column or click a filter and then click Open, the Selected <Filter> screen appears. If you mark Selected, Range,
or Query, a selection screen appears so you can specify filters.

Query name. The Query name field appears if you select Query. Enter the name of the query to use to filter the
report or click the binoculars to search for a query.

To create a new query, click the binoculars and click Add a New Query on the Open Query screen. For more
information about creating queries, see the Query Guide.

Previous Filter. To view or edit the previous filter without returning to the Filters tab, click Previous Filter on
the toolbar.

Next Filter. To view or edit the next filter without returning to the Filters tab, click Next Filter on the toolbar.
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Format Tab

On the Format tab, you decide how the report should look. You can create headings and footers, include a list of
criteria used to create the report, and select the format for displaying monetary amounts.

The list on the left of the screen displa¥s formatting options for the Grant Reimbursement Accounts Validation
Report: Headings, Criteria, Sort, Page Footer, Report Footer, and Miscellaneous. When you select an item in the
list, the right side of the screen displays selections for that section of the report.

Note: The heading defaults to Grant Reimbursement Accounts Validation Report in the Title field. You can
leave this as the title for the report or enter your own.

Headings. Use Headings to enter a maximum of 60 characters in each of the Title and Subtitle fields. The title
and subtitle appear at the top of the report. You can select how the heading should be aligned and whether
your organization's name will appear in the header. You can include the page number and the date in the
heading. You can also select to include the heading on every page of the report.

I3 New Grant Reimbursement Accounts Yalidation Report x|

File Edit Yiew Favorites Tools Help
o

FIEEET e
1: General | 2 Filters §
B Headings Headings

Criteria .

Sort —Heading Format

Page Foater Title: IGrant R eimbursement dccounts Y alidation Repart
Report Footer S ublitle: I

Miscellaneous
Aligr: IEenter 'I

[ Prirt arganization narme in header

- ‘

¥ Print Page Mumber in Heading [# Piint Report Date in Heading
Format; IF'age 1 j Farmat: IShc-rt Date and Tine j
Aligre [Right = || Aigne Lt =l

[V Print report heading on each page

< Back et Cancel Print Previsw Layout

Note: The program automatically selects all criteria. Unmark the checkbox for any you do not want to print
with the report.
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Criteria. Select Criteria to print a list of criteria used to create the report. Mark Print these criteria on and select
a separate page or the first page. Selections print in the criteria section of the report.

lE Mew Grant Reimbursement Accounts Yalidation Report il

File Edit View Favorites Tools Help

Ha3a al=?- |

1: General' 2 Filters 3 Format |

Headings

i85 Criteria

Sort v Print these criteria an Ia separate page 'l
Page Footer Saved report name

H?D'th Footer Output queny name

Miscellaneous Funds ta include

Accounts to include

Account attributes to include
Categories to include

Department(s] to include

Grants to include

Grant attributes to include

Check for Duplicate accounts

Include separate section for each Fund

< Back | ([ | Cancel | Brint | Freview | Laypout |

Sort. Use Sort to select the order for grants to appear on the report. When you select Sort, a grid displays Grant
ID in the Sort by column. You can also choose to sort by Grant Description. Select “Ascending” or
“Descending” in the Order by column. To print each grant on a separate page, mark Page break on each new
Grant ID.

A& New Grant Reimbursement Accounts ¥alidation Report i x|

File Edit View Favorites Tools Help

Hda3sa o= 2 |

gl General' 2 Filters 3 Format |

Headings Sort

Criteria

f Sort by | Crder by I
Grant ID Ascending

Report Faater
Miscelaneous

™ Page break on each new Grant |0

< Back [ ewt 2 Cancel Erint Freview Lapout
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Page Footer. Use Page Footer to create a footer to appear at the bottom of each page of the report. You can
enter a maximum of 254 characters in the Text field for the page footer. You can also select how to align the
text and include the page number and date in the footer.

M@ New Grant Reimbursement Accounts Yalidation Report x|

File Edit Yiew Favorites Tools Help

EIEEETEIRIEIE S |

il General' 2 Filters  3: Format |

Headings Page Footer
Criteria PR
Sart — Fage rooler | exl

{8 Page Foater Tent:

Feport Footer
Miscellaneous

Aligr: IEenter 'I

I Print Page Number in Footer [~ Piint Report Date in Foater
Format; IF'age 1 j Farmat: IShc-rt Date and Time j
Aligr: IHight j Aligr: ILeﬂ j

< Back | [ et > | Cancel | Erint | Freview | Lapout |

Report Footer. Use Report Footer to create a footer to appear at the bottom of the last page of the report. You
can enter a maximum of 254 characters in the Text field for the report footer and select how to align the text.

I New Grant Reimbursement Accounts Yalidation Report x|

File Edit View Faworites Tools Help

dasam = ?- |

s General' 2 Filkerz 3 Format |

Headings Report Footer

=] Criteria
Soit Report Footer Text
Page Footer Teut:

:8 Report Footer
Mizcelansous

Aligr: ILeft vl

Tip: Make selections for displaying amounts and view them in the Sample amount display before printing the
report.
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Miscellaneous. Use Miscellaneous to specify how numbers will appear on the report and the font size for the
report.

1@ New Grant Reimbursement Accounts Yalidation Repork e il
File Edit View Favorites Tools Help

Hda3sa o= 2 |

gl General' 2 Filters 3 Format |

Headings Miscellaneous
Criteria

Sort Show currency characker on Al amounts
Page Footer Showe percent sign on Al amounts
Report Footer Megative amaunt Farmat (1234.56]
i ¥ ! Mumber of digits after decimal For amounts 2

Murnber of digits after dacimal For percentages 2

Show 1000's separator Yes

Shows blanks instead of zeros Mo

Faont size g

Sample amovnt:

Amounk ($1,234.56)
Percent 100, 00%
< Back Ewt Cancel Brint Freview Laypout

Grant Analysis Report

You can use the Grant Analysis Report to view grant activity for a selected range. This report can help you
determine grant activity available to generate AR transactions, or activity not assigned to a billing item. This
report can be in a summary or detail format.

To run the Grant Analysis Report, you must have Projects and Grants and Accounts Receivable installed.

The Grant Analysis Report has tabs on which you set parameters: General, Filters, and Format. To move among
the tabs, click Next and Back at the bottom of the screen or select a tab. On these tabs you specify the
information to include in the report and how the report should look. For more information about creating a Grant
Analysis Report, see “Creating a report in General Ledger” on page 15.
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General Tab

On the General tab, you set parameters specific to the report and make selections about information included in
the report.

lQ New Grant Analysis Report 5[

File Edit Wiew Favaorites Tools Help

Hadag =2
1: General |g: Filtersl 53 Folmatl
Repor e [N ~ |
Include Grant activity it this date range -
Drate: |<Specific figeeal periods> j 10407 /2006 ba 10431 /2006
Start fiscal pear: IThis figcal pear j Start period: ILast fizcal period 'l
End fizcal pear: IThis fiscal pear ﬂ End period: ILast fizcal period 'l
i- Exclude Grants with no activity ¥ Include activity for funded projects

Include the following Grant information:

[ Activity used to gemerate AR transactions
[ Activity available to generate AR transactions
[V Activity naot assigned to a biling item

Include these tranzaction types: I Fegular j

[~ Create an output query of grants
Report arientation: I Landscape T I

< Back | Mest » | Cancel | Frint | Preview | Lapout |

Report type. In the Report type field, select “Summary” or “Detail”.

Date. In the Date field of the Include Grant activity in this date range frame, you can select a specific date or
date range for grant activity to include.

If you select <Specific range>, <Specific fiscal periods>, or <Specific fiscal year>, you can specify a start date
and an end date. If you leave the Start date field blank, all activity is included up to the end date. If you leave
the End date field blank, all activity from the start date until present is included. If you leave both fields blank,
all activity is included.

Exclude Grants with no activity. If you mark this option, you can efficiently exclude grants from the report
that have no activity.

Include activity for funded projects. If you mark this option, you can show activity for funded projects in the
report. Funded projects for grants are located on the Project tab of the Grant record.

Include the following Grant information. In this frame, you can select what sections/activity you want to
appear on the report.

Include these transaction types. Use this field to select what types of transactions to include in the report.
You can select “Regular”, “Encumbrance”, or “Regular and Encumbrance” This field appears only if you have
the optional module Purchase Orders installed.

Create an output query of Grants. If you mark Create an output query of Grants, the program creates a
query of the grants included in the report. You can use the query later in other areas of General Ledger.
Note: To view the report as it will appear using your selections and filters, click Preview. To view a sample
layout of the report without data, click Layout.

Report orientation. In the Report orientation field, select “Landscape” or “Portrait”.
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Filters Tab

On the Filters tab, you include information based on selected criteria such as funds and accounts. For example,
you can include only the funds in a selected range. Funds not falling within the range do not appear on the report.
For more information about filtering in The Financial Edge, see the Program Basics Guide.

lQ New Grant Analysis Report 5[
File Edit WYiew Favaorites Tools Help
B3 - |
1: General { i| 3 Format I
Filters | Include Selected Filkers |ﬂ
Funds &l <Al Funds =
Accounts &l <Al Accounts =
Account Codes &l <Al Account Codes =
Account Attributes all <Al Account Attributes =
Grants &l <Al Grants>
Grant Attribukes &l <Al Grant Attribukes:
Projects Al <All Projects =
Project Attributes all <Al Project Attributes =
Classes all Al Classes=>
Transaction Attribukes &l <Al Transackion Attribukes =
Journals &l <Al Journals=
Tission{s) all <Al Missiongs) =
Spendable/hon-Spendabl... Al <Al SpendablefMon-Spendableis) > LI
< Back | Mext » | Cancel | FErint | Preview | Lapout |
|

Open. Click afilter in the grid and click Open on the action bar. The selection screen appears so you can
designate specific filters for the report.

Clear All Filters. Click Clear All Filters to remove all previously selected filters from the report.
Filters. The Filters column lists all the filters for this report. You cannot edit this column.

Include. Choose Selected in the Include column. A selection screen appears so you can designate specific filters
for the report.

Selected Filters. Filters you specify appear in the Selected Filters column. If you choose Selected in the Include
column or click a filter and then click Open, the Selected <Filter> screen appears. If you mark Selected,
Range, or Query, a selection screen appears so you can specify filters.

Query name. The Query name field appears if you select Query. Enter the name of the query to use to filter the
report or click the binoculars to search for a query.

To create a new query, click the binoculars and click Add a New Query on the Open Query screen. For more
information about creating queries, see the Query Guide.

Previous Filter. To view or edit the previous filter without returning to the Filters tab, click Previous Filter on
the toolbar.

Next Filter. To view or edit the next filter without returning to the Filters tab, click Next Filter on the toolbar.

Format Tab

On the Format tab, you decide how the report should look. You can create headings and footers, include a list of
criteria used to create the report, and select the format for displaying monetary amounts.



GRANT REPORTS 25

The list on the left of the screen displays formatting options for the Grant Analysis Report: Headings, Criteria,
Detail, Sort/Break, Page Footer, Report Footer, Miscellaneous and Color Scheme. When you select an item in
the list, the right side of the screen displays selections for that section of the report.

Note: The heading defaults to Grant Analysis Report in the Title field. You can leave this as the title for the
report or enter your own.

Headings. Use Headings to enter a maximum of 60 characters in each of the Title and Subtitle fields. The title
and subtitle appear at the top of the report. You can select how the heading should be aligned and whether
your organization’s name will appear in the header. You can include the page number and the date in the
heading. You can also select to include the heading on every page of the report.

lQ New Grant Analysis Repork 5'

File Edit “iew Favorites Tools Help

Hada®E o= ?- |

B Headeg:

1 Generall 2: Filters

Criteria
Detai — Heading Farmat
Sort/Break Title: IGrant Analyziz Repart
Page Foater Subtitle: I

Report Footer

Mizcellaneous Aligr: ICenter 'l

Colar Scheme . e =
[¥ Print organization name in header

v Print Page Number in Heading ¥ Frint Beport Date in Heading ———
Farmat; IF'age 1 j Farmat; IShort Date and Time j
Align: | Right =] || A Left =]

v Print repart heading on each page

< Back | st > Cancel FErint Freview Layout

Note: The program automatically selects all criteria. Unmark the checkbox for any you do not want to print
with the report.
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Criteria. Select Criteria to print a list of criteria used to create the report. Mark Print these criteria on and select
a separate page or the first page. Selections print in the criteria section of the report.

lE New Grant Analysis Report 5[

File Edit Yiew Favaorites Tools Help

dasawa=?- |

1 General' 2 Filters 3 Format I

| 5] Headings Criteria
Detail [¥ Frirt these criteria on Ia separate page 'I

Sort/Break Saved report name S
Page Foater Output query name =
Report Footer [ates ko include
Miscellaneous Exrclude no activity Grants
Color Scheme Include Funded Projects
Tranzaction types to include
Grants o include
Grant attibutes to include
Funds to include
Ancaunts to include
Account codes to include
[w] Azcount attributes o include
Frojects ta include
Project attributes o include
Claszes to include
Transaction attibutes to include ;l

< Back | Hext s | Cancel | FErint | Freview | Layout

Detail. Use Detail to select details specific to the Grant Analysis Report.

Show distribution for these characteristics — Mark this checkbox to select distributions to include in the
report. The program adds a column to the report displaying distributions for the selected characteristic for
each row with a distribution.

Show characteristic as a column in the main report body — Mark this checkbox to show characteristics as a
column in the report. This option is disabled unless you mark Show distribution for these characteristics.

Show transaction total — Mark this checkbox to show the total distributed characteristics in the Debit
Amount or Credit Amount column for the account row. This option is disabled unless you mark Show
distribution for these characteristics.

Show net change column — Mark this checkbox to display the Net Change column on the report. This
checkbox is available only if you select to run the report in Detail.
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Show reimbursement information — Mark this checkbox to display reimbursement information on the
report.

lQ New Grant Analysis Report 5[

File Edit Yiew Favaorites Tools Help

dadam -
1 General' 2 Filters 3 Format I
Headings Detail
Criteria
W iShaow distibution for thess characteristics
Sort/Break -
W
Page Footer v Pro!ect ID -
[¥ Project Dezcription
Repart Faater ¥ Class
Mizcellaneous [ Missian

Lolor Scheme [¥ SpendableM on-5pendable

[¥ Performance Up |
Daown |

I | Show characteristic as & ealummn in the mait repork Bady

I~ Shaw transaction tatal

¥ | Show net change eolimn

[V Show reimbursement information

< Back | Hext s | Cancel | FErint | Freview | Layout |

Sort/Break. Use Sort/Break to select the order for information to appear on the report and where breaks fall
between sets of information. When you select Sort/Break, a grid displays the categories you can sort in the
report. Select a sorting category in the Sort by column and select Ascending or Descending in the Order by
column. To start a new page for each Sort by selection, mark Page break on each new <Sort by selection>.

lQ MNew Grant Analysis Report ﬂ

File Edit ‘iew Favorites Tools Help

dasaw o= - |

1 General' 2: Filters 3 Format I

Headings Sort{Break

Criteria

Detail Sork by | Cakegory I Order by I EBreaks |
=]

f ak
Page Foal

ter
Report Footer
Miscelameous
Color Scheme

[ | o o

Break Header far -

Text before walus: I

Tt after walue: |

BEireak Footer for -
I~ Erint count per,

I~ | Fiirit count as a percentage of total
I™ Fage break o each new

< Back | st > | Cancel | Frint Freview Lapout
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Page Footer. Use Page Footer to create a footer to appear at the bottom of each page of the report. You can
enter a maximum of 254 characters in the Text field for the page footer. You can also select how to align the
text and include the page number and date in the footer.

lQ New Grant Analysis Repork 5'

File Edit “iew Favorites Tools Help

Hasaw = ?- |

1 Generall 2: Filters  3: Farmat I

Headings Page Footer

Criteria
Detail — Page Footer Text
Saort/Break Text:

B Page Footer
Report Foater
Mizcellaneous

Color Schemne Aligr: I Center T l

=T Print Page Mumber in Footer ———— — [ Print Beport Date in Footer —————
Farmat; IF'age 1 j Farmat; IShort [rate and Tine j
Aligr: IHight j Aligr: ILeft j
< Back | Hext s | Cancel | FErint | Preview | Layout |

Report Footer. Use Report Footer to create a footer to appear at the bottom of the last page of the report. You
can enter a maximum of 254 characters in the Text field for the report footer and select how to align the text.

lQ New Grant Analysis Repork 5'

File Edit Yiew Favorites Tools Help

Al

HEadam =2

1 Generall 2: Filters  3: Farmat I

Report Footer
Criteria 5 R
Detail eport Footer Tex

Sort/Break Text:
Page Footer

‘B Feport Footer
Mizcellaneous

Colar Scheme Align: m

< Back | Hiest > Cancel FErint Freview Layaout

Tip: Make selections for displaying amounts and view them in the Sample amount display before printing the
report.
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Miscellaneous. Use Miscellaneous to specify how numbers will appear on the report and the font size for the

report.
lQ New Grant Analysis Report 5[
File Edit Yiew Favaorites Tools Help
2| m A oo %
FIEET-I=IEER
1 General' 2 Filters 3 Format I
Headings Miscellaneous
Criteria
Detail Show currency character on All amounts
Saort/Break Show percent sign on All amounts
:age FDFDtEI Megative amount Format {1234.56)
4 b
] Report Fos er Murnber of digits after decimal for amounts hed
: Color Schemne Murnber of digits after decimal far percentages 2
Show 1000's separator Yes
Show blanks instead of zeros Mo
Font size -1
Sample amount:
Arniounk ($1,234.56)
Percent 100,00%
< Back | Hexzts | Cancel | FErint | Preview | Layout |

Color Scheme. Use Color Scheme to select colors for report headings. When you click the color box next to the
selection, the Color screen appears so you can select a standard color or define a custom color. If you leave

the Apply a Color Scheme checkbox unmarked, the report prints in black and gray.

lQ New Grant Analysis Repork

File Edit “iew Favorites Tools Help

Hagdam o= ?-

1 Generall 2: Filters  3: Farmat I

Dietail [~ Apply a Calar Scheme
Sort/Break
Page Foater
Report Footer
Miscelaneous
‘B Color ne

. Calurnn heading back. calor
I_ Column heading fore colar
[~ Group heading back calar

. Group heading fore colar

Hestare [Defaults |

Headings Color Scheme
Criteria

Report Name
Subtitle

Group Headings

< Back | st > Cancel

FErint Freview Layout
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Grant Budget vs. Actual Report

The Grant Budget vs. Actual Report shows budget information and the actual activity of selected grants and
accounts. You can use this report to compare actual and budgeted revenue and expenses for a grant. This report
can be in a summary or detail format.

To run the Grant Budget vs. Actual Report, you must have Projects and Grants installed, and a transaction code
must be assigned for grant tracking activity. The grant activity tracking transaction code set up to enable
budgeting by grant. For more information about setting up a grant-tracking transaction code, see the General
Ledger Configuration Guide.

The Grant Budget vs. Actual Report has tabs on which you set parameters: General, Filters, and Format. To move
among the tabs, click Next and Back at the bottom of the screen or select a tab. On these tabs you specify the
information to include in the report and how the report should look. For more information about creating a Grant
Budget vs. Actual Report, see “Creating a report in General Ledger” on page 15.

General Tab

On the General tab, you set parameters specific to the report and make selections about information included in
the report.

1@ New Grant Budget vs. Actual Report 3 |

Eile Edit Wiew Favorites Tools Help

a5 =2
1: General IZ: Filtersl & Format'
Fepart type: Eiletail vl
Show budget details for -
Scenano |D: IEID Vl b air Operating Budget

[~ Use Grant tatal expense budgets

Include budgets in thiz date range:

Date: |This fiscal pear x| 01701 /2007 to 12/31 /2007

[ Include activity for funded Projects [ Include balance sheet accounts

[ Include Grants with no activity

Include these transaction types: | Regular j
Report arientation: I Partrait e l

< Back | Mext » | Cancel | Frint | Freview | Lapout |

Report type. In the Report type field, select “Summary” or “Detail”.

Glossary: A budget scenario is a single version of an organization’s budget for a given time period. You can
have multiple budget scenarios if you have the optional module Budget Management. For example, you can
create a scenario of your original budget and also create scenarios for various revisions of that budget.

Scenario ID. In the Scenario ID field, select the budget scenario for the report to use. A description of the
scenario appears in the display to the right.

Use Grant total expense budgets. Mark this option to show the grant total expense budgets. The total
budget for expense accounts displays on the report instead of the individual period amounts.
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Date. In the Date field of the Include budgets in this date range frame, you can select a specific date or date
range for budget activity to include.

If you select <Specific range>, <Specific fiscal periods>, or <Specific fiscal year>, you can specify a start date
and an end date. If you leave the Start date field blank, all activity is included up to the end date. If you leave
the End date field blank, all activity from the start date until present is included. If you leave both fields blank,
all activity is included.

Include activity for funded Projects. If you mark this option, you can show activity for funded projects in
the report. Funded projects for grants are located on the Project tab of the Grant record.

Include Grants with no activity. If you mark this option, grants with no activity will be included in the report.
Include balance sheet accounts. Mark this checkbox to include balance sheet accounts.

Include these transaction types. Use this field to select what types of transactions to include in the report.
You can select “Regular”, “Encumbrance”, or “Regular and Encumbrance” This field appears only if you have
the optional module Purchase Orders installed.

Note: To view the report as it will appear using your selections and filters, click Preview. To view a sample
layout of the report without data, click Layout.

Report orientation. In the Report orientation field, select “Landscape” or “Portrait”.

Filters Tab

On the Filters tab, you include information based on selected criteria such as grants and grant attributes. For
example, you might include only the grants in a selected range. Grants not falling within the range do not appear
on the report. For more information about filtering in The Financial Edge, see the Program Basics Guide.

1@ Hew Grant Budget vs. Actual Report : x|
File Edit Wiew Favorites Tools Help
Ha3saE =2 |
Filters | Indude Selected Filters Iﬂ
Funds Al <All Funds >
Account Codes all <Al Account Codes >
Accounts Al <Al Accounts =
Account Attributes Al <All Account Attributes =
Categories all <All Categories =
Grants all <All Grants>
Grant Attributes Al <All Grant Attributes>
Projects All <All Projects>
Project Attributes All <All Project Attributes =
Project Types All <All Project Types >
Project Statuses all <Al Project Statuses =
Project Divisions All <All Project Divisions =
Project Departments All <All Project Departments > LI
< Back | Mext = | Cancel | FErint | Freview | Layout |
|

Open. Click a filter in the grid and click Open on the action bar. The selection screen appears so you can
designate specific filters for the report.



257 CHAPTER

Glossary: A filter is a requirement records must meet to be included in a report. For example, if you apply the
Accounts filter, only the accounts you select are included in the report. You can select filters to apply to a
report from the Filters tab. Be patient! Depending on the filters you select, this report may take several
minutes to run after you click Print or Preview.

Clear All Filters. Click Clear All Filters to remove all previously selected filters from the report.
Filters. The Filters column lists all the filters for this report. You cannot edit this column.

Include. Choose Selected in the Include column. A selection screen appears so you can designate specific filters
for the report.

Selected Filters. Filters you specify appear in the Selected Filters column. If you choose Selected in the Include
column or click a filter and then click Open, the Selected <Filter> screen appears.

Previous Filter. To view or edit the previous filter without returning to the Filters tab, click Previous Filter on
the toolbar.

Next Filter. To view or edit the next filter without returning to the Filters tab, click Next Filter on the toolbar.

Format Tab

On the Format tab, you decide how the report should look. You can create headings and footers, include a list of
criteria used to create the report, and select the format for displaying monetary amounts.

The list on the left of the screen dislflays formatting options for the Grant Budget vs. Actual Report: Headings,
Criteria, Sort/Break, Page Footer, Report Footer, Miscellaneous and Color Scheme. When you select an item in
the list, the right side of the screen displays selections for that section of the report.

Note: The heading defaults to Grant Budget vs. Actual Report in the Title field. You can leave this as the title
for the report or enter your own.

Headings. Use Headings to enter a maximum of 60 characters in each of the Title and Subtitle fields. The title
and subtitle appear at the top of the report. You can select how the heading should be aligned and whether
your organization’s name will appear in the header. You can include the page number and the date in the
heading. You can also select to include the heading on every page of the report.

&} New Grant Budget vs. Actual Report X|

File Edit View Favorites Tools Help

IR |

1 General' 2: Filters

T

Criteria ;

Somt/Braak r— Heading Format

Page Footer Title: IGrant Budaget vs. Actual Report
Fleport Footer Subte: |

Mizcellaneous
Calor Scheme Aligr: IEenter 'l

[w Print organization name in header

¥ Print Page Number in Heading [V Frint Report Date in Heading
Format: IF'age 1 j Format: IShort [rate and Time j
aligr: [Fight =] || g [Len =

¥ Frint report heading on each page

< Back | st » Cancel Frint Freview Lapout
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Note: The program automatically selects all criteria. Unmark the checkbox for any you do not want to print

with the report.

Criteria. Select Criteria to print a list of criteria used to create the report. Mark Print these criteria on and select

a separate page or the first page. Selections print in the criteria section of the report.

I3 New Grant Budget vs. Actual Report
File Edit View Favorites Tools Help

dada@ o= 2-

il General' 2: Filters 3 Format I

Headings

Transaction types to include
Include balance sheet accounts
Tranzaction types to include
Aocounts boinclude

[w] Accounts atttibutes to include
Clazzesz to include

Funds to include

Grants to include

Grant attibutes to include
Include activity for Funded Projects
AccountCodes to include
Categories to include

SDta"B[Bak [V Frint these criteria on Ia separate page 'I

Page Footer Saved report name =
H?DOW Faater Output query name

Miscellaneous Seenario D to include

Color Scheme Dates to include

[

¢ Back | st > | Cancel |

Frint | Previeﬂl Lapout |

Sort/Break. Use Sort/Break to select the order for information to appear on the report and where breaks fall
between sets of information. When you select Sort/Break, a grid displays the categories you can sort in the
report. Select a sorting category in the Sort by column and select Ascending or Descending in the Order by
column. To start a new page for each Sort by selection, mark Page break on each new <Sort by selection>.
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You can also create breaks between the sections you have sorted by. In the Text before value and Text after
value fields, you can enter up to 30 characters in each field for information to print directly before and after
the break. If you mark Print count per Grant ID or Print count as percentage of total for the selected sort
field, the number or percentage for each selected sort option appears in the footer. If you mark Page break
on each new Grant ID, a new page starts for the highest level break.

& New Grant Budget vs. Actual Report X|

File Edit View Favorites Tools Help

dasaw o= - |

1 General' 2: Filters 3 Format I

Headings Sort/Break
Criteria

] : Sort by I Order by | Break? H
Fage Footer Grant ID Ascending -
Report Faater r
Mizcellaneous r
Calor Scheme

r

O i

Break Header for Grant D -

Text before walus: I

Tt after walue: |

Break Footer for Grant [D-
I~ Erint count per Grant [0

I~ | Fiitit count as a percentage of total
I™ | Fage brezk oneach nev Grant [

< Back | st » | Cancel | Frint | Freview | Lapout |

Page Footer. Use Page Footer to create a footer to appear at the bottom of each page of the report. You can
enter a maximum of 254 characters in the Text field for the page footer. You can also select how to align the
text and include the page number and date in the footer.

A3 New Grant Budget vs. Actual Report x|

File Edit Yiew Favorites Tools Help

dadam

1 General' 2 Filters 3 Format I

Headings Page Footer
Criteria

Sort/Braak r— Page Footer Text

‘B Page Footer Test:

Report Footer

Mizcellaneous

Color Scheme
Align: IEenter 'l

[~ Print Page Number in Footer ——— [~ Print Repart Date in Footer ————

Farmat: IF'age 1 j Farmat: IShort Date and Time j
aligre [Fight = | | g [Len =

< Back | Hewt » Cancel FErint Preview Lapout
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Report Footer. Use Report Footer to create a footer to appear at the bottom of the last page of the report. You
can enter a maximum of 254 characters in the Text field for the report footer and select how to align the text.

I3 new Grant Budget vs. Actual Report x|

File Edit View Favorites Tools Help

Basawal=?- |

1 General' 2 Filters 3 Format I

Headings Report Footer

Criteria

Sot/Break Repart Foober Text
Page Footer Text:
‘B Report Footer
Miscelameous
Color Scheme

Aligr: I Left - l

< Back Hext s Cancel FErint Freview Layout

Tip: Make selections for displaying amounts and view them in the Sample amount display before printing the
report.

Miscellaneous. Use Miscellaneous to specify how numbers will appear on the report and the font size for the
report.

I3 New Grant Budget vs. Actual Report |

File Edit Wiew Favorites Tools Help

dadamalde- |

bl General' 2: Filters 3 Format I

Headings Miscellaneous
Criteria
Sot/Break Show currency character on All amounts

Page Footer Show percent sign on All amounts
Report Footer Negative amount format (1234.56)

5 Color S Mumber of digits after dedmal for amounts 2
Mumber of digits after dedmal for percentages 2
Show 1000's separator ‘fes
Show blanks instead of zeros Mo
Font size 8

Sample amount:

Amount ($1,234.56)
Percent 100.00%

< Back | st » Cancel Frint Freview Lapout
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Color Scheme. Use Color Scheme to select colors for report headings. When you click the color box next to the

selection, the Color screen appears so you can select a standard color or define a custom color. If you leave
the Apply a Color Scheme checkbox unmarked, the report prints in black and gray.

I8 new Grant Budget vs. Actual Report

b

File Edit Yiew Favorites Tools Help
EIFEEIEIRIEIR R |

1 Generall 2: Filters  3: Farmat I

Headings Color Scheme

Criteria

Sort/Break I” Apply & Color Scheme Report Name

Page Footer M Colurn heading back colar Subtitle

Report Footer

‘B Color

I~ Group heading back calar Group Headings

. Group heading fore colar

Frestare Defaults |

< Back Hext s Cancel FErint Preview Layout
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Reporting categories in General Ledger include Account Reports, Allocation Reports, Budget Reports, Financial
Statements, GASB 34 Reports, Journal and Batch Reports, Pivot Reports, and Project Reports. This chapter
discusses Journal and Batch Reports. For information about other report categories, see the chapter for that
category.

Note: We recommend you read the documentation for The Financial Edge thoroughly. Descriptions presented
here provides you with basic information about journal and batch reports in General Ledger. Hands-on
experience is the best way to learn, so we encourage you to try various options with the sample database.

Journal and batch reports in General Ledger include:
¢ Batch Detail Report
Batch Summary Report

e Recurring Batch Detail Report

Recurring Batch Summary Report
¢ Transaction Journal

Batch Detail Report

The Batch Detail Report provides detailed information about selected batches and transactions within those
batches. This report can include the batch number, batch description, number of transactions, balance, status,
date posted, who created and posted the batch, and batch notes. Transaction information includes transaction
number, account number, account description, journal, journal reference, transaction date, transaction debit or
credit amount, and transaction distribution details.

Glossary: A batch is a group of debit and credit transactions posted to ledger accounts. By placing transactions
in a batch, you can group transactions according to source, date, time, and function. For more information
about batches, see the Journal Entry Guide.

The Batch Detail Report has tabs on which you set parameters: General, Filters, and Format. To move among the
tabs, click Next and Back at the bottom of the screen or select a tab. On these tabs you specify information to
include in the report and how the report should look. For more information about creating a Batch Detail Report,
see “Creating a report in General Ledger” on page 15.
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General Tab

On the General tab, you set parameters specific to the report and make selections about information included in
the report.

I@ Hew Batch Detail Report I
Fil=e Edit “iew Favortes Toolz Help

RS W -2 |

1: General |2: Fillersl 2 Farmat |

Ihclude batches created on these dates -

Creation date: IInc:Iude all dates ﬂ

Ihciude batches with these statuzes -

[+ Open [+ Pending Approval ¥ Approved [ Posted
Inciude batches with these post dates:
Past date: IIncIude all dates j

Inciude batches lagt changed on these dates -

Change date: IIncIude all dates j

[~ Create an output query of transactions

R eport orientation; ILandscape 'I

Creation date. In the Creation date field, select a creation date range or specific creation date for the batches
to include in the report.

If you select <Specific range>, you can specify a start date and an end date. If you leave the Start date field
blank, all activity is included up to the end date. If you leave the End date field blank, all activity from the start
date until present is included. If you leave both fields blank, all activity is included.

Include batches with these statuses. In the Include batches with these statuses frame, mark Open,
Pending Approval, Approved, or Posted.

Post dates. In the Post dates field, select a post date range or specific post date.
Change dates. In the Change dates fields, select a change date range or specific change date.

Create an output query of transaction. If you mark this option, the system creates a query of the
transaction you select and includes it in the report. This query is available for use in other areas of the
program.

Note: To view the report as it will appear using your selections and filters, click Preview. To view a sample
layout of the report without data, click Layout.

Report orientation. Landscape is the only report orientation available for this report.
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Filters Tab

Glossary: A filter is a requirement records must meet to be included in a report. For example, if you apply the
Accounts filter, only the accounts you select are included in the report. You can select filters to apply to a
report from the Filters tab. Be patient! Depending on the filters you select, this report may take several
minutes to run after you click Print or Preview.

On the Filters tab, you can include information based on selected criteria such as batches, journals, accounts, and
classes. For example, you can include accounts within a selected range, and accounts not falling within the range
do not appear on the report.

New Botch Detailfopor |
Fil=  Edit “iew Favortes Toolz Help
SRR |

1: General  2: Filters I 2 Format |

@ 0pen ) Clear Al Filters

Filkers I Include Selected Filters

Bakches all <Al Batches >

Batches Created By all <Al Batches Created By >

Batches Posted By all «<all Batches Posted Buw

Journals all <Al Journals =

Accounts all <Al Accounts >

Projects all <all Projects=

Classes all il Classes =

Account Attributes all <All Account Attributes >

Transaction Attributes all <All Transaction Attributes=

Project Attributes all <Al Project Aktribukes =

Mlisionis) all <Al Missions) =

apendable/Mon-3pendableds) Al <4l sSpendablefMon-3pendablels) =

Perfarmancels) all <8l Performancels) =

Open. Click a filter in the grid and click Open on the action bar. The selection screen appears so you can
designate specific filters for the report.

Clear All Filters. Click Clear All Filters to remove all previously selected filters from the report.
Filters. The Filters column lists all the filters for this report. You cannot edit this column.

Include. Choose Selected in the Include column. A selection screen appears so you can designate specific filters
for the report.

Note: Mark Selected, Range, or Query to include a selected filter, range of filters, or a previously created
query of filters. Depending on the selection, different options appear on the screen. If you mark All, you cannot
define filters. For more information about filtering in The Financial Edge, see the Program Basics chapter in the
Program Basics Guide.

Selected Filters. Filters you specify appear in the Selected Filters column. If you choose Selected in the Include
column or click a filter and then click Open, the Selected <Filter> screen appears. If you mark Selected, Range,
or Query, a selection screen appears so you can specify filters.

Query name. The Query name field appears if you select Query. Enter the name of the query to use to filter the
report or click the binoculars to search for a query.

To create a new query, click the binoculars and click Add a New Query on the Open Query screen. For more
information about creating queries, see the Query Guide.
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Previous Filter. To view or edit the previous filter without returning to the Filters tab, click Previous Filter on
the toolbar.

Next Filter. To view or edit the next filter without returning to the Filters tab, click Next Filter on the toolbar.

Format Tab

On the Format tab, you decide how the report should look. You can create headings and footers, include a list of
criteria used to create the report, sort the information in the report, and select the format for displaying
monetary amounts.

The list on the left of the screen displays formatting options for the Batch Detail Report: Headings, Criteria,
Detail, Grand Totals, Sort/Break, Page Footer, Report Footer, Miscellaneous, and Color Scheme. When you
select an item in the list, the right side of the screen displays selections for that section of the report.

Headings. You can enter a maximum of 60 characters in each of the Title and Subtitle fields. The title and
subtitle appear at the top of the report. You can select how the heading should be aligned and whether your
organization's name will appear in the header.

Note: The heading defaults to Batch Detail Report in the Title field. You can leave this as the title for the report
or enter your own.

You can include other options in the header, such as the page number and the date. You can also select to
include the header on every page of the report.

I Mew Batch Detail Report B=
File Edit “iew Favortes Toolz Help

e = el |

1 Genelall 2 Filters ~ 3: Format |

B Headings H eadings
Criteria

Detail —Heading Farmat
Grand Taotalz Title:  |Batch Detail Fieport
Sort/Break Subtitie: I

Page Footer

Report Footer Align: ICenter 'I

Miscelaneous

Color 5 cheme [ Print organization name in header
—Iv Print Page Murmber in Heading [V Print Report Date in Heading
Farmat; IF‘age 1 j Format: IShort Date and Time j
Aligre [Fiight =] || s [Leit =l

[¥ Print report heading on each page

Note: The program automatically selects all criteria. Unmark the checkbox for any you do not want to print
with the report.
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Criteria. Select Criteria to print a list of criteria used to create the report. Mark Print these criteria on and select
a separate page or the first page. Selections print in the criteria section of the report.

I New Batch Detail Report
Fil=  Edit “iew Fawortes Tools Help
H (&S g L

1 Genelal] 2: Filters ~ 3: Farmat l

= Headings Critena

S Detail [+ Frint these criteria on | a separate page h
=] Grand Totals w| Saved report name 1]
=] Srt/Break | Dutput query name

] Page Foater

2] Report Footer
2] Miscellaneous
] Colar Scheme

w| Creation dates to include
w| Batch statuges to include
w| Post dates o include

v| Change dates to include

v Accounts to include

w| Batches bo include

v Batches created by

v| Blatches posted by

v Journals to include

v Projects to include

w| Claszes to include

v Account attributes to include

w| Tranzaction attributes to include
w| Project attributes to include

[

Note: You can show project detail only if you have the optional module Projects and Grants.

Detail. Use Detail to select details specific to the Batch Detail Report. Mark the checkboxes to show distribution
by transaction characteristics. If you have the optional module Projects and Grants and have defined

transaction codes, additional checkboxes appear.

If you select to show distributions by only one characteristic, the Show characteristic as a column in the main
report body checkbox defaults to marked. With this option marked, the program adds a column to the report
displaying distributions for the selected characteristic for each row that has a distribution. The additional

column reduces the amount of pages used for the report when printing.

n Mew Batch Detail Heport
File Edt “iew Fawaortes Toolz Help

H <2 W 7 -

1 General] 2 Filters ~ 3: Farmat l

=] Criteria

[v¥ Show distibution for these characteristics

=] Sart/Break y
2] Page Footer
2] Report Footer
] Miscellaneous
=] Colar Scheme

[ Project Description
[T Class

_ |
Dot

W Show characteristic as a column in the main report body

-

[v Show batch header

[~ Show details for control accountz

[v Summarize account details by source tranzaction

2] Headings Detail
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Grand Totals. Use Grand Totals to show combined totals for transaction characteristics. If you have the
optional module Projects and Grants and have defined transaction codes, additional checkboxes appear.

I New Batch Detail Report

File Edit “iew Favortes Tool: Help
RS R0 -2 |
1: General' 2 Filters 3 Format |
Headings Grand Totals
Criteria
Detail [¥ Shaw combined tatals for these characternstics:
Grand Totals
e, [ Project 1D
Sort/Break . L
[ Project Description
Page Faoter [ Class
Feport Footer o
Miscelaneous I Mission
™ Spendable/Mon-Spendable
Color Scheme
[~ Performance Up |
Diown |

Sort/Break. Use Sort/Break to select the order that information appears on the report. When you select

Sort/Break, a grid displays the categories you can sort in the report. Select a sorting category in the Sort by
column and select Ascending or Descending in the Order by column.

If you make no selections in the Sort by column, the program sorts by the entire account number in ascending
order.
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You can also create breaks between the sections you have sorted by. In the Text before value and Text after
value fields, you can enter up to 30 characters in each field for information to print directly before and after
the break. If you mark Print count per [ ] or Print count as percentage of total for the selected sort field, the
number or percentage for each selected sort option appears in the footer. To start a new page with the
highest level break, mark Page break on each new [ ].

I New Batch Detail Report
File Edt “iew Fawortes Toolz Help

HRESRE = ?-
1 Generall 2: Filkers ~ 3: Format |

Headings Sort/Break
Criteria

Detail Sart by | Orderty | Break? |
Grand Taotals Batch Number
=]

Azcending

Page Footer

Feport Footer
Miscellaneaus
Color Scherne

o Vo o o

Break Header for Batch Mumber-

Teut before walue: I

Teut after value: |

Break Footer for Batch Murnber-
I | Eritit count pen Batel Mumber,
™| Erint count as & percentage of total

I” | Bage break an each new Bateh Numter

Page Footer. Use Page Footer to create a footer to appear at the bottom of each page of the report. You can
enter a maximum of 254 characters in the Text field for the page footer. You can also select how to align the
text and include the page number and date in the footer.

I New Batch Detail Report E
File Edit “iew Fawvortes Toolz Help

= = D= g

1 Generall 2 Filters 3 Farmat |

Headings Page Footer
Criteria

Detail — Page Footer Text
Grand Tatals Text:
Sort/Break

Fieport Footer

Mizcelaneous Align: Im
Colar Scheme

I Print Page Mumber in Footer [~ Piint Report Date in Footer
Format: IF'age 1 j Format: IStht Date and Time j

Aligr: [Right =] | | [Lett =
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Report Footer. Use Report Footer to create a footer to appear at the bottom of the last page of the report. You
can enter a maximum of 254 characters in the Text field for the report footer and select how to align the text.

I New Balance Sheet

File Edit “iew Fawvorites

HRS R0 - |

Tools  Help

1: General | 2 Filtersl 3 Columng | 4: Multiple Column Headingz  5: Format |

Heading:
Criteria
Detail

Sort

Page Footer

B Report Footer
Miscellaneous
Calor Scheme

Report Footer

Report Footer Test
Text:

Align: ILeft vl

Tip: Make selections for displaying amounts and view them in the Sample amount display before printing the

report.
Miscellaneous. Use Miscellaneous to specify how numbers appear on the report and the font size for the
report.
I Hew Batch Detail Report E

File Edit Wiew Favorites

= = R = Il 2

Tools Help

Headings
Criteria
Detail

Grand Totals
Sort/Break
Page Footer
Freport Footer

areous

- Calor Scheme

1: Generall 2 Filters 3 Format |

Miscellaneous

Show currency character on Al amounts
Show percent gsighn on Al amounts
Megative amount format [1234.56)
Mumber of digits after decimal for amounts 2

Mumber of digits after decimal for percentages 2

Show 1000's separator Tes

Show blanks instead of zems Mo

Font size a

Sample amount;

Amauint [$1.234.5E]

100.00%

Percert
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Color Scheme. Use Color Scheme to select colors for report headings. When you click the color box next to the

selection, the Color screen appears so you can select a standard color or define a custom color. If you leave
the Apply a Color Scheme checkbox unmarked, the reports prints in black and gray.

I} Mew Batch Detail Report
File Edit Wiew Favorites Toolz Help

RS R =] ?- |

1 Generall 2 Filters  3: Format |

Headings Color Scheme
Criteria

Detail [ Apply a Color Scheme Report Name
g;?;g;:fls . Column heading back color Subtitle
Page Footer [ Column heading fore color Column Headings

Fieport Foater
Miscellaneous
B Color Scheme M Gioup heading fore caolor

[ Group heading back calor Group Headings

Restore Defaults |

Batch Summary Report

The Batch Summary Report lists summary information for each batch. The information is displayed in a single line
format. This report includes the batch header and status information.

Glossary: A batch is a group of debit and credit transactions posted to ledger accounts. By placing transactions
in a batch, you can group transactions according to source, date, time, and function.

The Batch Summary Report has tabs on which you set parameters: General, Filters, and Format. To move among
the tabs, click Next and Back at the bottom of the screen or select a tab. On these tabs you specify information to

include in the report and how the report should look. For more information about creating a Batch Summary
Report, see “Creating a report in General Ledger” on page 15.

General Tab

Glossary: A parameter is any field, option, or filter that narrows information in a report and determines the
appearance of the report’s output. By specifying parameters, you customize output results of the report. For
example, you can apply filters, create a header and footer, or choose a color scheme for the report’s results.
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On the General tab, you set parameters specific to the report and make selections about information included in

the report.
IQ Hew Batch Summary Report E

Fil=  Edit “iew Fawortez Toolz Help

= D= R =

1: General |2: Fillersl 2 Format |

Include batches created on these dates -

Creation date: |Include all dates

Include batches with these statuses -
[+ Open

Inciude batches with these post dates:

Post date:

Change date:

¥ Pending Approval ¥ Approved [+ Posted ¥ Deleted
IIncIude all dates j

Inciude batches lagt changed on these dates -
IIncIude all dates j

R eport orientation: I Landzcape ™ I

Creation date. In the Creation date field, select a creation date range or specific creation date for the batches

to include in the report.

If you select <Specific range>, you can specify a start date and an end date. If you leave the Start date field
blank, all activity is included up to the end date. If you leave the End date field blank, all activity from the start
date until present is included. If you leave both fields blank, all activity is included.

Include batches with these statuses. In the Include batches with these statuses frame, mark Open,

Pending Approval, Approved, or Posted.

Post dates. In the Post dates field, select a post date range or specific post date.

Change dates. In the Change dates fields, select a change date range or specific change date.

Note: To view the report as it will appear using your selections and filters, click Preview. To view a sample
layout of the report without data, click Layout.

Report orientation. In the Report orientation field, select Portrait or Landscape.
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Filters Tab

On the Filters tab, you can include information based on selected criteria such as batches and the user who
created and posted batches. For example, you can include batches within a selected range, and batches not
falling within the range do not appear on the report.

lﬂ Mew Batch Summary Report E2
File Edit “iew Favortes Toolz Help

=R R = e |

1: General 2 Filtkers |§: Formall

&0 0pen 7 Clear &ll Filters
Filkers I Include | Selected Filkers |
Batches all <Al Batches=
Batches Created By all <Al Batches Created By
Batches Posted By all <Al Batches Posted By >

Open. Click afilter in the grid and click Open on the action bar. The selection screen appears so you can
designate specific filters for the report.

Clear All Filters. Click Clear All Filters to remove all previously selected filters from the report.

Glossary: A filter is a requirement records must meet to be included in a report. For example, if you apply the
Accounts filter, only the accounts you select are included in the report. You can select filters to apply to a
report from the Filters tab. Be patient! Depending on the filters you select, this report may take several
minutes to run after you click Print or Preview.

Filters. The Filters column lists all the filters for this report. You cannot edit this column.

Include. Choose Selected in the Include column. A selection screen appears so you can designate specific filters
for the report.

Selected Filters. Filters you specify appear in the Selected Filters column. If you choose Selected in the Include
column or click a filter and then click Open, the Selected <Filter> screen appears. If you mark Selected,
Range, or Query, a selection screen appears so you can specify filters.

Query name. The Query name field appears if you select Query. Enter the name of the query to use to filter the
report or click the binoculars to search for a query.

To create a new query, click the binoculars and click Add a New Query on the Open Query screen. For more
information about creating queries, see the Query Guide.

Previous Filter. To view or edit the previous filter without returning to the Filters tab, click Previous Filter on
the toolbar.

Next Filter. To view or edit the next filter without returning to the Filters tab, click Next Filter on the toolbar.

Format Tab

On the Format tab, you decide how the report should look. You can create headings and footers, include a list of
criteria used to create the report, sort the information in the report, and select the format for displaying
monetary amounts.



JOURNAL AND BATCH REPORTS 27

The list on the left of the screen displays formatting options for the Budget Summary Report: Headings, Criteria,
Sort, Page Footer, Report Footer, Miscellaneous, and Color Scheme. When you select an item in the list, the right
side of the screen displays selections for that section of the report.

Note: The heading defaults to Batch Summary Report in the Title field. You can leave this as the title for the
report or enter your own.

Headings. You can enter a maximum of 60 characters in each of the Title and Subtitle fields. The title and
subtitle appear at the top of the report. You can select how the heading should be aligned and whether your
organization's name will appear in the header.

You can include other options in the header, such as the page number and the date. You can also select to
include the header on every page of the report.

u Mew Batch Summary Report
File Edit ¥iew Favortes Toolz Help

H &S E W ?-

1 General] 2 Filters 2 Format l

Headings
=] Criteria .
=] Sort Heading Farmat
Z] Page Footer Title: |Batch Summary Report
=] Report Footer S ublite: |

=] Mizcellaneous
Z] Color Scheme Align: | Center h

¥ Print organization nanne in header

¥ Frint Page Mumber in Heading [V Print Report Date in Heading
Farmat: |Page 1 j Farmat: |Shnrt Date and Time ﬂ
Aligr: [Right = | g [Left =l

v Frint report heading on each page

Note: The program automatically selects all criteria. Unmark the checkbox for any you do not want to print
with the report.

Criteria. Select Criteria to print a list of criteria used to create the report. Mark Print these criteria on and select
a separate page or the first page. Selections print in the criteria section of the report.

“ HNew Batch Summary Report
File Edit %“iew Favortes Tools Help

H &S @ ?-

1: General] 2: Filters 3 Format ]

E] Headings Criteria

S Sant Iv Frint these critena on | a separate page e
=] Page Foater | Saved report name

=l Fhlaport Fonter | Creation dates to include

2] Mizcellaneous | Batch statuzes to include

2] Color Scheme v Past dates to include

v| Change dates to include
w| Batches o include
v| Batches created by
v| Batches posted by
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Sort. Use Sort to select the order that information appears on the report. When you select Sort, a grid displays

the categories you can sort in the report. Select a sorting category in the Sort by column and select Ascending
or Descending in the Order by column.

If you make no selections in the Sort by column, the program sorts by the batch number in ascending order.

Ig Hew Batch Summary Report
File Edit “iew Favortes Tools Help

e e = e e

1 Generall 2 Filterz  3: Format |

Headings Sort
Criteria
Sart Sart by | Crder by |
Page Faoter Batch Mumber Azcending
Report Footer

Miscellaneous
Color Scheme

Page Footer. Use Page Footer to create a footer to appear at the bottom of each page of the report. You can

enter a maximum of 254 characters in the Text field for the page footer. You can also select how to align the
text and include the page number and date in the footer.

lE MNew Batch Summary Report [ x|
File Edit “iew Favortes Tools Help

e R = e e |

1: General' 2: Filters 3 Farmat |

Headings Page Footer
Criteria Pane Footer Test
Sort [ Fage rooter | exl

B Page Footer Text:
Feport Foater
Mizcellaneous
Color Scheme

Align: IEenter 'I

I Print Page Mumber in Foater

[~ Piint Repart Date in Footer
Format: I Page 1 j Format: IShnrt [Date and Time j

Align: | Right 2 L [ =]
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Report Footer. Use Report Footer to create a footer to appear at the bottom of the last page of the report. You
can enter a maximum of 254 characters in the Text field for the report footer and select how to align the text.

lQ MNew Batch Summary Report
File Edit Yiew Favoites Toolz Help

N R = e |

1 Generall 2 Filkeers 3 Format |

Headings Report Footer
Criteria A | Foater Test
St eport Footer Tex

Page Footer Text:
B Report Footer
Miscellaneous
Color Scheme

Align: ILeft vl

Tip: Make selections for displaying amounts and view them in the Sample amount display before printing the
report.

Miscellaneous. Use Miscellaneous to specify how numbers appear on the report and the font size for the
report.

lg Mew Batch Summary Report
File Edt “iew Fawortes Toolz Help

= = RE = gl B

1 Generall 2: Filkers ~ 3: Format |

Headings Miscellaneous
Criteria

Sort Shaw cunmency character on Al amourts
Fage Foater Shaw percent zign on &1 amourts
Report Foater Megative amount format [1234.56]
5 Color Se MWumber of digits after decimal for amounts 2

MWumber of digits after decimal for percentages 2

Show 1000°: separatar Yes

Show blanks inztead of zeros Ha

Fant zize g

Sample amount;

Amait [$1.234.5E)
Percent 100.00%
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Color Scheme. Use Color Scheme to select colors for report headings. When you click the color box next to the
selection, the Color screen appears so you can select a standard color or define a custom color. If you leave
the Apply a Color Scheme checkbox unmarked, the reports prints in black and gray.

lQ Mew Batch Summary Report
File Edit “iew Fawvoritez Toolz Help

=Rl =R = e |
1 Generall 2 Filterz 3 Format |

Heading: Color Scheme

Criteria

Sart [~ Apply a Calor Scheme
Page Foter

Report Name

Fieport Faoter . Column keading back. color Subtitle
Mizcellaneaus [ Column heading fore color Column Headings

B Color Scheme

[~ Group heading back color Group Headings

. Group heading fore color

Festore Defauls |

Recurring Batch Detail Report

The Recurring Batch Detail Report provides detailed information about recurring batches and the transactions
within those batches. This report helps you check transaction detail information.

Glossary: A recurring batch is a template used to quickly create regular batches. Once you create a recurring
batch, you can use it repeatedly to create regular batches of transactions. This feature not only saves time but
can also prevent data entry errors. There are two types of recurring batches: recurring amount and recurring
percent. For more information about recurring batches, see the Journal Entry Guide.

The Recurring Batch Detail Report has tabs on which you set parameters: General, Filters, and Format. To move
among the tabs, click Next and Back at the bottom of the screen or select a tab. On these tabs you specify
information to include in the report and how the report should look. For more information about creating a
Recurring Batch Detail Report, see “Creating a report in General Ledger” on page 15.
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General Tab

On the General tab, you set parameters specific to the report and make selections about information included in
the report.

A& Hew Recuriing Batch Detail Report

File Edit “iew Favortez Toolz Help
RS0 -2 |

1. General |2: Filtelsl 3 Format |

Ihclude batches created on these dates -

Creation date: IIncIude all dates j

Include batches last used on theze dates

Date used: IIncIude all dates j

Ihclude batches lagt changed on these dates -

Change date:  [Include sll dates =l

Include these batch types: IHecuning Amaunt and Recuring Fized Percent j

Report onentation; I Landzcape ™ I

Creation date. In the Creation date field, select a creation date range or specific creation date for the batches
to include in the report.

If you select <Specific range>, you can specify a start date and an end date. If you leave the Start date field
blank, all activity is included up to the end date. If you leave the End date field blank, all activity from the start
date until present is included. If you leave both fields blank, all activity is included.

Date used. In the Date used field, select a date range or specific date the batch was last used.

Change date. In the Change date field, select a date range or specific date the batch was last changed.

Include these batch types. In the Include these batch types field, select Recurring Amount, Recurring Fixed
Percent, or Recurring Amount and Recurring Fixed Amount.

Note: To view the report as it will appear using your selections and filters, click Preview. To view a sample
layout of the report without data, click Layout.

Report orientation. Landscape is the only report orientation available for this report.
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Filters Tab

On the Filters tab, you can include information based on selected criteria such as batches, journals, accounts, and
account attributes. For example, you can include accounts within a selected range, and accounts not falling
within the range do not appear on the report.

@ Hew Recurring Batch Detail Report
Fil=e Edit “iew Favortez Toolz Help
HRe w2 |
1 General 2 Filters | 3 Format |
=, Clear All Filters
Filters I Include Selected Filkers
Bakches all <Al Batches
Batches Created By all <Al Batches Created By
Journals Al <Al Journals =
Accounts all <Al Accounts s
Projects all <8ll Projects=
Classes Al <Al Classes=>
Account Attributes all <Al Account Attributes =
Transaction Attributes Al <Al Transaction Attribukes =
Project Attributes all <all Project Attribukes =
Mlissiongs) all <Al Missions)=
Spendable/Mon-Spendableds) Al <Al Spendable/Mon-3pendableds) =
Performancels) all <Al Performancels) =

Open. Click a filter in the grid and click Open on the action bar. The selection screen appears so you can
designate specific filters for the report.

Clear All Filters. Click Clear All Filters to remove all previously selected filters from the report.

Glossary: A filter is a requirement records must meet to be included in a report. For example, if you apply the
Accounts filter, only the accounts you select are included in the report. You can select filters to apply to a
report from the Filters tab. Be patient! Depending on the filters you select, this report may take several
minutes to run after you click Print or Preview.

Filters. The Filters column lists all the filters for this report. You cannot edit this column.

Include. Choose Selected in the Include column. A selection screen appears so you can designate specific filters
for the report.

Note: Mark Selected, Range, or Query to include a selected filter, range of filters, or a previously created
query of filters. Depending on the selection, different options appear on the screen. If you mark All, you cannot
define filters. For more information about filtering in The Financial Edge, see the Program Basics chapter in the
Program Basics Guide.

Selected Filters. Filters you specify appear in the Selected Filters column. If you choose Selected in the Include
column or click a filter and then click Open, the Selected <Filter> screen appears. If you mark Selected,
Range, or Query, a selection screen appears so you can specify filters.

Query name. The Query name field appears if you select Query. Enter the name of the query to use to filter the
report or click the binoculars to search for a query.

To create a new query, click the binoculars and click Add a New Query on the Open Query screen. For more
information about creating queries, see the Query Guide.
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Previous Filter. To view or edit the previous filter without returning to the Filters tab, click Previous Filter on
the toolbar.

Next Filter. To view or edit the next filter without returning to the Filters tab, click Next Filter on the toolbar.

Format Tab

On the Format tab, you decide how the report should look. You can create headings and footers, include a list of
criteria used to create the report, sort the information in the report, and select the format for displaying
monetary amounts.
The list on the left of the screen displays formatting options for the Recurring Batch Detail Report: Headings,
Criteria, Sort/Break, Page Footer, Report Footer, Miscellaneous, and Color Scheme. When you select an item in
the list, the right side of the screen displays selections for that section of the report.
Note: The heading defaults to Recurring Batch Detail Report in the Title field. You can leave this as the title for
the report or enter your own.

Headings. You can enter a maximum of 60 characters in each of the Title and Subtitle fields. The title and
subtitle appear at the top of the report. You can select how the heading should be aligned and whether your
organization's name will appear in the header.

You can include other options, such as the page number and the date. You can also select to include the
header on every page of the report.

lg Mew Recurring Batch Detail Report
File Edit “iew Fawortes Toolz Help

I I = el |

1 Generall 2: Filkers ~ 3: Format |

B Heading: Headings

Criteria
Dietail — Heading Farmnat
Sart/Break, Title: IHecurring Batch Detail Report
Page Foter Sublile: |

Report Footer

Miscellaneous Align: IEenter "I

Color Scheme

¥ Print arganization narnme in header

W Print Page Number in Heading [V Print Report Date in Heading
Format: IF'age 1 j Farmat: ISholt Date and Time j
Mligre [Fiight =] || A et =l

[¥ Frint report heading on each page

Note: The program automatically selects all criteria. Unmark the checkbox for any you do not want to print
with the report.
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Criteria. Select Criteria to print a list of criteria used to create the report. Mark Print these criteria on and select
a separate page or the first page. Selections print in the criteria section of the report.

lE MNew Recurring Batch Summary Report
Fil= Edit Wiew Favortes Toolz Help

= D= R el

1: General' 2: Filters 3 Farmat |

[# Piint these criteria on Ia zeparate page 'l

Page Footer

Report Footer
Miscellaneous
Color Scheme

Saved report name
Creation dates to include
Laszt used dates to include
Change dates to include
Batch types to include
Batches to include
Batches created by

Note: You can show project detail only if you have the optional module Projects and Grants.

Detail. Use Detail to select details specific to the Recurring Batch Detail Report. Mark the checkboxes to show
distribution by transaction characteristics. If you have the optional module Projects and Grants and have

defined transaction codes, additional checkboxes appear.

If you select to show distributions by only one characteristic, the Show characteristic as a column in the main
report body checkbox defaults to marked. With this option marked, the program adds a column to the report
displaying distributions for the selected characteristic for each row that has a distribution. The additional

column reduces the amount of pages used for the report when printing.

l@ New Recurring Batch Detail Report
Fil= Edit Wiew Favortes Tools Help

= D= RNl

1 General' 2 Filters 3 Farmat |

[ D
[ Project Description
[T Class

Page Footer

Repart Faater
Miscellaneous
Calor Scheme

Up |
Drown |
¥ Show charactenistic as a colurmn in the maih report body

I | Shav transaction tatal

[ Show batch header

Headigs
Criteria
¥ Shaw distribution for these characteristics

Sort/Break. Use Sort/Break to select the order that information appears on the report. When you select
Sort/Break, a grid displays the categories you can sort in the report. Select a sorting category in the Sort by

column and select Ascending or Descending in the Order by column.
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If you make no selections in the Sort by column, the program sorts by the entire account number in

ascending order.

You can also create breaks between the sections you have sorted by. In the Text before value and Text after

value fields, you can enter up to 30 characters in each field for information to print directly before and after

the break. If you mark Print count per [ ] or Print count as percentage of total for the selected sort field, the
number or percentage for each selected sort option appears in the footer. If you mark Page break on each

new [ ], a new page starts for the highest level break.

lE Mew Hecurring Batch Detail Report
Eile Edit “iew Favortes

Tools

= = R

Help

1 Generall 2 Filters 3 Format |

Sort/Break

Sort by I Order by I Break? I
Azcending

Headings
Criteria

Deetail

‘B Sort/Break
Page Footer
Feport Footer
Miscelaneous
Color 5cheme

Batch 1D

aononon

Break Header for Batch ID-

Text before value; |

Texut after value: |

Break Foater for Batch D
[ | Brint court pen Bateh [0

[ | Erint court a3 a percertage af total
™| Bage tireak oneach nev Bateh (D

Page Footer. Use Page Footer to create a footer to appear at the bottom of each page of the report. You can

enter a maximum of 254 characters in the Text field for the page footer. You can also select how to align the

text and include the page number and date in the footer.

IQ HNew Recurring Batch Detail Report
File Edit “iew Favorites Help

= = RE R ] el B 2

Tools

1: General' 2: Filters  3: Format |

Headings Page Footer
Criteria P——
Detail —Fage Footer Texl
Sort/Break Text:

B Page Footer

Report Footer
Miscellaneous
Color Scheme

Align: IEenter 'I

[ Print Page Mumber in Foater

[~ Print Repart Date in Footer
Farmat: I Page1 j Format: ISh-:-rt Date and Time j
Aligr: [ Right =l | Al [Leit =
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Report Footer. Use Report Footer to create a footer to appear at the bottom of the last page of the report. You
can enter a maximum of 254 characters in the Text field for the report footer and select how to align the text.

lﬂ New Recurring Batch Detail Report [ x|
File Edit %“iew Favortes Tools Help

e = el |

1: General' 2 Filters 3 Format |

Headings Report Footer

Criteria
Dretail Report Footer Text
Sort/Break Text:
Page Footer

B Report Footer

Miscellaneous

Calor Scheme Aligr: m

Tip: Make selections for displaying amounts and view them in the Sample amount display before printing the
report.

Miscellaneous. Use Miscellaneous to specify how numbers appear on the report and the font size for the
report.

IQNBW Recurring Batch Detail Report E
File Edit Wiew Favorites Tools Help

RS R w2 |

1 General' 2 Filters 3 Format |

Headings Miscellaneous

Criteria
Detail Show cumency character an Al amaunts
Sart/Break Shaw percent sign an All amounts
Page Footer Megative amaunt farmat [1234.56)
Report Foater Murnber of digits after decirmal for amaunts 2
E Color Scheme Murnber of digits after decimal for percentages 2

Show 1000'z separator Yez

Show blanks instead of zeros Mo

Font size g

Sample amount;
Arnoint [$1.234.5E)
Percert 100.00%
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Color Scheme. Use Color Scheme to select colors for report headings. When you click the color box next to the
selection, the Color screen appears so you can select a standard color or define a custom color. If you leave
the Apply a Color Scheme checkbox unmarked, the reports prints in black and gray.

lQ Mew Recurring Batch Detail Report
File Edit Wiew Favorites Toolz Help

RS R ?- |

1 Generall 2 Filters ~ 3: Format |

Headings Color Scheme
Criteria

Detail [~ Apply a Calar Scheme Report Name
Sort/Break

Page Footer W Column heading back calor Subtitle

Report Foater [ Column heading fore calor Column Headings

Miscellaneous [ Group heading back color Group Headings

B Color Scheme

. Group heading fore color

Restore Defaults |

Recurring Batch Summary Report

The Recurring Batch Summary Report lists summary information for each recurring batch. The information is
displayed in a single line format.

Glossary: A recurring batch is a template used to quickly create regular batches. Once you create a recurring
batch, you can use it repeatedly to create regular batches of transactions. This feature not only saves time but
can also prevent data entry errors. There are two types of recurring batches: recurring amount and recurring
percent. For more information about recurring batches, see the Journal Entry Guide.

The Recurring Batch Summary Report has tabs on which you set parameters: General, Filters, and Format. To
move among the tabs, click Next and Back at the bottom of the screen or select a tab. On these tabs you specify
information to include in the report and how the report should look. For more information about creating a
Recurring Batch Summary Report, see “Creating a report in General Ledger” on page 15.
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General Tab

On the General tab, you set parameters specific to the report and make selections about information included in
the report.

l@ Mew Recurring Batch Summary Report E3
Fil= Edit ‘iew Faworter Toolz Help

=R Rl el |

1: General |2: Filters | K3 Fu:urmatl

Include batches created on these dates

Creation date: IIncIude all dates j

Include batches last used on these dates:

Drate uzed: IIncIude all dates j

Include batches last changed on these dates -

Change date: IIncIude all dates j

Include these bateh bpes: | Recuring Amount and Recuring Fived Percent 7 |

Repart origntation: ILandscape 'I

Creation date. In the Creation date field, select a creation date range or specific creation date for the batches
to include in the report.

If you select <Specific range>, you can specify a start date and an end date. If you leave the Start date field
blank, all activity is included up to the end date. If you leave the End date field blank, all activity from the start
date until present is included. If you leave both fields blank, all activity is included.

Date used. In the Date used field, select a date range or specific date the batch was last used.

Change date. In the Change date field, select a date range or specific date the batch was last changed.

Include these batch types. In the Include these batch types field, select Recurring Amount, Recurring Fixed
Percent, or Recurring Amount and Recurring Fixed Amount.

Note: To view the report as it will appear using your selections and filters, click Preview. To view a sample
layout of the report without data, click Layout.

Report orientation. In the Report orientation field, select Portrait or Landscape.
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Filters Tab

On the Filters tab, you can include information based on batches and the user who created batches. For example,
you can include batches created by the user logged in as Supervisor, and batches created by other users do not
appear on the report.

lQ Mew Recurring Batch Summary Report 1]
File Edit Yiew Fawvoiter Tools Help

SN R =l el |

1. General  2: Filterz I§: Formatl

&0 0pen ) Clear &l Filers

Filters I Include Selected Filkers
Baktches all <Al Batches =
Batches Created By all <l Batches Created By =

Open. Click a filter in the grid and click Open on the action bar. The selection screen appears so you can
designate specific filters for the report.

Clear All Filters. Click Clear All Filters to remove all previously selected filters from the report.

Glossary: A filter is a requirement records must meet to be included in a report. For example, if you apply the
Accounts filter, only the accounts you select are included in the report. You can select filters to apply to a
report from the Filters tab. Be patient! Depending on the filters you select, this report may take several
minutes to run after you click Print or Preview.

Filters. The Filters column lists all the filters for this report. You cannot edit this column.

Include. Choose Selected in the Include column. A selection screen appears so you can designate specific filters
for the report.

Selected Filters. Filters you specify appear in the Selected Filters column. If you choose Selected in the Include
column or click a filter and then click Open, the Selected <Filter> screen appears. If you mark Selected,
Range, or Query, a selection screen appears so you can specify filters.

Query name. The Query name field appears if you select Query. Enter the name of the query to use to filter the
report or click the binoculars to search for a query.

To create a new query, click the binoculars and click Add a New Query on the Open Query screen. For more
information about creating queries, see the Query Guide.

Previous Filter. To view or edit the previous filter without returning to the Filters tab, click Previous Filter on
the toolbar.

Next Filter. To view or edit the next filter without returning to the Filters tab, click Next Filter on the toolbar.

Format Tab

On the Format tab, you decide how the report should look. You can create headings and footers, include a list of
criteria used to create the report, sort the information in the report, and select the format for displaying
monetary amounts.
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The list on the left of the screen displays formatting options for the Recurring Batch Summary Report: Headings,
Criteria, Sort, Page Footer, Report Footer, Miscellaneous, and Color Scheme. When you select an item in the list,
the right side of the screen displays selections for that section of the report.

Note: The heading defaults to Recurring Batch Summary Report in the Title field. You can leave this as the title
for the report or enter your own.

Headings. You can enter a maximum of 60 characters in each of the Title and Subtitle fields. The title and
subtitle appear at the top of the report. You can select how the heading should be aligned and whether your
organization's name will appear in the header.

You can include other options, such as the page number and the date. You can also select to include the
header on every page of the report.

n Mew Recurrning Batch Summary Report
File Edt “iew Faworites Toolz Help

EH &S @ ? -

1 General] 2: Filters ~ 3: Format l

Headings
=] Criteria "
5 5ot Heading Format
] Page Footer Title: |Hecuning Batch Summary Report
=] Report Footer Subhitle: |

2] Mizcellaneous
2] Color Scheme Align: | Center hd

[v Frint organization name in header

v Print Fage Mumber in Heading [v Print Report Date in Heading
Format: |F'age 1 ﬂ Farmat: |Short Date and Time ﬂ
Align: [ Fight = g Lt =l

[+ Print report heading on each page

Note: The program automatically selects all criteria. Unmark the checkbox for any you do not want to print
with the report.

Criteria. Select Criteria to print a list of criteria used to create the report. Mark Print these criteria on and select
a separate page or the first page. Selections print in the criteria section of the report.

“ New Recurring Batch Summary Report
File Edit Wiew Favorites Tools Help

H &= @ ?-

General] Filters FDlmall

T r—
=] Sort Iv Prirt these criteria an | a separate page b

=] Page Footer

v| Saved report name

=l H?Dﬂ't Footer | Creation dates to include
=] Miscellaneous v Lazt uged dates bo include
2] Color Scheme v| Change dates to include

v| Batch types to include
w| Batches o include
v| Batches created by
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Sort. Use Sort to select the order that information appears on the report. When you select Sort, a grid displays

the categories you can sort in the report. Select a sorting category in the Sort by column and select Ascending
or Descending in the Order by column.

If you make no selections in the Sort by column, the program sorts by the batch ID in ascending order.

lE Mew Recurrning Batch Summary Report
File Edt “iew Faworites Toolz Help

B2 R0 e - |

1 Generall 2 Filters ~ 3: Farmat |

Headings Sort

Criteria

i Sort by | Order by I
Fage Foater Batch D Ascending

Fieport Footer

Miscellaneous
Colar Scheme

Page Footer. Use Page Footer to create a footer to appear at the bottom of each page of the report. You can

enter a maximum of 254 characters in the Text field for the page footer. You can also select how to align the
text and include the page number and date in the footer.

IQ Mew Recurring Batch Summary Report I
File Edit ‘“iew Favortes Toolz Help

eI = el |

1 Genelall 2 Filters ~ 3: Format |

Headings Page Footer
[ Criteria P Fooier Toxt
EE — Page Footer Texl

B Page Footer Text:
Feport Footer
Miscellaneous
Color Scheme

Align: ICenter 'I

=1 Print Page Number in Footer

[¥ Print Beport Date in Footer
Format: IF'age 1 j Format: I Short Date and Time j

Align: [Right x| || Agn [Lef =l
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Report Footer. Use Report Footer to create a footer to appear at the bottom of the last page of the report. You
can enter a maximum of 254 characters in the Text field for the report footer and select how to align the text.

lﬂ New Recurring Batch Summary Report %]
File Edit %“iew Favortes Tools Help

= DS R = gl

1: General' 2 Filters 3 Format |

Headings Report Footer

Criteria
ot Report Footer Text
Page Footer Text:

B Report Footer

Miscellaneous
Color Scheme

Align: ILeft vI

Tip: Make selections for displaying amounts and view them in the Sample amount display before printing the
report.

Miscellaneous. Use Miscellaneous to specify how numbers appear on the report and the font size for the
report.

l@ MNew Recurring Batch Summary Report E3
Fil= Edit Wiew Favortes Tools Help

S e = e e |

1 Generall 2 Filters ~ 3: Farmat |

Headings Miscellaneous

Criteria
Sart Show currency character an All amounts
Fage Footer Shows percent sign on All amounts
Hpnrt Fouoter Megative amount farmat [1234.56)
E Color Sm Murnber of digitz after decimal for amaunts 2

Murber of digitz after decimal for percentages 2

Show 1000's separator Yes

Show blanks inztead of zeros Mo

Fant size g

Sample amount:
Arnount [$1.234.5E]
Percent 100.00%
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Color Scheme. Use Color Scheme to select colors for report headings. When you click the color box next to the
selection, the Color screen appears so you can select a standard color or define a custom color. If you leave
the Apply a Color Scheme checkbox unmarked, the reports prints in black and gray.

lg Mew Recurring Batch Summary Report [ x|
File Edit ‘“iew Favortes Toolz Help

FERE e = |
1 Genelall 2: Filters ~ 3: Farmat |

Headings Color Scheme

Criteria

Sort [~ Apply a Color Scheme
Page Footer

Report Name

Report Footer . Colurin heading back. color Subtitle
Miscellaneous [ Columin heading fore calor Column Headings
& Color Scheme [T Group heading back calor Group Headings

. Group heading fore color

Restore Defaults |

Transaction Journal

The Transaction Journal lists the debits and credits entered directly from Journal Entry or posted from other
Blackbaud programs.

Glossary: A transaction is a general ledger entry that indicates to the program the amount and account to
debit or credit. Transactions also contain additional information that helps trace and report on them.
Transactions include source codes and journal references and may include project and transaction code
distributions if you have the optional module Projects and Grants.

The Transaction Journal has tabs on which you set parameters: General, Filters, and Format. To move among the
tabs, click Next and Back at the bottom of the screen or select a tab. On these tabs you specify information to

include in the report and how the report should look. For more information about creating a Transaction Journal,
see “Creating a report in General Ledger” on page 15.
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General Tab

On the General tab, you set parameters specific to the report and make selections about information included in
the report.

I New Transaction Journal
File Edit Wiew Favorter Tool: Help

FIEE IR |

1: General |2: Filters | 3 Formatl

Include transactions with these post dates:

Drate: |<Spec:ific: fiscal periods> ﬂ 04/01/2002 to 04,30/2002

Start fiscal pear: IThis fiscal pear j Start peniod: IThis fiscal period 'I
End fizcal year: IThi$fiscaI_l,lear j End period: IThisfiscaI peiod 'I

Include these ranzaction types: IFleguIar and Encurmbrance j

[~ Create an output queny of accounts

Report orientation: ILandscape 'I

Date. In the Date field, select a date or date range for posted transactions to be included.

If you select <Specific range>, you can specify a start date and an end date. If you leave the Start date field
blank, all activity is included up to the end date. If you leave the End date field blank, all activity from the start
date until present is included. If you leave both fields blank, all activity is included.

Create an output query of accounts. If you mark this option, the system creates a query of the accounts
you select and includes it in the report. This query is available for use in other areas of the program.
Note: To view the report as it will appear using your selections and filters, click Preview. To view a sample
layout of the report without data, click Layout.

Report orientation. In the Report orientation field, select Portrait or Landscape.
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Filters Tab

On the Filters tab, you can include information based on criteria such as transaction, batches, categories, and
journals. For example, you can include certain journals, and journals not selected do not appear on the report.

I@ Hew Transaction Journal
File Edit “iew Favortez Toolz Help
FleEE = e |
1 General 2 Filters | 3 Format |
f®0pen ) Clear Al Filters
Filters I Include Selected Filkers Iﬂ
Transactions All =il Transackions=
Bakches All <Al Batches >
Cateqories all <Al Categories =
Journals all <l Journals =
Projects Al <Al Projects=
Project Attributes all <Al Project Attributes =
Transaction Attributes all <l Transackion Attribukes =
Mot et Posted Transactions Selected <hone
Accounts all <Al Accounts>
Account Codes Al <Al Account Codes=
Account Attributes All <Al Account Attributes s
Funds all <Al Funds =
Classes Al <hll Classes> LI

Open. Click afilter in the grid and click Open on the action bar. The selection screen appears so you can
designate specific filters for the report.

Clear All Filters. Click Clear All Filters to remove all previously selected filters from the report.

Glossary: A filter is a requirement records must meet to be included in a report. For example, if you apply the
Accounts filter, only the accounts you select are included in the report. You can select filters to apply to a
report from the Filters tab. Be patient! Depending on the filters you select, this report may take several
minutes to run after you click Print or Preview.

Filters. The Filters column lists all the filters for this report. You cannot edit this column.

Include. Choose Selected in the Include column. A selection screen appears so you can designate specific filters
for the report.

Note: Mark Selected, Range, or Query to include a selected filter, range of filters, or a previously created
query of filters. Depending on the selection, different options appear on the screen. If you mark All, you cannot
define filters. For more information about filtering in The Financial Edge, see the Program Basics chapter in the
Program Basics Guide.

Selected Filters. Filters you specify appear in the Selected Filters column. If you choose Selected in the Include
column or click a filter and then click Open, the Selected <Filter> screen appears. If you mark Selected,
Range, or Query, a selection screen appears so you can specify filters.

Query name. The Query name field appears if you select Query. Enter the name of the query to use to filter the
report or click the binoculars to search for a query.

To create a new query, click the binoculars and click Add a New Query on the Open Query screen. For more
information about creating queries, see the Query Guide.
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Previous Filter. To view or edit the previous filter without returning to the Filters tab, click Previous Filter on
the toolbar.

Next Filter. To view or edit the next filter without returning to the Filters tab, click Next Filter on the toolbar.

Format Tab

On the Format tab, you decide how the report should look. You can create headings and footers, include a list of
criteria used to create the report, sort the information in the report, and select the format for displaying
monetary amounts.

The list on the left of the screen displays formatting options for the Transaction Journal: Headings, Criteria,
Sort/Break, Page Footer, Report Footer, Miscellaneous, and Color Scheme. When you select an item in the list,
the right side of the screen displays selections for that section of the report.

Note: The heading defaults to Transaction Journal in the Title field. You can leave this as the title for the report
or enter your own.

Headings. You can enter a maximum of 60 characters in each of the Title and Subtitle fields. The title and
subtitle appear at the top of the report. You can select how the heading should be aligned and whether your
organization's name will appear in the header.

You can include other options in the header, such as the page number and the date. You can also select to
include the header on every page of the report.

lQ Mew Transaction Journal
File Edit ¥iew Favortes Toolz Help

RS R w2 |

1 Generall 2 Filters 2 Format |

E Heading: Headings
Criteria

Distail — Heading Format
Sort/Braak Title: | Transaction Joumal
Fage Foater Sublife: |

Feport Footer

Mizcelaneous Aligr: IEenter 'I

Calar Scheme . . .
[¥ Print crganization narne in header

¥ Print Fage Mumber in Heading [¥ Print Report Date in Heading
Farmat: IPage 1 j Farmat: IShort Date and Time j
Aligre [Fight =] || dian: [Left =l

[¥ Piint report heading on each page

Note: The program automatically selects all criteria. Unmark the checkbox for any you do not want to print
with the report.

Criteria. Select Criteria to print a list of criteria used to create the report. Mark Print these criteria on and select
a separate page or the first page. Selections print in the criteria section of the report.
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You can select to print criteria on either the first page of the report or on a separate page. All selected options

print in the criteria section of the report.

n Mew Tranzaction Journal

File Edt “iew Fawortes Toolz Help
u _5- % —‘ﬁ |||¢.I ? T

1 General] 2: Filkers ~ 3: Format l

=] Headings Critena
Criteria

2] Detail [+ Print these criteria on | 2 separate page h

] Sort/Break
] Page Foater
2] Report Footer
2] Miscellaneous
2] Colar Scheme

vl Saved report name

W] Dutput query name

w| Post dates bo include

w| Tranzaction types to include

w| Tranzactions to include

w| Batches bo include

w| Categories to include

w| Jourmals to include

w| Projects to include

w| Project attributes to include

w| Tranzaction attributes to inchude
W] Mot et posted transactions to include
w| Bccounts bo include

w| dccount Codes to include

w] Sccount attibutes bo include

w| Funds to include

[

Note: You can show project detail only if you have the optional module Projects and Grants.

Detail. Use Detail to select details specific to the Transaction Journal. Mark the checkboxes to show distribution
by transaction characteristics. If you have the optional module Projects and Grants and have defined

transaction codes, additional checkboxes appear.

If you select to show distributions by only one characteristic, the Show characteristic as a column in the main
report body checkbox defaults to marked. With this option marked, the program adds a column to the report
displaying distributions for the selected characteristic for each row that has a distribution. The additional
column reduces the amount of pages used for the report when printing.

“ Hew Transaction Journal

File Edit %“iew Favortes Tools Help
u _5. % —a |||‘.-| ? T

1: General] 2 Filters 3 Format ]

[+ Show characternistic as a column in the main report body

[~ Show trangaction tatal

2] Headings Detail
=] Criteria
[~ Show diztribution For these characteristics
Z] Sort/Break ™ Project ID
=] Page Footer l iphi
S Fonat Pt [ Project Description
=] Miscellaneous F Edlissisgn
=] Color Scheme [T Spendable/Mon-Spendable
[ Performance g
[ e |




295 CHAPTER

Sort/Break. Use Sort/Break to select the order that information appears on the report. When you select Sort, a
grid displays the categories you can sort in the report. Select a sorting category in the Sort by column and
select Ascending or Descending in the Order by column.

If you make no selections in the Sort by column, the program sorts by the entire account number in
ascending order.

You can also create breaks between the sections you have sorted by. In the Text before value and Text after
value fields, you can enter up to 30 characters in each field for information to print directly before and after
the break. If you mark Print count per [ ] or Print count as percentage of total for the selected sort field, the
number or percentage for each selected sort option appears in the footer. To start a new page for the highest
level break, mark Page break on each new [ ].

lg Mew Tranzaction Journal
File Edt “iew Fawortes Toolz Help

= = RES = gl B

1 Generall 2: Filkers ~ 3: Format |

Headings Sort{Break

Criteria

Detail Sort by | Categary | Order by | Break? |
‘B Sort/Break Account Number Azcending

Page Footer

Feport Footer
Miscellanenus
Color Scheme

A i

Break Header for Account Humber-

Teut before walue: I

Teut after value: I

Break Footer for Account Humber-
[~ Print count per Account Mumber

[~ Print count as a percentage of tokal

™ Page bieak on each new Account Mumber
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Page Footer. Use Page Footer to create a footer to appear at the bottom of each page of the report. You can

enter a maximum of 254 characters in the Text field for the page footer. You can also select how to align the
text and include the page number and date in the footer.

lQ New Transaction Journal x|
File Edit ‘“iew Favortes Tools Help

&S w2

1 Genelall 2 Filterz  3: Format |

Headings Page Footer
Criteria —
Detail — Fage Footer Tex
Sort/Break Teut:

B Page Footer

Fiepart Footer
Miscellaneaus

Color Scheme Align: lm

I Print Page Mumber in Footer

[~ Print Repart Date in Foater
Format: IF'age 1 j Farmat: IShort Date and Time j
Aligr:  [Fiight =] || A Left d|

Report Footer. Use Report Footer to create a footer to appear at the bottom of the last page of the report. You
can enter a maximum of 254 characters in the Text field for the report footer and select how to align the text.

lE Mew Tranzaction Journal

File Edit “iew Fawvorter Toolz Help
e =l R
1 Generall 2 Filterz 3 Format |
Haadings Report Footer
Criteria
Detail Feport Footer Text
Sort/Break Tent:
Page Footer

B Report Footer

Miscelaneous

Color Scheme Aligr: ILeft j'

Tip: Make selections for displaying amounts and view them in the Sample amount display before printing the
report.
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Miscellaneous. Use Miscellaneous to specify how numbers appear on the report and the font size for the
report.

lg Mew Tranzaction Journal
File Edt “iew Fawortes Toolz Help

= F = RES = ) el B

1 Generall 2: Filkers ~ 3: Format |

Headings Miscellaneous
Criteria

Detail Show cumency character on Al arnourks
Sort/Break Show percent sign on All amounts
Page Footer Megative amount format [1234.56)

Report Footer

; . MWumber of digits after decimal for amounts 2

' Color Scheme MWumber of digits after decimal for percentages 2
Show 1000°: separatar Yes
Show blanks inztead of zeros Ha
Fant zize g

Sample amount:

Amait [$1.234.5E)
Percent 100.00%

Color Scheme. Use Color Scheme to select colors for report headings. When you click the color box next to the
selection, the Color screen appears so you can select a standard color or define a custom color. If you leave
the Apply a Color Scheme checkbox unmarked, the reports prints in black and gray.

l@ Mew Tranzaction Journal E3
File Edit ‘“iew Favortes Tools Help

S e = e e |

1: Generall 2 Filters ~ 3: Farmat |

Headings Color Scheme

Criteria
Detail [~ &pply a Calor Scheme Report Name
IE'Z:_::;BFIEZ:; M Colurmn heading back colar Subtitle
Repart Faoter [ Column heading fore colar
eIIaneous [ Group heading back colar Group Headings
=il . B Group heading fore color
Restore Defaults |
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Note: We recommend you read the documentation for The Financial Edge thoroughly. Information presented
here provides you with basic information about project reports in General Ledger. Hands-on experience is the
best way to learn, so we encourage you to try various options with the sample database. Project Reports
appear only if you have the optional module Projects and Grants.

Reporting categories in General Ledger include Account Reports, Allocation Reports, Budget Reports, Financial
Statements, GASB 34 Reports, Journal and Batch Reports, Pivot Reports, and Project Reports. This chapter
discusses Project Reports. For information about other report categories, see the chapter for that category.

Project reports in General Ledger include:
e Project Activity Report

¢ Project Financial Statements

* Project Budget vs. Actual Report

¢ Project Detail Report

¢ Project Profile Report

Project Activity Report

The Project Activity Report lists project activity for a time period you select. This report can be in a summary or
detail format.

Glossary: A project is a transaction-level identifier that categorizes transactions and budget entries. You can
use projects to track equity balances or prepare financial statements for a given purpose. Projects are available
only if you have the optional module Projects and Grants.

The Project Activity Report has tabs on which you set parameters: General, Filters, and Format. To move among
the tabs, click Next and Back at the bottom of the screen or select a tab. On these tabs you specify information to
include in the report and how the report should look. For more information about creating a Project Activity
Report, see “Creating a report in General Ledger” on page 15.
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General Tab

On the General tab, you set parameters specific to the report and make selections about information included in
the report.

l@ Mew Project Activity Beport E3
Fil= Edit ‘iew Faworter Toolz Help

=R Rl el |

- Filters | K3 Fu:urmatl

Repart type:l Summarny j

Include project activity in thiz date range -
Date: | <Specitic fiscal periods: x| 06012003 to 0643042003

Start fiscal year: IThi$ fizcal year j Start period: ILast fiscal period 'I
End fizcal year: IThisfiscaIyear ﬂ End period: ILastfiscaI period "I

[+ Exclude projects with zero beginning balances and no activity

v Exclude projects with no activity

Include these transaction types: IHeguIar j

[~ Create an output query of projects

Repart arigntation: IF'ort[ait *I

Report type. In the Report type field, select Summary or Detail.

Date. In the Date field of the Include project activity in this date range frame, you can select a specific date or
date range for project activity to include.

If you select <Specific range>, <Specific fiscal periods>, or <Specific fiscal year>, you can specify a start date
and an end date. If you leave the Start date field blank, all activity is included up to the end date. If you leave
the End date field blank, all activity from the start date until present is included. If you leave both fields blank,
all activity is included.

Exclude projects with zero beginning balances and no activity. If you mark this option you can
efficiently exclude projects from the report that have zero beginning balances and no activity.

Exclude projects with no activity. If you mark this option you can exclude projects from the report that have
no activity.

Note: To view the report as it will appear using your selections and filters, click Preview. To view a sample
layout of the report without data, click Layout.

Create an output query of projects. If you mark this option, the system creates a query of the projects you
select and includes it in the report. This query is available for use in other areas of the program.

Report orientation. In the Report orientation field, select “Portrait” or “Landscape”.
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Filters Tab

Glossary: A filter is a requirement records must meet to be included in a report. For example, if you apply the
Accounts filter, only the accounts you select are included in the report. You can select filters to apply to a
report from the Filters tab. Be patient! Depending on the filters you select, this report may take several
minutes to run after you click Print or Preview.

On the Filters tab, you can include information based on selected criteria such as funds, projects, journals,
account attributes, and classes. For example, to include only the accounts with an account attribute of Expense
Category and a value of Salaries recorded in the account record. Accounts with other account attributes and with
values other than Salaries do not appear on the report.

IE MNew Project Activity Report
File  Edit “iew Fawortez Tool: Help
IR |
1: General 2 Filters |§: Farmat |
@@ 0pen ) Clear Al Filters
Filters I Include Selected Filkers I
Funds Al <All Funds =
Account Codes all <All Account Codes>
Account Aktributbes Selecked Include Expense Category: 01 EI
Projects ol <8l Projects =
Project Attributes all <all Project Attributes =
Classes Al <All Classes=>
Transaction Attributes All <Al Transaction Attributes
Mot Yet Posted Transactions  Selected <Mone =
Journals Al <All Journals =
Existing Endowrnents(s) Al <Al Exisking Endowments(s) =
Spendablefhon-Spendableds) Al <4l Spendable/Mon-3pendableds) >
Fund Raiserss) all <all Fund Raisers(s)>
Departrient Codes(s) all <l Department Codes(s) =

Open. Click afilter in the grid and click Open on the action bar. The selection screen appears so you can
designate specific filters for the report.

Clear All Filters. Click Clear All Filters to remove all previously selected filters from the report.
Filters. The Filters column lists all the filters for this report. You cannot edit this column.

Include. Choose Selected in the Include column. A selection screen appears so you can designate specific filters
for the report.

Note: Mark Selected, Range, or Query to include a selected filter, range of filters, or a previously created
query of filters. Depending on the selection, different options appear on the screen. If you mark All, you cannot
define filters. For more information about filtering in The Financial Edge, see the Program Basics chapter in the
Program Basics Guide.

Selected Filters. Filters you specify appear in the Selected Filters column. If you choose Selected in the Include
column or click a filter and then click Open, the Selected <Filter> screen appears. If you mark Selected, Range,
or Query, a selection screen appears so you can specify filters.

Query name. The Query name field appears if you select Query. Enter the name of the query to use to filter the
report or click the binoculars to search for a query.
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To create a new query, click the binoculars and click Add a New Query on the Open Query screen. For more
information about creating queries, see the Query Guide.

Previous Filter. To view or edit the previous filter without returning to the Filters tab, click Previous Filter on
the toolbar.
Next Filter. To view or edit the next filter without returning to the Filters tab, click Next Filter on the toolbar.

Format Tab

On the Format tab, you decide how the report should look. You can create headings and footers, include a list of
criteria used to create the report, sort the information in the report, and select the format for displaying
monetary amounts.
The list on the left of the screen displays formatting options for the Project Activity Report: Headings, Criteria,
Sort/Break, Page Footer, Report Footer, Miscellaneous, and Color Scheme. When you select an item in the I|st
the rlght side of the screen isplays selections for that section of the report.
Note: The heading defaults to Project Activity Report in the Title field. You can leave this as the title for the
report or enter your own.
Headings. You can enter a maximum of 60 characters in each of the Title and Subtitle fields. The title and

subtitle appear at the top of the report. You can select how the heading should be aligned and whether your
organization's name will appear in the header.

You can include other options in the header, such as the page number and the date. You can also select to
include the header on every page of the report.

lE New Project Activity Report [ x|
Fil= Edit “iew Fawortes Tools Help

BRE R == 2 |
)

T

1 Genelall 2 Filters

Criteria .

Sort/Break [ Heading Fomat

Page Focter Title:  [Praject Activity Report
Report Footer Subtitle: I

Miscellaneaus
Color Scherne Align: ICentel 'I

[¥ Print organization narme in header

v Print Page Number in Heading ¥ Print Report Date in Heading
Format: IF'age 1 j Format: ISholt Diate and Time j
Align: [Right =] | A JLet =

[¥ Print report heading on each page

Note: The program automatically selects all criteria. Unmark the checkbox for any you do not want to print
with the report.
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Criteria. Select Criteria to print a list of criteria used to create the report. Mark Print these criteria on and select
a separate page or the first page. Selections print in the criteria section of the report.

lE Mew Project Activity Report [ x|
Fil= Edit “iew Favortes Tools Help

H &S G2

1 Genelall 2: Filters ~ 3: Farmat |

Headings

‘B Criteria

Sart/Break ¥ Print these criteria on Ia zeparate page 'I

Page Footer Saved report name -
FReport Fagter Dutput query hame —
Mizcelaneaus Dates o inchude

Color Scheme Include projects with no activity

Include projects with a zero beginning balance
Tranzaction twpes ta include

Funds to include

Accounts atttributes to include

Account codes o include

Projects to include

Project attributes to include

Tranzaction attibutes to inchude

Claszes to include

Jourmnals to include

Mot yet pozted tranzactions to include

Uzer project security access ;l

Sort/Break. Use Sort/Break to select the order that information appears on the report and where to create
breaks in the information. When you select Sort, a grid displays the categories you can sort in the report.
Select a sorting category in the Sort by column and select Ascending or Descending in the Order by column.
You can sort by project ID in this report.

You can also create breaks between the sections you have sorted by. In the Text before value and Text after
value fields, you can enter up to 30 characters in each field for information to print directly before and after
the break. If you mark Print count per or Print count as percentage of total for the selected sort field, the
number or percentage for each selected sort option appears in the footer. If you mark Page break on each
new, a new page starts for the highest level break.

lﬂ Hew Project Activity Report E
File Edit Yiew Favoites Tool: Help

= = RE = el B

1 General' 2 Filters 3 Format |

Headings Sort/Break
Criteria

i & Sort by | Order by | Ereak?l
Page Footer Project ID Ascending -
Freport Footer r
Miscelaneous r
Color Scheme -

r

Break Header for Project D

Text before value: I

Test after value: |

Break Footer for Project 10
[ Britt count per Braject (D

[™ | Brint count a8 & pereentage of botal

I”| Fage break on each new Frojest @
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Page Footer. Use Page Footer to create a footer to appear at the bottom of each page of the report. You can
enter a maximum of 254 characters in the Text field for the page footer. You can also select how to align the

text and include the page number and date in the footer.

u Hew Project Activity Report
Fil= Edt Wiew Favortes Tools Help

H &2 @ ?-

1 General] 2 Filkerz  2: Farmat l

=] Heading: Page Footer
2] Criteria
2] Sot/Break Page Footer Text

Page Footer Test:
2] Report Footer
2] Miscellaneous
] Colar Scheme
[ Frint Page Mumber in Footer [~ Print Report Date in Footer

Report Footer. Use Report Footer to create a footer to appear at the bottom of the last page of the report. You
can enter a maximum of 254 characters in the Text field for the report footer and select how to align the text.

“ Hew Project Activity Report
File Edit Wiew Favaorites Tools Help

H &= @ ?-

1: General] 2 Filters 3 Format ]

Z] Headings Report Footer

=] Criteria

S Son/Bresk Report Footer Text

2] Page Faoter Text:

Z] Miscellaneous
Z] Color Scheme

Tip: Make selections for displaying amounts and view them in the Sample amount display before printing the

report.
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Miscellaneous. Use Miscellaneous to specify how numbers appear on the report and the font size for the
report.

IQ HNew Project Activity Report E
File Edit Wiew Favaorites Tools Help

S &0 = ?-

1: General' 2: Filters 3 Format |

Headings Miscellaneous

Criteria
Sort/Break Show currency character on Al amaonts
Page Footer Show percent sign on Al amounts
Hport Footer Megative amount format [1234.56)
5 Calor Se Mumber of digits after decimal for amounts 2

Mumber of digits after decimal for percentages 2

Show 1000'z separator Yes

Show blanks instead of zeros Mo

Fant size 8

Sample amaunt:

Armnaint [$1.234.5E]
Percert 100.00%

Color Scheme. You can apply a color scheme to the column heading and group heading of the report. When
you click in the color box next to the selection, a Color screen appears so you can select a standard color or
define a custom color. If you leave the Apply a Color Scheme checkbox unmarked, the report prints in black
and gray.

lE Mew Project Activity Report
File Edit Wiew Favortes Toolz Help

= D= R i e

1: General' 2 Filters 3 Format |

Headings Color Scheme

Criteria
Sort/Break ™ Apply a Color Scheme Report Name
Page Footer M Column heading back colar Subtitle

Feport Footer

i8 Color 5cheme ™ Group heading back color Group Headings

. Group heading fore color

Heztane Vefaults |

Project Financial Statements

The Project Financial Statements report shows an Income Statement and Balance Sheet for individual projects.
This gives you useful data for tracking financial information associated with individual projects.
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The Project Financial Statements report has tabs on which you set parameters: General, Filters, Columns,
Multiple Columns Headings, and Format. To move among the tabs, click Next and Back at the bottom of the
screen or select a tab. On these tabs you specify information to include in the report and how the report should
look. For more information about creating a Project Financial Statements report, see “Creating a report in
General Ledger” on page 15.

General Tab

On the General tab, you set parameters specific to the report and make selections about information included in
the report.

I& New Project Financial Statements - |
File Edit View Favorites Tools Help

dadac =2 |

1. General |2: Filtersl i Culumnsl 4 Multiple Column Headingz | 5 Format |

Show IIncnme Statemnent and Balance Sheet j

Frimary lewel of detail: IEategory j

¥ Secondary level of detail IM 'I Mo budget available for Tranzaction Code.

[~ Page break on each new Project

v Include inactive Projects
v Include Projects with zero balances and no activity

v Include Projects with beginning balances and no activity

R eport onentation; IPortrait 'I

< Back | Hemt » | Cancel | Print Preview Layout |

Show. In the Show field, select which financial statements you want to appear in the report.

Primary level of detail. In the Primary level of detail field, you can specify the primary level of detail in the
report. Your options include Category, Fund, Account Code, Account, and Department.

Secondary level of detail. In the Secondary level of detail field, you can specify a transaction code to use as a
the secondary level of detail in the report. Transaction codes are created in Configuration.

Budgets cannot be distributed to a transaction code that has not been designated as the transaction code for
grant activity tracking. You can designate which transaction code to use for grant budgeting on the Grant
Business Rules page of Configuration. For more information about Business Rules, see the Configuration
Guide for General Ledger.

Page break on each new Project. To start a new page in the report for each new project, mark Page break
on each new Project.

Include inactive Projects. If you mark this checkbox the report will include inactive projects. If you leave this
checkbox unmarked, the report will include only active projects.

Note: To view the report as it will appear using your selections and filters, click Preview. To view a sample
layout of the report without data, click Layout.
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Include Projects with zero balances and no activity. If you mark this checkbox the report will include

projects with zero balances and no activity.

Include Projects with beginning balances and no activity. If you mark this checkbox the report

will include projects with beginning balances and no activity.
Report orientation. In the Report orientation field, select Portrait or Landscape.

Filters Tab

On the Filters tab, you can include information based on selected criteria such as funds, projects, journals,

account attributes, and classes.

IQ New Project Financial Statements x|
File Edit Wiew Favorites Tools Help
b adaE a2

1: General | ar Columnsl 4: Multiple Colurn Headings | &: Farmat

&3 0pen  *, Clear All Filters

Filters I Include Selected Filters Iﬂ

Funds All <Al Funds =

Account Codes all <Al Account Codes>

Accounts Al <All Accounts =

Account Attributes All <All Account Atkributes =

Projects all <all Projects =

Project Attributes all <all Project Attributes =

Transaction Attributes all <Al Transaction Attribukes =

Classes All <All Classes>

Journals all <Al Journals =

Mak ¥et Posted Transactions Mone <Mone =

Cash Flow Codes All <Al Cash Flow Codesz

working Capital Codes all <all Working Capital Codes =

Missionis) all <Al Missiongs) = LI

< Back | Hemt » | Cancel | Print | Preview | Layout |

Open. Click a filter in the grid and click Open on the action bar. The selection screen appears so you can

designate specific filters for the report.

Clear All Filters. Click Clear All Filters to remove all previously selected filters from the report.

Filters. The Filters column lists all the filters for this report. You cannot edit this column.

Include. Choose Selected in the Include column. A selection screen appears so you can designate specific filters

for the report.

Selected Filters. Filters you specify appear in the Selected Filters column. If you choose Selected in the Include
column or click a filter and then click Open, the Selected <Filter> screen appears. If you mark Selected, Range,

or Query, a selection screen appears so you can specify filters.
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Columns Tab

On the Columns tab, you can open existing columns, delete columns, and view the heading, formula, and dates
defined for columns you have already created.

A New Project Financial Statements ﬂ
File Edit Wiew Favorites Tools Help
a3 o= ?- |

1: General | 2 Filters 4 Multiple Calurin Headings | 5 Farmat

4 New Calumn ®@5 0 pen Column  Delete Calumn

Bz R epeat Column

Hide? I Heading I Farmula I Date Range I
| (I Cakegory
2| 0
3| [T acusl {actualt 11/01/2006 ko 11/30..,

New Column. When you click New Column, the Column <#> screen appears, showing the General, Date Range,
and Filters tabs from which you can create a new column.

Open Column. To open an existing column and edit its settings, select a row in the grid and click Open Column.

Repeat Column. To repeat a column’s settings, select that column and click Repeat Column. A new row with
the same settings appears in the grid. If you click the drop down arrow on the Repeat Column button, you can

select “All parameters” or “Date parameters only.” If you select “Date parameters only,” you will create a new
column with the same date parameters of the selected column.

Delete Column. To delete a column’s settings, select that column and click Delete Column. Only columns not
being used to define another column can be deleted.

Hide? Mark the checkbox in the Hide? column for any column you do not want to appear in the report.

Heading. The Heading column displays the column heading defined in the Column heading field of the Columns
General tab.

Formula. The Formula column displays the column information defined in the Column Definition frame of the
General tab when you click Open Column.

Date Range. The Date Range column displays the dates selected on the Date Range tab when you click Open
Column.

Warning: Selections made on the General, Date Range, and Filters tabs when you open a column apply only to
report columns and not to the report itself.
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General tab. You can name and define report columns on this tab. Using the alignment buttons, you can specify
how columns should be aligned. Column formatting options include: Column width, Report width, Format,
and Decimal places. In the Column Definition frame, you select the column Type, Amount or Description and
determine the calculations or description for that column. Click Validate to validate the expression created in
the Column Definition frame. Click Clear to clear the expression. If you mark Hide this column on the report

and export the report, the hidden columns will not be exported.

Column width: I‘I aa inches

{Actual + Encumbrance}
{Driginal Budget}
{diusted Budgeth
{Budget Adjustments}
{Calurnn 3}

[~ Hide this column on the report

Report width: ~ 5.75 inches
= Start Date End Date ettt IEUHEHG}I jv
Decimal places: |2 'I
Column Definition -
Type: IAmount =]
ihctualk
{Eneumbrance}

__>|

L e (R AR Y

Cancel |

Date Range tab. On this tab, the selections you make determine the period or date for which balances are

included on the report.

General |

Drate: |<Specific fizcal penods:

j 08/01,/2006 to 02/31 /2006

Start fizcal year IThis fiscal pear

j Start periad: IThis fizcal period 'I

End fiscal year: IThis fiscal pear

j End period: IThis fizcal period 'I
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Filters tab. On this tab you can select filters that apply only to the selected columns and not the entire report.

Column 4

Column

Filkers I Include I Selected Filters Iﬂ
Funds Al <Al Funds =
Account Codes al <Al Account Codes =
Accounts &l <Al Accounts =
Aceaunt Attribukes &l <Al Account Attributes =
Projects Al <Al Projects =
Project Attributes All <Al Project Attributes =
Transaction Attributes al <Al Transaction Attribukes:>
Classes &l <Al Classes =
Journals Al <Al Journals=
Mok Yet Posted Transactions Al <Al Mot et Posted Transactions =
Mission(s) all <Al Missionis) =
Spendable/Mon-spendablelsy Al <Al SpendableiMon-3pendableds) >
Petformances) Al <Al Performances) = ;I

Cancel |

Multiple Column Headings Tab

On the Multiple Column Headings tab, you can create a heading to cover more than one column.

A2 New Project Financial Statements ﬂ

File Edit Wew Favoribes Tools Help

dadag - |

At Generall 2 Filters | 3: Colurmms £ 4: Multiple Colurnn Headings I o Formatl

Heading Start Column I End Colurmn Align I

Heading. Text entered into the Heading column appears as a heading above one or more of the individual
column headers.

Start. In the Start column, select the first column the multiple column heading will cover.

End. In the End column, select the last column the multiple column heading will cover. The End column must be
greater than or equal to the Start column.

Align. In the Align column, select a left, center, or right alignment.

Format Tab

On the Format tab, you decide how the report should look. You can create headings and footers, include a list of
criteria used to create the report, sort the information in the report, and select the format for displaying
monetary amounts.
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The list on the left of the screen displays formatting options for the Project Financial Statements: Headings,
Criteria, Detail, Page Footer, Report Footer, Miscellaneous, and Color Scheme. When you select an item in the
list, the right side of the screen displays selections for that section of the report.

Note: The heading defaults to Project Financial Statements in the Title field. You can leave this as the title for

the report or enter your own.

Headings. You can enter a maximum of 60 characters in each of the Title and Subtitle fields. The title and
subtitle appear at the top of the report. You can select how the heading should be aligned and whether your
organization's name will appear in the header.

You can include other options in the header, such as the page number and the date. You can also select to
include the header on every page of the report.

lg New Project Financial Statements il

File Edit Miew Faworites Tools Help

dadam a2 |

B Headings H eadings

3K Generall 2 Filtersl 25 Enlumnsl 4: Multiple Column Headings

Criteria 7

Dietail — Heading Farmnat

Page Footer Title: IF'loiect Financial Statements
Fieport Footer Sublite: |

Miscelaneous

Color Scheme Align: I Center % I

[¥ Print organization narne in header

W Print Page Number in Heading [V Print Report Date in Heading
Format: IF'age 1 j Farmat: I Short Date and Time j
Aligre |Fiight =] || A et =l

v Print repaort heading on each page

< Back Ident Caticel Erint Freview Lapout

Note: The program automatically selects all criteria. Unmark the checkbox for any you do not want to print
with the report.
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Criteria. Select Criteria to print a list of criteria used to create the report. Mark Print these criteria on and select
a separate page or the first page. Selections print in the criteria section of the report.

lE New Project Financial Statements

File Edit Wiew Favorites Tools Help

Hasan o= ?-

8 Genelall & Filtersl & Eolumnsl 4: Multiple Column Headings  5: Format |

Headings

‘B Criteria

Page break on each new Project
Include Projects with no activity
Include inactive Projects

Show total net surplus/[deficit)
Show beginning/ending balance in income statement
Show budget account details
Uszer account secunty access
Uszer Project security access
Funds ta include

Account Codes to inchude
Accounts to inchude

Account attributes to include

' Dietail [ Print these criteria on Ia separate page 'I

Page Footer Saved report name =
FReport Fagter Statement types to show I
Miscellaneaus Primary level of detail to show

Color Scheme Secondary level of detail to show

[ |

< Back | Hexts | Cancel |

Frint | Plevie@l Layout |

Detail. Use Detail to Print total net surplus/(deficit) for each project. Mark the Include beginning/ending
balance in Income Statement checkbox to display the beginning/ending balance on the Income Statement

portion of the report.

Ig New Project Financial Statements

File Edit Wiew Favorites Tools Help

dada o= ?-

1 Genelall s Filtersl &t Eolumnsl 4: Multiple Column Headings  5: Format |

Headings Detail
Criteria

Report Footer
Miscelaneous
Color Scheme

Shaw: IProiect budgets with accourt detail x|

Print total net surplus{deficit) -
Page Footer Include beginning/ending balance in Income Statement -

< Back | [Hext > Cancel Print

Preview

Layout
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In the Show field, you can select “Project budgets with account detail” if you want to show the account detail.
Select “Project total expense budgets”, if you want the budget based on the Project total budget.

The Show field is available only if you add a column to include budget information.

Page Footer. Use Page Footer to create a footer to appear at the bottom of each page of the report. You can
enter a maximum of 254 characters in the Text field for the page footer. You can also select how to align the
text and include the page number and date in the footer.

Ig New Project Financial Statements il

File Edit Wiew Favorites Tools Help

EIEEEEIEER R |

1 Genelall s Filtersl 2t Eolumnsl 4: Multiple Column Headings  5: Format |

Headings Page Footer

Liieria Page Footer Test
Dretail r

‘B Page Focter Text:

Report Footer
Miscelaneous
Color Scheme

Aligr: I Center o I

I Print Page Mumber in Footer [~ Print Repart Date in Foater
Format: IF'age 1 j Farmat: I Short Date and Time j
Aligre [Fiight =l | | #ane Lt =l

< Back | [Hext > Cancel Print Preview Layout
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Report Footer. Use Report Footer to create a footer to appear at the bottom of the last page of the report. You
can enter a maximum of 254 characters in the Text field for the report footer and select how to align the text.

lg New Project Financial Statements : i[
File Edit Wiew Favorites Tools Help
a3 =2 |

e Genelall = Filtersl & Eolumnsl 4: Multiple Column Headings  5: Format |

Headings Report Footer

Litera Report Footer Test
Detail

Page Footer Text:

‘B Feport Faoter
Miscellaneaus
Color Scheme

Align: | Leit vI

< Back | THext s Cancel Frrint Freview Layout

Tip: Make selections for displaying amounts and view them in the Sample amount display before printing the
report.
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Miscellaneous. Use Miscellaneous to specify how numbers appear on the report and the font size for the
report.

lE New Project Financial Statements

File Edit Wiew Favorites Tools Help
dasam =2 |

e Genelall Z Filtersl &k Eolumnsl 4: Multiple Column Headings  5: Format |

Headings Miscellaneous

Criteria
Dietail Show currency character on All amounts
Fage Faoter Show percent sign on All amounts

Fieport Footer Megative amount Format {1234.58)
E ol Sche Mumber of digits after decimal for amounts z

Mumber of digits after decimal For percentages z

Show 1000's separator Yes

Show blanks instead of zeros Mo

Font size g

Sample amaoLint:

Amount ($1,234.56)
Percent 100.00%
< Back | Hexts | Cancel | Frrint | Preview | Laypout |

Color Scheme. You can apply a color scheme to the column heading and group heading of the report. When
you click in the color box next to the selection, a Color screen appears so you can select a standard color or
define a custom color. If you leave the Apply a Color Scheme checkbox unmarked, the report prints in black
and gray.

lE New Project Financial Statements ﬂ

File Edit Wiew Favorites Tools Help

B ada o= ?- |

e Genelall = Filtersl &k Eolumnsl 4: Multiple Column Headings  5: Format |

Headings Color Scheme

Criteria
Dretail I Apply a Color Scheme Report Name
Page Footer M Column heading back colar Subtitle

Feport Footer

[7 Group heading back calor Group Headings

. Group heading fore color

Festore Defaults |

< Back | Hexts Cancel Frrint Preview Layout
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Project Budget vs. Actual Report

The Project Budget vs. Actual Report provides budget information and reports the actual activity of selected
projects and accounts.

Glossary: A project is a transaction-level identifier that categorizes transactions and budget entries. You can
use projects to track equity balances or prepare financial statements for a given purpose. Projects are available
only if you have the optional module Projects and Grants.

The Project Budget vs. Actual Report has tabs on which you set parameters: General, Filters, and Format. To
move among the tabs, click Next and Back at the bottom of the screen or select a tab. On these tabs you specify
information to include in the report and how the report should look. For more information about creating a
Project Budget vs. Actual Report, see “Creating a report in General Ledger” on page 15.

General Tab

On the General tab, you set parameters specific to the report and make selections about information included in
the report.

\@ New Project Budget vs. Actual Report x|
File Edit View Favorites Tools Help

Hada@ a=|2-
1: General |g: Filtersl a5 Folmat'

Fiepart type: I Detail = I

Show budget details far -

Scenario [D: IDD 'l ain Operating Budgat

¥ Use Project total expense budgets

Include budgets in this date range-

Date: I This fizcal year j 071407 /2007 ba 1243712007

[~ Include balance sheet accounts

I~ include Projects with no activing

Include these tranzaction types: I R egular j
Report arientation: I Portrait i I

< Back | Mext = | Cancel | FErint Preview Layout

Glossary: A budget scenario is a single version of an organization’s budget for a given time period. You can
have multiple budget scenarios if you have the optional module Budget Management. For example, you can
create a scenario of your original budget and also create scenarios for various revisions of that budget.

Report type. In the Report type field, select “Summary” or “Detail”.

Scenario ID. In the Scenario ID field, select the budget scenario for the report to use. A description of the
scenario appears in the display to the right.

Use Project total expense budgets. Mark this option to show the project total expense budget. The total
budget for expense accounts displays on the report instead of the individual period amounts.

Date. In the Date field of the Include budgets in this date range frame, you can select a specific date or date
range for budget activity to include.
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If you select <Specific range>, <Specific fiscal periods>, or <Specific fiscal year>, you can specify a start date
and an end date. If you leave the Start date field blank, all activity is included up to the end date. If you leave
the End date field blank, all activity from the start date until present is included. If you leave both fields blank,
all activity is included.

Include balance sheet accounts. Mark this checkbox to include balance sheet accounts.

Include Projects with no activity. If you mark this option, projects with no activity will still be included in the
report.

Include these transaction types. In the Include these transaction types field, select “Regular”,
“Encumbrance,” or “Regular” and “Encumbrance”. This field appears only if you have the optional module
Purchase Orders installed.

Note: To view the report as it will appear using your selections and filters, click Preview. To view a sample
layout of the report without data, click Layout.

Report orientation. In the Report orientation field, select Portrait or Landscape.

Filters Tab

On the Filters tab, you can include information based on selected criteria such as accounts, funds, projects, and
project attributes. For example, to include only the accounts with an account attribute of Expense Category and a
value of Salaries recorded in the account record. Accounts with other account attributes and with values other
than Salaries do not appear on the report.

13 New Project Budget vs. Actual Report =l
File Edit View Favorites Tools Help
Basam o ?- |

1: General || 3 Folmatl

{ ] Open ) Clear Al Filters

Filters | Indude Selected Filters |ﬂ

Funds Al <All Funds =

Account Codes Al <All Account Codes >

Accounts Al <Al Accounts =

Account Attributes all <All Account Attributes =

Categories All <All Categories =

Projects All <All Projects>

Project Types All <All Project Types>

Project Statuses All <All Project Statuses =

Project Divisions All <All Project Divisions =

Project Departments All <All Project Departments >

Project Locations All <All Project Locations >

Project Atiributes all <All Project Attributes =

Transaction Attributes all <All Transaction Attributes > LI

< Back | Mext » | Cancel | FErint | Preview | Lapout |

Open. Click afilter in the grid and click Open on the action bar. The selection screen appears so you can
designate specific filters for the report.

Clear All Filters. Click Clear All Filters to remove all previously selected filters from the report.

Glossary: A filter is a requirement records must meet to be included in a report. For example, if you apply the
Accounts filter, only the accounts you select are included in the report. You can select filters to apply to a
report from the Filters tab. Be patient! Depending on the filters you select, this report may take several
minutes to run after you click Print or Preview.
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Filters. The Filters column lists all the filters for this report. You cannot edit this column.

Include. Choose Selected in the Include column. A selection screen appears so you can designate specific filters
for the report.

Note: Mark Selected, Range, or Query to include a selected filter, range of filters, or a previously created query
of filters. Depending on the selection, different options appear on the screen. If you mark All, you cannot
define filters. For more information about filtering in The Financial Edge, see the Program Basics chapter in the
Program Basics Guide.

Selected Filters. Filters you specify appear in the Selected Filters column. If you choose Selected in the Include
column or click a filter and then click Open, the Selected <Filter> screen appears. If you mark Selected,
Range, or Query, a selection screen appears so you can specify filters.

Query name. The Query name field appears if you select Query. Enter the name of the query to use to filter the
report or click the binoculars to search for a query.
To create a new query, click the binoculars and click Add a New Query on the Open Query screen. For more
information about creating queries, see the Query Guide.

Previous Filter. To view or edit the previous filter without returning to the Filters tab, click Previous Filter on
the toolbar.

Next Filter. To view or edit the next filter without returning to the Filters tab, click Next Filter on the toolbar.

Format Tab

On the Format tab, you decide how the report should look. You can create headings and footers, include a list of
criteria used to create the report, sort the information in the report, and select the format for displaying
monetary amounts.

The list on the left of the screen displays formatting options for the Account Profile Report: Headings, Criteria,
Sort/Break, Page Footer, Report Footer, Miscellaneous, and Color Scheme. When you select an item in the list,
the right side of the screen displays selections for that section of the report.

Note: The heading defaults to Project Budget vs. Actual Report in the Title field. You can leave this as the title
for the report or enter your own.

Headings. You can enter a maximum of 60 characters in each of the Title and Subtitle fields. The title and
subtitle appear at the top of the report. You can select how the heading should be aligned and whether your
organization's name will appear in the header.
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You can include other options in the header, such as the page number and the date. You can also select to
include the header on every page of the report.

I3 New Project Budget vs. Actual Report : x|
File Edit View Favorites Tools Help

Hadam = ?- \

1 General' 2 Filters

Criteria

Sort/Break r— Heading Format
Page Foater Title: |Pl0iect Budget ve. Actual Report

ngolt Footer Subtitle: I
Miscelameous

Color Scheme Aligr: IEenter YI

¥ Print arganization name in header

v Print Page Number in Heading v Print Report Date in Heading
Farmat: IF'age 1 j Farmat: IShort Date and Time j
aligr: [Fight =] | | lign: [Len =

[V Frint repart heading on each page

< Back Hext s Cancel FErint Freview Layout

Note: The program automatically selects all criteria. Unmark the checkbox for any you do not want to print
with the report.

Criteria. Select Criteria to print a list of criteria used to create the report. Mark Print these criteria on and select
a separate page or the first page. Selections print in the criteria section of the report.

I3 New Project Budget vs. Actual Report x|
Eile Edit View Favorites Tools Help

dasaw o= |

1k General' 2: Filters  3: Format I

Criteria
¥ Frint thess criteria on Ia separate page 'I

Head

ings

Critenia

. Sort/Break

Page Footer Saved report name s
Repart Footer Output query name

Miscellaneous Seenario D to include

Calar Scherne Dates ko include

Transaction types to include
Include balance sheet accounts
Accounts to include
AccountCodes to include

Funds ta include

Projects to include

[w] Accounts atttibutes to include
Project attributes to include
Project lypes to include

Froject statuzes to include
Project divisions to include
Project departments to include LI

< Back | st > Cancel Frint Freview | Lapout |
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Sort/Break. Use Sort to select the order that information appears on the report. When you select Sort, a grid
displays the categories you can sort in the report. Select a sorting category in the Sort by column and select
Ascending or Descending in the Order by column. If you make no selections in the Sort by column, the
program sorts by the entire account number in ascending order.

You can also create breaks between the sections you have sorted by. In the Text before value and Text after
value fields, you can enter up to 30 characters in each field for information to print directly before and after
the break. If you mark Print count per or Print count as percentage of total for the selected sort field, the

number or percentage for each selected sort option appears in the footer. If you mark Page break on each
new, a new page starts for the highest level break.

I New Project Budget vs. Actual Report x|
File Edit Yiew Favorites Tools Help

Hasaw .= ?- |

1 Generall 2: Filters  3: Farmat I

Headings Sort/Break
Criteria

d Saort by | Category I Order by I Break? \ﬂ
Fage Footer Project ID Ascending -
Report Footer -

Miscellaneous r
Color Scheme

o il

Break Header for Project |0

Test before value: |

Text after value: I

Break Faooter for Project |0
I~ | Frirt count per Fraject |0

I Erirk court as & percentage of total

I Page break on each new Project D

< Back | st > | Cancel | FErint Freview Layout
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Page Footer. Use Page Footer to create a footer to appear at the bottom of each page of the report. You can
enter a maximum of 254 characters in the Text field for the page footer. You can also select how to align the
text and include the page number and date in the footer.

I New Project Budget vs. Actual Report : x|
File Edit Yiew Favorites Tools Help

Basaw al=2- |

1 Generall 2: Filters  3: Farmat I

Headings Page Footer

Criteria

Sort/Braak r— Page Footer Text

‘B Page Footer Text:

Report Footer

Miscelameous

Color Scheme
Aligr: ICenter ‘l
T Print Page Mumber in Footer ———— — [ Print Beport Date in Footer —————
Farmat; IF'age 1 j Farmat; IShort [rate and Tine j
Aligr: IHight j Aligr: ILeft j

< Back | Hext s | Cancel | FErint | Preview | Layout |

Report Footer. Use Report Footer to create a footer to appear at the bottom of the last page of the report. You
can enter a maximum of 254 characters in the Text field for the report footer and select how to align the text.

I New Project Budget vs. Actual Report x|
File Edit Yiew Favorites Tools Help

Ha3saw a2

hlE Generall 2: Filters  3: Farmat I

Al

Headings Report Footer
Criteria
Sort/Braak Report Footer Texst
Page Foater Text:
‘B Feport Footer
Miscellameous
Color Scheme
Align: |Left vl
< Back | st Cancel FErrint Freview Layaout

Tip: Make selections for displaying amounts and view them in the Sample amount display before printing the
report.
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Miscellaneous. Use Miscellaneous to specify how numbers appear on the report and the font size for the

report.
& new Project Budget vs. Actual Report x|
File Edit Yiew Favorites Tools Help
Hdadam =2
1 General' 2 Filters 3 Fommat I
Headings Miscellaneous
Criteria
Sart/Break Show currency character on All amounts
Page Foater Show percent sign on All amounts
Hpolt Focter Megative amount format (1234.56)
3 IEOLIE - -
Color S cherme Mumber of digits after dedmal for amounts 2
Mumber of digits after decimal for percentages 2
Show 1000's separator fes
Show blanks instead of zeros No
Font size 8
Sample amount:
Amount (£1,234.58)
Percent 100.00%
< Back | Hext s | Cancel | FErint | Preview | Layout |

Color Scheme. You can apply a color scheme to the column heading and group heading of the report. When
you click in the color box next to the selection, a Color screen appears so you can select a standard color or
define a custom color. If you leave the Apply a Color Scheme checkbox unmarked, the report prints in black

and gray.

I3 New Project Budget vs. Actual Report

File Edit View Favorites Tools Help

Bada@ al=?-

1 General' 2: Filters 3 Format I

Soit/Break [~ Apply & Colar Scheme
Page Foater

Feport Footer
Mizcelaneous

B Column heading back colar

I_ Caluran heading fore colar

8 Color Scheme I_ Group heading back colar
W Gioup heading fare calor

Hestare Defaults |

Headings Color Scheme
Criteria

Report Name
Subtitle

Group Headings

< Back | st » Cancel

Frint Preview Lapout
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Project Detail Report

The Project Detail Report can be printed in summary or detail format. In detail format, the report provides
general ledger account level balance and transaction detail information for projects within a selected date range.
The summary format provides general ledger account activity at the transaction level. Both the summary and
detail formats provide beginning balance, net change, and ending balance amounts for a project.

Glossary: A project is a transaction-level identifier that categorizes transactions and budget entries. You can
use projects to track equity balances or prepare financial statements for a given purpose. Projects are available
only if you have the optional module Projects and Grants.

The Project Detail Report has tabs on which you set parameters: General, Filters, and Format. To move among
the tabs, click Next and Back at the bottom of the screen or select a tab. On these tabs you specify information to
include in the report and how the report should look. For more information about creating a Project Detail
Report, see “Creating a report in General Ledger” on page 15.

General Tab

On the General tab, you set parameters specific to the report and make selections about information included in
the report.

u Mew Project Detail Report
File Edit “iew Fawaortes Tool: Help

EH &= 5w ?-

] 2: Filers ] & Fnrmat]

Report type; | Surnrnarny ﬂ

Include project activity in thiz date range

Drate: |<Spec:ific: fiszal periods> ﬂ 0640142003 to 06/3042003

Start fizcal pear: |This fizcal pear ﬂ Start period: IW
End fizcal vear: |Thi$ fizzal wear ﬂ End period: W

W Exclude projects with zero beginning balances and no activity

W Exclude projects with no activity

Include these ranzaction types: |Hegu|ar j

[~ Create an output quern of projects

Repart origntation: | Portrait il

Report type. In the Report type field, select Detail or Summary.

Date. In the Date field of the Include project activity in this date range frame, you can select a specific date or
date range for project activity to include.

If you select <Specific range>, <Specific fiscal periods>, or <Specific fiscal year>, you can specify a start date
and an end date. If you leave the Start date field blank, all activity is included up to the end date. If you leave
the End date field blank, all activity from the start date until present is included. If you leave both fields blank,
all activity is included.

Exclude projects with zero beginning balances and no activity. If you mark this option you can
efficiently exclude projects from the report that have zero beginning balances and no activity.
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Exclude projects with no activity. If you mark this option you can efficiently exclude projects from the
report that no activity.

Include these transaction types. In the Include these transaction types field, select Regular, Encumbrance,
or Regular and Encumbrance.

Create an output query of projects. If you mark this option, the system creates a query of the project you
select and includes it in the report. This query is available for use in other areas of the program.

Note: To view the report as it will appear using your selections and filters, click Preview. To view a sample
layout of the report without data, click Layout.

Report orientation. In the Report orientation field, select Portrait or Landscape.

Filters Tab

On the Filters tab, you can include information based on selected criteria such as funds, account attributes, and
project attributes. For example, to include only the accounts with an account attribute of Expense Category and a
value of Salaries recorded in the account record. Accounts with other account attributes and with values other
than Salaries do not appear on the report.

I2 New Project Detail Report E2
File Edit ‘iew Fawortes Tool: Help

SRRl Tl |

1: General | K3 Fnrmatl
&0 0pen 7 Clear All Filters
Filkers I Include Selected Filters Iﬂ
Funds Al <Al Funds =
Account Codes Al <Al Account Codes =
Arcounts Al <Al Bccounts =
Account Atbributes Al <Al Account Attributes >
Categories all <Al Categories =
Projects all =il Projects =
Project Atkributes all <Al Project Attributes =
Classes Al <Al Classes:=
Journals Al <Al Journals
Mot ‘et Posted Transactions |Selected <Monex
Transaction Attribukes Al <Al Transaction Attributes=
Missionis) all <Al Mission(s)=
Spendableiton-Spendabl. .. Al <Al spendable/hon-Spendableds) = :I

Open. Click a filter in the grid and click Open on the action bar. The selection screen appears so you can
designate specific filters for the report.

Clear All Filters. Click Clear All Filters to remove all previously selected filters from the report.

Glossary: A filter is a requirement records must meet to be included in a report. For example, if you apply the
Accounts filter, only the accounts you select are included in the report. You can select filters to apply to a
report from the Filters tab. Be patient! Depending on the filters you select, this report may take several
minutes to run after you click Print or Preview.

Filters. The Filters column lists all the filters for this report. You cannot edit this column.

Include. Choose Selected in the Include column. A selection screen appears so you can designate specific filters
for the report.
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Selected Filters. Filters you specify appear in the Selected Filters column. If you choose Selected in the Include
column or click a filter and then click Open, the Selected <Filter> screen appears. If you mark Selected,
Range, or Query, a selection screen appears so you can specify filters.

Query name. The Query name field appears if you select Query. Enter the name of the query to use to filter the
report or click the binoculars to search for a query.
To create a new query, click the binoculars and click Add a New Query on the Open Query screen. For more
information about creating queries, see the Query Guide.

Previous Filter. To view or edit the previous filter without returning to the Filters tab, click Previous Filter on
the toolbar.

Next Filter. To view or edit the next filter without returning to the Filters tab, click Next Filter on the toolbar.

Format Tab

On the Format tab, you decide how the report should look. You can create headings and footers, include a list of
criteria used to create the report, sort the information in the report, and select the format for displaying
monetary amounts.
The list on the left of the screen displays formatting options for the Account Profile Report: Headings, Criteria,
Sort/Break, Page Footer, Report Footer, Miscellaneous, and Color Scheme. When you select an item in the list,
the right side of the screen displays selections for that section of the report.
Note: The heading defaults to Project Detail Report in the Title field. You can leave this as the title for the
report or enter your own.

Headings. You can enter a maximum of 60 characters in each of the Title and Subtitle fields. The title and
subtitle appear at the top of the report. You can select how the heading should be aligned and whether your
organization's name will appear in the header.

You can include other options in the header, such as the page number and the date. You can also select to
include the header on every page of the report.

I New Project Detail Report [ x|
Fil= Edit “iew Favortes Tools Help

= D= R el 2

1: General I 2 Filters

B Headv

Criteria :

Cart/Break — Heading Format

Page Footer Title: |F'n:|iect Dretail Repart
Feport Footer Sublitle: I

Miscellaneaus
Color Scheme Align; ICentel 'I

[¥ Print arganization narme in header

W Print Page Number in Heading [V Print Report Date in Heading
Format: IF'age 1 j Farmat: IStht Date and Time j
Aligr | Right ]| g fLet =l

[¥ Frint report heading on each page

Note: The program automatically selects all criteria. Unmark the checkbox for any you do not want to print
with the report.
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Criteria. Select Criteria to print a list of criteria used to create the report. Mark Print these criteria on and select

a separate page or the first page. Selections print in the criteria section of the report.

File Edit “iew Faworites

I Mew Project Detail Report

Toolz Help

= D= R = 2

Headings
‘B Criteria
Sort/Break
Page Footer
Fieport Footer

1 Generall 2 Filters ~ 3: Farmat |

Criteria
¥ Print these criteria on Ia separate page "I

Saved report name “
Output querny name

Miscellaneous

E Dates to inchude
] Colar Scheme

Include projects with a zero beginning balance

Include projects with no activity

Transaction twpes ta include

Fundz ta include

Account codes to include

Accounts to inchude

Account atttributes ba include

Categories to include =
Frojects to include

Project attributes to include

Classes to include

Jourmnals to include

Mat yet pozted tranzactions to include ;I

Sort/Break. Use Sort/Break to select the order that information appears on the report and where to create
breaks in the information. When you select Sort, a grid displays the categories you can sort in the report.
Select a sorting category in the Sort by column and select Ascending or Descending in the Order by column.
You can sort by project ID in this report.

You can also create breaks between the sections you have sorted by. In the Text before value and Text after
value fields, you can enter up to 30 characters in each field for information to print directly before and after
the break. If you mark Print count per or Print count as percentage of total for the selected sort field, the
number or percentage for each selected sort option appears in the footer. If you mark Page break on each
new, a new page starts for the highest level break.

I Hew Project Detail Report E

File Edit Wiew Favartes
RS Ewe?-

1: Generall 2 Filters 3 Format |

Tools Help

Headings Sort/Break
Criteria
H=] & Sart by | Category | Order by | Break? |
Page Footer Project 1D Azcending -
Report Footer r
tizcellaneous r
Calor Scheme

r

r

Break Header for Project D

Text before value: I

Text after value: I

Break Footer for Project 1D
[ Eritit count per Praject (D

™| Bt caunt a5 & pereentane of batal

I Fage break oneach new Project D
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Page Footer. Use Page Footer to create a footer to appear at the bottom of each page of the report. You can
enter a maximum of 254 characters in the Text field for the page footer. You can also select how to align the
text and include the page number and date in the footer.

M@ Mew Project Detail Report E
File Edit “iew Favoritez Toolke Help

= = RE = el B

1 General' 2 Filters 3 Format |

Headings Page Footer
Criteria P
Detail — Fage Footer Tex

Sort/Break e
B Page Footer

Report Footer
Miscelaneous

Color Scheme Align: Il:enter 'I

I Piint Page Mumber in Footer

[~ Print Repart Date in Footer
Farmat: IF'age 1 j Farmat: ISholt Date and Time j
Aligr: [ Right =l g [Len =l

Report Footer. Use Report Footer to create a footer to appear at the bottom of the last page of the report. You
can enter a maximum of 254 characters in the Text field for the report footer and select how to align the text.

1@ New Project Detail Report ]
File Edt “iew Fawortes Toolz Help

= D= R = e

1 Genelall 2 Filters ~ 3: Farmat |

Headings Report Footer
Criteria q y——
Detail eport Footer Tex

Sort/Break Test:

Page Footer
B Report Footer

Mizcelaneous

Color Scheme Align: I Left = I

Tip: Make selections for displaying amounts and view them in the Sample amount display before printing the
report.
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Miscellaneous. Use Miscellaneous to specify how numbers appear on the report and the font size for the

report.

File Edit Wiew Favortes

A3 Mew Project Detail Report

Tool: Help

= = RE = e

Generall Filters FDll‘ﬂall

Headings
Criteria
Sort/Break
Page Footer
Freport Footer
ANEOLIS

- Calor Scheme

Miscellaneous

Sample amount;

Show currency character on All amounts
Show percent zign on All amounts
Megative amaount format [1234.56)
MHurnber of digitz after decimal for amounts 2

MHurnber of digitz after decimal for percentages 2

Show 1000's zeparator Tes

Shaw blanks instead of 2eros Mo

Font size a

Aot

[$1.234.56)

Percert

100.00%%

Color Scheme. You can apply a color scheme to the column heading and group heading of the report. When
you click in the color box next to the selection, a Color screen appears so you can select a standard color or
define a custom color. If you leave the Apply a Color Scheme checkbox unmarked, the report prints in black

and gray.

I New Project Detail Report

File Edit “iew Favortes

H S RW -

Toolz Help

=2 -

Headings
Criteria

Detail
Sort/Braak
Page Footer
Report Footer
Miscellananus

1 Generall 2 Filters 2 Format |

Color Scheme

I~ Apply a Color Scheme

. Column heading back color

I_ Column heading fore color
|_ Group heading back color

- Group heading fore color

Restore Defaults

Report Name
Subtitle

Column Headings

Group Headings

Project Profile Report

The Project Profile Report displays a summary of the information in a project record. This report can be printed
for a single project or for multiple projects. The Project Profile Report can be created from both Reports and

Projects.



329 CHAPTER

Glossary: A project is a transaction-level identifier that categorizes transactions and budget entries. You can
use projects to track equity balances or prepare financial statements for a given purpose. Projects are available
only if you have the optional module Projects and Grants.

The Project Profile Report has tabs on which you set parameters: General, Filters, and Format. To move among
the tabs, click Next and Back at the bottom of the screen or select a tab. On these tabs you specify information to
include in the report and how the report should look. For more information about creating a Project Profile
Report, see “Creating a report in General Ledger” on page 15.

General Tab

On the General tab, you set parameters specific to the report and make selections about information included in
the report.

IQ Mew Project Profile Report E

File Edit ‘“iew Fawortez Toolz: Help
FlERE A= |
1: General |2: Fillersl 2 Farmnat |
Inciude the following project infarmation:
[ Contacts .fi‘n.lc:tlwty Farmat
¥ Attibutes Fiseal years: ™ 2000
[# Budget worksheet [~ 2001
[V Activity v 2002
g :;.d;:s Budget scenaricc [ ain Dperating Budget =l
[V Mates Type: IHeguIal j
¥ Histary of changes [~ Show balance sheet accounts
Budget \Wark shest
Budget scenari: [ ain Dperating Budget =]
Fizcal year: | 2002 j

Include the following project information. In the Include the following project information box, mark the
checkboxes of the project information to include in the report.

Activity format. In the Activity Format frame you make selections for account activity. This frame and its fields
are enabled only when the Activity checkbox is marked in the project information box.

Fiscal years. In the Fiscal years field of the Activity format frame, mark the fiscal years to be included in the
report. This field is enabled only when the Activity checkbox is marked in the project information box.

Glossary: A budget scenario is a single version of an organization’s budget for a given fiscal year. You can have
multiple budget scenarios if you have the optional module Budget Management. For example, you can create
a scenario of your original budget and also create scenarios for various revisions of that budget.

Budget scenario. In the Budget scenario field, select a budget scenario. The budget scenarios listed are those
created in the optional module Budget Management or on the Budgets tab of a project record. This field is
enabled only when the Activity checkbox is marked in the project information box.

Type. In the Type field, select Regular or Encumbrance or Regular and Encumbrance. This field is enabled only
when the Activity checkbox is marked in the project information box.

Budget worksheet. In the Budget Worksheet frame you make selections for budget information. This frame
and its fields are enabled only when the Budget worksheet checkbox is marked in the project information

box.
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Budget scenario. In the Budget scenario field, select a budget scenario. The budget scenarios listed are those
created in the optional module Budget Management or on the Budgets tab of a project record. This field is
enabled only when the Activity checkbox is marked in the project information box.

Fiscal year. In the Fiscal year field of the Budget Worksheet frame, select the fiscal year to be included in the
report. This field is enabled only when the Budget worksheet checkbox is marked in the project information
box.

Create an output query of projects. If you mark this option, the system creates a query of the project you
select and includes it in the report. This query is available for use in other areas of the program.

Note: To view the report as it will appear using your selections and filters, click Preview. To view a sample
layout of the report without data, click Layout.

Report orientation. In the Report orientation field, select Portrait or Landscape.

Filters Tab

On the Filters tab, you can include information based on selected criteria such as projects and project attributes.
For example, to include only the projects with an project attribute of Project Manager and a value of Karen Reid
recorded in the project record. Projects with other attributes and with values other than Karen Reid do not
appear on the report.

IE New Project Profile Report
File Edit ‘“iew Fawortez Toolz: Help

FlERE A= |

1: General 2 Filters |§: Farmat |

@@ 0pen ) Clear Al Filters

Filters I Include Selected Filters
Projects Al <All Projects=
Project Aktributes all <all Project Attributes =

Open. Click a filter in the grid and click Open on the action bar. The selection screen appears so you can
designate specific filters for the report.

Clear All Filters. Click Clear All Filters to remove all previously selected filters from the report.

Glossary: A filter is a requirement records must meet to be included in a report. You can select filters to apply
to a report from the Filters tab. Be patient! Depending on the filters you select, this report may take several
minutes to run after you click Print or Preview.

Filters. The Filters column lists all the filters for this report. You cannot edit this column.

Include. Choose Selected in the Include column. A selection screen appears so you can designate specific filters
for the report.

Selected Filters. Filters you specify appear in the Selected Filters column. If you choose Selected in the Include
column or click a filter and then click Open, the Selected <Filter> screen appears. If you mark Selected,
Range, or Query, a selection screen appears so you can specify filters.

Query name. The Query name field appears if you select Query. Enter the name of the query to use to filter the
report or click the binoculars to search for a query.

To create a new query, click the binoculars and click Add a New Query on the Open Query screen. For more
information about creating queries, see the Query Guide.
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Previous Filter. To view or edit the previous filter without returning to the Filters tab, click Previous Filter on
the toolbar.

Note: Mark Selected, Range, or Query to include a selected filter, range of filters, or a previously created
query of filters. Depending on the selection, different options appear on the screen. If you mark All, you cannot
define filters. For more information about filtering in The Financial Edge, see the Program Basics chapter in the
Program Basics Guide.

Next Filter. To view or edit the next filter without returning to the Filters tab, click Next Filter on the toolbar.

Format Tab

On the Format tab, you decide how the report should look. You can create headings and footers, include a list of
criteria used to create the report, sort the information in the report, and select the format for displaying
monetary amounts.

The list on the left of the screen displays formatting options for the Account Profile Report: Headings, Criteria,
Sort, Page Footer, Report Footer, and Miscellaneous. When you select an item in the list, the right side of the
screen displays selections for that section of the report.

Note: The heading defaults to Project Profile Report in the Title field. You can leave this as the title for the
report or enter your own.

Headings. You can enter a maximum of 60 characters in each of the Title and Subtitle fields. The title and
subtitle appear at the top of the report. You can select how the heading should be aligned and whether your
organization's name will appear in the header.

You can include other options in the header, such as the page number and the date. You can also select to
include the header on every page of the report.

lQ Mew Project Profile Report
File Edit Wiew Favorites Toolz Help

RS R ?- |

1 Generall 2 Filters ~ 3: Format |

B Headings H eadings
Criteria

St —Heading Format
Page Footer Title: |F'loiec:t Profile Repart
Report Footer S ubtitle: I

Miscelaneous
Aligr: ICenter 'I

[¥ Print crganization narne in header

¥ Print Fage Mumber in Heading [¥ Print Report Date in Heading
Farmat; IPage 1 j Farmat; IShort Date and Time j
Aligre [Fiight =] || dian: [Left =l

[¥ Piint report heading on each page

Note: The program automatically selects all criteria. Unmark the checkbox for any you do not want to print
with the report.
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Criteria. Select Criteria to print a list of criteria used to create the report. Mark Print these criteria on and select
a separate page or the first page. Selections print in the criteria section of the report.

lE MNew Project Profile Report
File Edit ‘iew Favortes Toolz Help

= D= R I e

1: Generall 2 Filters ~ 3: Farmat |

Headings

Sort

Page Footer
Report Footer
Miscellareous

¥ Print these criteria on Ia zeparate page 'I

Saved report name

Qutput query hame

Include activity fiscal years
Include activity budget scenario
Include achivity type

Include budget

Projects to include

Project attributes to include

Sort. Use Sort to select the order that information appears on the report. When you select Sort, a grid displays

the categories you can sort in the report. Select a sorting category in the Sort by column and select Ascending
or Descending in the Order by column. If you make no selections in the Sort by column, the program sorts by

the entire account number in ascending order.

lﬂ Mew Project Profile Report
File Edit “iew Favoritez Toolke Help

= = RE R el B

1 General' 2 Filters 3 Format |

Repart Faater
Miscelaneous

™ Page break on each new

Headings Sort

Criteria
Sort by | Categony | Order by |
Page Foater Project ID Ascending
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Page Footer. Use Page Footer to create a footer to appear at the bottom of each page of the report. You can
enter a maximum of 254 characters in the Text field for the page footer. You can also select how to align the

text and include the page number and date in the footer.

lQ Mew Project Profile Report

File Edit “iew Favoritez Toolz Help

= D= NE R = e e 2

1 Generall 2 Filters 2 Format |

Headings Page Footer
Criteria Paoe Footer Text
Soit — Page Footer Tex
B Page Footer Text:
Fepart Faater
Miscelaneous
Aligr: ICenter 'I
[ Print Page Mumber in Footer [~ Print Repaort Date in Footer
Farmat: IF'age 1 j Farmat: IShDrt Date and Time j
Align:  [Right =l | [ dign: [Let =l

Report Footer. Use Report Footer to create a footer to appear at the bottom of the last page of the report. You
can enter a maximum of 254 characters in the Text field for the report footer and select how to align the text

lQ Mew Project Profile Report
File Edit “iew Favoritez Toolz Help

= D= R = e R

1 Generall 2 Filterz 3 Format |

Headings Report Footer
Criteria Flenort Footer Text
Sort eport Fooker Tex
Page Footer Text:
B Report Footer
Miscelaneous
Aligr: | Left - I

Tip: Make selections for displaying amounts and view them in the Sample amount display before printing the

report.

Miscellaneous. Use Miscellaneous to specify how numbers appear on the report and the font size for the

report.
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Miscellaneous

Show currency character on

Show percent sign on
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